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ISTIKLAL MARSI

Korkma, sonmez bu safaklarda yiizen al sancak;
So6nmeden yurdumun Gstiinde tiiten en son ocak.

O benim milletimin yildizidhr, parlayacak;
O benimdir, o benim milletimindir ancak.

Catma, kurban olayim, ¢ehreni ey nazl hilal!

Kahraman irkimabir gil! Ne bu siddet, bu cel@l?

Sana olmaz dokulen kanlarimiz sonra helal.
Hakkidir Hakk’ atapan milletimin istiklal.

Ben ezelden beridir hir yasadim, hir yasarim.
Hangi ¢ilgin bana zincir vuracakmis? Sasarim!
Kukremis sel gibiyim, bendimi ¢igner, asarim.
Y irtarim daglari, enginlere sigmam, tasarim.

Garbin & é&kim sarmigsa gelik zirhli duvar,
Benim iman dolu gdgsim gibi serhaddim var.
Ulusun, korkma! Nasil boyle bir imam bogar,
Medeniyyet dedigin tek disi kalmis canavar?

Arkadas, yurduma al¢aklar: ugratma sakin;
Siper et gévdeni, dursun bu hayasizca akin.
Dogacaktir sanava dettigi glinler Hakk’1n;

Kim bilir, belki yarin, belki yarindan da yakin.

Bastigin yerleri toprak diyerek gecme, tan:
Dusun altindaki binlerce kefensiz yatan.
Sen sehit oglusun, incitme, yaziktir, atam:
Verme, dinyalar: alsan da bu cennet vatan:.

Kim bu cennet vatanin ugruna olmaz ki feda?
Suheda fiskiracak toprag: siksan, stihedal
Céani, canéni, butun varimi alsin da Huda,
Etmesin tek vatammdan beni diinyada clida.

Ruhumun senden 118hi, sudur ancak emeli:
Degmesin mabedimin gdgsiine ndmahrem €li.
Bu ezanlar -ki sehadetleri dinin temeli-
Ebedi yurdumun Usttinde benim inlemeli.

O zaman vecd ile bin secde eder -varsa- tasim,
Her certhamdan 118hi, bosarp kanl1 yasim,
Fiskirir ruh-1 micerret gibi yerden na' sim;

O zaman yUkselerek arsa deger belki basim.

Dalgalan sen de safaklar gibi ey sanli hilal!
Olsun artik dokulen kanlarimin hepsi helél.
Ebediyyen sana yok, irkimayok izmihlél;
Hakkidir hur yasamis bayragimin hiirriyyet;
Hakkidir Hakk’ a tapan milletimin istiklal!

Mehmet Akif Ersoy



GENCLIGE HITABE

Ey Tirk gencligi! Birinci vazifen, Turk istiklalini, Ttrk Cumhuriyetini,
ilelebet muhafaza ve midafaa etmektir.

Mevcudiyetinin ve istikbalinin yegane temeli budur. Bu temel, senin en
kiymetli hazinendir. Istikbalde dahi, seni bu hazineden mahrum etmek
isteyecek dahili ve harici bedhahlarin olacaktir. Bir gin, istiklal ve cumhuriyeti
mudafaa mecburiyetine dusersen, vazifeye atilmak igin, iginde bulunacagin
vaziyetin imkan ve seraitini disunmeyeceksin! Bu imkan ve serait, cok
namisait bir mahiyette tezahtr edebilir. Istiklal ve cumhuriyetine kastedecek
dusmanlar, batin dinyada emsali gorilmemis bir galibiyetin - mumessili
olabilirler. Cebren ve hile ile aziz vatamn bitun kaleleri zapt edilmis, butin
tersanelerine girilmis, batun ordular: dagitilmis ve memleketin her kdsesi bilfiil
isgal edilmis olabilir. Butlin bu seraitten daha elim ve daha vahim olmak (zere,
memleketin dahilinde iktidara sahip olanlar gaflet ve dalélet ve hattd hiyanet
icinde bulunabilirler. Hattd bu iktidar sahipleri sahsi menfaatlerini,
mustevlilerin siyasi emelleriyle tevhit edebilirler. Millet, fakr u zaruret icinde
harap ve bitap dusmdis olabilir.

Ey Tirk istikbalinin evladi! iste, bu ahval ve serait icinde dahi vazifen,
Turk istiklal ve cumhuriyetini kurtarmaktir. Muhta¢ oldugun kudret,
damarlarindaki asil kanda mevcuttur.

Mustafa Kemal Atattirk
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DERS MATERYALININ TANITIMI

Ogrenme biriminde neler Ogrenme biriminin
Ogrenme biriminde yer Ogrenilecegiile ilgili 6n numarasini gosterir.
alan konulari gosterir. bilgileri gosterir.
A A
[ ]
J
L/
Karekod okuyucu ile taratilarak resim, Ogrenme birimindeki Ogrenme biriminin
video, soru ve ¢oztmleri vb. ilave kaynak- onemli kavramlari gosterir. adini gosterir.

lara ulasilabilecek karekod bolimuddr.
Detayl bilgi icin http://kitap.eba.govtr/
karekod
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Derse baslamadan 6nce yapi-
l lacak hazirliklari gosterir.

Ogrencilerin edindigi
o > bilgiyi kullanmasini
saglayacak galismalari gosterir.

Konu ve uygulamalara iliskin
ek bilgi ve ipuclarini gosterir.

B

Konuyu pekistirmek icin
ogrencilerin yapmasi gereken <«———o
etkinlikleri gosterir.



Karekod, gorsel kaynakgasini
gosterir.

»
>

Kazanilan bilgi ve becerilerin
her 6grenme birimi sonunda
Ol¢lildiigi calismalari gosterir.
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HAZIRLIK CALISMALARI

1. Goruntil isleme programlari en ¢cok hangi alanlarda kullanilir?

2. Gorlintl isleme programlari kullanilarak neler yapilabilir?

1.1. GORUNTU iISLEME PROGRAMI

Gorlntlnin olusturulmasi, hatali goériintlinin dizeltilmesi, gériintide dikkat cekilmek istenen
yerin belirginlestirilmesi, gorlntiye bakildiginda istenen alginin olusturulmasi gibi amaclari
gerceklestirmek icin goriinti islemeye ihtiyac duyulur. Bu ihtiyag, goriintli isleme programlariyla
karsilanir. Gorinta isleme yazilimlari dijital bir goriintiiniin olusturulmasina, degistirilmesine,
dizenlemesine ve iyilestiriimesine olanak saglar. Renk diizenleme, netlestirme, rotuslama,
kirpma, ekleme islemleri ile gortntideki kusurlar giderilerek istenen gorinti elde edilebilir ve
gorintl yazdirilabilir. Gorlintl isleme programlari bunlarin yaninda boyama ve ¢izim araci olarak
da kullanilabilir. Ayni zamanda geometrik sekilleri ve bicimlendirilmis metinleri gorintilerle
bitlinlestirmek mimkindur. Bircok gorintl kullanilarak kolajlar da olusturulabilir. Bu islemler;
gorlintl isleme programindaki ayarlar, 6zellikler, araglar, katmanlar, filtreler, efektler ve bunlarin
kombinasyonlari kullanilarak yapilir.

1.1.1. Program Kurulumu

Goruntl isleme yazilmi deneme sirimi ya da tam sliriim olarak kullanilabilir. Programi
kurabilmek icin ilgili klasordeki setup dosyasi ¢alistirilir ve yiikleme islemi baslatilir. Yikleme
islemi bittiginde gorinti isleme programi kullaniimaya hazirdir (Gorsel 1.1).

Gorsel 1.1: Programin ilk agilis ekrani
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1. UYGULAMA

islem adimlarina gére goriintii isleme programinin bilgisayara kurulumunu gercek-
lestiriniz.

1. Adim: Programi lisansli olarak temin ediniz.

2. Adim: Bilgisayarinizda kullandiginiz isletim sisteminin 32/64 bit oldugundan emin olunuz.

3. Adim: isletim sisteminize uygun sekilde setup dosyasini calistirarak kurulumu baslatiniz.

4. Adim: Kurulum sirasinda karsiniza gelecek segenekler icinden programin kurulacagi dizini
sabit diskinizin durumuna goére belirleyiniz. Programin etkin ve verimli ¢alismasi icin varsayilan
konumu degistirmemeye dikkat ediniz.

5. Adim: Yiikleme tamamlandiginda lisans kaydini gerceklestirmek igin internet baglantinizin
aktifliginden emin olunuz.

6. Adim: Lisans kaydinizi gergeklestiriniz.

7. Adim: Yiklediginiz programi Baglat meniisiinden veya masatisti kisayolundan galistiriniz.

1.1.2. Program Arayuzu

Goruntl isleme programinda dijital gortntiiler Gorsel 1.2°deki gibi bir ana pencerede agilir.
Programda bulunan menl komutlari, araglar ve panel tabanh 6zelliklerin gesitli birlesimleri
kullanilarak gorintuler diizenlenir.

A <—e G
= :
—>C
E <o
D
!
—>F

Gorsel 1.2: Goriintii isleme programi ana ekrani
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(A) Application Bar (Menu Bar): Goriintl isleme yazihminin komutlarini ve fonksiyonlarini
gosterir.

(B) Options Bar: Secili aracin 6zellestirilmesini saglayan kontroller bulunur. Ayrica gubugun
sag tarafinda bulunan digmeler araciligiyla kullanici davet etme, arama, bir goriintliyl paylasma
ve ihtiyaca uygun g¢alisma alani segme islemleri yapilabilir.

(C) Title Tab: Acik gbriintlintin adini, blylitme oranini ve renk modunu gosterir. Agik goriintller
arasinda gecis yapmak icin sekmelere tiklanir.

(D) Image Window: Acik gorintilerin goriintlledigi alandir.

(E) Toolbox: Resim diizenleme araglarini gosterir. Kullanilacak arag tiklanir ve gériinti Gzerine
islem yapilir. Ayrica aktif 6n ve arka plan renklerini gosterir.

(F) Status Bar: Gorlintileme oranini ve Ozelliklerini gosterir.

(G) Panels: Kaynaklara ve komutlara ulasilir. Panelleri gériintilemek ve gizlemek igin sekmelere
tklanir.

2. UYGULAMA

islem adimlarina gore goriintii isleme programinin farkli calisma alanlarini aktiflesti-

riniz.

1. Adim: Choose a Workspace diigmesine tiklayiniz (Goérsel 1.3).

Gorsel 1.3: Choose a Workspace diigmesi

2. Adim: Acilan meniiden Painting secenegine tiklayiniz.
3. Adim: Paneller ve toolboxtaki degisiklikleri g6zlemleyiniz.
4. Adim: Choose a Workspace diigmesinden 3D se¢enegine tiklayiniz.

5. Adim: Bu calisma alanindaki degisiklikleri gozlemleyiniz.
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1.2. TEMEL KOMUTLAR

Goriunti isleme programindaislemleri gerceklestirmek igin uygulanacak bir¢ok komut bulunur.
Bu komutlara ekrandaki araclar, paneller, acilan meniler veya olusturulan cesitli kisayollar
araciligiyla ulasilir.

1.2.1. Temel Menii Komutlar

File menlsiinde dosyalama islemlerine ait New... (Yeni), Open... (Ag), Save (Kaydet), Save As...
(Farkh Kaydet), Export (Disa Aktar), Import (ice Aktar), Print... (Yazdir) ve Exit (Cikis) vb. komutlar
bulunur. Bu komutlaritamamlamak igin gelen iletisim pencereleriistege uygun sekilde cevaplanir.

Edit menlsinden Undo (Geri Al), Redo (Yinele), Cut (Kes), Copy (Kopyala), Paste (Yapistir),
Transform, Color Settings (Renk Ayarlari), Preferences (Tercihler) vb. diizenleme komutlarina
ulasilir. Edit menisiindeki bu komutlar genellikle yapilan bir islemin diizenlenmesi amaciyla
kullantlir.

Image mends, goriintilemeileilgilikomutlariicerir. Image menisiinden Mode (Goriintileme
Modu), Image Size... (Gorlinti Boyutu), Canvas Size... (Tuval Boyutu) gibi komutlara erisim
saglanir.

Layer menisl, katmanlar ile ilgili tim komutlari barindirir. Type menisi altinda metin
islemlerine ait komutlara erisilir. Select menisi altinda ise seg¢im islemlerine ait komutlar
bulunur. Filter menisiinden filtrelere ulasilir. U¢ boyutlu calismalar icin tiim ayarlamalar ve
komutlar 3D mensi altinda bulunur. Géruntileme 6zellikleri View meniisi altinda bulunan
komutlar araciligiyla bigimlendirilir. Program calisma arayizii ayarlari Window mensd ile yapilhr.
Goriuntl isleme programinin eklenti yonetimi igin Plugins menisi kullanilir. Ayrica yardim ile ilgili
konulara Help menusi kilavuzluk eder.

3. UYGULAMA

islem adimlarina gére yeni belge olusturup kaydetme islemini gerceklestiriniz.
1. Adim: Gorlintli isleme programinda File>New... segenegine tiklayiniz veya klavyeden Ctrl+N
tuslayiniz.

2. Adim: New Document iletisim penceresinde verilen hazir ayarlari kullanmak igin Saved,
Photo, Print, Art&lllustrasyon, Web, Mobil, Film&Video sekmelerinden Photo>Portrait>2x3 hazir
ayarini seginiz.
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3. Adim: Hazir ayar kullanarak belgeyi olusturmadan 6nce sag boélimde bulunan PRESET
DETAILS kismini asagida verilen degerlere gore doldurunuz (Gorsel 1.4).

e Width (Genislik): 24

e Height (Yukseklik): 48

e Birim: Centimeters

e Orientation (Yonlendirme): Dikey (Width ve Height degerlerine gore otomatik olarak
belirlenir.)

e Resolution (Cozlnarlik): 600

e Birim: Pixels/Inch

e Color Mode (Renk Modu): CMYK Color
® Renk Uzayi Boyutu: 16 bit

e Background Contents: Custom

e Renk: Kirmizi

Gorsel 1.4: Yeni belge penceresi

4. Adim: Create diigmesine tiklayiniz.
5. Adim: Olusturulan belgeye Rectangle Tool aracini kullanarak bir dikdértgen giziniz.

6. Adim: Foreground colora tiklayinca agilan Color Picker iletisim kutusundan 6n plan rengini
beyaz olarak degistiniz.

7. Adim: Rectangle Tool aracini seginiz ve bir dikdortgen giziniz.

8. Adim: File>Save secenegine tiklayiniz veya klavyeden Ctrl+S tuslayiniz.
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9. Adim: Gelen iletisim ekraninda kaydetmek istediginiz klasori ve dosyanin kayit tirin
seginiz.

10. Adim: Belgenin adini “1.Calisma.psd” olarak giriniz ve Save digmesine tiklayiniz.

Renk modu veya goriintii modu, renklerin hangi yontem kullanilarak olusturulacagini
belirler. RGB, CMYK, Index, Gri Tonlama ve Bitmap olmak lzere bes farkli renk modu
vardir. Boyalarla olusturulan CMYK modu baski alinacak gorintilerde, i1sikla olusturulan
RGB modu ise dijital gortntilerde kullanilir.

4. UYGULAMA

islem adimlarina gére énceden calishginiz belgeyi farkli kaydetme, disa aktarma,
yazdirma ve kapatma islemlerini gergeklestiriniz.

1. Adim: Gorintl isleme programinda File>Open... mendisitne tiklayiniz veya klavyeden
Ctrl+0 tuslayiniz.

2. Adim: Ac iletisim penceresinden agiimasini istediginiz belgenin bulundugu klasori seginiz.
3. Adim: Ugiincii uygulamada kaydedilen “1.Calisma.psd”yi secip A¢ digmesine tiklayiniz.
4. Adim: File>Print... menusiine tiklayiniz veya klavyeden Ctrl+P tuslayiniz.

5. Adim: Agilan pencereden Printer alaninda yaziclyi secerek belgenin kag adet yazdirilacagini
Copies alanina yaziniz ve Print digmesine tiklayiniz (Gorsel 1.5).

Gorsel 1.5: Yazdir penceresi

Gorinti isleme
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6. Adim: Belgeyi PNG olarak disa aktarmak icin File>Export>Quick Export as PNG se¢enegine
tiklayiniz.

7. Adim: Gelen Save As iletisim penceresinde PNG tirindeki belgeyi kaydedeceginiz klasori
seciniz ve belge adini giriniz.

8. Adim: Mevcut belgeyi “numara_ad_soyad” ismiyle farkh bir klasore kaydetmek igin
File>Save As... secenegine tiklayiniz.

9. Adim: Belgenin kaydedilecegi klasori seciniz ve belge adini giriniz. Kaydet digmesine
tiklayiniz.

10. Adim: Belgeyi kapatmak icin File>Close secenegine tiklayiniz. Birden fazla belge aciksa
File>Close All secenegine tiklayiniz.

Goriintl isleme programini kapatmak icin File>Exit veya sag st kosedeki X simgesi
tiklanir.

Gorintl dosyalari, kullanim amacina uygun formatta kaydedilmelidir. Dosya;
Uzerindeki degisiklikler korunacaksa ham dosya (.psd) olarak, webde kullanilacaksa
.png olarak, webde kii¢lik boyutlu kullanilacaksa .jpg olarak kaydedilmelidir.

1.2.2. Araglar

Goruntl isleme programlarinda istenen dizenleme ve degisikliklerin yapilmasi icin segim
araclari, kesme ve dilimleme araclari, boyama araclari, rotus araclari, filtreler, katmanlar, eylemler
kullantlir.

Gorsel 1.6’da goriintl isleme yaziliminda bulunan araglar verilmistir. Secilmek istenen arag
tiklanir. Gizlenmis arag varsa aracin sag alt kdsesindeki ok isareti tiklanarak goriintilenir. Ayrica
araclar icin varsayilan olarak tanimlanan klavye kisayollari da kullanilabilir. Gizlenmis araglar icin
de ayni kisayol gecerlidir. Arag grubu icinde gecis yapmak icin Shift + kisayol tuslanir.
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Rectangle Marquee Tool
(Diktorgen Secim Araci)

Object Selection Tool (Nesne
Secim Araci)

Move Tool (Tagima Araci)

|
Lasso Tools (Kement Araglari) ‘
|

Krop Tools (Kirpma Araclari) ’ Frame Tool (Yer Tutucu Araci) ‘

Spot  Healing Brush Tool
(Dlzeltme Fircasi Aracl)

Clone Stamp Tool (Klonlama
Damgasl Aracl)

Brush Tool (Fir¢a Araci) ‘

History Brush Tool (Gegmise ‘

DSénme Araci) ’ Eraser Tool (Silgi Araci) ‘

Degrade Tool (Renk Gegisi Araci) ‘ ’ Blur Tool (Silgi Araci) ‘

|
|
|
’Eyedropper Tool (Damlahk Arau)‘
|
|
|

Dodge Tool (Soldurma Araci) ‘ ’ Pen Tool (Kalem Araglari) ‘

Horizontal Type Tool (Yatay Yazi Path Selection Tool (Yol Se¢im

Araci) Araclari)
Rectangle Tool (Diktortgen Cizim ’ Hand Tool (El Araci) ‘
Araci)

Edit Toolbar (Araglar gubugunu

’ Zoom Tool (Buyuteg) ‘ diizenle)

Set foreground color (On plan
rengini ayarla)

Set background color (Arka plan
rengini ayarla)

Gorsel 1.6: Araglar kutusu

Secim Araglari: Goriintlide degisiklik veya diizenleme yapilacak bolgeyi belirler ve secer. Ayni
veya farkl bir gorintiden alinan boélimd, dizenlenecek gorintindn ilgili bolgesine kopyalar
veya tasir.

Kesme ve Dilimleme Araglari: Goriintlinlin istenmeyen bolgelerini keser veya web arayliz
ihtiyacina uygun olarak gorintileri dilimler.

Olgiim ve Gezinti Araglan: Goriintliniin renk ve boyut &zellikleri ile ilgili islemler yapar.
Gorilntllenen bolgeyi ve bliyuklGgu degistirir.

Cizim ve Boyama Araglari: Goriuntuleri gizim ve firca uglariyla zenginlestirir. Bitmap ve vektor
tabanli gorintiler hazirlar.

Rétus Araglari: Gorlintlide oldugu distnulen renk, ton ve kompozisyon hatalarini giderir.

Filtreler: Temizleme, rétuslama, sanatsal efektler ekleme, 151k ve aydinlatma efektleri olustur-
ma Ozellikleriyle goriintileri 6zglinlestirir.

Katmanlar: Calisma esnasinda karisiklik yasanmamasina yardimci olur.

Eylemler: Goriintil isleme programinda yapilan islemleri daha sonra tekrar kullaniimak tGzere
kaydeder.

Gorinti isleme
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1.2.3. Se¢im Araglari (Selection Tools)

Gorintlinln parcgalari, gorinttinin geri kalanindan bagimsiz olarak tasinabilir, renklendirilebilir
veya donusturilebilir. Gorlntulerin bazi bélimlerini diizenlemek Uzere se¢im araglari ile segim
yapilmalidir. Gorlintlideki nesneleri veya benzer renkteki alanlari segmek icin farkli yéntemler de
kullanilabilir.

Move Tool (Tasima) araci, katmanlari ve kilavuzlari tasimak icin kullanilir (Gorsel 1.7).

u 4—I—b Move Tool

'D Arthoard Tool

Gorsel 1.7: Move araglari

Secim komutlari Gorsel 1.8’de gorilur. Rectangular Marquee Tool araci, kare veya dikdortgen
sekline sahip secimleri; Elliptical Marquee Tool araci, daire veya elips sekline sahip secimleri;
Single Row Marquee Tool araci, tek satir segimleri; Single Column Marquee Tool araci ise tek
sttun segimleri yapmak igin kullanilr.

! Rectangular Marguee Tool M
1 Elliptical Marquee Tool M
c=a Single Row Marques Tool

E Single Column Marquea Tool

Gorsel 1.8: Segim araglari

Gorsel 1.9'da Lasso araglari verilmistir. Lasso Tool araci, serbest secimler olusturur. Polygonal
Lasso Tool araci, birgok diiz gizgiyle sinirlandiriimis bir se¢imi kolayca olusturur. Magnetic Lasso
Tool araci ise sinirlari belli nesneleri secer.

olygonal Lasso Tool

= Magnetic Lasso Toaol

Gorsel 1.9: Lasso secim araglari

Gorsel 1.10°da 6zel secim araclari verilmistir. Object Selection Tool araci, belirlenen bolgedeki
nesneyi otomatik olarak secer. Quick Selection Tool araci, ayarlanabilir yuvarlak bir firca ucunu
kullanarak boyama yontemine benzer sekilde se¢im yapar. Magic Wand Tool araci ise benzer
renkli alanlarin segilmesini saglar.

i Object Selection Tool W
Quick Selection Tool W

#+Magic Wand Tool W

Gorsel 1.10: Ozel secim araglari
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Pen araclari, goruntiideki bir alanin secilmesini veya yeni nesne cizilmesini saglar (Gorsel
1.11).

L‘.-:} Pen Toal
'-5_-} Freeform Pen Toaol

§fz/ Curvature Pen Tool
1‘.:_} Add Anchor Point Toal
1‘:} Delete Anchor Point Tool

[ Conwvert Point Toaol

Gorsel 1.11: Pen araglan

1.2.4. Kesme ve Dilimleme Araglari

Gorunttde istenmeyen bolgeleri temizlemek amaciyla kesme araglari kullanilir (Gorsel
1.12). Crop Tool araci bir gérintlniin Ust, alt ve yan taraflarindaki gereksiz alani hizla kaldirir.
Perspective Crop Tool araci, perspektiften kaynaklanan bozulmalari diizeltmek icin bir gortintiyi
kirpar. Slice Tool araci, dilim olusturur. Slice Select Tool araci ise dilimleri secer.

u '|:|_ Crop Tool
I:I Perspective Crop Tool
A" Slice Tool
';.' Slice Select Tool

Gorsel 1.12: Kesme ve dilimleme araglari

5. UYGULAMA

-

islem adimlarina gére internetten bulacaginiz veya 6gretmeninizin verecegi bir
gorselin bir bolimuni kesiniz.

1. Adim: Gorselin bulundugu dosyay! tiklayip, gorinti isleme programinin Uzerine sirikle-
yerek birakiniz.

2. Adim: Crop Tool aracini seginiz.

3. Adim: Gorselin belirlediginiz kismini sol (st késesinden baslayarak dikdértgen alan igine

aliniz.
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4. Adim: Kesme islemini onaylamak icin Enter tusuna basiniz veya Commit current crop
operation [ digmesine tiklayiniz (Gérsel 1.13).

Gorsel 1.13: Crop araciyla istenmeyen bélgelerin temizlenmesi

1.2.5. Yazi (Type) Araglan

ihtiyag duyuldugunda gériintiilere yazilar eklenebilir ve secim alani olarak yazilar kullanilabilir.
Type Tool araglari, goriintlinin (zerinde yatay veya dikey olarak yazi olusturur. Horizontal Type
Tool ile Horizontal Type Mask Tool yatay, Vertical Type Tool ile Vertical Type Mask Tool dikey yazi
yazmak i¢in kullanilir. Horizontal Type Tool ile Horizontal Type Mask Tool araglariile yazilan yazilar
ayri katmanlarda, digerlerinde ise hangi katman secili ise o katmanda yer alir (Gorsel 1.14).

o T Horizontzl Type Tool
lT Vertical Type Toaol

l' i Vertical Type Mask Tool
orizontal Type Mask Tool

Gorsel 1.14: Type Tool (T)

1.2.6. Cizim ve Boyama Araglari (Drawing and Painting Tools)

Gorlntl isleme programinda bir ¢izim yapmak igin ¢izim ve boyama araglari kullanilabilir.
istenen sekiller ve cizgiler; Rectangle Tool, Ellipse Tool, Triangle Tool, Polygon Tool, Line Tool
araclariyla gizilir. Listeden segilen 6zel sekiller ise Custom Shape Tool araciyla gizilir (Gorsel 1.15).
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[ ] Rectangle Tool

I:::I Ellipse Toaol
™\ Triangle Tool
shygon Tool

“ Line Tool

.-fﬂ_;_ Customn Shape Tool

Gorsel 1.15: Cizim araglari

Brush Tool araci, firga konturlariyla boyar. Pencil Tool araci, keskin kenarl konturlar ile boyar.
Color Replacement Tool araci, segili bir rengi yeni bir renge donustirir. Mixer Brush Tool araci,
tuval renklerini karistirarak ve islakligi degistirerek gercekei boyama imkani saglar (Gorsel1.16).

" '-f Brush Toaol
S

£ Pencil Tool
D;f Caolor Replacement Tool

'i'f Mizer Brush Tool

Gorsel 1.16: Brush araglari

History Brush Tool araci, anlik gériintl veya secili durumun kopyasini boyar. Art History Brush
Tool araci, anhk gorinti veya segili durumu kullanarak boyama stillerinin benzetimini yapar
(Gorsel 1.17).

=« History Brush Toal Y

o) Art History Brush Tool Y

Gorsel 1.17: History Brush araglari
Gradient Tool araci; cizgisel, agisal, yansimali renk karisimlari olusturur. Paint Bucket Tool
araci, benzer renkli pixelleri arka plan rengi ile boyar (Gorsel 1.18).

| Rectangular Marguee Tool M
i : i Elliptical Marquee Toal M

c=a Single Row Margues Tool

Single Column Margues Tool

Gorsel 1.18: Degrade ve boyama araglari
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6. UYGULAMA

islem adimlarina gére Gorsel 1.19'da verilen gériintiiyi olusturunuz.

Gorsel 1.19: Cizim, boyama ve yazi araglari uygulamasi

1. Adim: 1024x1024 piksel boyutlarinda Background Contents beyaz olan bir belge olusturu-

nuz.

2. Adim: Polygon Tool araci ile dolgu rengi kirmizi, kenarlik rengi siyah olan bir besgen ciziniz.
Besgen cizmek icin Number of Sides 6zelligini 5 olarak belirleyiniz.

3. Adim: Move Tool aracini seginiz. Kirmizi besgeni tiklayiniz ve klavyeden Alt tusu basiliyken
surikle birak yontemi ile besgeni cogaltiniz.

4. Adim: Kopyaladiginiz besgenin dolgu rengini siyah olarak degistiriniz.

5. Adim: Move Tool aracini seginiz. Siyah besgeni tiklayiniz ve ayarlar kismindan Show
transfrom controls 6zelligini isaretli hale getiriniz. Besgeni kdsesinden orantili olarak kiiglltip
uygun sekilde konumlandiriniz.

6. Adim: Siyah besgen seciliyken Edit>Copy secenegine tiklayiniz. Edit>Paste segenegine
tiklayarak siyah besgeni ¢ogaltiniz.

7. Adim: Yeni besgenin dolgu rengini turuncu olacak sekilde degistirip turuncu besgeni uygun

yere konumlandiriniz.

8. Adim: Ellipse Tool aracini segip, mavi dolgu ve siyah kenarlik ile Shift tusunu basili tutarak
bir daire ¢iziniz.

9. Adim: Cizilen daireyi istediginiz bir yontemle iki adet ¢ogaltiniz. Verilen 6rnek tasarima
uygun sekilde daireleri konumlandiriniz ve renklendiriniz.

10. Adim: Custom Shape Tool aracini seginiz. Set to shape to create ayarindan Gorsel 1.19°da
verilen cicek ve agag sekillerini seginiz. Cigek ve agag sekillerinin dolgularini belirleyip uygun
yerlere ekleyiniz.
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11. Adim: Type Tool aracini seginiz. Ayarlar cubugundan Set to font size 6zelligini 72 pt, Set
the text color 6zelligini kirmizi ve Create wraped text 6zelligini Arc Upper olarak belirleyiniz. Tuval
Gzerinde uygun yere tiklayip “Grafik ve Canlandirma” metnini yaziniz.

12. Adim: Grafik ve Canlandirma metnini ¢ogaltiniz. Altta kalan metnin rengini gri olarak

degistiriniz ve kirmizi metnin golgesi olarak konumlandiriniz.

13. Adim: Olusturdugunuz gorintliyd ham dosya formatinda ve web kullanimina uygun
formatta kaydediniz.

1.2.7. R6tus Araglari

Gorintiler Uzerinde dizeltmeler yapmak icin rotus araglari kullanilabilir.

Spot Healing Brush Tool araci, lekeleri ve nesneleri kaldirir. Healing Brush Tool araci,
gorintideki kusurlari onarmak icin boyar. Patch Tool araci, bir desen veya 6rnegi kullanarak
secili alandaki kusurlari onarir. Red Eye Tool araci, flastan kaynaklanan kirmizi yansimayi kaldirir
(Gorsel 1.20).

o ‘ﬁ? Spot Healing Erush Tool
‘.‘E? Healing Brush Tool

{:; Patch Tool

;E; Content-Aware Move Tool

+0 Red Eye Tool

Gorsel 1.20: Healing Brush araglari

Clone Stamp Tool araci, gérintiide belirlenen bdlgenin 6rnegiyle boyar. Pattern Stamp Tool
araci, gériintinin bir pargasini desen olarak boyar (Gorsel 1.21).

C 1_ Clone Stamp Toaol 5
*% pattern Stamp Tool 5

Gorsel 1.21: Clone Stamp araglari
Blur Tool araci, keskin kenarlari bulaniklastirir. Shapen Tool araci, bulanik kenarlari keskin-
lestirir. Smudge Tool araci, tiklanan alandaki renkleri birbirine bulastirir (Gorsel 1.22).

O ‘ Blur Tool
‘. Sharpen Tool

p Smudge Tool

Gorsel 1.22: Blur araglari
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Dodge Tool araci, gérintinin rengini acik hale getirir ve soldurur. Burn Tool araci, gorlintliniin
rengini koyulastirir. Sponge Tool araci, goérintideki bir alanin renk doygunlugunu degistirir
(Gorsel 1.23).

u ,. Dodge Tool
% Burn Tool

@ Sponge Toaol

Gorsel 1.23: Dodge araglari

Eraser Tool araci, pikselleri siler. Background Eraser Tool araci, strikleme ile alanlari silip
saydam yapar. Magic Eraser Tool, tiklanan renkteki alanlari saydam yapar (Gorsel 1.24).

" 4 Eraser Todl
:E" Background Eraser Tool
& {*f Magic Eraser Tool

Gorsel 1.24: Eraser araglari

7. UYGULAMA

islem adimlarina gére Gérsel 1.25’te bulunan gorselde cilt ve sa¢ lizerinde rétus-

lama islemini gergeklestiriniz.

Gorsel 1.25: Rotus araglari uygulamasi

1. Adim: Gorsel Uzerinde rotuslama yapilacak bolgeleri (sivilce, kirisiklik, goz rengi, sag vb.)

belirleyiniz.
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2. Adim: Rétuslama islemini yapmak icin Clone Stamp Tool aracini seginiz.

3. Adim: Diizeltme yapacaginiz bélgenin blylkligine uygun olarak fir¢a ucu ayarini yapmak
icin gorinti Gzerindeyken farenin sag tusuna tiklayiniz. Brush Preset picker penceresi araciliglyla
uygun biyiklik ve kenar yumusakhgi secimini gergeklestiriniz.

4. Adim: Alt tusuna bastiginizda firga ucunun iginde belirir. Ornek alinacak bdlgeyi
belirlemek icin bu haldeyken farenin sol tusuna tiklayiniz. Dizeltme yapacaginiz bélgede farenin
sol tusuna tiklayip striklemeye basladiginizda, imleci birakincaya kadar diizeltme islemine
devam edilecektir.

5. Adim: Cilt Gzerinde silme islemi yapmak i¢in Patch Tool aracinin kullaniniz.

6. Adim: Diizeltme yapilacak alani seginiz. Segtiginiz bolgeyi 6rnek alinacak bolgeye siiriikleyip
birakiniz. Yapilan islem diizeltme icin yeterli degilse ayni islemi tekrarlayiniz.

7. Adim: Rétuslama islemi tamamlanincaya kadar ayni islemi tekrarlayiniz.

SIRA SizDE

internetten buldugunuz veya dgretmeninizin size dagitacag bir gorsel iizerinde
rotuslama islemi uygulayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Uygun rotus araglarini secti.

2. Sectigi rotus aracina uygun adimlari gergeklestirdi.

3. Roétuslama islemini yapt.

4. Dosyay! kaydetti.
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1.2.8. Gezinme ve Olgme Araglari (Navigation)

Hand Tool araci, gorlintliyl pencerenin icinde tasir. Rotate View Tool araci, tuvali gegici olarak
dondurir (Gorsel 1.26).

u -u' Hand Tool

4y Rotate View Tool

Gorsel 1.26: Navigation araglari

Eyedropper Tool araci, tiklanan pikseldeki rengi 6rnekler. Color Sampler Tool araci ile dort
piksele kadar renk 6rneklenebilir. Ruler Tool araci uzakliklari, konumlari ve acilari dlcer. Note Tool
araci, notlar ekler. Count Tool araci, gérintiideki nesneleri sayar (Goérsel 1.27).

- f Eyedropper Tool
EJ 30 Material Eyedropper Tool
":E# Color Sampler Tool

M Ruler Tool

ﬁ Mote Tool
1:\___ 3 count Tool

Gorsel 1.27: Eyedropper araglari

Zoom araci gorintinin gorintiileme boyutunu blyttir (Gorsel 1.28). Zoom araci, Alt tusuna
basilarak kullanilirsa biylUtme yerine kiigiltme yapar.

Gorsel 1.28: Zoom Tool

1.3. BOYUT VE COZUNURLUK

Gorlntlinin hangi amacla kullanilacagl goriinti dosyasi olusturulurken bilinmelidir. Amaca
uygun boyutlara ve ¢ozlinirlige sahip olarak dosya olusturulmahdir.

Piksel, gorlntileri olusturan en kiglk birimdir. Cep telefonu, bilgisayar gibi tim elektronik
cihazlarin ekranlari piksellerden olusur. Ekranlardaki bu yapi kirmizi, mavi ve yesil renklerin
tonlarini gosterir.

Piksel boyutlari, bir gorintinin yukseklik ve genisliginin toplam piksel sayisini belirler.
Coziinirlik, bitmap gérintisiindeki en ince ayrintidir. in¢ basina diisen piksel sayisi (ppi - pixel
per inch) arttikca ekraninin netligi ve keskinligi artar. Yiksek ¢ozlinlrlige sahip bir goriinti, daha
iyi gorunti kalitesi saglar.
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Piksel boyutu, gorintinin kullanilacagl alana gore belirlenmelidir. Goériintd, piksel boyutu
ne kadar biylkse o kadar biyik bir alanda kullanilabilir veya baski yapilabilir. Billboardda
kullanilacak goriinti A4 boyutlarina uyumlu olusturuldugunda istenen etkiyi saglamaz.

Monitor ¢ozunurligu, piksel boyutlari olarak tanimlanir. Monitorin ¢ozintrlGgi ve fotografin
piksel boyutlari esit ise fotograf %100 gorlintllendiginde ekrani tam olarak doldurur. Gérintinin
ekranda ne kadar blyuk goruntilenecegi; gorintliiniin piksel boyutlari, monitér boyutu,
monitoriin ¢ozlinlrlak ayari gibi faktorlerin birlesimine gore degisir.

Yazici ¢6zUnUrlGgl, dpi (dot per inch) olarak da bilinen ing basina mirekkep noktasi cinsinden
Olgulir. Genel olarak ing¢ basina ne kadar fazla nokta diiserse o kadar iyi ¢ikti elde edilir. Yazic
¢OzUnUrligi ile gdriintl ¢dzinlrligl birbiriyle iliskilidir. inkjet yazicida yiiksek kaliteli fotograf
yazdirmak i¢in en az 220 ppi gorintl ¢ozinrlGgu olmalidir.

Gorilntliinin dosya boyutu; kilobyte, megabyte, gigabyte olarak 6lciilen goriintli dosyasinin
dijital boyutudur. Dosya boyutu, goriintlinin piksel boyutlariyla orantilidir. Dosya boyutunu
etkileyen bir diger faktor de dosya formatidir. Dosya formatlari farkh sikisirma yontemleri
kullandigi icin dosya boyutlari ayni pikselde belirgin bicimde degisebilir.

8. UYGULAMA

islem adimlarina gére goriintii boyutu ayarlarini diizenleyiniz.

1. Adim: Goriintli boyutunu hizlica 6grenmek icin belge penceresinin sol alt kdsesine bakiniz.

2. Adim: Image>Image Size... segenegine tiklayiniz.

3. Adim: Gelen iletisim penceresinde degisiklige baslamadan 6nce baski boyutunu etkileye-
cek islemler yapip yapmayacaginiza karar veriniz. Degisiklikleriniz baski boyutunu etkileyecekse
Resample (yeniden 6rnekleme) 6zelligini etkinlestiriniz.

Resample etkinlestirildiginde boyut degisikliginin en stte goriintlilenen Image Size
(disk boyutu) degerini degistirdigi gorilar.

4. Adim: Width ve Height yanindaki metin kutularina gérintiiniizin genislik ve yikseklik
degerini girip birim belirleyiniz. Width ve Height degerlerinin birbirine oranini korumak isterseniz
Do not constrain aspect ratio simgesinin etkinlestirildiginden emin olunuz. Bu baglantiyi
kaldirmak isterseniz Do not constrain aspect ratio simgesini kaldiriniz. Degerler birbirine bagliysa
otomatik olarak gelecektir.
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5. Adim: Goriintd igin istediginiz ¢ozlnurlik degerini Resolation metin kutusuna yaziniz ve
birimi belirleyiniz (Gorsel 1.29).

Gorsel 1.29: Image Size iletisim penceresi

1.4. SECiLi ALAN OLUSTURMAK VE RENK AYARI YAPMAK

Goruntlnin parcalari, geri kalanindan bagimsiz olarak tasinabilir, renklendirilebilir veya
donlsturulebilir. Gorlintlideki nesneleri veya benzer renkteki alanlari segmek igin farkli araglar
kullantlir.

1.4.1. Segili Alan Olusturmak

Goruntl dosyalari Uzerinde islem yapabilmek icin once ilgili yerin secilmesi gerekir. Yer
secimi yapildiktan sonra islem uygulanir. Bylece sadece istenen alanda degisiklik yapilr. Segilen
alan uzerine filtreler ile renk dolgulari uygulanabilir ve kesme, kopyalama, yapistirma gibi basit
islemler yapilabilir. Her goriintlde secilecek alan farkli yapiya sahiptir ve her yapi icin farkh se¢im
yontemi vardir. Kement araglari, geometrik isaretleme araglari, hizli secim araci ve sihirli degnek
aracl, Select>Color Range... komutu se¢me islemlerini yapmak ve gorintli diizenlemek igin
hazirlanmistir.

1.4.1.1. Se¢im

Goruntlnin bir parcasinda degisiklik (silme, cogaltma, dondirme, renk degistirme vb.)
yapmak icin tamamen veya kismen aktif hale getirilen piksellere se¢cim denir. Belirli bir bolge
tamamen secilmis ise etrafinda yanip sonen kesikli bir kenarlik goriintr. Secim iptal edilirse
kenarlik kaybolur.
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1.4.1.2. Segili Alani Degistirmek

Resim dosyasindaki gorlintiiniin tamamini secmek icin Select>All secenegi tiklanir veya
klavyeden Ctrl+A tus kombinasyonuna basilir. Se¢me islemini iptal etmek igin Select>Deselect
secenegi kullanilir veya klavyeden Ctrl+D tus kombinasyonuna basilir. Tekrar ayni alan segilmek
istenirse Select>Reselect tiklanir veya klavyeden Shift+Ctrl+D tus kombinasyonuna basilir.
Boylece tekrar se¢me islemiyle vakit kaybedilmez. Secilen alanin disinda kalan yerleri secmek
icin Select>Inverse tiklanir veya klavyeden Shift+Ctrl+| tus kombinasyonuna basilir.

Gorsel 1.30°da se¢im araglarina ait ayarlar gorilir. Soldan itibaren yeni segim olusturmak
icin New selection, dnceki secime eklemek icin Add to selection, dnceki secimden ¢ikarmak
icin Subtract from selection ve 6nceki secimle kesisim olusturmak icin Intersect with selection
segenekleri aktif hale getirilmelidir.

File Edit Image Layer Type Select Fiter 3D View Plugins Window Help

el I [ B L= Feather: 0 px Style:  Fixed Ratio ~ | Width: 1 &  Heght 1 Select and Mask...

Gorsel 1.30: Segim araglari ayarlari

9. UYGULAMA

islem adimlarina gére 6gretmeninizin verecegi veya internetten bulacaginiz Solo
Turk akrobasi ucagina ait bir gorselin arka planini kaldiriniz.

1. Adim: Gorintl dosyasini aginiz.

2. Adim: Object Seletion Tool araciile ugagiicine alacak sekilde bir dikdértgen alan belirleyerek

gorintd isleme programinin segim yapmasini saglayiniz.
3. Adim: Options Bar panelinde beliren ayarlari kullanarak varsa secim hatalarini diizeltiniz.
4. Adim: Select>Inverse komutuna tiklayarak arka plani secili duruma getiriniz.
5. Adim: Edit>Clear komutuna tiklayarak arka plani temizleyiniz.

6. Adim: Dosyay! uygun formatta kaydediniz.

1.4.2. Renk Ayari

Gorintileri istenen sekilde diizenlemek icin renk ayarlari da kullanilabilir. Gorlintiintn 1sik,
karsithk ayarlari degistirilerek farkli etkiler elde edilebilir.

1.4.2.1. Ton ve Kontrast

Ton, rengin parlaklk derecesini belirler. Herhangi bir renk fazla isik alirsa agik, az isik alirsa
koyu renk olarak adlandirilir.
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Kontrast, karsit demektir. Acik ve koyu, buyik ve kiguk gibi zithklari yansitir. Kontrast,
gorinti Gzerindeki en aydinlik ile en karanlik renkleri ifade eder. Keskin gériintiler elde etmek
icin kontrast dogru ve uygun sekilde kullaniimalidir. Yiksek kontrast, koyu goélgelerden beyaz
aydinliklara kadar genis farkliligi anlatir. Distk kontrast, karanhk golgeler ve parlak aydinliklarin
asiri uglarini icermeyen daha sinirh farklhihgi ifade eder.

1.4.2.2. Ton ve Kontrast Ayarlari

Ton ve kontrast ayarlari Image>Adjusment>Brightness/Contrast... secenegi ile gerceklestiri-
lebilecegi gibi goriintl isleme programinin ton ve kontrast algilayip, otomatik olarak diizeltmesi
saglanabilir. Otomatik ayarlamaicin Image mendsii altinda bulunan Auto Tone veya Auto Contrast
secenekleri tiklanir.

10. UYGULAMA

islem adimlarina gére dgretmeninizin verecegi veya internetten bulacaginiz bir
goriintl Gzerinde ton ve kontrast ayarlarini gergeklestiriniz (Gorsel 1.31).

Gorsel 1.31: Renk ayarlari uygulamasi

1. Adim: Goriintl dosyasini aginiz.

2. Adim: Image>Auto Tone segenegine tiklayiniz ve gorinti isleme programi tarafindan
otomatik olarak isik ayarinin yapilmasini saglayiniz.

3. Adim: Image>Auto Contrast segcenegine tiklayiniz ve gorinti isleme programi tarafindan
otomatik olarak kontrast ayarinin yapilmasini saglayiniz.

4. Adim: Image>Adjustment>Brightness/Contrast... secenegini tiklayarak Gorsel 1.32’deki
Brightness/Conrast iletisim penceresini aginiz.

5. Adim: Kaydirma cubugu kullanarak veya metin kutularina deger yazarak goértuntindn daha
aydinlik ve net gériinmesini saglayiniz.

Goriinti isleme



Gorsel 1.32: Brightness/Contrast iletisim penceresi

6. Adim: Kiiclk degisiklikler yaparak gorlintideki etkiyi gozlemleyiniz.
7. Adim: Dosyayi kaydediniz.

1.5. KATMANLAR (LAYERS)

Katmanlar, gorintil isleme programinin en énemli unsurlarindan biridir. Katmanlar, yapilan
calismalarin kontrolll ve diizenli olmasina, ¢alisma sirasinda karisiklik yasanmamasina yardimci
olan nesnelerdir. Katmanlar hareket ettirilebilir, ¢ogaltilabilir, silinebilir, birlestirilebilir ve
gizlenebilir 6zelliklere sahiptir.

Katmanlarla ilgili islemler Layers paneli (Gorsel 1.33) ve Layer mendisi kullanilarak yapilr.
Layers panelinin galisma ekraninda goriintllenip kaldiriimasi igin Window menisiinden Layers
(F7) komutu kullanilr.

Goruntl isleme programinda yeni bir dokiiman olusturuldugunda Layers panelinde sadece
bos kicuk bir resim seklinde kilitli olan Background (arka plan) katmani belirir. Yeni bir katman
olusturulmadigi slirece Background katmani silinemez.

—> K
A <o
B «—eo —> ]
—> j
C <o —> |

SRR

Gorsel 1.33: Layers paneli
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A: Katman efektlerinin yer aldig listedir.

B: Katman kilitleme secenekleri ile katmani kilitler veya katmanin kilidini kaldirir.
C: Katmani gizler veya gizli katmani goriintiler (Indicates layer visibility).

C: Secili olan katmanlari birbirine baglar (Link Layer).

D: Secili katmana stil uygular (Add a layer style).

E: Katmana maske uygular (Add layer mask).

F: Ayar katmani olusturur.

G: Yeni grup olusturur (Create a new group).

G: Yeni katman olusturur (Create a new layer).

H: Katmani siler (Delete layer).

I: Katmanin kilitli oldugunu gosterir.

i: Katman Fill (Dolgu) degerini ayarlar. Efektler bu islemden etkilenmez.

J: Katmanin Opacity (Saydamlik) degerini ayarlar. Efektler tizerinde de etkilidir.

K: Katman panelinin sag lst kdsesindeki sembole tiklandiginda katman ile ilgili diger ayarla-
malarin yapildigi meniyi agar.

1.5.1. Katman Olusturmak, Silmek, Cogaltmak

Gorilntl isleme programinda yeni bir katman olusturmak, silmek, cogaltmak veya diger
islemleri yapmak icin birden ¢ok yol mevcuttur. Tercihe gore Layer menusd, Layers paneli, klavye
kisayollari veya Layers panelinin sag Ust kosesindeki % semboliine tiklandiginda agilan meni
kullanilabilir.

1.5.1.1. Katman Olusturmak
Yeni bir katman olusturmak icin Layers panelinden Create a new layer, Layer meniisiinden i
veya klavyeden Ctrl+Shift+N tus kombinasyonlari kullanilabilir (Gorsel 1.34).

Gorsel 1.34: Yeni katman olusturma
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Goruntl isleme programinda olusturulan katman “Layer 1” ismindedir. Katman ismi izerine
¢ift tiklanarak istenilen katman yeniden adlandirilabilir. Boylelikle yapilan galismada karisiklik
engellenir.

Background katmani Uzerine cift tiklanip, acilan pencereden katmana isim verilerek veya
Background katmani izerinde sag tusa basilip, Layer from background komutu verilerek katman
normal Layer katmanina doéndstirulebilir.

Katman isimlerinin sol tarafinda yer alan gbz semboliine tiklanarak calisma sirasinda
gorinmesi istenilmeyen katmanlari gizlemek mimkinddr. Bu islem, katmani silmeden gizlemek
amaciyla kullanilir.

Bir katman kilitlenebilir veya kilitli bir katmanin kilidi kaldirilabilir. Katmanlari kismi veya
tamamiyla kilitlemek mimkiindiir. Dért gesit katman kilit secenegi vardir. ilk kilit, saydam
pixelleri; ikinci kilit, gériinti pixellerini kilitler. Uglincii kilit, katmanin konumunu kilitleyerek
katmanin pixellerinin tasinmasini engeller. Dérdiincu kilit ise katman Gzerinde herhangi bir islem
yapilmasini engelleyerek tam anlamiyla bir kilitleme islemi yapar.

Her islemin farkli katmanlarda yapilmasi ¢alismalarda kolaylik ve diizen saglamasi
acisindan 6nemlidir.

1.5.1.2. Katman Cogaltmak

Mevcut katmani koruyarak kopyasini almak mimkiindir. Bir katmanin kopyasini almak, bir
baska deyisle katmani gogaltmak igin su yollardan herhangi biri kullanilabilir:

e Katmana basili tutup, panelde yer alan yeni katman semboli tizerine birakarak

e Katman (izerinde sag tusa basili tutup, acilan listeden Duplicate Layer secerek

e Katman seciliyken Layer menistinden Duplicate Layer komutunu kullanarak

e Katman secili ve Alt tusuna basiliyken fare ile siiriikleyip, panel Gizerine birakarak

e Dokliman Uzerinde ¢ogaltilmak istenen nesne secili ve Alt tusuna basiliyken fare ile striik-

leyip birakarak

Alt tusu ile birlikte Shift tusuna basarak ayni hizada veya dizlemde nesnenin
cogaltilmasini saglamak mimkinddr.
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1.5.1.3. Katman Silmek

Diger katman islemlerinde oldugu gibi katman silme islemi icin de bircok secenek vardir.
Katman menisinid kullanmak, katman Gzerinde Delete tusuna basmak veya silmek istenen
katmani katman panelinin sag alt tarafinda yer alan ¢6p kutusuna tasimak bunlardan bazilaridir.

1.5.2. Katmanlarin Sirasini Degistirmek

Gorintl isleme programinda katmanlarin sirasi degistirilip Ustteki katman alta, alttaki katman
Uste alinarak katmanlarin yeri diizenlenebilir. Yeri degistiriimek istenen katmana tiklayip sirikle
birak yontemi ile katmani istenilen konuma (alta veya Uste) getirmek mimkindir (Gorsel 1.35).

Gorsel 1.35: Katman siralama

Katmanlarin sirasini degistirmek i¢in kullanilan diger bir yol ise Layer menisiindeki Arrange
komut secenekleridir.

Bring to Front: Katmani en One getirir.

Bring Forward: Katmani bir 6ne getirir.

Send Backward: Katmani bir arkaya gonderir.

Send to Back: Katmani en alta génderir.

Reverse: Katman sirasini tersine gevirir.

11. UYGULAMA

islem adimlarina gére dikddrtgen, tiggen, daire sekillerini iceren ve icerdigi seklin
adini tastyan ¢ katman olusturup siralama, g¢ogaltma ve silme ile ilgili islemleri
gerceklestiriniz (Gorsel 1.36).
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Lock: + N a Fill: 100% | -~
Loy
O E Daire

o B
O - Background

Gorsel 1.36: Katman olusturma ve diizenleme

1. Adim: Katman panelinin alt tarafinda yer alan Create a new layer semboliine tiklayarak yeni
bir katman olusturunuz.

2. Adim: Dikdortgen secim aracini Shift tusu ile birlikte kullanarak ekrana kirmizi renkli bir
kare ciziniz ve katman ismi Gizerine ¢ift tiklayarak katmana “Kare” adini veriniz.

3. Adim: Yeni bir katman daha olusturunuz ve bu katmana yesil renkli bir licgen c¢izerek,
katmanin adini “Uggen” olarak belirleyiniz.

4. Adim: Yeni bir katman olusturarak, bu katmana Shift tusu ile birlikte elips aracini kullanarak
mavi renkli bir daire giziniz. Katmanin ismini “Daire” olarak diizenleyiniz.

5. Adim: Katmanlari Gorsel 1.36’daki gibi siralayiniz.

6. Adim: Kare isimli katmani ¢ogaltiniz. Bunun i¢in cogaltilmak istenen katmani secip lizerinde
farenin sag tusuna tiklayiniz. Acilan pencereden “Duplicate layer” segenegini seciniz (Gorsel
1.37).

O lF Kare copy
1B T

O E Kare

Gorsel 1.37: Katman ¢ogaltma

7. Adim: “Kare copy” adindaki katmani siliniz. Silme islemi i¢cin katmani tutup, ¢op kutusu
semboli Gzerine getirerek birakiniz.

8. Adim: Katmanlarin yaninda bulunan gbz simgesine tiklayarak katman gizleme islemini
gozlemleyiniz.

9. Adim: Calismayi “katman olusturma” adiyla “.psd” formatinda kaydediniz.

1.5.3. Katmanlari Baglamak

Katmanlar birbirine baglanarak birlikte hareket ettirilebilir veya katmanlarin bigcim
degistirmeleri saglanabilir. Birbirine baglanmak istenen katmanlar segilerek katman panelinin alt
bélimundeki Link layers (zincir sekli) tiklanir. Bu islemle katmanlar birbirlerine kilitlenir.
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1.5.4. Katman Hizalamak (Align) ve Dagitmak (Distribute)

Goruntl isleme programinda Align (Hizalama) komutu kullanilarak nesnelerin hizalanmasi

mimkindir. Layer menisiinden Align veya Window mentsiinden Options komutlari ile Align

boélimine erisilebilir (Gorsel 1.38). Align islemi yapabilmek icin en az iki katmanin secili olmasi

gerekir.

Gorsel 1.38: Align komutu segenekleri

Gorsel 1.38'deki (¢ nokta sembolline tiklandiginda Goérsel 1.39 acilir. Burada hizalama

secenekleri daha detayli olarak belirlenir. Agilan gorseldeki nesnelerin 6zellikleri Tablo 1.1’de

verilmistir.

Distribute:

Distribute Spacing: Align To:

Canvas

Gorsel 1.39: Align ve Distribute

Tablo 1.1: Katman Hizalama ve Dagitma Secenekleriyle Gorevleri

Align Segenekleri ve Gorevleri

Align left edges (Sol kenarlari hizala): Secili katmanlardaki sol pikseli en solda
bulunan katmandaki sol piksele veya segim kenarliginin sol kenarina hizalar.

Align horizontal centers (Yatay merkezleri hizala): Secili katmanlardaki
yatay merkez pikselini segili tim katmanlarin yatay merkez pikseline veya se¢im
kenarliginin yatay merkezine hizalar.

Align right edges (Sag kenarlar hizala): Baglantilh katmanlardaki sag pikseli
secilen tim katmanlardaki en sagda bulunan piksele veya secim kenarliginin sag
kenarina hizalar.

Align top edges (Ust kenarlar hizala): Secili katmanlardaki tist pikseli segili
tim katmanlardaki en stte bulunan piksele veya secim kenarliginin Gst kenarina
hizalar.

HE E B OO

Align vertical centers (Dikey merkezleri hizala): Secili her katmandaki dikey
merkez pikselini secili tim katmanlarin dikey merkez pikseline veya sec¢im
kenarliginin dikey merkezine hizalar.

Align bottom edges (Alt kenarlari hizala): Secili katmanlardaki alt pikseli
secili katmanlardaki en altta bulunan piksele veya se¢im kenarliginin alt kenarina
hizalar.
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Distribute Secenekleri ve Goérevleri

Distribute top edges (Ust kenarlari dagit): Her katmanin st pikselinden
baslayarak katmanlari esit araliklarla yerlestirir.

Distribute vertical centers (Dikey merkezleri dagit): Her katmanin dikey
merkez pikselinden baglayarak katmanlari esit araliklarla yerlestirir.

Distribute bottom edges (Alt kenarlari dagit): Her katmanin alt pikselinden
baslayarak katmanlari esit araliklarla yerlestirir.

Distribute left edges (Sol kenarlari dagit): Her katmanin sol pikselinden
baslayarak katmanlari esit araliklarla yerlestirir.

Distribute horizontal centers (Yatay merkezleri dagit): Her katmanin yatay
merkezinden baslayarak katmanlari esit araliklarla yerlestirir.

Distribute right edges (Sag kenarlari dagit): Her katmandaki sag pikselden

BE B8 Enoo

baslayarak katmanlari esit araliklarla yerlestirir.

Distribute Spacing

Distribute vertically (Dikey olarak dagit): Katmanlar arasindaki dikey aralig
esit olarak dagitir.

Distribute horizontally (Yatay olarak dagit): Katmanlar arasindaki yatay

araligi esit olarak dagitir.

Align To bolimiinde Selection ve Canvas olmak lizere iki secenek vardir. Selection secenegi
nesneleri kendi aralarinda hizalarken Canvas (Tuval) se¢cenegi sayfaya gore hizalama yapar.

12. UYGULAMA

islem adimlarina gore calisma alanina ii¢ farkli renkte dikdértgen ekleyerek hizalama
islemini gerceklestiriniz (Gorsel 1.40).

Gorsel 1.40: Hizalama uygulamasi gorselleri

1. Adim: Mavi, Yesil ve Lacivert adinda (¢ katman olusturunuz ve bu katmanlara Rectangle
Tool aracini kullanarak ayni boyutlarda dikdortgenler ekleyiniz.

2. Adim: Rectangle Tool aracini kullanarak Mavi katmanina mavi, Lacivert katmanina lacivert,
Yesil katmanina yesil renkli dikdortgenler ¢iziniz.
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3. Adim: Canvas ve Align left edges seceneklerini secerek nesneleri tuvalin sol kenarina
hizalayiniz.

4. Adim: “Align to: Selection” ve “Align top edges” seceneklerini secerek Ustte yer alan
nesnenin Ust gizgisine gore hizalayiniz.

5. Adim: Align to secenegini Canvas olarak degistirip, Align top edges komutunu uygulayarak
¢alisma alaninin st kismina hizalayiniz.

6. Adim: Align bottom edges hizalama secenegini secerek alt kenarliga gore hizalayiniz.

1.5.5. Katmanlari Birlestirmek

Goruntl isleme programinda birden fazla katman birlestirilerek tek bir katmana
donusturdlebilir. Bunun igin birlestirilmek istenen katmanlar segilip, sag tusa basilarak agilan
meniden Merge Layers komutu, klavyeden Ctrl+E tuglari veya Layer menisiinden Merge Layers
seceneklerinden herhangi biri kullanilabilir.

Katmanlar sekillerden olusuyorsa bu katmanlari birlestirmek icin Merge Shapes komutu
kullanilir. Merge Visible sadece gorinir olan katmanlari birlestirir. Flatten Image ise Background
katmani dahil tim katmanlari birlestirerek yeni bir Background katmanina dontsturur.

1.5.6. Katman Gruplan

Katman sayisi fazla oldugunda katmanlari yénetebilmek icin katmanlar bir klasér icine alinarak
gruplandirilir. Boylelikle daha diizenli ¢alisma imkani olur.

1.5.6.1. Katman Gruplari Olusturmak

Birden fazla katmani segebilmek igin Ctrl tusu kullanilarak tek tek istenilen katmanlar segilir
veya en Ustteki katman secilip Shift tusuna basildiktan sonra en alttaki katmanin tiklanmasiyla
da aradaki katmanlar secilir. Fare+Shift tusu ardisik olan katmanlar, Fare+Ctrl tusu ise ardisik
olmayan katmanlarin segimi icin kullanilir.

Bir grup olmasi istenen katmanlar secilerek Create a new group nesnesinin icine tasinir veya
gruplandiriimak istenen katmanlar secilip farenin sag tusuna basildiginda acilan listeden Group
from Layers komutu segcilir. Grup ismi, istenen sekilde degistirilebilir.

1.5.6.2. Katman Gruplarini Silmek

Katman gruplarini silmek i¢in birden fazla yol vardir. Birinci segenek, katman grubunu tutup
Layers panelin alt tarafinda yer alan ¢op kutusuna tasimaktir. Katman grubu bu yontemde
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icindekilerle birlikte silinir. Bazen sadece grup silinip icindekilerin tutulmasi istenebilir. Bu
durumda Et‘lklanlr. Agilan listeden Delete group segcilir. Grubun igindeki katmanlarla birlikte
tamamen silinmesi (Group and Contents) veya grup iginde yer alan katmanlar silinmeden
yalnizca grup isminin silinmesi (Only Group) seceneklerini sunan iletisim penceresinden uygun
olan secenek tiklanarak silme islemleri gerceklestirilir.

13. UYGULAMA

islem adimlarina gore 3 tanesi araba resimleri, 3 tanesi ise ucak resimleri iceren 6
tane katman olusturarak katmanlarla ilgili islemleri gerceklestiriniz.

1. Adim: Alti tane katman olusturunuz ve bu katmanlari Araba 1, Araba 2, Araba 3, Ugak 1,
Ucak 2, Ucgak 3 olarak adlandiriniz.

2. Adim: Araba 3 katmani en 6nde, Ucak 1 katmani ise en altta olacak sekilde katmanlari
siralayiniz. Bu islem igin Bring to Front ve Send to Back komutlarindan yararlaniniz.

3. Adim: Araba 1, Araba 2 ve Araba 3 katmanlarini birbirine baglayiniz. Bunun igin birbirine
baglamak istediginiz U¢ katmani secip Layers panelinin alt tarafindaki Link layers komutuna
tiklayiniz.

4. Adim: Merge Layers komutu ile Araba 1, Araba 2 ve Araba 3 katmanlarini segerek tek
katman olacak sekilde birlestiriniz.

5. Adim: Ucak 1, Ucgak 2 ve Ucak 3 katmanlarini secip, Layers panelinin alt tarafindaki Create
a new group nesnesi icine siriikleyerek birakiniz.

6. Adim: Group 1 ismiyle olusan klasor Gzerine tiklayarak, klasoriin adini “Ugaklar” olarak
degistiriniz.
7. Adim: Ucaklar klasori Gizerinde sag tusa basip agilan listeden Duplicate group komutunu

seciniz ve adini “Ugaklar 1” olarak belirleyecek sekilde klasorii cogaltiniz.

8. Adim: Ucaklar klasori Uzerinde sag tusa tiklayiniz. Acilan listeden “Ungroup Layers”
komutunu secgerek katmanlari gruptan gikariniz.

9. Adim: Delete group komutunu kullanarak “Ugaklar 1” klasérind siliniz.

1.5.7. Katman Maskelemek (Layer Mask)

Katman maskeleri kullanilarak, katmanin secili olan herhangi bir bolimi gosterilip gizlenebilir
ve katmana filtreler uygulanabilir. Maskeler gériintintn orijinalini bozmadan istenmeyen alanlari
saklama, istenen alanlari da gosterme 6zelligine sahiptir.
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Layer menisil altinda Layer Mask, Vector Mask ve Create Clipping Mask olmak Uzere (g tlr
maskeleme secenegi vardir. Layer Mask, katmandaki nesneye katman maskeleri uygulamak
icin kullanilir. Katmanlar maskelenerek birden ¢ok gorsel tek bir gorlintiide birlestirilebilir veya
fotograftaki istenmeyen bir bolim kaldirilabilir. Katman maskeleri, boyama veya sec¢im araclari
kullanilarak diizenlenebilen bitmap gorintilerdir. Vector Mask, vektoérel nesnelere maske
uygulamak icin kullanilir. Kalem veya sekil araglari kullanilarak olusturulur. Create Clipping
Mask, nesneye kirpma maskesi uygulamaya yarar. Bir katman goruntisinin diger bir katman

gorintisiine uygun olarak ic ice yerlestiriimesi amaciyla kullanilir.

NOT

Background katmanina maske olusturabilmek i¢in bu katmani normal katmana
donistirmek gerekir. Layer>New>Layer from Background komutu ile katman arka plan

olmaktan c¢ikartilir.

14. UYGULAMA

islem adimlarina gére arama motoru aracililyla bulacaginiz veya égretmeninizin
dagitacag bir gorseli maskelemek icin gerekli islemleri gerceklestiriniz.

1. Adim: 1890x1417 boyutlarinda ve arka plan rengi pembe olan yeni bir ¢alisma sayfasi aginiz.

2. Adim: File>Place Linked komutunu kullanarak resim ekleyiniz.

3. Adim: Maskelenecek alana uygun secim araglarindan birini kullanarak maskelemek istedigi-

niz alani seginiz (Gorsel 1.41).

Gorsel 1.41: Maskelenecek alani segme
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4. Adim: Layers panelinin alt tarafindaki Add layer mask komutunu uygulayiniz (Gorsel 1.42).

Gorsel 1.42: Maskelenmis katman gorseli

15. UYGULAMA

islem adimlarina gore internetten buldugunuz herhangi bir cicek resminin Gérsel
1.43’teki gibi maskelenmesi i¢in gerekli islemleri gergeklestiriniz.

Gorsel 1.43: Create Clipping Mask uygulanmis gorsel

1. Adim: Arka plani beyaz olan yeni bir ¢calisma sayfasi aginiz.

2. Adim: Custom Shape Tool aracini seginiz. Set shape to create 6zelligini cicek sekli olarak

belirleyip calisma alanina ekleyiniz (Gorsel 1.44).

s,

5’;4’\“

Gorsel 1.44: Cigek sekli
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3. Adim: Yeni bir katman olusturunuz ve bu katmana bir ¢icek resmi ekleyiniz (Gorsel 1.45).

Gorsel 1.45: Olusturulan yeni katmana eklenecek 6rnek cigek resmi

4. Adim: Cicek resminin bulundugu katman lzerinde farenin sag tusuna basarak Create
Clipping Mask komutunu veriniz.

5. Adim: Calismay! kaydediniz.

SIRA SiZDE

internet ortamindan bulacaginiz vektorel ézellikteki bir gérseli, vektér maskelerini
kullanarak maskeleyiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Vektori ¢alisma alanina ekledi.

2. Kalem aracini kullanarak vektériin maskelenecek alanini secti.

3. Maskeleme islemini yapt.

4. Dosyay!i kaydetti.
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1.5.8. Katman Opakligi ve Katman Harmanlama Modlari

Opacity, katmanlara saydamlik vermek igin kullanilan bir 6zelliktir. 1 ile 100 arasinda deger
alir ve normalde katmanin opaklik degeri %100'diir. Ustte yer alan katman, alttaki katmani érter.
Opaklik degerinin degistirilmesi ile alttaki katmanin gérintiilenmesi saglanabilir. Opaklik degeri
kiculdukece gorunarluk azahr (Gorsel 1.46).

%100 %80 %60 %40 %20
Gorsel 1.46: Katman opaklik 6rnegi

Blendings Modes ile resimlerin birbirleriyle ne tir iliski icine girecekleri belirlenir. Layers
panelinin sol Ust kisminda yer alir. Normal, Dissolve, Darken, Hue vb. harmanlama modlari vardir.
Harmanlama modlarini kullanmak igin en az iki katmanin agik olmasi gerekir.

16. UYGULAMA

islem adimlarina gére Goérsel 1.47 ve Gorsel 1.48'de yer alan Manzara ile Ugak ve
Balonlar resimlerinin harmanlanmasi islemini gerceklestiriniz.

Gorsel 1.47: Manzara Gorsel 1.48: Ugak ve Balonlar

1. Adim: Yeni bir calisma sayfasi a¢iniz ve Manzara isminde bir katman olusturunuz.
2. Adim: Manzara katmanina sececeginiz bir Manzara resmi ekleyiniz.

3. Adim: Balonlar isminde yeni bir katman olusturarak ucak ve balonlarin yer aldigi bir gorsel
ekleyiniz.

4. Adim: Ugak ve Balonlar gorselinin zemin rengini saydam yapiniz.

5. Adim: Katmanlari manzara resmi Uste gelecek sekilde siralayiniz.
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6. Adim: Manzara katmani seciliyken harmanlama modlarindan “Hue” modunu seginiz.
7. Adim: iki gérselin pozisyonunu Goérsel 1.49'da goriildiugi gibi ayarlayiniz.

Gorsel 1.49: iki gorselin harmanlanmasi

8. Adim: Her iki katmani da kilitleyiniz.

9. Adim: Katmanlari birlestirerek tek bir arka plan katmani haline getiriniz. Bu islem icin her
iki katman segiliyken Layer>Flatten image komutunu uygulayiniz.

10. Adim: Calismayi “harmanlama” olarak kaydediniz.

1.5.9. Katman Stilleri

Katmanlarin stil o6zelliklerini kullanarak segili katmandaki iceriklere ¢esitli efektler
uygulanabilir. Bunun i¢in katman panelinin alt tarafinda bulunan Add a layer style sembolii veya
Layer menisinde yer alan Layer Steels>Blending Options komutu kullanilir (Goérsel 1.50).

Gorsel 1.50: Blending Options
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Bevel and Emboss (Kabartma): Bevel nesnenin kabarik goriinmesini, Emboss ise nesnenin
cukur goriinmesini saglar.

Stroke (Kontur): Secili nesneye kenarlk ekler.

Inner Shadow: Nesnenin i¢ kismina golge efekti uygular.
Inner Glow: Nesneye Isik efekti uygular.

Satin: Nesneye saten efekti uygular.

Color Overlay: Nesneyi belirlenen renkle kaplar.
Gradient Overlay: Nesneyi degrade renk gegisiyle kaplar.
Pattern Overlay: Nesneye desen uygular.

Outer Glow: Nesnenin dis tarafina isima efekti uygular.

Drop Shadow (Golge): Nesnenin dis kismina golge efekti uygular.

17. UYGULAMA

islem adimlarina gore internetten buldugunuz veya 6gretmeninizin dagitacag
bir cicek gorselini kullanarak Goérsel 1.51'deki gibi yazi ve fotografa stilleri uygulama
islemini gerceklestiriniz.

Gorsel 1.51: Stil 6rnekleri

1. Adim: Sectiginiz resmi boyutlandirip Alt tusu yardimi ile gérseldeki gibi yan yana gelecek
sekilde ¢ogaltiniz.

2. Adim: Add a layer style komutunu kullanarak gorsel ve yazilara sirasiyla gérselin altinda
yazan efektleri uygulayiniz.

3. Adim: Calismayi “katmanefektleri.psd” olarak kaydediniz.
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SIRA SiZDE

Gorsel 1.52°deki gibi iki cokgen olusturarak besgene Inner Glow, sekizgene ise Bevel
& Embos efektlerini veriniz.

Gorsel 1.52: Stil verilmis gokgenler

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Cokgen aracini kullanarak bir besgen olusturdu.

2. Cokgen araci yardimiyla sekizgen olusturdu.

3. Cokgenlerin rengini gorseldeki gibi ayarladi.

4. Besgene Inner Glow stilini gorseldeki gibi uyguladi.

5. Sekizgene Bevel & Embos stilini tanimlayarak gorseldeki gibi goriinecek
sekilde ayarladi.

6. Katman isimlerini besgen ve sekizgen olarak ayarladi.

7. Dosyay! kaydetti.

8. Zamani verimli kullandi.

1.5.9.1. Katman Stillerini Cogaltmak

Bir katmandaki nesneye uygulanan stillerin aynisi farkli bir katmanda yer alan diger nesnelere
de uygulanmak istenebilir. Bu tir durumlarda her stili tek tek uygulamak yerine stili kopyalayip
diger katmana uygulamak mimkindr.
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18. UYGULAMA

islem adimlarina gére Dikdértgen ve Elips adinda iki katman olusturunuz. Kirmizi
renkteki Dikdortgen katmanina Satin, Outer Glow ve Stroke efektlerini belirtilen
ozelliklerde (Tablo 1.2) uygulayip ayni efektleri tek seferde Elips katmanina aktarmak
icin gereken islemleri gerceklestiriniz (Gorsel 1.53).

Tablo 1.2: Satin, Outer Glow, Stroke Efektlerine Uygulanacak Ozellikler

Satin Outer Glow Stroke
Distance: 50 Blend Mode: Overley Fill Type: Pattern
Size: 50 Opacity: 50 Size: 18

O ﬁ Elips

O FHfects
O Stroke
O Satin
© Outer Glow

O E Dikdértgen

o Hfects

O Stroke
© Satin
© Outer Glow

O - Background

Gorsel 1.53: Katman stillerini kopyalamak

1. Adim: Yeni bir galisma sayfasi agarak “Dikdértgen” adinda bir katman olusturunuz ve
Rectangle Tool aracini kullanarak kirmizi renkte bir dikdértgen ciziniz.

2. Adim: Cizdiginiz dikdortgeni secip Tablo 1.2'de belirtilen stilleri uygulayiniz.
3. Adim: Elips adinda bir katman olusturunuz ve Elipse Tool aracini kullanarak bir elips giziniz.

4. Adim: Dikdortgen katmanindaki stilleri bu katmana uygulamak igin dikdértgen katmani
Gizerinde sag tusa basip “Copy Layer Style” komutunu uygulayiniz.

5. Adim: Elips katmani Gzerinde farenin sag tusuna basip “Paste Layer Style” komutunu
uygulayiniz.

1.6. FILTRELER (FILTERS)

Filtreler, segili resmin bir bélimiine veya timiine gesitli efektler (rotuslama, 1sik, bulaniklas-
tirma, deformasyon vb.) uygulamak icin kullanilir. Gorlnti isleme programinda kullanilabilecek
efektler Filter menisi altinda yer alir. Bazi filtreler RGB, bazilari ise CMYK modunda calisir.
Bu nedenle bazi filtreler uygun mod secilmediginde pasif olarak gérindr.
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1.6.1. Neural Filters

Neural Filters, orijinal gorinti Gzerinde gercekte bulunmayan yeni pixeller olusturarak
gorintileri diizenlemeyi saglayan sinir filtreleridir.

1.6.2. Filter Gallery

Filter menisi altindaki Filter Gallery sayesinde bircok filtreyi 6n izlemesi ile birlikte gorip
uygulamak mumkindir. Filtre galerisinde Artistic, Brush Strokes, Distort, Sketch, Stylize,
Texture gibi filtre secenekleri yer alir. Artistic filtreleri, sanatsal efektler uygulamak igin kullanilir.
Brush Strokes filtreleri ile gorsele firga veya miirekkep darbeleri uygulanir. Distort filtreleri ile
gorlntlyl carpitarak deforme eden filtreler olusturulur. Sketch filtre grubu, resme el ile ¢izilmis
gibi karalama efekti uygular. Stylize, gériintiiniin piksellerini degistirerek gérinti tGzerinde etkiler
olusturur. Texture filtreler ise resme derinlik veren dokular uygulamaya yarar.

19. UYGULAMA

islem adimlarina gére segeceginiz bir gorsele Filtre galerisini kullanarak Gorsel
1.54’teki gibi filtreleri uygulama islemini gergeklestiriniz.

Artistic-Neon Glow Artistic-Underpainting Brush Strokes-Ink Outlines Disort-Diffuse Glow

Sketc-Photocopy Stylize-Glowing Edges Texture-Patchwork Texture-Mosaic Tiles

Gorsel 1.54: Filtre galerisi filtre 6rnekleri

Goriinti isleme



1. Adim: Filtre uygulamak istediginiz gorseli calisma alanina ekleyiniz ve Properties paneli
yardimiyla gérselin boyutlarini W:300, H:400 olarak ayarlayiniz.

2. Adim: Gorseli secip Alt tusu yardimiyla ¢ogaltiniz.
3. Adim: Cogalthiginiz gorsellere alt taraflarinda adi yazan filtreleri uygulayiniz.

4. Adim: Calismayi kaydediniz.

Filtreler bir gorselin tamamina uygulanabilecegi gibi sadece bir bélimiine de uygulanabilir.
Gorsel 1.55.a da sec¢im araci kullanilarak resmin bir bolimi secilmis ve secilen boliime gorsel
1.55.b de Filtre galerisinden Texture-Craqulure filtresi uygulanmistir.

Gorsel 1.55.a: Filtre uygulanmamis gorsel ~ Gorsel 1.55.b: Bir boliimiine filtre uygulanmis gorsel

1.6.3. Adaptive Wide Angle

Adaptive Wide Angle, panoramagoriintiilerde veya genis acilimerceklerle cekilen fotograflarda
egri gorlinen cizgileri dizlestirmek ve deformasyonu gidermek icin kullanilan filtredir.

1.6.4. Camera Raw Filter

Camera Raw Filter, goriintl isleme programinda fotografla ilgili tim ayarlari tek bir ekrandan
yapabilmeye yarayan kismi acarak goriinti izerinde detayli rotuslar yapilmasini saglar.

1.6.5. Lens Correction

Lens Correction, lens diizeltme aracidir. Bozulma ve perspektif gibi lens sorunlarini gidermek
icin kullantlir.
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1.6.6. Liqufy

Liqufy, resmi deforme etmek icin kullanilan filtredir. Gorlntlinin herhangi bir alanini itip
cekmeye, dondiirmeye, biiziip sisirmeye veya yansitmaya yarar.

1.6.7. Vanishing Point

Vanishing Point filtresi duvarlar, zeminler veya herhangi bir dikdértgen nesne gibi perspektif
duzlemleriiceren gorintilerde perspektif diizeltmeyi kolaylikla yapmayi saglar. Bu filtre sayesinde
bir bina veya egimli ylizey Gizerine yazi yazilarak gorsel eklenebilir.

1.6.8. 3D Filters

3D Filters, herhangi bir goriintliye derinlik veya kontrast eklemek icin kullanilir. Gorlinti isleme
programi bircok 3D formati destekledigi icin bu dosyalar programa aktarilabilir, yeni goéruntiler
olusturulabilir veya gorintiler Gzerinde diizenlemeler yapilabilir. Generate Bump (Height) Map
ve Generate Normal Map olmak lzere iki harita filtresi vardir.

1.6.9. Blur

Blur, fotograflarda bulaniklastirma efekti olusturmaya yarayan filtredir. Secili olan kismi veya
gorintinidn tamamini yumusatir. Rotus islemlerinde gokga kullanilir.

Average: Gorlntunin renk ortalamasini alarak gorseli bu renkle kaplar.
Blur: Goriintl Gzerinde belli belirsiz bir bulaniklastirma efekti olusturur.
Blur More: “Blur” filtresinden daha etkili bir bulaniklastirma saglar.

Box Blur: Daha yogun bir bulaniklastirma olusturur. Radius (yarigap) ozelligi ile gériintiinin
bulaniklastirma degeri ayarlanabilir.

Gaussian Blur: “Box blur”a benzer. Bulaniklastirma, yumusatma etkisini ayarlar ve istenen
seviyeye getirir.

Lens Blur: Bir 6geyi daha ¢ok ortaya ¢ikarir.

Motion Blur: Hareketli bir kameranin yakaladig1 goriintlyl simiile ederek cismin hareketini
gorebilmeye yarar.

Radial Blur: Resmi dairesel olarak dondiirmek veya derinlik katmak i¢in kullanilan bir kamera
efektidir.

Shape Blur: Goriintl Gzerinde segilen sekle gore bulaniklastirma yapar.
Smart Blur: Gorintudeki pirizleri azaltmaya yarar.

Surface Blur: Goriinti yizeyinde bulaniklik olusturarak goriintiyl glizellestirir.
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1.6.10. Blur Gallery

Blur Gallery, belirli alanlarda bulaniklik olusturup ayarlar yapmaya yarar.

Field Blur: Gorinta lzerinde bulaniklastirma yapilacak alanlar olusturarak bulaniklastirma
saglar. Netlestirme veya bulaniklastirma istenen yerlere raptiyeler eklenerek ayarlama yapilir.

Irish Blur: Segcili alan disinda tuval tzerindeki her seyi bulaniklastirir.

Tilt-Shift Blur: Bu efekt uygulandiginda goriintii Gzerinde iki diiz paralel ¢izgi olusur. Bu gizgilerin
ictarafinda kalan alan net alandir. Onun disinda kalan alanlaraistege gore bulaniklastirma uygular.

Path Blur: Segilen bir yol boyunca hareketi simiile eden bulanik bir alan ve hareket yolu

olusturur.

Spin Blur: Radial bulanikhga benzer ancak bulaniklik agisi O ile 360 derece arasinda olgilir.

1.6.11. Distort

Distort, bir gortuntlyl geometrik olarak deforme ederek 3D veya farkl sekillerde efektler
olusturur.

Displace: Bir secimin nasil deforme edilecegini belirlemek icin baska bir gériintu haritasini
kullanarak gorlintiiniin pixelini degistirir.

Pinch: Goriintlye ice veya disa dogru blikme efekti uygular.

Polar Coordinates: Gorseli kutupsal koordinatlardan dortgene veya dortgenden kutupsal
koordinatlara donustirdr. Bu filtre art arda uygulandiginda farkl gériintiler ortaya cikar.

Ripple: Su dalgasi efekti olusturur.

Shear: Goruntlyl bir egri boyunca deforme eder.
Spherize: Kiiresel veya dogrusal deformasyon efektidir.
Twirl: Donme efekti olusturur.

Wave: Dalga efekti verir.

ZigZag: Suya atilan bir tasin olusturdugu dalgalara benzeyen bir efekt olusturur.

1.6.12. Noice

Noice, fotograflarin herhangi bir yerine girilti (parazit) eklemeye yarar. Bu efekt,
bulaniklastirma galerisi efektleriyle birlikte kullanilir. Boylelikle bulanik bir bolime biraz ayrinti
veya doku ekleyebilmeyi saglar.

Add Noise: Parazit filtresi ekler. Gériintliye rastgele pixeller uygular. Agir rétuslanmis alanlara
daha gergekgi bir gorinim kazandirmak veya dokulu bir katman olusturmak igin de kullanilir.
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Despeckle: Goruntiideki duslk tonlu pikselleri yok eder. Dergi veya diger basili materyallerin

tarama sirasinda goriinen gorsel parazitlerini de ortadan kaldirir.
Dusk & Scratches: Gorsel lzerindeki renkleri birbirine yaklastirarak kontrasti azaltir.

Median: Gorlintideki hareket goriinimiinii veya taranmis goriintiide olusabilecek istenme-
yen desenleri ortadan kaldirarak veya azaltarak pirizsiz ylizeylerin olusmasini saglar.

Reduce Noise: Yetersiz isikla gekilen fotografin olusturdugu parlak giriltiyld ve renk

glralttsand azaltr.

1.6.13. Pixelate

Pixelate, gorlintliniin pixellerini degistirerek efektler olusturmaya yarar.

Color Haftone: Gorilintlideki pixelleri yari tonlari ile doldurur.
Crystallize: Gorlintl lGzerinde gokgen bigimli renk kiimeleri seklinde bir doku yaratir.

Facet: Renkli pixel boyutlari olusturmak icin bir araya gelen diiz veya benzer renk pixellerini
barindirir. Genellikle taranan gorintiye el ile boyanmis bir gériinim verir.

Fragment: Gorinti Gzerinde uzak ve bulanik bir etki yaratir.

Mezzotint: Doymus renkleri renkli bir goriintliye veya normal bir gériintiyi rastgele bir siyah

beyaz desene donlstlirmeye yarar.
Mosaic: Gorlintiye mozaik etkisi verir.

Pointtillize: Gorseli noktasal bir resimdeki gibi rastgele yerlestirilmis noktalar olarak yeniden

gizer.

1.6.14. Render

Render, goriintl Gizerinde 151k efektleri olusturmaya yarar.

Flame: Alev efekti olusturur.
Tree: Agag filtresi olusturur.

Clouds: Foreground ve Background (6n ve arka plan) renklerini kullanarak bulut etkisi vermeye

yarayan filtredir.

Differance Clouds: On plan ve arka plan rengi arasinda degisen rastgele degerleri kullanarak
bulut desenleri olusturmaya yarar. Filtre ilk secildiginde goriintiiniin bolimleri bulut deseninde
ters gevrilir. Filtre birkac kez uygulandiginda ise mermer dokusuna benzeyen desenler olusur.

Fibers: On ve arka plan renklerini kullanarak dokuma lifleri olusturur.

Lens Flare: Kamera objektifine parlak bir i1sigin vurmasiyla olusan isik kirllmasinin simile

edilmesini saglar.
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Lighting Effects: Isik efekti olusturur.

1.6.15. Sharpen

Keskinlestirme filtreleri, gorinti tzerinde keskinligi ve bulanikhigi ayarlar.

Shake Reduction: Fotograf ¢ekimi sirasinda fotograf makinesinin sallantisindan kaynaklanan

bulaniklasmayi olabildigince dizeltir.
Sharpen: Goriinti Gzerinde keskinlestirme saglar.
Sharpen Edges: Kenarlarin daha net gériinmesini saglar.
Sharpen More: Goriintl Uzerinde daha siddetli bir keskinlestirme saglar.

Smart Sharpen: Akilli keskinlestirme filtresidir. Bir gorintiiniin golge ve vurgu alanlarinda ayri

ayri keskinlestirme yapabilmeyi saglar.
Unsharp Mask: Keskinligi azaltma maske filtresidir. Goriintli kenarlarindaki kontrasti artirarak

keskinlestirme saglar.

1.6.16. Stylize

Stylize, goruntudeki pixellerin yerini degistirerek ve kontrasti bulup ylkselterek gorinti

Uzerinde degisik etkiler olusturmayi saglar.
Diffuse: Secimin daha az odaklanmis goériinmesini saglamak igin secimdeki pikselleri karistirir.
Emboss: Kabartma seklinde bir efekt olusturur.
Extrude: Gorseli ¢ boyutlu blok veya piramide dondstirdr.
Find Edges: Kenarlari vurgulayarak gorseli el veya kursun kalemle cizilmis bir sekle dénistirur.
Oil Paint: Gorseli yaglh boya ile yapilmis bir tabloya dondsturdr.
Solarize: Gorselin negatif ve pozitifini karistirarak efekt olusturur.
Tiles: Gorsel lizerinde fayansla kaplanmis bir etki olusturur.
Trace Contour: Gorinti Gizerindeki kontur gizgilerini bularak geri kalanlari yok eder.

Wind: Rizgar efekti olusturur.

1.6.17. Video

Video, video yakalama kartiyla elde edilen goriintileri diizenlemek igin kullanilan filtreleri
icerir.
De-Interlace: Videodan aktarilan goriinti Gzerinde temizlik yapar.

NTSC Colors: Asiri doygun renklerin televizyon tarama gizgileri arasinda tasmasini énlemek
icin renk gamini televizyon Gretimi icin kabul edilebilir olanlarla sinirlar.
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1.6.18. Other

Custom, High Pass, HSB/HSL, Maximum, Minimum, Offset gibi diger filtrelerin yer aldig
kisimdir. Kisisel filtre olusturmak, goérinti secimini dengelemek, renkleri ayarlamak ve goriinti

maskelerini degistirmek icin kullanilir.

Costom: -999 ile +999 arasinda numerik degerler girip, pixelleri diizenleyerek gorsel tizerinde
farkl filtreler olusturulmasini saglar.

High Pass: Bir gorintideki duslik frekansh ayrintilari kaldirir. Taranan goriintilerden gizgi
resimleri ve blyuk siyah beyaz alanlari ¢ikarmak icin de kullanilir.

HSB/HSL: Bir goriintiniin renk tonunu veya doygunlugunu ayarlar.
Maksimum: Goriintl Gzerindeki agik pikselleri vurgular.
Minimum: Gorlintl Gzerindeki koyu pikselleri vurgular.

Offset: Secili alanin orijinal konumunda bos bir alan birakip, secimi yatay veya dikey olarak
belirtilen miktarda kaydirir.

20. UYGULAMA

islem adimlarina gére Goérsel 1.56'daki gibi bir ates cemberi hazirlama islemini
gerceklestiriniz.

Gorsel 1.56: Ates gemberi 6rnegi

1. Adim: Arka plan rengi siyah olan yeni bir calisma sayfasi aginiz.
2. Adim: Yeni bir layer olusturunuz.

3. Adim: Ellipse Tool aracini seginiz ve bu araca ekranin Ust kisminda aktif olan 6zellikler
boliminden path 6zelligini veriniz.
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4. Adim: Ekrana path 6zelligi olan bir daire ¢iziniz (Gorsel 1.57).

Gorsel 1.57: Path 6zelligi verilen daire

5. Adim: Filter>Render>Flame komutunu seciniz (Gorsel 1.58).

Gorsel 1.58: Flame ozellik penceresi

6. Adim: Flame Type boliminden “4. Multiple Flames Path Directed” segenegini seginiz.
7. Adim: Length 6zelligini 200 olarak ayarlayiniz.

8. Adim: Calismay! “atescemberi.jpg” olarak kaydediniz.
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21. UYGULAMA

islem adimlarina gore 6gretmeniniz tarafindan sizlere dagitilacak bir gérsele (Gorsel
1.59.a) Render filtresi altinda yer alan Tree filtresini uygulayiniz (Goérsel 1.59.b)

Gorsel 1.59.a: Filtresiz gérsel Gorsel 1.59.b: Render>Tree filtresi uygulanmis gorsel

1. Adim: Gorsel 1.59.a’daki gibi bir gorsel ekleyiniz.
2. Adim: Yeni bir katman olusturunuz.

3. Adim: Filter>Render>Tree komutunu kullanarak Tree filtresi 6zellikler penceresini aginiz
(Gorsel 1.60).

Gorsel 1.60: Render>Tree filtresi 6zellikler penceresi

4. Adim: istediginiz agac tipini secerek gorsel (izerinde uygun konuma yerlestiriniz.

5. Adim: Calismayi kaydediniz.
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SIRA SiZDE

Goruntl isleme programi filtrelerinden yararlanarak Gorsel 1.61'deki calismayi
yapiniz.

Gorsel 1.61: Agaclar gorseli

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olgtlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. Arka plan rengi beyaz olan yeni bir calisma sayfasi acti.

2. Eklenecek her nesne igin ayri katmanlar olusturdu.

3. Render>Tree komutunu kullanarak agaclar ekledi.

4. Agacglarin boyutunu ayarladi.

5. Render>Picture Frame komutunu kullanarak gergeve ekledi.

6. Dosyay! kaydetti.

1.7. BiCiMLi YAZILAR TASARLAMAK

Gorilntl isleme programini kullanarak yazilari dizenlemek, yazilara efekt vermek veya resimli
yazilar hazirlamak mimkdnddr.
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1.7.1. Yazi Araglari Ozellikleri

Type Tool secildigi zaman programin Ust tarafinda aracla ilgili 6zellikler gorulir (Gorsel 1.62).
Metinle ilgili yazi tipi, renk, boyut, yon, hizalama vb. islemler bu bélim kullanilarak yapilir.

Myriad Pro Regular - ! Sharp

A B C C D E F G G H
Gorsel 1.62: Type Tool araci 6zellikler penceresi

A: Metin ara¢ cubugunun secili oldugunu gosterir.
B: Metnin yonini (yatay veya dikey) belirler.
C: Yaz tipini (font) belirler.

C: Secilen yaz tipi ile ilgili farkli bigcimlerin (Bold, Regular, Bold, Black vb.) yer aldigi kisimdir.
Farkli bigimler 6zelligi her fontta mevcut degildir.

D: Yazi tipi boyutunu (font size) ayarlar.

E: Fontun genel goriinimu (Anti-aliasing method) ile ilgili keskinlik, parlaklik, yumusaklik gibi
ayarlarin yapildigi bélimdur.

F: Metni sola, ortaya, saga hizalar.
G: Yazlya renk verir.
G: Warp Text olusturma penceresini acar.

H: Karakter ve paragraf paneline gecisi saglar.

1.7.1.1. Karakter Ayarlari

Character paneli kullanilarak fontlar, yazi tipleri, diger font ozellikleri, yazi boyutu, satir arasi
mesafeler, harfler arasi mesafeler, yazi rengi, harfe alt simge, Ust simge vb. metin karakter
ayarlamalari yapilir (Gorsel 1.63).

Character

Myriad Pro ~ Regular

Ii (Auto)
0

I 100%

olor:
TITTTT: TT. T T
fi ad T 1t ¥

Turkish ~ A3  Sharp

Gorsel 1.63: Character paneli
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1.7.1.2. Paragraf Ayarlari
Bir paragraftaki yazilarin hizalama, girinti ve paragraf arasi bosluk ayarlarini yapmak igin
Paragraph paneli kullanilir. Window menisinden Paragraph secilerek panel acilir (Gorsel 1.64).

Gorsel 1.64: Paragraph paneli

1.7.1.3. Transform ve Free Transform

Yazi segiliyken Window menisiinden Properties komutunu kullanarak Transform panelini
acmak mimkindir (Gorsel 1.65). Transform ve Free Transform islemi ile ilgili diger seceneklere
Edit menisinden erisilir.

Properties

T Type Layer

~ Transform 2}
W 1162,03p; X | 157,23 px

H 469,43 px Y 559,54 px

A 142,92 -

Gorsel 1.65: Transform paneli

22. UYGULAMA

islem adimlarina goére gériintii isleme programi kullanarak yazdiginiz “Ankara”
metnine Free Transform secenekleri ve Transform altindaki Scale, Rotate, Skew, Distort,
Perspective, Warp komutlarini uygulayan galismayi gergeklestiriniz.

1. Adim: Calisma sayfasina “#120689” renk kodunda ve 72 pt bliyukligiinde yatay olarak
“ANKARA” yaziniz.

2. Adim: Yaziyi secip, klavyeden Ctrl+T tuslarina basarak Free Transform komutunu aktif ediniz
(Gorsel 1.66).

X: 878,00 px A Y: 78650 px W: 100,00% e H: 100,00% £ 0,00

Gorsel 1.66: Free Transform
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3. Adim: Free Transform komutu secildiginde ekranin Ust tarafindaki arag¢ kutusundan Rotate
degerini “-45” olarak belirleyiniz (Gorsel 1.67).

Gorsel 1.67: Rotate degeri -45 olarak ayarlanmis metin

4. Adim: X ve Y degerlerini degistirerek metnin konumunda meydana gelen farkliliklari
gozlemleyiniz.

5. Adim: W ve H degerlerinde degisiklikler yapip, metnin genislik ve yiksekliginde ki¢liltme
veya bliyitme saglayarak olusan farklliklari gézlemleyiniz.

6. Adim: H ve V (Horizontal ve Vertical skew) degerlerine farkl degerler girerek degisiklikleri
gozlemleyiniz.

7. Adim: Edit>Transform>Distort komutunu aktif duruma getirerek metni deforme ediniz
(Gorsel 1.68).

Bu komutun aktif olabilmesi icin yazinin metin 6zelliginden c¢ikartilip vektore
donisturulmesi gerekir. Bunun igin Type>Rasterize Type Layer komutu kullanilir.

Gorsel 1.68: Deforme edilmis metin

8. Adim: Distort komutunu Shift komutu veya Alt komutu ile birlikte kullanarak farkh sekiller
elde ediniz.

9. Adim: Metne Edit>Transform>Perspective komutunu uygulayiniz.

10. Adim: Edit>Transform>Warp komutunu uygulayarak metni farkh sekillere donistiriniz
(Gorsel 1.69).
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Gorsel 1.69: Warp komut se¢enegi uygulanmis metin

11. Adim: Metne Edit>Transform>Rotate komutunu uygulayarak metni sirasiyla 180 derece,
saat yonlinde ve saatin tersi yoniinde dondiriniz.

12. Adim: Flip Horizontal ve Flip Vertical komutlariile yaziya yatay ve dikey eksende aynalama
yapiniz (Gorsel 1.70).

Flip Horizontal Flip Vertical

Gorsel 1.70: Flip Horizontal ve Flip Vertical uygulanisi

SIRA SizDE

Goruntl isleme programinda agacaginiz beyaz renkli ¢alisma sayfasina adiniz ve
soyadinizi kirmizi renkte ve 48 pt boyutunda yatay olarak yaziniz. Metne Transform
komutu altinda yer alan tiim komutlari uygulayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme ol¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

. Adini ve soyadini kirmizi renkli, 48 pt olarak yazdi.

. Metne Scale komutunu uyguladi.

. Metne Rotate komutunu uyguladi.

. Metne Skew komutunu uyguladi.

. Metne Distort komutunu uyguladi.

. Metne Perspective komutunu uyguladi.

. Metne Warp komutunu uyguladi.

O IN | O A WN|R

. Metne Rotate 180°, Rotate 90° Clockwise ve Rotate 90° Counter Clockwise
komutlarini uyguladi.

9. Metne Flip Horizontal ve Flip Vertical komutlarini uyguladi.
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1.7.2. Yazilara Efekt Vermek

Warp Text araci ile metinleri sekillendirmek mimkindir. Warp Text Ozelligine yazi araci
seciliyken Type menisiinden, Warp Text veya yazi araci ile ilgili 6zellikler bélimiinden erisilebilir
(Gorsel 1.71).

Warp Text X

Style: & Bulge

© Horizontal Vertical

Bend: +50

Horizontal Distortion:

&
Vertical Distortion:

&

Gorsel 1.71: Warp Text

23. UYGULAMA

islem adimlarina gore “Bilisim Teknolojileri” yazisina Gérsel 1.72’deki Warp Text
efekti 6zelligini verme islemini gerceklestiriniz.

Gorsel 1.72: Warp Text uygulanan metin

1. Adim: Bilisim Teknolojileri yazisini mavi renkli ve 48 pt olarak yaziniz.
2. Adim: Metni secerek Type menisiinden Warp Text komutunu uygulayiniz.
3. Adim: Acilan pencereden Style olarak Bulge 6zelligini seginiz.

4. Adim: Dosyayi kaydediniz.

1.7.3. Yol Boyunca Metin Eklemek

Goruntl isleme programi araglarini kullanarak, bir yol ¢izip metni bu yola eklemek
mimkindir. Kalem araci kullanilarak gizilen bir ¢izgi boyunca veya geometrik sekillerin etrafina
metin eklenebilir.
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24. UYGULAMA

islem adimlarina gére Goérsel 1.73’teki gibi bir seklin etrafina metin ekleme islemini
gerceklestiriniz.

Gorsel 1.73: Yola metin ekleme

1. Adim: Shift tusu ile birlikte Elipse aracini kullanarak galisma alanina bir daire ekleyiniz.

2. Adim: Metin aracini segerek, dairenin dis ¢izgisi Gzerine gelip metni yaziniz (Gorsel 1.74).

Gorsel 1.74: Daire dis kenarina yazi yazma

3. Adim: Chraracter panelinde yer alan degerini metin dairenin etrafini saracak sekilde
ayarlayiniz.

25. UYGULAMA

islem adimlarina gére Gérsel 1.75teki yol boyunca yazilan Bilisim Teknolojileri
metnini olusturma islemini gerceklestiriniz.
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Gorsel 1.75: Yola metin ekleme
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1. Adim: Curvature Pen Tool aracini kullanarak Gorsel 1.76’daki gibi bir ¢izgi sekli olusturunuz.

Gorsel 1.76: Curvature Pen Tool araciyla gizim

2. Adim: Type Tool aracini kullanarak metni ¢gizgi tGzerinde yaziniz (Goérsel 1.77).

2.
%_‘rg\&%\

Gorsel 1.77: Type Tool aracini kullanarak yola yazi ekleme

3. Adim: Chraracter panelinde yer alan degerini 25 olarak ayarlayiniz.
4. Adim: Calismayi kaydediniz.

1.7.4. Metni Yola Donistiirmek

Goruntt isleme programi kullanihp, metin yazi 6zelliginden cikarilarak bir yola (path)
donusturilebilir. Type menlsiinden Create Work Path komutu ile islem gergeklestirilir. Paths
panelinin ekranda goriintiilenmesi i¢cin Window>Paths segilir.

26. UYGULAMA

islem adimlarina goére gériintii isleme programini kullanarak 48 punto, Calibri
Regular ve mavi renk 6zelliklerinde “Bilisim Teknolojileri” yazisini yaziniz. Yazdiginiz
metni yola donlstirme islemini gergeklestiriniz.
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1. Adim: Yeni bir calisma sayfasi aginiz ve Type Tool aracini kullanarak “Bilisim Teknolojileri”
yazisini istenen ozelliklerde yaziniz.

2. Adim: Yazi seciliyken Type menisiinden Create Work Path komutunu veriniz. Bu islem ile
metin, yazi 6zelliginden ¢ikacak ve Paths panelinde Work Path adinda bir path olusacaktir (Gorsel
1.78).

Gorsel 1.78: Metne path 6zelligi verme

3. Adim: Layers panelinde olusan Bilisim Teknolojileri katmani 6nlindeki gbéz simgesine
tiklayiniz. Bu islem ile hazirlanan Work Path daha net gorlinecektir (Gorsel 1.79).

tehn Taknolofllar

Gorsel 1.79: Work Path uygulanmis metin

4. Adim: Work Path ismini “Path 6rnegi” adi ile kaydediniz. Bu islem igin Paths panelindeki
Work Path yazisinin lizerine gift tiklayip, agilan pencereden Name boliimiine istenen ismi yazarak
OK digmesine basmak yeterlidir (Gorsel 1.80).

Save Path X

Name: Path 6rnegi

Gorsel 1.80: Save Path
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5. Adim: Yazi ozelliginden path 06zelligine gecen “Bilisim Teknolojileri” goérselinde Path
Selection Tool (A) aracini kullanarak sectiginiz nesnelerin yerini degistiriniz (Gorsel 1.81). Direct
Selection Tool aracini kullanarak gorsele istediginiz sekli veriniz (Gorsel 1.82).

Selection Tool A

tion Tool A

Gorsel 1.81: Selection Tool

Gorsel 1.82: Path Selection ve Direct Selection uygulanan gorsel

6. Adim: Calismayi “path uygulamasi” ismi ile kaydediniz.

SIRA SiZDE

Kirmizi renkte ve 48 pt 6zelliklerinde yazdiginiz “MUSTAFA KEMAL ATATURK” yazisini
yola donustirerek sekillendiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. “MUSTAFA KEMAL ATATURK” yazisini kirmizi renkli ve 48 pt olarak yazdi.

2. Metni yazi 6zelliginden gikartip yola donustlird.

3. Direct Selection Tool aracini kullanarak sekillendirme islemini gerceklestirdi.

4. Calismayi kaydetti.

1.7.5. Metni Sekle Donustiirmek

Metni yola dontstirme islemi gibi metin bir sekle de déndstirilebilir. Bu islemler i¢in Type
menisiinden Convert to Shape komutu veya Paths paneli kullanilir.

Goriinti isleme



27. UYGULAMA

islem adimlarina goére goriintii isleme programini kullanarak yazdiginiz 36 punto,

Bahnschrift yazi tipi ve kirmizi renk 6zelliklerindeki “Bilisim Teknolojileri” metnini sekle
donustliirme islemini gerceklestiriniz.

1. Adim: Yeni bir calisma sayfasi agip istenen ozelliklerde “Bilisim Teknolojileri” yazisini yaziniz.

2. Adim: Yaz segiliyken Type mentisiinden Convert to Shape komutunu secerek metnin sekil
ozelligi almasini saglayiniz.

3. Adim: Gorsel 1.83’te yer alan isaretli bolim Uzerine ¢ift tiklayiniz ve agilan pencereden
rengi mavi olarak seginiz.

Gorsel 1.83: Convert to Shape ozelligi verilen yazi katmani

4. Adim: Katmanin Opacity 6zelligini %50 olarak ayarlayiniz.

5. Adim: Calisma dosyasini “metinden sekle” adiyla kaydediniz.

1.7.6. Metni Maskelemek

Horizontal Type Mask Tool ve Vertical Type Mask Tool araclarini kullanarak yazilan yazilari
yatay veya dikey yonde maskelemek mimkiindur.

28. UYGULAMA

islem adimlarina gore “Bilisim Teknolojileri Dersi” yazisini Gérsel 1.84’teki gibi yatay
yazarak maskeleme islemini gergeklestiriniz.

Gorsel 1.84: Maskeleme 6rnek gorseli

Gorinti isleme | 75



1. Adim: Goriintl isleme programini aginiz ve File>Place Linked komutunu kullanarak bir
resim ekleyiniz.

2. Adim: Horizontal Type Mask Tool aracini kullanarak 36 punto biyilkliglinde yaziyi yaziniz.
3. Adim: Maskelemenin yapildigi (yazinin yer aldigi) katman Gzerine tiklayiniz.

4. Adim: Layers panelindeki Add Layer Mask semboliine tiklayarak islemi tamamlayiniz
(Gorsel 1.85).

Gorsel 1.85: Maskeleme islemi

SIRA SiZDE

istediginiz herhangi bir gérseli secerek “Grafik ve Canlandirma” yazisina dikey
maskeleme islemi uygulayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. Gorseli calisma alanina ekledi.

2. Vertical Type Mask Tool aracini kullanarak metni dikey yazdi.

3. Add Layer Mask komutunu uygulayarak metni maskeleme islemini
tamamladi.

4. Calismayi kaydetti.

1.7.7. 3D Yazi Olusturmak

Goruntd isleme programi ile 3D yazilar olusturulabilir. Bunun icin 3D meni se¢eneklerinden
ve 3D panelinden yararlanilr.
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29. UYGULAMA

islem adimlarina goére 3D &zelligi kullanilarak hazirlanan Gérsel 1.86’daki metni
yazma islemini gergeklestiriniz.

Gorsel 1.86: 3D yazi 6rnegi

1. Adim: Yazi aracini kullanarak ¢alisma alanina 72 pt buyukltginde “3D TEXT” yaziniz.

2. Adim: Yaziyi secgip 3D menisiinden New 3D Extrusion from Selected Layer komutunu
seciniz. 3D ¢alisma alani agilacaktir.

3. Adim: 3D Properties boliminden Extrusion Depth 6zelligini 46,65 olarak ayarlayiniz (Gorsel
1.87).

Gorsel 1.87: Extrusion Depth ayarlamasi

4. Adim: Shape Preset kismindan “Inflate” secenegini seciniz.

5. Adim: Ust cubuktaki araclarin 3D Mode seceneklerinden “Rotate the 3D Object” secerek
nesneyi dondlriintiz (Gorsel 1.88).

3D Mode:

Q. %
o &

Gorsel 1.88: 3D Mode segenekleri

1.7.8. Metinlere Stil Uygulamak

Gorintl isleme programinda metinlere stil eklenirken katmanlara stil eklemede oldugu gibi
Layer Style ozelligi kullantlir.
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30. UYGULAMA

islem adimlarina gére “Merhaba” kelimesini Gorsel 1.89’daki gibi yazmak igin gerekli

islemleri gergeklestiriniz.

Gorsel 1.89: Stil uygulanan metin

1. Adim: Calisma sayfasina 36 punto, siyah ve Calibri yazi tipinde “Merhaba” yaziniz.

2. Adim: Metnin kabarik ve cukur gorinti olusturmasi icin Bevel & Embos efektini uygulayiniz.
Bevel & Embos efektine Outer Bevel stilini uygulayiniz. Direction 6zelligini “Up” ve Size ozelligini
13 px olarak ayarlayiniz. Shadow Mode rengini pembe olarak belirleyiniz.

3. Adim: Metne Stroke efektini uygulayiniz. Fill Type 6zelligini Gradient olarak seginiz.

4. Adim: Calisma dosyasini “Uygulama 30” olarak kaydediniz.

1.7.9. Metne Filtre Uygulamak

Goruntl isleme programi kullanilarak yazilan bir yaziya filtre uygulamak mimkindir. Bir
metne filtre uygulayabilmek icin metnin yer aldigi katmani rasterize yapmak (katmani resme
donustirmek) gerekir. Bunun icin yazinin bulundugu katman (zerinde farenin sag tusu ile

tiklanarak Rasterize Layer segilir.

31. UYGULAMA

islem adimlarina gére bir gicek resmi gérseli lizerine yazdiginiz yaziya ZigZag filtresini

uygulama islemini gerceklestiriniz (Gorsel 1.90).

Gorsel 1.90: ZigZag filtresi uygulama
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1. Adim: Goérunti isleme programini acarak cicek resmi ekleyiniz.
2. Adim: Eklediginiz gorsel izerine “HOSGELDIN BAHAR” yaziniz.

3. Adim: Yazinin bulundugu katman (zerinde sag tusa basarak agilan listeden Rasterize Layer
seginiz.
4. Adim: Filter>Distort>ZigZag filtresini metne uygulayiniz.

5. Adim: Calismay! “zigzag.jpg” olarak kaydediniz.

1.8. EYLEMLER (ACTIONS)

Actions, gorintl isleme programinda yapilan islemlerin daha sonra tekrar kullaniimak
tizere kaydedilip saklanmasini saglayan nesnelerdir. Ornegin birden fazla fotografa ayni boyut
veya efektin uygulanmasi gerekebilir. Bir logo ¢ok sayida resimde kullaniimak istenebilir. Boyle
durumlarda gorinti isleme programinin actions o6zelliginden yararlanilir. Actions kullanilarak
yapilan her islem kaydedilir. Ayni islemler istendigi zaman tek tus ile farkli dosyalarda ve
fotograflarda kullanilabilir.

Actions paneline Window menisiinden Action komutu veya klavyeden Alt+F9 tuslari

kullanilarak erisilir (Gorsel 1.91).

History  Actions

Gorsel 1.91: Actions paneli

A: Stop playing/recording
B: Begin recording

C: Play selection

D: Create new set

E: Create new action

F: Delete
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32. UYGULAMA

islem adimlarina gére internetten buldugunuz veya 6gretmeniniz tarafindan verilen
bir manzara resmine Mosaic ve Gaussion Blur filtrelerini uygulamayi saglayacak eylemi
olusturarak kaydeden calismayi gerceklestiriniz (Gorsel 1.92 ve Gorsel 1.93).

Gorsel 1.92: Filtresiz goérsel Gorsel 1.93: Gaussian Blur ve Mosaic
filtre uygulanan gorsel

1. Adim: Yeni bir calisma sayfasi a¢iniz ve manzara resmini ekleyiniz.

2. Adim: Create new set diigmesini kullanarak “Ornek Calismam” adinda bir action klasérii
olusturunuz.

3. Adim: New action digmesine tiklayiniz. Acgilan pencereden eyleminize bir isim (name)
vererek Kaydet (Record) diigmesine basiniz (Gorsel 1.94). Bu asamadan sonra yapilan her islem

“Stop playing” diigmesine tiklanincaya kadar kaydedilecektir.

Name: ilk eylemim (" record D)

Set:  Ornek Galismam e

Function Key: None -

Color: None

Gorsel 1.94: New action penceresi

4. Adim: Layers panelinde Background kilidini kaldiriniz ve bu katmanin adini “filtrelerim”
olarak degistiriniz.
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5. Adim: Filter>Blur>Gaussian Blur filtresini secip, Radius 6zelligini 6 pixel olarak ayarlayiniz.
6. Adim: Filter>Pixelate>Mosaic filtresini secip Cell Size 6zelligini 10 square yapiniz.
7. Adim: Stop playing digmesine tiklayarak kaydetme islemini durdurunuz.

8. Adim: Bu eylemi daha sonra farkh calismalarda kullanmak veya arkadaslarinizla paylasmak
amaciyla kaydediniz. Bunun igin klasor segiliyken Actions panelinin sag (st kosesindeki
semboliine tiklayiniz.  Agilan meniden “Save Actions” komutunu secerek eyleminizi
bilgisayarinizda olusturacaginiz bir klasorin icine kaydediniz.

Kaydedilen eylemi yeni bir ¢calismada kullanmak icin ilgili eylem dosyasini Actions
paneli Gzerine sirtikleyerek birakmak yeterlidir.

33. UYGULAMA

islem adimlarina gére otuz ikinci uygulamada kaydettiginiz eylemi, herhangi bir
gorintl dosyasi Uzerinde uygulayacak islemi gergeklestiriniz.

1. Adim: islem yapilacak gorseli aginiz.

2. Adim: Action dosyasini bilgisayarda kayitl oldugu yerden sirikle birak yéntemi ile Actions
paneli Gzerine tasiyiniz.

3. Adim: Tasidiginiz actionu segip Actions panelinden Play selection diigmesine tiklayiniz.

34. UYGULAMA

islem adimlarina gore internetten indireceginiz veya 6gretmeninizin sizlerle
paylasacagl en az 5 adet gigek resminden olusan bir klasor olusturunuz ve Gorsel
1.95'teki eylemin klasordeki tim resimlere ayni anda uygulanmasini saglayacak
islemleri gergeklestiriniz.

Gorsel 1.95: Action uygulanan gicek resmi
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1. Adim: Goriintl isleme programini aginiz ve File>Open komutunu kullanarak bir cicek resmi
ekleyiniz.

2. Adim: Cicek resminin yer aldig1 Background kilidini aginiz.

3. Adim: Edit>Stroke komutunu kullanarak 50 px boyutunda, yesil renkte ve Inside 6zellik-
lerinde bir ¢cerceve olusturunuz.

4. Adim: Kaydetme islemini durdurunuz ve dosyayi kapatiniz.

5. Adim: File>Automate>Batch (Toplu islem) komutunu secerek Gorsel 1.96’daki ayarlari
yapiniz.

Gorsel 1.96: Batch komut penceresinden bir kisim

Source (Kaynak) Folder ile gorsellerin oldugu klasori, Destination (Hedef) kismindaki Folder
secenegiyle de cerceveli resimlerin kaydedilecegi klasori seginiz.

6. Adim: Karsiniza ¢ikan pencereleri onaylayarak eylemin tiim goérsellere uygulanmasini ve
hedef klasore kaydedilmesini saglayiniz.

SIRA SizDE

internetten bulacaginiz veya 6gretmeninizin dagitacag 10 adet tarihi yer gorselini
“tarihi yerler” isminde bir klasore kaydediniz. Bu gorsellere 8x10 300 Dpi CMYK
ozelliklerini topluca vermeyi saglayarak eylemi hazirlayiniz. Hedef dosyanin adini “tarihi
yerler cmyk” olarak olusturunuz.

DEGERLENDIRME

Calismalariniz diger sayfada yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.
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KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Tarihi yer gorsellerinin bulundugu “tarihi yerler” adl kaynak klasori
olusturdu.

2. Gorselleri klasore ekledi.

3. Hedef dosyalarinin tutulacagi “tarihi yerler cmyk” adinda klasor olusturdu.

4. “Baskiya hazirlik” gorseller isminde bir action seti olusturdu.

5. “eylemim” isminde bir action olusturdu.

6. istenen &zellikleri action olarak kaydetti.

7. Kaydetme islemini durdurdu.

8. File>Automate>Batch komutunu kullanip, “tarihi yerler” klasoriindeki

gorselleri yeni 6zellikleri ile toplu olarak “tarihi yerler cmyk” klasoriine aktardi.

1.9. WEB ARAYUZU VE BOLUMLERI HAZIRLAMAK

Goruntl isleme yazimi kullanilarak birden fazla ekran bigimi ve cihaz igin gelismis tasarim
olusturulur. istenirse bu tasarimlar tek ve sonsuz tuvalde yapilir. Resimler lzerinde islemler
yapilirken ayni zamanda web sayfa tasarimina yonelik temel islemler de bu programda
gerceklestirilir. Ozellikle dilimleme araci kullanilarak etkilesimli web sayfalari hazirlanir.

1.9.1. Web Arayiizii icin Yeni Belge Olusturmak

Calisma alaninda yeni bir belge agmak icin farkli yollar kullanilabilir. Bu yollarin biri, gérinti
isleme programi agildiktan sonra Create new segilmesidir (Gorsel 1.97).

]

Gorsel 1.97: Create new segenegi
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Create new secildikten sonra hazir sablonlarin bulundugu New Document (Yeni Belge)
penceresiyle karsilasilir (Gorsel 1.98). Bu penceredeki 6n ayarl bos belgeler (BLANK DOCUMENT
PRESETS) kullanilarak tasarima uygun ekran bicimi ve cihaz secilir. ihtiyaca gére &n ayarl bos

belge diizenleri olusturularak kaydedilir.
A B

!

C<—e . *—>C
D<o T_,F
G <o
G <o
H <—e

Gorsel 1.98: New Document penceresi

A) Web Segenegi: Tasarima uygun genislik, yikseklik ve ¢ézlnirlikte 6n ayarl bos belgelere

ulasmak icin kullantlir.

B) Untitled-1: On ayarli bos belgenin ayarlari yapildiktan sonra dokiimani kaydetmek icin bu
kutudan uygun bir isim belirlenir.

C) Width (Geniglik): Calisilacak belgenin genisligi bu kutuya girilerek belirlenir.

C) Pixels (Pikseller): Bu acilir kutu kullanilarak galisilacak belgenin boyutlari Pixels (piksel),
Inches (ing), Centimeters (santimetre), Millimeters (milimetre), Points (nokta) ve Picas (pika)
birimlerinde belirlenir.

D) Height (Yiikseklik): Calisilacak belgenin yliksekligi bu kutuya girilerek belirlenir.

E) Orientation (Yonlendirme): Belgenin yatay mi, dikey mi olacagi belirlenir.

F) Artboards (Calisma Yiizeyi): Tasarim belgesinde artboards kullanilip kullanilmayacagi bu
onay kutusundan segilir.

G) Resolution (Coziiniirliik): Birim alan basina kag piksel olacagl bu kutudan belirlenir. 72

Pixels/Inch genellikle kullanilan ¢oéziindrlGktar.
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G) Color Mode (Renk Modu): Belgede kullanilacak renk modu belirlenir. Web arayiizler icin
sadece RGB Color (kirmizi, yesil, mavi renkler) segilebilir.

H) Background Contents (Arka Plan igerigi): Arka plan rengi bu agilir kutudan belirlenir. Arka
plan icin seffaf, beyaz, siyah veya ayarlanacak 6zel bir renk belirlenebilir.

i) Create (Olustur): Ayarlari yapilan ¢alisilacak belge Create diigmesine tiklanarak olusturulur.

35. UYGULAMA

islem adimlarina gére goériintii isleme yaziliminda web arayiizii tasarlamak icin
1600 piksel genisliginde, 1000 piksel yiiksekliginde, arka plan rengi siyah olacak sekilde
tasarim belgesi olusturunuz.

. Adim: Gorlintl isleme yazilimini ¢alistiriniz.

. Adim: Agilan ekranda Create New diigmesine tiklayiniz.

. Adim: Yeni gelen New Document penceresinde Web secenegini tiklayiniz.
. Adim: Pencerenin sag tarafindaki Width kutusuna 1600 degerini giriniz.

. Adim: Width kutusunun sag tarafindaki agilir listeden Pixels segenegini seginiz.

a U A W N R

. Adim: Pencerenin sag tarafindaki Height kutusuna 1000 degerini giriniz.

7. Adim: Pencerenin sag alt tarafindaki Background Contents acilir listesinden Black degerini
seginiz.

8. Adim: Pencerenin sag altindaki Create diigmesini tiklayiniz.

SIRA SiZDE

Web araylzi tasarlamak icin 1400 piksel genisliginde, 800 piksel yiksekliginde ve
arka plan rengi Transparent (seffaf) olan belgeyi olusturunuz.

DEGERLENDIRME

Calismalarinizdiger sayfada yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme ol¢itlerini dikkate aliniz.

Goriinti isleme | 85



86

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

. Goruntd isleme yazilimini ¢alistirdi.

. Create New dugmesine tikladi.

. Web secenegine tikladi.
. Width kutusuna 1400 degerini girdi.
. Width kutusunun sagindaki aclilir listeden Pixels degerini secti.

. Height kutusuna 800 degerini girdi.

. Background Contents agilir listesinden Transparent secti.
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. Create diigmesine tikladi.

1.9.2. Artboards (Calisma Yiizeyleri)

Bir arayliz tasarimi veya web arayiiz tasarimi yapilirken karsilasilacak en biiyik problemlerden
biri, farkli ekran boyutlari ve cihazlar icin tasarimi ayarlamaktir. Artboards ile farkli cihazlar ve
ekran boyutlari i¢in tasarimlar hazirlanabilecek tuvale ulasilarak tasarim sireci kolaylastirilir.
Artboards olustururken énceden ayarlanmis farkh boyutlar arasindan secim yapilabilir veya 6zel
boyutlar tanimlanarak kullanilabilir.

Artboards sadece bir ekran boyutu ile tasarim yapilsa bile kullanishdir. Ornegin bir web sitesi
tasarlanirken, farkli sayfalarin tasarimlari yan yana ve tek bir icerik olarak goérintilenebilir.

1.9.2.1. Artboard Olusturmak

Artboard 0Ozel bir tir katman grubu olarak ifade edilebilir. Bir artboard, icerdigi dgelerin
boyutlarini kendi sinirlarina gére kirpar (Gorsel 1.99).

Gorsel 1.99: Ayni tasarimin iki farkli artboard gériiniimii

Artboards kullanilarak otuz besin lzerinde farkli cihaz veya ekran boyutu ile cahsilabilir.
Gorsel 1.99°da Web Most Common (En Cok Ortak Kullanilan Web) ekran boyutuna sahip soldaki
Artboard 1 ile Mobile Design (Mobil Tasarim) ekran boyutuna sahip sagdaki Artboard 2 arasindaki
fark gorilar. Bu fark, farkl boyuttaki artboardlarin igerigini kendi sinirlarina gére kirpmasindan

olusur.

Goriinti isleme



Artboard olusturmak igin goriintl isleme yazilimi agildiktan sonra Create New secenegi secilir.
Acilan New Document penceresinden Web veya Mobile secildiginde ekranin sag tarafinda,
PRESET DETAILS bolimiinde artboards onay kutusu segili olarak gelir (Goérsel 1.100). Photo, Print,
Art & lllustration veya Film & Video secildiginde ise artboards onay kutusu secili olarak gelmez.
Sablonlar artboards ile birlikte kullaniimak istendiginde bu onay kutusu segili hale getirilmelidir.

Gorsel 1.100: Artboards onay kutusu

1.9.2.2. Artboards Boyutlandirmak

Artboards, belirli ekran boyutlarinda veya belirli cihazlar icin uygun sekilde olusturulabilir.
Bununla birlikte Layers panelinde boyutu degistirilecek olan Artboard 1 segilerek (Gorsel 1.101)
etrafinda olusan ici beyaz kutucuklardan sirikle birak yontemiyle istenen boyutta artboards

olusturulur.

Gorsel 1.101: Layers panelinden Artboard 1 segimi

Gorsel 1.102'deki kutular kullanilarak sirikle birak yontemiyle Artboard istenen yonde
bayatalur veya kiclltulir. Gorsel 1.103’te sagdan kugtltilmus bir Artboard gorilir.

1

}

Gorsel 1.102: Artboard boyutlandirma kutular Gorsel 1.103: Sagdan kiigiiltlilmiis Artboard

Gorinti isleme
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1.9.2.3. Artboard Cogaltmak

Ayni anda birden fazla artboard ile ayni ekranda ¢alismak mimkiindur. Bu 6zellik sayesinde
farkh web sayfalari tek ekranda tasarlanabilir. Bunun igin artboardlari ¢cogaltmak gerekir (Gorsel
1.104).

Gorsel 1.104: Artboard Tool segimi

Gorintl isleme yaziliminin sol tarafindaki Tools bolimiinde bulunan Move Tool lizerinde fare
sol tusuna bir siire basilirsa alt araglar ortaya cikacaktir. Bu aracglardan Artboard Tool, ardindan
Layers panelinden Artboard 1 segcilir. Gorsel 1.105’te olusan arti simgelerine tiklanarak Artboard
1’in bos bir kopyasi olusturulur.

Gorsel 1.105: Artboard 1 secilince olusan arti simgeleri

Artboard 1’deki layerlar yeni olusan Artboard 2’de yer almaz (Gorsel 1.106).

Gorsel 1.106: Artboard 1’in bos kopyasi Artboard 2
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Artboard 1’deki layerlar yeni olusan Artboard’da yer alacaksa klavyeden Alt tusuna basili
tutarken arti simgesi tiklanir (Gorsel 1.107). Bu sayede her iki artboard icerigi farkh diizenlenebilir.

Gorsel 1.107: Artboard 1’in kopyasi Artboard 1 copy

1.9.2.4. Artboards Silmek

Silinecek Artboards, Layers panelinden secilir ve klavyeden Delete tusuna basilir veya silinecek
Artboards, Layers panelinden siirtkle birak yontemiyle Gorsel 1.108’deki ¢op kutusu simgesine
birakilir.

Gorsel 1.108: Artboard 2 silme

36. UYGULAMA

islem adimlarina goére goérinti isleme yazihminda web arayiizii tasarlamak igin
Artboard 1 olusturunuz. Artboard 1’in Artboard 2 isminde kopyasini olusturup Artboard
1i siliniz.

1. Adim: Goriuntl isleme yazilimini galistiriniz.
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. Adim:
. Adim:
. Adim:
. Adim:
. Adim:
. Adim:
. Adim:
. Adim:

Acilan ekranda Create New digmesine tiklayiniz.

Yeni gelen New Document penceresinde Web se¢cenegini tiklayiniz.
Seceneklerden Web Most Common seginiz.

Pencerenin sag tarafindaki Artboards onay kutusunu segcili hale getiriniz.
Pencerenin sag altindaki Create digmesini tiklayiniz.

Artboard Tool seginiz.

Layers panelinde Artboard 1 seginiz.

Artboard 1 etrafinda yer alan arti simgesine tiklayiniz.

10. Adim: Layers panelindeki Artboard 1’i seciniz ve klavyeden Delete tusuna basiniz.

SIRA SiZDE

Web arayiizii tasarlamak icin (g tane bos artboard olusturup ilk artboardu siliniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi

yaparken degerlendirme o6lcttlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Create New diigmesine tiklad!.

2. Web secenegine tiklad.

3. Web Most Common secenegini secti.

getirdi.

4. New Document penceresinin sagindaki Artboards onay kutusunu segcili hale

5. Create diigmesine tikladi.

6. Artboard Tool secti.

7. Layers panelinde Artboard 1’i secti.

8. Calisma alaninda Artboard 1’in sagindaki arti simgesine tikladi.

9. Calisma alaninda olusan Artboard 2'nin sagindaki arti simgesine tikladi.

10. Layers panelinde Artboard 1’i secti.

11. Klavyeden Delete tusuna bast.
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1.9.3. Diigmeler

Web sayfalarindaki digmeler tiklandiginda genellikle farkli web sayfalarina gegisi saglar.
Goruntd isleme yazimi kullanilarak gesitli ve 6zglin web sayfa baglanti digmeleri tasarlanabilir.

1.9.3.1. Diigme Olusturmak

Gorlntl isleme yazilimi galistirildiktan sonra Create new segenegi tiklanir. Agilan New
Document penceresinin PRESET DETAILS kismindaki isim kutusuna Dugme, Width kutusuna 500
ve Height kutusuna 350 piksel degerleri girilir (Gorsel 1.109).

Gorsel 1.109: Diigme boyutlar

Create secenegine tikladiktan sonra calisma alaninda beyaz bir arka plan olusur. Araglar
boéliminden Polygon Tool araci segilir (Gorsel 1.110).

Gorsel 1.110: Polygon Tool segimi
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Polygon Tool araci secildikten sonra beyaz ¢calisma alaninda herhangi bir yere tiklanir. Polygon
seceneklerinin diizenlenebilecegi yeni bir pencere ile karsilagihr. Width kutusuna 60, Height
kutusuna 60 ve Number of Sides (Kenar sayisi) kutusuna 8 degeri girilir (Gorsel 1.111).

Gorsel 1.111: Polygon olusturma

OK secenegi tiklandiktan sonra ¢alisma alaninda sekil belirir. Dikey ve yatay hizalama
secenekleri kullanilarak seklin ekranin ortasina gelmesi saglanir (Gorsel 1.112).

L L

Gorsel 1.112: Yatay ve dikey hizalama

Properties panelindeki Transform boliminde Set Rotation agisina 45 derece girilir (Gorsel
1.113).

Gorsel 1.113: Set Rotation kutusu
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Daha sonra araglar boliminden Direct Selection Tool segilir (Gorsel 1.114).

Gorsel 1.114: Direct Selection Tool segimi

Direct Selection Tool araci kullanilarak polygonun sag tarafi ortadan itibaren segcilir (Gorsel
1.115). Segim sonrasi polygonun sag tarafinda ici dolu dort kutu olusur (Gorsel 1.116).

Gorsel 1.115: Polygon segimi Gorsel 1.116: Se¢im sonrasi Polygon

Shift tusuyla beraber sag ok tusuna basildiginda sekil saga dogru genislemeye baslar. Polygon
istenen boyuta ulasinca tuslar birakilir (Gorsel 1.117).

Gorsel 1.117: Polygonun uzatilmig hali
Polygon uzatildiktan sonra pencerenin sag alt tarafindaki Layers béliminden Add a layer

sytle simgesi tiklanir (Gorsel 1.118). Acilan seceneklerden en Ust siradaki Bevel & Emboss secilir
(Gorsel 1.119).

Gorsel 1.118: Add a layer style simgesi Gorsel 1.119: Bevel & Emboss segenegi

Gorinti isleme
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Yeni agilan Layer Style penceresinde Bevel & Emboss onay kutusu ile Gradient Overlay onay
kutusu segilir (Gorsel 1.120). Pencerede bulunan OK diigmesine tiklanir.

L ]
L1

Gorsel 1.120: Layer Style penceresi
Araclar bolimindeki “T” simgesi kullanilarak digmenin ismi yazilir. Bu digmeyi ihtiyaca gore

cogaltip, digmenin Gzerindeki ismi degistirerek yeni digmeler elde etmek mimkindir. Gorsel
1.121’de digmenin ismi “ANA SAYFA” olarak yazilir.

Gorsel 1.121: ANA SAYFA diigmesi

Digme kaydedilmeden 6nce Layers boliminden Background silinir. Silinecek Background
katmani secildikten sonra Delete layer simgesi tiklanir (Gorsel 1.122).

\

Gorsel 1.122: Background katmani segimi ve Delete layer simgesi
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Beyaz arka plan silindikten sonra digmenin arka plani gri ve beyaz karelerden olusur. Bu, arka
planin seffaf oldugunu ifade eder (Goérsel 1.123).

Gorsel 1.123: Seffaf arka planli diigme

File (Dosya) menisiinden Save As... (Farkh Kaydet) secilir ve uygun bir dosya ismi verilerek
calisma kaydedilir.

37. UYGULAMA

islem adimlarina gore gériintii isleme yaziliminda, web arayiiziinde kullanmak igin
“RESIMLER” isminde diigme tasarlayiniz.

1. Adim: Gorinti isleme yazilimini galistiriniz.
2. Adim: Acilan ekranda Create New diigmesine tiklayiniz.

3. Adim: Yeni gelen New Document penceresinde PRESET DETAILS isim kutusuna “Digme”
yaziniz.

4. Adim: Width kutusuna 500 piksel degerini giriniz.

5. Adim: Height kutusuna 350 piksel degerini giriniz.

6. Adim: Pencerenin sag altindaki Create diigmesini tiklayiniz.
7. Adim: Araclar bolimiinden Polygon Tool seginiz.

8. Adim: Calisma alanina tiklayiniz.

9. Adim: Create Polygon penceresinde Width 60, Height 60 ve Number of Sides kutusuna da
8 degerini giriniz. OK diigmesine tiklayiniz.

10. Adim: Dikey ve yatay hizalama seceneklerini kullanarak seklin ekranin ortasina gelmesini
saglayiniz.

11. Adim: Properties panelindeki Transform bolimiinde Set Rotation agisina 45 derece giriniz.
12. Adim: Araglar kismindan Direct Selection Tool seginiz.

13. Adim: Direct Selection Tool ile polygonun sag tarafini ortadan itibaren seginiz.
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14. Adim: Shift tusuyla beraber sag ok tusuna basiniz. Sekil istenen boyuta gelince tuslari
birakiniz.

15. Adim: Pencerenin sag alt tarafindaki Layers béliminden Add a layer sytle simgesini
tiklayiniz. Agilan seceneklerden en (st sirada yer alan Bevel & Emboss seginiz.

16. Adim: Yeni acilan Layer Style penceresinde Bevel & Emboss onay kutusu ile Gradient
Overlay onay kutusunu seginiz.

17. Adim: Layer Style penceresinde bulunan OK diigmesine tiklayiniz.

18. Adim: Araclar béliimiindeki “T” simgesini kullanarak “RESIMLER” ismini digmenin iizerine
yaziniz.

19. Adim: Layers boliminden Background katmanini seginiz. Daha sonra Delete layer
(Katmani sil) simgesini tiklayiniz.

SIRA SiZDE

Web arayiiziinde kullanmak igin “TARIHCE” isminde diigme tasarlayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Create New digmesine tikladi.

2. New Document penceresinde PRESET DETAILS isim kutusuna “Digme”
yazdi.

3. Width kutusuna 500 piksel degerini girdi.

4. Height kutusuna 350 piksel degerini girdi.

5. Create diigmesine tikladi.

6. Araclar bolimiinden Polygon Tool secti.

7. Calisma alanina tikladu.

8. Create Polygon penceresinde Width 60, Height 60 ve Number of Sides
kutusuna 8 degerini girerek OK digmesine tikladi.

9. Dikey ve yatay hizalama secgeneklerini kullanarak seklin ekranin ortasina

gelmesini sagladi.
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DEGERLENDIRME OLGUTLERI EVET HAYIR

10. Properties panelindeki Transform bélimiinde Set Rotation agisina 45
derece girdi.

11. Araglar kismindan Direct Selection Tool se¢ti.

12. Direct Selection Tool araci ile polygonun sag tarafini ortadan itibaren secti.

13. Pencerenin sag alt kismindaki Layers bolimiinden Add a layer sytle simgesi
tiklandiginda acilan seceneklerden en st sirada yer alan Bevel & Emboss secti.

14. Yeni acilan Layer Style penceresinde Bevel & Emboss onay kutusu ile
Gradient Overlay onay kutusunu secti.

15. Layer Style penceresinde bulunan OK diigmesine tikladi.

16. Araglar bélimiindeki “T” simgesini kullanarak “TARIHCE” ismini diigmenin
Uzerine yazdi.

17. Layers bolimiinden Background katmanini secti. Daha sonra Delete layer

simgesini tiklad.

1.9.4. Web Arayiizii Boliimleri

Bir web sayfasi tasarlanirken sayfa cesitli bolimlere ayrilir. Bu bélimler Gorsel 1.124te

verilmistir.

Header (Bashk): Web sayfasinin Ust bolimini ifade eder. Genellikle logo ve web sayfa

baglanti digmeleri bu kisimda bulunur.

Content (igerik): icerikle ilgili bolimleri ifade eder. Genelde sayfanin orta kismindadir.

Footer (Altbilgi): Web sayfasinin alt bolimini ifade eder. Genelde sosyal medya hesaplari,

cesitli baglantilar ve telif ile ilgili bilgiler bulunur.

Bashk
(Header)

igerik
(Content)

Altbilgi
(Footer)

Gorsel 1.124: Temel bir web sayfasinin bélimleri

Gorinti isleme

97



98

1.10. WEB ARAYUZUNE DILIM EKLEMEK

Goruntl isleme yaziliminda tasarlanan resimler, diizenlenen fotograflar ve ¢alisilan sayfalar
internet ortaminda web sayfasi seklinde etkilesimli olarak yayinlanabilir. Dilimleme, web
ortaminda dosyalarin hizli bir sekilde yiiklenmesini saglar ve glincellenmesini kolaylastirir. Dilimler
kullanilarak belirtilen web sayfasina baglanti saglanir. Olusturulan ve kaydedilen digmeler
File>Place Embedded... menileri ile calisma alanina uygun bir sekilde yerlestirilir. Ardindan Slice
Tool secilir (Gorsel 1.125).

Gorsel 1.125: Slice Tool

Slice Tool ile tiklandiginda web sayfalarina yonlendirilecek tim digme, resim ve yazilar
dilimlenir (Gorsel 1.126).

Gorsel 1.126: Dilimlenmis ANA SAYFA diigmesi

Bu islemden sonra her bir digmeye tiklandiginda farkli bir web sayfasina yénlendirme
islemi yapilabilir. ANA SAYFA diigmesine Slice Tool ile gelinip, fare sag tusuna tiklaninca agilan
seceneklerden Edit Slice Options segilir (Gorsel 1.127).

Gorsel 1.127: Edit Slice Options se¢enegi
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Yeni acilan Slice Options penceresinden dilimle ilgili Gorsel 1.128'deki ayarlamalar yapilir.

Gorsel 1.128: Slice Options penceresi

Slice Type (Dilimleme Tipi): No Image, Image veya Table seceneklerinden biri secilir.
Name (isim): Dilime isim verilir.
URL (Web Sayfasi): Dilim tiklandiginda yonlendirilecek sayfanin adresi yazilr.

Target (Hedef): Dilim tiklandiginda web sayfasinin nerde agilacagi belirlenir. _self, _blank, _
parent, top gibi secenekler yazilr.

Message Text (Mesaj Metni): Web sayfasi acildiginda tarayicinin durum c¢ubugunda
gorintilenecek metin yazilir.

Alt Tag (Alternatif Etiket): Ekran okuyucu programlar icin dilimin gorevi belirtilir.

Dimensions (Boyutlar): Dilimin konumu ve boyutlari kutulara yazilarak belirlenir.

Slice Options penceresinde URL kutusuna “index.html” yazilarak, bu dilime tiklandigl zaman
hangi web sayfasina baglanilacagl belirtilir. Calisma, web sayfasi olarak kaydedilip tarayicida
cahstinldiginda ANA SAYFA digmesine tiklanirsa “index.html” sayfasi agilacaktir. Ayni islemler
TARIHCE diigmesi icin de yapilabilir. Slice Options penceresinin URL kutusuna “tarih.html” yazilir.

Gorinti isleme
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Bu sayede islevsel iki tane diigme elde edilir. ANA SAYFA digmesine basilinca “index.htm
sayfasina, TARIHCE diigmesine basilinca “tarih.html” sayfasina gidilir. Bu durumda iki farkh web
sayfasi tasarlanmalidir. Bunun igin araglardan Artboard Tool segilir (Gorsel 1.129).

Gorsel 1.129: Artboard Tool

Daha sonra klavyeden Alt tusu basili tutulurken Artboard 1’in sag tarafindaki + simgesi tiklanir.
Boylelikle ayni sayfadan iki tane olusturulur (Gorsel 1.130).

Gorsel 1.130: Artboard 1 ve Artboard 1 copy

Yeni olusturulan sayfa “tarih.html” web sayfasi olacak sekilde diizenlenir (Gorsel 1.131).

Gorsel 1.131: “tarih.html” sayfasi

1.10.1. Web Sayfasi Olarak Kaydetmek

Olusturulan “index.html” ve “tarih.html” sayfalarini web sayfasi olarak kaydetmek icin
File>Export>Save for Web (legacy) secenegi secilir. Yeni acilan Save for Web penceresinde Gorsel
1.132’deki Save... segenegi segilir.
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Gorsel 1.132: Save se¢enegi

Save secenegi secildikten sonra gelen pencerede Dosya adi kutusuna “index.html” yazilir.
Format kutusundan HTML and Images (Html ve goriintiler) segilir. Settings ve Slices kutularinin
degeri degistiriimez. Kaydet digmesi tiklanir (Gorsel 1.133). Boylelikle web sayfasinin ana sayfasi

olusturulur.

Gorsel 1.133: Save Optimized As penceresi

TARIHCE web sayfasini olusturmak icin Layers panelindeki Artboard 1 copy segilir. Meniiler-
den Edit>Copy secenegi secildikten sonra File>New segenegi tiklanir. Create secenegi ile
Artboard 1 copy boyutlarinda bir belge olusturulur. Daha sonra Edit>Paste secenegi ile bos
belgeye Artboard 1 copy yapistirihr. TARIHCE sayfasinda olmasi gereken icerik yerlestirildikten
sonra sayfada yer alan diigmeler Slice Tool ile dilimlenir ve Edit Slice Options ile diigmelerin hangi
web sayfalarina baglanacagi diizenlenir. Son olarak File>Export>Save for Web secenegi secilir.
Acllan pencereden Save secenegi ile gelen pencerede Dosya adi kutusuna “tarih.html” yazilr.
Format kutusunda HTML and Images seciliyken Kaydet diigmesine tiklanir. Boylelikle iki farkh
web sayfasi olusturulur.
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38. UYGULAMA

islem adimlarina gére “resimler.html” web sayfasini olusturunuz.

1. Adim: Goriunti isleme yazilimini calistiriniz.
2. Adim: Agilan ekranda Create New diigmesine tiklayiniz.

3. Adim: Yeni gelen New Document penceresinde PRESET DETAILS isim kutusuna “resimler”
yaziniz.

4. Adim: Width kutusuna 2390 piksel degerini giriniz.
5. Adim: Height kutusuna 1400 piksel degerini giriniz.
6. Adim: Pencerenin sag altindaki Create diigmesini tiklayiniz.
7. Adim: Araglar bélimiinden Rectangle Tool seginiz.

8. Adim: Calisma alanina tiklayiniz. Gelen pencerede Width kutusuna 2390 ve Height kutusuna
da 1400 degerini giriniz. OK diigmesine tiklayiniz.

9. Adim: Rectangle nesnesini Move Tool kullanarak ekranin tam ortasina yerlestiriniz.
10. Adim: Gradients béliminden Blues segeneklerinden mavi renk gegisi seginiz.

11. Adim: Text Tool kullanarak ekranin sol tst kdsesine 48 punto biyikliGglinde, kirmizi renkte
“RESIMLER” yaziniz.

12. Adim: File>Place Embedded mendsu ile ¢alisma alanina kaydedilen “ANA SAYFA” diigme-
sini yerlestiriniz.
13. Adim: Slice Tool ile digmeye dilim ekleyiniz.

14. Adim: ANA SAYFA digmesine Slice Tool ile gelip, mouse sag tusuna tiklayinca agilan Edit
Slice Options secenegini seciniz.

15. Adim: URL kutusuna “index.html” yaziniz. OK diigmesine tiklayiniz.

16. Adim: File>Export>Save for Web secenegini seciniz. Gelen pencereden Save se¢enegini

seciniz ve agllan pencerede Dosya adi kutusuna “resimler.html” yaziniz. Format kutusunda HTML
and Images segiliyken Kaydet diigmesine tiklayiniz.

SIRA SiZDE

III

“iletisim.html!” isminde web sayfasi tasarlayiniz.
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DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi

yaparken degerlendirme olcutlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Gorintd isleme yazimini galistirdi.

2. Create New diigmesine tiklad1.

3. New Document penceresinde PRESET DETAILS isim kutusuna “iletisim”
yazdi.

4. Width kutusuna 2390 piksel degerini girdi.

5. Height kutusuna 1400 piksel degerini girdi.

6. Create diigmesine tikladi.

7. Aracglar boliminden Rectangel Tool secti.

8. Calisma alanina tikladi.

9. Create Rectangele penceresinde Width 2390, Height kutusuna da 1400
degerini girerek OK digmesine tiklad.

10. Move Tool kullanarak seklin ekranin ortasina gelmesini sagladi.

11. Text Tool kullanarak 48 punto buydkliginde, kirmizi renkte, ekranin sol
ust kosesine “ILETISIM” yazdi.

12. File>Place Embedded mendileri ile ¢alisma alanina ANA SAYFA digmesini
yerlestirdi.

13. Slice Tool ile diigme lizerine dilim ekledi.

14. Slice Tool ile digme lizerine mouse sag tus ile tikladi.

Ill

15. Edit Slice Options segenegini sec¢ip URL kutusuna “index.html” yazdi.

16. File>Export>Save for Web secenegini secti.

17. Save sec¢enegini secti.

18. Acilan pencerede Dosya adi kutusuna “iletisim.html” yazdi.

19. Format kutusunda HTML and Images segiliyken Kaydet diigmesine tikladi.

Gorinti isleme
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OLCME VE DEGERLENDIRME

A) Asagidaki sorular dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Asagidaki dosya uzantilarindan hangisi goriintii dosyasina aittir?

A) .doc B) .pptx C) .psd D) .rar E) .xlIs

2. Secimi tersine gevirmek i¢in asagidakilerden hangisi kullanilir?

A) Ctrl + A

B) Edit>Inverse

C) Shift + Ctrl +1
D) Select>Reselect

E) Select>Deselect

3. Magic Wand aracinin gorevi asagidakilerden hangisidir?
A) Hizli se¢im yapar.
B) Toleransa gore sec¢im yapar.
C) Renge gore sekil gizer.
D) Sekle gore secim yapar.

E) Sihirli segim yapar.

4. Asagidakilerden hangisi kontrast terimini ifade eder?

A) Resimdeki acik renkleri
B) Resimdeki koyu renkleri
C) Resimdeki bulanikhgi

D) Beyaz i1sik oranini

E) Acik ve koyu renk farkini

5. Asagidaki komutlardan hangisi gériintii dosyasinin boyutunu degistirmek igin kullanilir?
A) Edit>Image Size
B) Image>Image Size
C) Image>Canvas Size
D) View>Print Size

E) Window>Options
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6. Katmanlar, Layer panelinde yer alan agagidaki simgelerden hangisinin ilizerine gotiiriile-

rek silinir?

A) E B) ﬂ Q) n D) E)

7. Asagidaki filtrelerden hangisi fotograflarda bulaniklastirma efekti olusturmak igin kulla-

nilir?
A) 3D Filters B) Vanishing Point
C) Adaptive Wide Angle D) Blur

E) Distort

8. Asagidaki se¢eneklerden hangisi Actions panelinde yer almaz?
A) Create new set B) Create new action

C) Create new folder D) Play selection

E) Delete

Goriintii isleme yazilminda gorsele gore asagidakilerden hangisi dogrudur?

A) Cahsilacak belgenin genisligi 768 pikseldir.

B) Calisilacak belgenin ylksekligi 1366 pikseldir.

C) Calisilacak belgenin ismi “Untitled-1" olarak belirlenmistir.
D) Artboards otomatik olarak olusturulmayacaktr.

E) Cozandrluk 768 inch basina piksel olarak belirlenmistir.

10.

Slice Options (Dilimleme segenekleri) penceresinde yer alan gorseldeki URL: kutusuna
asagidaki hangi bilgi girilir?
A) Dilimin ismi
B) Dilime tiklandiginda hangi web sayfasinin agilacagi
C) Dilime tiklandiginda web sayfasinin hangi pencerede acilacagi
D) Web sayfasi agildiginda durum ¢ubugunda gortntiilenecek metin

E) Ekran okuyucu programlar igin dilimin gérevi

Gorinti isleme
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HAZIRLIK CALISMALARI

1. Gorsel efekt yazilimi icin kullanacaginiz programi telif haklarini géz onilinde
bulundurarak nasil temin edebilirsiniz?

2. Gorsel efekt programinin deneme sirimind internetten indirerek nasil
kullanabilirsiniz?

2.1. GORSEL EFEKT PROGRAM KURULUMU

Gorsel efekt programlari; animasyon olusturmak, videolar izerinde gorsel efektler uygulamak,
yazilar Gzerinde farkli efektleri uygulayarak onlari hareketli hale getirmek icin kullanilabilir. Bu
islemler iki veya ¢ boyutlu olarak yapilabilir.

Render, iki boyutlu veya (¢ boyutlu resim, video, animasyon gibi modellemeleri ilgili gorsel
efekt yazilimindan ¢ikt olarak Ureten bir islemdir. Render islemi yapilirken bilgisayarin islemci,
bellek ve ekran karti 6zelliklerinin de yliksek olmasi, yapilacak islemlerin daha hizli gerceklesmesini
saglayacaktr.

Kullanilacak gorsel efekt yazilimi, deneme slirimi veya tam strim olarak tercih edilebilir.
Programi kurabilmek icin ilgili klasérdeki setup dosyasi calistirilir ve yikleme islemi baslatilir.
Yukleme islemi bittiginde artik gorsel efekt programi kullanima hazirdir (Gérsel 2.1).

Gorsel efekt programiyla olusturulan animasyonlari veya videolar, farkli dosya formatlarinda
ve cesitli 6zelliklerde (diisiik boyut, yiksek kalite) render edebilmek icin kullanilan programlar da
mevcuttur. Bu programlar deneme veya tam slirim olarak temin edilip kullanilabilir.

Gorsel 2.1: Programin ilk agilis ekrani

1. UYGULAMA

islem adimlarina gore telif haklarini géz 6niinde bulundurarak temin ettiginiz gorsel
efekt programinin bilgisayara kurulumunu gerceklestiriniz.

1. Adim: Temin ettiginiz program sikistiriimis bir formatta ise kurulum dosyalarini bilgi-
sayarinizin sabit diskinde uygun bir bolime ¢ikariniz.

2. Adim: Kurulum dosyasi icindeki setup dosyasini calistirarak ilgili programi deneme veya
tam strdm olarak kurunuz.

3. Adim: Yikleme islemi bittiginde Baslat menlsiinden veya masaistiinden yiklenen
programi ¢alistiriniz.
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SIRA SiZDE

Telif haklarini géz oniinde bulundurarak temin ettiginiz gorsel efekt programini
bilgisayariniza kurunuz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Gorsel efekt programini sabit diskte uygun bir bolime cikardi.

2. Setup dosyasini ¢calistirarak programin deneme veya tam siriimind kurdu.

3. Baglat menisiinden veya masaustinden programi bularak ¢alistirdi.

2.2. CALISMA SAHNESI AYARLARI

Calisma sahnesinde varsayilan olarak gelen bir dizi panel bulunur. Bu panellerin yerleri
degistirilebilir. Bazi paneller kapatilabilir, kapal olanlar ise daha sonra acilabilir. Kullanicilarin
daha rahat bir diizende calisabilmesi icin calisma alanindaki paneller kisiye gbre ayarlanip
kaydedilebilir.

2.2.1. Gorsel Efekt Programinda Agilis Ayarlari

Gorsel efekt programindaki acilis ayarlari, kullanicinin programi daha hizli ve verimli
kullanmasini saglar.

2.2.2. Calisma Alani

Program ilk agildiginda varsayilan galisma alani ile karsilasilir. Bu ¢alisma alaninda mendiler,
paneller ve araclar yer alir (Gorsel 2.1).

Calisma Sahnesi’nin Gst menl bilesenleri; File (dosya), Edit (dizenleme), Composition
(kompozisyon), Layer (katman), Effect, Animation, View (gériinim), Window, Help olarak siralanir.

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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Varsayilan ¢alisma alaninin (st tarafinda segme, sahneyi ekranda kaydirma, yakinlastirma gibi
cesitli araglarin oldugu Toolbox (ara¢ kutusu) bolimi bulunur. Sol tarafta, projede kullanilacak
resimlerin, videolarin veya farkh tlrde dosyalarin projeye dahil edilebilecegi Project paneli
bulunur (Ctrl+0 ile bu panel gosterilebilir veya gizlenebilir.). Orta bélimde, projede yeni bir
kompozisyon olusturabilmeye imkan veren Composition paneli bulunur. Calisma alaninin sag
tarafinda, ozellikle yazilarda kullanilabilecek farkli animasyon segeneklerinin oldugu Effects &
Presets paneli bulunur. Bir nesneyi, video boyunca hareket eden baska bir nesneye sabitlemeyi
saglayan track motion 6zelligi Tracker panelinde bulunur. Bunlarin disinda farkl islevleri yerine
getirebilecek baska paneller de vardir. Gosterilmek veya gizlenmek istenen paneller Window
mendisiinden yonetilebilir. Calisma alaninin en altinda yer alan panel ise Timeline (zaman
cizelgesi) panelidir.

2.2.3. Paneller

Program acildiginda karsilasilan varsayilan calisma alaninda Project (proje), Composition
(kompozisyon), Timeline (zaman gizelgesi), Info (bilgi), Audio (ses), Preview (6n izleme), Effects
& Presets (efektler ve on ayarlar), Align (hizalama), Libraries (kutliphane), Character (yazi),
Paragraph (paragraf), Tracker (takip) ve Content-Aware (icerik bazli dolgu) panelleri yer alir
(Gorsel 2.2).

N N

N

Gorsel 2.2: Varsayilan ¢alisma alanindaki paneller

Panellerin c¢alisma alanindaki yeri degistirilebilir. Bunun igin panel isimlerinin oldugu
yere imle¢ yaklastirilir ve sirikle birak yontemiyle ilgili panelin ¢alisma alanindaki yeri
degistirilebilir. Calisma alanindaki panelleri tekrar varsayilan hale getirebilmek icin mentden
“Window>Workspace>Default>Reset "Default" to Saved Layout” secenekleri secilebilir. Window
menUsinden hangi panelin acilip kapanacagi ayarlanabilir.
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Project Paneli: Projede kullanilacak materyallerin oldugu boélimdir. Resim, video dosyalari
yaninda photoshop ve illustrator gibi program tirleri de istenirse katmanlariyla birlikte projede
kullanilabilir (Gorsel 2.3).

New Composition...
New Folder

New Adobe Photoshop File...
New MAXON CINEMA 4D File...
Import > File... Ctrl+1
Import Recent Footage > Multiple Files... Ctrl+Alt+1

From Libraries...

Import Adobe Premiere Pro Project...
Pro Import After Effects...

Vanishing Point (vpe)...

Placeholder...

Solid...

Gorsel 2.3: Project paneli

Composition Paneli: Projeye istenilen genislik, ylkseklik, fps (saniyedeki cerceve sayisi) gibi
degerler dogrultusunda yeni kompozisyonlarin eklenebilecegi paneldir. Ayrica var olan bir video
dosyasinin (footage) projeye dahil edilip, ilgili dosyanin genislik, yikseklik veya video uzunlugu
degerleri kullanilarak yeni bir kompozisyonun eklenebilecegi paneldir (Gorsel 2.4).

Gorsel 2.4: Composition paneli

Info Paneli: Kompozisyon lizerinde imlecin bulundugu noktanin x, y koordinatlari ve RGB renk
kodlari hakkinda bilgi verir.

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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Preview Paneli: Hazirlanan kompozisyonun render isleminden dnce 6n izlemesinin yapilabil-
digi bolimdir. Klavyeden space (bosluk) tusu kullanilarak ilgili kompozisyonun 6n izlemesi
yapilabilir. Projenin hizli bir sekilde 6n izlemesi yapilmak istenirse Resolution (CozUnirllk)
seceneklerinden Half, Third veya Quarter gibi disiik ¢cozinurlik secilebilir. Full Screen secenegi
isaretlenip, 6n izleme seceneklerinden Play simgesine tiklanarak tam ekran olacak sekilde 6n
izleme yapilabilir (Gorsel 2.5).

Gorsel 2.5: Preview paneli

Effects & Presets: Resim, video veya yazilara siriikle birak yontemiyle cesitli efektlerin
kolayhkla uygulanabildigi paneldir. Uygulanan efektler daha sonra Effect Control panelinden
ayarlanabilir (Gorsel 2.6).

Gorsel 2.6: Effect & Presets paneli

Align Paneli: Calismada kullanilan elemanlarin kompozisyonda hizalanmasi ile ilgili islemlerin
yapildig1 paneldir.
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Character Paneli: Yazi blyklGgu, fontu, rengi vb. yazi ile ilgili ayarlamalarin yapildigi paneldir
(Gorsel 2.7).

Gorsel 2.7: Character paneli

Tracker Paneli: Bir nesneyi, video boyunca hareket eden baska bir nesneye sabitlemeyisaglayan
Track Motion komutu bu panelde bulunur. Calismanin li¢ boyutlu yapisini ¢ikarip videodaki bir
noktaya herhangi bir yaziyi sabitlemeyi saglayan Track Camera komutu da bu paneldedir.

2.2.4. Calisma Alanini Kisisellestirmek

Projede calisilirken ihtiyaca gore farkh paneller agilmis veya panellerin yerleri degistirilmis
olabilir. Calisma alaninin kisiye 6zgi ayarlanmis hali kaydedilip, daha sonra istege bagli olarak geri
yliklenebilir (Gorsel 2.8).

IWindDwI Help
|Workspace > | All Panels
Assign Shortcut to “Default” Workspace > Animation
Erigisens > ayhan deneme
. Color
| IR | Default Shift+F10
~  Audio Ctrl+4 Effects
RS ik Essential Graphics
~  Character Ctrl+6 Learn Shift<F11
~ Content-Aware Fill (eeries
Effects & Presets Ctrl+5 .
B ) Minimal
Essential Graphics Motion Tracking
+ Info Ctrl+2 Paint
L-earn- Small Screen
Libraries Standard Shift+F12
Lumetri Scopes Text
Mask Interpolation Undocked Panels
Media Browser
Metadata Reset “Default” to Saved Layout
Motion Sketch Save Changes to this Workspace
Paint Ctrl+8 | Save as New Workspace...
~  Paragraph Ctrl+7 Edit Workspaces...

Gorsel 2.8: Yeni Calisma Alani olarak kaydetme
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2.2.5. Klavye Kisayollari

Bir proje Uzerinde calisilirken yapilacak islemler arag kutusu, panel veya meniiler Gzerinden
gerceklestirilebilir. Ornegin kompozisyon (zerinde bir nesneyi secebilmek icin ara¢ kutusu
Uzerindeki Selection Tool (Segim araci) kullanilabilir. Bu aracin kisayol tusu, V harfidir. Bunun
gibi farkh islemlerin daha hizli yapilabilmesi icin klavyede tanimlanan kisayol karsiliklari vardir.
Bu kisayol tuslarinin diizenlenmesi veya goriintilenmesi istenirse Edit menUlisiinden Keyboard
Shortcuts secenegi kullanilabilir (Gorsel 2.9).

Gorsel 2.9: Klavye kisayollarini ayarlama

2. UYGULAMA

islem adimlarina goére gorsel efekt programi arayiiziindeki panellerin yerini
degistirme ve varsayilan hale geri getirme uygulamasini gerceklestiriniz.

1. Adim: Program araylziindeki panellerin tizerine tiklayarak secilmesini saglayiniz.

2. Adim: Secili panelin yerini, secili panelin Ust taraftaki isminin yanindaki bos alana imleci
gotirip, surikle birak yontemiyle hareket ettirerek degistiriniz.

3. Adim: GCalisma alaninda gériinmeyen bir panel varsa ilgili paneli Window menisiinden
secerek gorindr hale getiriniz.

4. Adim: Window>Workspace>eset “Default” to Saved Layout secenekleriyle birlikte ¢calisma
alanini varsayilan haline geri getiriniz.
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SIRA SiZDE

Calisma alanindaki panellerin yerini degistirip, bazilarini gizleyerek daha sonra
varsayilan hale geri getirilmesini saglayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olgttlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Program araylizindeki herhangi bir panelin lizerine tiklayarak paneli secti.

2. Segcili panelin yerini siiriikle birak yontemiyle hareket ettirerek degistirdi.

3. Essential Graphics adli paneli Window menisiinden acti.

4. Calisma alanini varsayilan hale geri getirdi.

3. UYGULAMA

islem adimlarina gére arag gubugu tizerindeki hand (el) komutunun kisayol tusunun
degistirilmesi uygulamasini gergeklestiriniz.

1. Adim: Hand Tool aracinin kisayol tusunu 6grenerek bu kisayol tusuyla birlikte ¢alisma
sahnesinde actiginiz birkompozisyon lizerinde komutu deneyiniz (El araci, kompozisyon Gizerindeki
projeyi calisma sahnesinde farkli yonlere kaydirmak veya hareket ettirmek icin kullanihr.).

2. Adim: Edit>Keyboard Shortcuts secenegiyle kisayollarin gortintiilendigi klavyeye ulasiniz.

3. Adim: Klavyenin altindaki sol kisimda yer alan komutlar bélimiinden hand kelimesini aratip
ilgili komutun kisayol karsiligina fare ile tiklayiniz.

4. Adim: Hand Tool aracinda atamak istediginiz yeni kisayol tusuna klavyeden basip OK ile
klavye kisayollari penceresini kapatiniz.

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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SIRA SiZDE

Programin klavyesi Uzerinde istediginiz bir kisayolu lglinci uygulamaya benzer
sekilde degistiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LIiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Hand Tool kisayol tusunu kullanarak bu araci ¢alisma sahnesinde agilan bir
kompozisyon Uzerinde denedi.

2. Edit>Keyboard Shortcuts secenegiyle kisayollari goruntiledi.

3. Klavyenin altindaki sol kisimda yer alan komutlar boliminden hand
kelimesini arayarak ilgili komutun kisayol karsiligina fare ile tiklad!.

4. Hand Tool aracina atamak istedigi yeni kisayol tusuna klavyeden basip Ok ile
klavye kisayollari penceresini kapatt.

2.3. MATERYAL EKLEMEK

Gorsel efekt programinda ihtiyaca bagli olarak resim veya video gibi materyaller kullanilabilir.
Photoshop ve lllustrator gibi programlarda olusturulan dosyalar, istenirse katmanlariyla birlikte
kullanilan programa aktarilabilir.

2.3.1. Dosya Aktarmak (Import)

Gorsel efekt programinda kullanilmak istenen resim veya videolarin dncelikle Project paneline
aktarilmasi gerekir. Bunun igin Project panelinin altindaki bosluk Gzerindeyken sag tus yapilip
import>file secenegiyle beraber proje alanina resim veya video dosyasi eklenebilir (Gorsel 2.10).
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Gorsel 2.10: Project paneline dosya ekleme

Proje alaninda aktarilmak istenen bir photoshop dosyasiysa Import>file menisiinden sonra
ilgili dosya secileceginde Import As acilir listesinden Composition secilir (Gorsel 2.11).

Import As:
| rt Options:
Footage w mpco pCIDns
reate Composition
Footage | p
Composition - Retain Layer Sizes
Dosya ad (T N | A AccepableFies :

Import Folder Iptal

Gorsel 2.11: Photoshop dosyasi ekleme

Dosya import edilirken Footage secenegi secilirse, alinmak istenen dosya photoshop ve
illustrator gibi katmanli dosyalar bile olsa sadece bir katmandaki icerik programa aktarilabilir.

Resim veya videolar Project paneline aktarildiginda ilgili dosyanin adi (Name), tipi (Type),
dosya buyuklGgl (Size), cerceve orani (Frame Rate), baslangi¢c noktasi (In Point), bitis noktasi
(Out Point) ve dosya konumu (File Path) gibi bir dizi 6zellik bulunur (Gorsel 2.12).

Gorsel 2.12: Project panelindeki dosyanin 6zellikleri

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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2.3.2. Paneldeki Dosyalari Diizenlemek

Project paneline aktarilan dosyalarin diizenli olmasini saglamak igin ilgili resim veya videolar,
olusturulacak farkli klasorlerin icine alinabilir.

Panel lizerinde yeni bir klasor olusturmak icin File mentsiinden New>New Folder secenekleri
secilebilir. Project paneli Gzerindeyken farenin sag tusuna basilip agilan segenekler icinden New
Folder secenegiyle de yeni klasér olusturulabilir (Gorsel 2.13).

Gorsel 2.13: Yeni klasor olusturma

4. UYGULAMA

islem adimlarina gére biri photoshop, digeri video dosyasi olmak Uzere iki farkli
dosyanin gorsel efekt programina aktarilmasi ve 6n izlemesinin yapilmasina dair 6rnek
uygulamayi gerceklestiriniz.

1. Adim: Import>Multiple Files secenekleriyle birlikte photoshop ile hazirlanmis bir dosyayi
seginiz.

2. Adim: Import As acllir listesinden Composition segenegini seginiz.

3. Adim: ikinci acilan diyalog penceresiyle bilgisayarinizdaki bir video dosyasini seginiz.

4. Adim: Project paneline eklediginiz dosyalardan photoshop olan dosyaya cift tiklayarak
Footage panelinde dosyanin agilmasini saglayiniz.

5. Adim: Video dosyasina cift tiklayip Footage panelinde videonun agilmasini saglayiniz.

6. Adim: Klavyeden bosluk tusuna basarak veya Preview panelinden Play simgesine tiklayarak
videonun 6n izlemesini yapiniz.
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SIRA SiZDE

Cahisma alaninda biri photoshop, digeri video dosyasi olmak Uzere iki farkli dosyayi
Import>Multiple Files segcenekleriyle birlikte Project paneline aktariniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESi

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. Import>Multiple Files secenekleriyle birlikte photoshop ile hazirlanmis bir
dosyayi secti.

2. Import As acllir listesinden Composition secenegini secti.

3. ikinci acilan diyalog penceresiyle bilgisayardaki bir video dosyasini secti.

4. Project paneline eklenen dosyalardan photoshop tiriinde olanina cift tikla-
yarak Footage panelinde dosyanin agilmasini sagladi.

5. Video dosyasina cift tiklayarak Footage panelinde videonun agilmasini
sagladi.

6. Klavyeden bosluk tusuna basarak veya Preview panelinden Play simgesine
tiklayarak videonun 6n izlemesini yapti.

2.3.3. Kompozisyon Olusturmak

Gorsel efekt programinda bir proje Uzerinde calismaya baslayabilmek icin 6ncelikle yeni
bir kompozisyon olusturulmali veya mevcut bir video kullanilarak o videonun ozelliklerinde
(videonun c¢ozlnurlik, fps gibi degerleriyle ayni 6zelliklerde) bir kompozisyon olusturulmalidir
(Gorsel 2.14).

Gorsel 2.14: Kompozisyon olusturma
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Composition mentsinden New Composition secenegiyle (kisayol karsiligi Ctrl+N), belirli
ozelliklere sahip (fps, genislik-yikseklik vb.) yeni bir kompozisyon olusturulabilir (Gorsel 2.15).

Gorsel 2.15: Kompozisyon ozellikleri

Yeni bir kompozisyon segenegi secildiginde acilan pencerede birtakim 6zelliklerin girilmesi
gerekir. Composition Name kismindan kompozisyona bir isim verilir. Preset kismindan
kompozisyon icin hazir ayarlardan biri secilip kullanilabilir. HDTV (High Definition TV) 1080 29.97
secenegi secildiginde kompozisyonun Width degeri 1920 px, Height degeri 1080 px, Frame
Rate degeri 29.97 otomatik olarak gelir. Preset kismindan farkh ¢ézlintrlik ve fps degerlerinde
kompozisyonlar olusturulabilir. Lock Aspect Ratio o6zelligi seciliyse genislik veya yikseklik
degerlerinden birine bir deger girildiginde digeri de program tarafindan otomatik olarak belirlenir.

Frame Rate secenegi, animasyon veya videolarda saniyede gosterilecek kare sayisini belirler
(fps-frame per second). Fps orani 24’tin altinda olan videolar izlenirken goriintide takilmalar
veya donmalar olacaktir. Bu sebeple kompozisyonla calisirken fps orani en az 24 ve lzerinde
secilmelidir.

Resolution kismi, olusturulacak kompozisyonun ¢6zinGrlGglnin ayarlandigr bolimdur.
Full, Half, Third ve Quarter olmak (zere farkh segenekler bulunur. Kompozisyon igin
1920x1024 olarak belirlenen genislik ve yukseklik degeri icin ¢ozindrlik kismi Half secilirse
calismanin 6n izlemesi yapilirken 990x512 olcllerinde goriintilenerek daha hizli sonug alinir.
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Kullanilan bilgisayarin sistem 0Ozelliklerine bagh olarak ¢ézindrluk; 1:1, 1:2, 1:3, 1:4 veya Ozel
olarak ayarlanabilir. Background Color kismindan kompozisyon igin istenilen bir arka plan rengi
ayarlanabilir. Composition>Composition Settings secenekleriyle daha sonradan da kompozisyon
ayarlari yapilabilir.

Resim, video veya baska bir materyalin eklenebilmesi icin Project panelindeki ilgili dosya tiiri
surikle birak yontemiyle kompozisyon Gzerine tasinir.

5. UYGULAMA

islem adimlarina goére belirli &zelliklere sahip bir kompozisyonu olusturma
uygulamasini gergeklestiriniz.

1. Adim: Project panelindeyken sag tus yaparak New Composition secenegini seciniz.

2. Adim: Preset kismindan Custom secenegini secerek Width degerini 1980, Height degerini
1024 olarak ayarlayiniz.

3. Adim: Frame Rate degerini 25 olarak giriniz.

4. Adim: Calismanizin sdresini 10 saniye olarak belirleyiniz.

5. Adim: Arka plan rengi olarak maviyi seciniz.

SIRA SiZDE

Farkli ¢cozlintrlik, cerceve orani ve arka plan degerlerine sahip bir kompozisyon
olusturunuz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme ol¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Project panelindeyken sag tus yaparak New Composition secenegini secti.

2. Preset kismindan Custom secenegini secerek Width degerini 1980, Height
degerini 1024 olacak sekilde ayarladi.

3. Frame Rate degerini 25 olarak girdi.

4. Calisma sliresini 10 saniye olarak belirledi.

5. Arka plan rengi olarak maviyi secti.

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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2.3.4. Ara¢ Cubugu (Toolbar)

Ust meniniin altinda yer alan ara¢ kutusu izerinde farkh goérevlere sahip komutlar
bulunur (Gorsel 2.16). Arag¢ kutusu secenekleri, kompozisyon Uzerine aktarilan materyallerin
yonetilmesinde kullaniciya biyuk kolaylk saglar.

Gorsel 2.16: Arag kutusu

Home: Gorsel efekt programinin ana ekranina dénilmesini saglar. Bu ana ekran lizerinde yeni
bir proje olusturulabilecegi gibi Create New secenekleri ile birlikte segilecek bir resim veya video
dosyasinin genislik, yikseklik ve fps degerlerinde yeni bir kompozisyon da olusturulabilir.

Selection Tool (V): Kompozisyon lizerindeki istenilen materyali (resim, video, yazi vb.) segmeyi
saglar. Klavyedeki kisayolu V harfidir. Kompozisyon lzerindeki materyallerden bazilari secilmek
istenirse Shift tusuna basilarak ilgili resme veya yaziya tiklanabilir.

Hand Tool (H): Kompozisyonda yer alan ¢alismayi ilgili panelde farkh yonlere kaydirabilmek
amaciyla kullanilir. Klavyedeki kisayolu H harfidir. Calisilan kompozisyona %100’Gn Uzerinde
yakinlastirma yapildiginda galisma, gorilebilen ekranin disina tasacagiicin hand araci kullanilarak
ekranda kaydirilabilir ve gorlinmeyen kisimlarin ekranda gériinmesi saglanabilir.

Zoom Tool (Z): Kompozisyonu ekranda yakinlastirmaya veya uzaklastirmaya yarar. Klavyedeki
kisayolu Z harfidir. Zoom araci segildiginde biyiteg lizerinde + isareti goziikiiyorsa bu arag,
¢alismayi yakinlastirir. Blyliteg Uzerinde - isareti gozikiyorsa zoom araci ¢alismayi uzaklastirir.

Rotation Araci (W): Ekranda yer alan bir resmi, videoyu veya yaziyi istenen yone déndirmeyi
saglar. Klavyedeki kisayolu W harfidir. Shift tusu ile beraber secilen icerigi farenin sol tusuna
basarak saat yoninde veya saat yoniine zit olacak sekilde 45 derecelik agilarla déndirmek
mimkindur. Alt tusu ile birlikte farenin sol tusuna basili tutularak ilgili resmin kendisi ekranda
sabit olacak sekilde sadece donlisim noktalari istenen aglya gore donduriliir ve dondiirme
acisina karar verildiginde farenin sol tusu birakilir. Béylece dondiirme islemi gerceklesir.
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Pan Behind (Anchor Point) Araci: Kompozisyon Uzerindeki herhangi bir seklin, resmin,
videonun veya yazinin merkez noktasini gérmek icin kullanilir. ilgili materyal déndiiriiimek
istendiginde Pan Behind araciyla gorinir hale getirilen bu nokta, istenen yere kaydirilip, donme

hareketi bu nokta esas alinarak gerceklestirilir (Gorsel 2.17).

N
a0
N

v
v

Gorsel 2.17: Pan Behind araci

Rectangle Araci (Q): Kompozisyon lizerine dikdortgen, koseleri yuvarlatilmis dikdortgen,
elips, poligon ve yildiz araclarinin eklenebilecegi komuttur (Gorsel 2.18). Her bir secenekte dolgu
rengi, kontur ve kontur kalinligi gibi ilave secenekler bulunur.

Gorsel 2.18: Sekil araglari

Katmanlar panelinde resim veya videonun oldugu bir katman seciliyken sekil araglarindan
herhangi biri segilir ve kompozisyon Uzerine ¢izilmeye galisilirsa o an segili olan resim veya video
maskelenir (Gorsel 2.19). Sekil araclariyla ¢izim yapilacaksa katmanlar bolimiinden sag tus
ile New>Shape Layer secilerek sekil katmani olusturulduktan sonra sekil ¢cizmek daha yerinde
olacaktir.

Gorsel 2.19: Sekil araglariyla maskeleme

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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6. UYGULAMA

islem adimlarina gére sekil araglarini kullanarak kompozisyon (zerine belirli bir
konturu ve dolgu rengi olan bir sekli cizme uygulamasini gerceklestiriniz.

1. Adim: Menu Gzerindeki yildiz sekil aracini (Star Tool) seginiz.
2. Adim: Dolgu (Fill) 6zelliginin yanindaki renk simgesine tiklayarak kirmizi rengi seginiz.

3. Adim: Kontur (Stroke) 6zelliginin yanindaki kenarlik simgesine tiklayarak mavi rengi seginiz
ve kontur blyuklGgina 5 piksel olarak ayarlayiniz.

4. Adim: Kompozisyona sigacak bir yildiz sekli ¢iziniz.

SIRA SiZDE

Farkl dolgu ve kenarlik renkleri icin olusturacaginiz kompozisyona farkh biyuklik-
lerde sekiller giziniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme o6l¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Meni Gzerindeki yildiz sekil aracini (Star Tool) secti.

2. Dolgu (Fill) 6zelliginin yanindaki renk simgesine tiklayarak kirmizi rengi secti.

3. Kontur (Stroke) ozelliginin yanindaki kenarlik simgesine tiklayarak mavi
rengi secti.

4. Kontur blykliguni 5 piksel olarak ayarladi.

5. Kompozisyona sigacak bir yildiz sekli gizdi.

Pen Araci (G): Secilen dolgu, kontur rengi ve bluyuklugi
dogrultusunda herhangi bir sekil olusturmaya yarar (Gorsel
2.20). Klavyedeki kisayolu G harfidir. Bu arag, herhangi bir
resmin veya videonun oldugu katman segciliyken kullanilirsa
maskeleme yapilir.

Gorsel 2.20: Pen Tool secenekleri

Gorsel Efekt Yaziliminda Temel Dizenlemeler



Pen Tool aracinin alt se¢ceneklerinden Add Vertex araci, gizilen seklin herhangi bir kenari
Gzerine donisiim noktasi (vertex) ekler. Bu sayede daha hassas gizimler yapilabilir. Delete Vertex
araciysa sekil Uzerinde gereksiz oldugu distnilen dénlisim noktalarini silmeyi saglar. Sekil
Gzerindeki donlisim noktalari segilip, ilgili noktacigin iki yaninda beliren tutamacglara farenin sol
tusuyla basili tutularak tutamaclar saga sola veya yukari asagl yonde hareket ettirilir ve sekil
Uzerinde daha hassas ayarlamalar yapilir.

Mask Feather araciysa herhangi bir sekil Gzerinde maskeleme yapilacagi zaman ilgili noktaya,
bir donlsiim noktasindan disariya dogru bir yumusatma efekti vermek icin kullanilir (Gorsel
2.21).

Gorsel 2.21: Mask Feather araciyla maskeleme

Type Araci ( Ctrl+T): Kompozisyon alanina yatayda veya dikeyde yazi eklemek icin kullanilan
bir aractir (Gorsel 2.22). Klavyedeki kisayolu Ctrl+T tuslaridir.

Gorsel 2.22: Type araglari

Brush Araci (Ctrl+B): Resim veya videonun herhangi bir karesine firca ile boyama islemi
yapilmasini saglar.

Clone Stamp Araci (Ctrl+B): Resim veya videonun herhangi bir yerindeki bolgenin
kopyalanarak baska bir bolgeye aktarilmasini saglar. Bu islem igin klavyeden Alt tusuna
basili tutularak farenin sol tusuyla beraber kopyalanacak bélge hafizaya alinir.

Gorsel Efekt Yaziliminda Temel Dizenlemeler
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Daha sonra resim veya videonun baska bir bélimine, hafizaya alinan bolge farenin sol tusuna
basilarak boyama yontemiyle aktarilir (Gorsel 2.23).

Gorsel 2.23: Clone Stamp araci

Eraser Tool (Ctrl+B): Kompozisyon lizerindeki herhangi bolim silmeyi saglar. Silinen kisimlar,
kompozisyon icin belirlenen arka plan rengiyle gérindr.

Roto Brush Tool (Alt+W): Roto Brush araci, resim veya video Uzerindeki herhangi bir nesneyi
maskeleyerek ilgili katmanin altindan bir yazi veya arka plan gorseli gostermek icin kullanilir
(Gorsel 2.24). Klavyedeki kisayolu, Alt ile beraber W tusudur. Refine Edge araciysa sag, tly gibi
secgilmesi zor olan bolgelerin daha hassas ayarlamalar yapilarak segilebilmesine olanak veren
komuttur.

Gorsel 2.24: Roto Brush araglar

7. UYGULAMA

islem adimlarina gére Roto Brush araciyla bir videodaki belli bir alanin secilerek
videonun diger kisimlarinin nasil maskelenecegi ve secili kisimlarin arka planina nasil
yazi eklenecegi uygulamasini gercgeklestiriniz.

1. Adim: Gorsel 2.23'te gorildigu gibi 6rnek bir video dosyasini internetten temin ediniz
(Videoda segcilebilecek bir nesnenin olmasina dikkat ediniz.).

2. Adim: indirdiginiz video dosyasini proje dosyalarina import ederek bu videodan bir katman
olusturunuz (Project panelindeki video dosyasini strikle birak yontemiyle katmanlar bélimiine
taslyiniz.).
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3. Adim: Video dosyasini Ctrl+D tuslariyla cogaltiniz.

4. Adim: Katmanlar panelinde sag tus yaparak New>Text secenekleriyle yeni bir yazi katmani
ekleyiniz. Okulunuzun ismini yazi katmanina yazdiktan sonra yazi katmanini iki video katmaninin
ortasina gelecek sekilde yerlestiriniz (Gorsel 2.25).

Gorsel 2.25: Katmanlar paneli

5. Adim: En ustteki video katmanini secip, kompozisyon Uzerine cift tiklayarak ilgili
kompozisyonu Layer (katman) olarak aginiz.

6. Adim: Roto Brush aracini secerek video Gzerindeki aile Gyelerini fircayla boyayiniz. Firga ile
boyanan alanin ¢izim islemi sonunda etrafi mor olacak sekilde segili goriinmesi gerekir (Goérsel
2.26). istenmeyen béliimler secilmisse Alt tusuna basarak Roto Brush araciyla bu kismi secimden

cikarabilirsiniz.

Gorsel 2.26. Roto Brush ile secim yapilmasi

7. Adim: Videoda goriinmesi istenen bolimleri Roto Brush araciyla sectikten sonra orta
bolimde yer alan Composition panelini tiklayarak seciniz. Ardindan Preview panelinden
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Resolution o6zelligini Half segip, Full Screen ozelligini isaretleyerek projenin tam ekran olacak
sekilde 6n izlemesini yapiniz (Gorsel 2.27.).

Gorsel 2.27: Roto Brush ile 6n izleme

SIRA SizDE

Roto Brush aracini deneyebileceginiz secim yapilabilecek nesnelere sahip bir video
temin ediniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme o6l¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Temin ettigi video dosyasini proje dosyalarina import edip, bu videoyu
suriikle birak yontemiyle katman paneline tasiyarak yeni bir katman olusmasini
sagladi.

2. Video dosyasini Ctrl+D tuslariyla cogaltt.

3. Katmanlar panelinde sag tus yaparak New>Text secenekleriyle yeni bir yazi
katmani ekledi.

4. Okul ismini yazi katmanina yazdiktan sonra yazi katmanini iki video
katmaninin ortasina gelecek sekilde yerlestirdi.

5. En Ustteki video katmanini secip, kompozisyon lzerine cift tiklayarak Layer
panelini acti.

6. Roto Brush aracini secerek video Uizerindeki aile tyelerini fircayla boyadi ve
diger kisimlarin maskelenmesini sagladi.

7. Videoda goriinmesi istedigi bolimleri Roto Brush araciyla sectikten sonra
orta bolimde yer alan Composition paneline tiklayarak secti. Ardindan Preview
panelinden Resolution 6zelligini Half secip, Full Screen 6zelligini isaretleyerek
projenin tam ekran olacak sekilde 6n izlemesini yapt.
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Puppet Position Pin Tool: Kompozisyona eklenen herhangi bir nesneyi hareketlendirmek icin
kullanilabilen gesitli kukla araglarindan olusur. Puppet Position Tool araci hareketin baslanmasi
istenen noktayi isaretlemek icin kullanilir. ilgili nokta isaretlendikten sonra resim veya videodaki
hareket ettiriimesi istenen nesnenin ag yapisi ¢cikarilir. Bunun icin Puppet araci secildikten sonra
st menideki Mesh 6zelligi Show olacak sekilde secilir (Gorsel 2.28).

Gorsel 2.28. Ag yapisi goriiniimii

Position araciyla hareketin baslayacagi pin belirlendikten sonra Puppet Starch Pin araciyla
bir veya birden fazla pin daha eklenir. Starch Pin araciyla eklenen pinler, birden fazla eklem yeri
eklenerek hareketin daha gercek¢i olmasini saglar. Puppet Advanced Pin Tool araci, Starch Pin
araciyla eklenen pinlerin arasina gelismis bir pin ekler. Gelismis Pin araciyla birlikte ilgili bolgede
yer alan kisim; konum (Position), 6lgek (Scale), donme (Rotation) 6zellikleri kullanilip, farkli
degerler girilerek hareket ettirilebilir. Puppet Bend Pin Tool araciyla birlikte boyun, kuyruk gibi
kisimlara bikme veya egme hareketi verilebilir. Bend aracinda 6lcek ve donme 6zelliklerine gore
hareket verilir (Gorsel 2.29).

Gorsel 2.29. Puppet Tool (Kukla araglari)

8. UYGULAMA

islem adimlarina gére Puppet Tool kullanarak resim veya videodaki bir nesneyi
hareket ettirme uygulamasini gergeklestiriniz.

1. Adim: Proje alanina hareket ettiriimesi planlanan bir gorsel ekleyiniz (Bu uygulamada
zlrafa kullanilacaktr.).

2. Adim: 1980x1024 olgllerinde, 29 fps degerine sahip ve 10 saniyelik bir kompozisyon
olusturunuz. Bu gorseli kompozisyon alanina tasiyarak hareket ettirilecek nesneden bir katman
olusturunuz.
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3. Adim: Puppet Position Pin Tool aracini secerek zlrafanin ayaklarinin basladigi doért
farklh noktaya pin ekleyiniz (Gorsel 2.30). Pin eklerken zaman ¢izelgesindeki zaman isaretgisini 0.
saniyeye tasimayi unutmayiniz (Gorsel 2.31).

Gorsel 2.30: Puppet Position Pin Tool eklenmesi

Gorsel 2.31: Zaman isaretgisi

4. Adim: Puppet Starch Pin Tool kullanarak her bir bacak lzerine ikiser tane pin ekleyiniz
(Gorsel 2.32).

Gorsel 2.32: Puppet Position Pin Tool eklenmesi
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5. Adim: Puppet Advanced Pin Tool aracini kullanarak gorseldeki yesil ile gbsterilen bolgelere
pin ekleyiniz (Gorsel 2.33).

Gorsel 2.33: Puppet Advanced Pin Tool eklenmesi

6. Adim: Zaman ¢izelgesindeki zaman isaretgcisini 3. saniyeye tasiyiniz. Se¢im araciyla birlikte
zurafanin bacaklarinin orta kismindaki gelismis pin simgesini kullanarak zirafanin bacaklarini
Gorsel 2.34’teki 2. konuma getiriniz.

Gorsel 2.34: Birinci konum hareketi
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Bacak pozisyonlari degistiginde Position ve Rotation 6zelliklerinin karsisinda, ilgili
zaman isaretcisi altinda keyframeler olusur.

Gorsel 2.35: ikinci konum hareketi

7. Adim: Zaman cizelgesindeki zaman isaretgcisini 6. saniyeye tasiyiniz. Se¢im araciyla birlikte
zdrafanin bacaklarinin orta kismindaki gelismis pin simgesini kullanarak zlrafanin bacaklarini
Gorsel 2.36’daki 3. konuma getiriniz.

Gorsel 2.36: Ugiincii konum hareketi
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8. Adim: Zaman isaretgisini 0. saniyeye tasiyiniz. Farenin sol tusuna basarak, ilgili karedeki
tiim keyframeleri segerek kopyalayiniz (Gorsel 2.37).

Gorsel 2.37: Kopyalanacak keyframeler

9. Adim: Zaman isaretgisini 9. saniyeye taslyip kopyalanmis keyframeleri Ctrl+V tuslariyla
yapistiriniz (Goérsel 2.38).

Gorsel 2.38: Keyframelerin yapistiriimasi

10. Adim: Klavyeden space tusuna basarak veya Preview panelinden Play simgesine tiklayarak
calismanizi 6n izleme yapiniz.

2.4. DONUSTURME (TRANSFORM) iSLEMLERI

Kompozisyon Uzerinde yer alan resim veya video dosyalarinin boyutlarinin ve ekranda
bulundugu acginin degistirebilecegi bélimdir. Bu meniden seffaflik seviyesi, ilgili icerigin ¢alisilan
sahnedeki ekranda hangi yone bagli olarak sigdirilacagi da belirlenebilir.
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Project paneline eklenen bir igerik, stirtiikle birak ydontemiyle sahneye tasindiginda resmin veya
videonun biyiikliigiine bagli olarak ekranda kendi élgiisiinde goriintiilenir. icerik, kenarlarindaki
donlstirme noktalarindan farenin sol tusuyla birlikte daha biyik veya daha kiiglik hale
getirilebilir.

Composition paneli lzerinde sag tus yapilarak Transform (DoOnlstirme) segenekleri
altindaki komutlarla birlikte ilgili icerigin boyutlari, agisi veya seffaflik degerleri degistirilebilir.
icerigi kompozisyona sigdirmak icin Fit to Comp, Fit to Comp Width veya Fit to Comp Height
seceneklerinden yararlanilabilir (Gorsel 2.39).

Gorsel 2.39: Transform segenekleri

Fit to Comp: Gorselin boyutlarinin kompozisyon boyutlarina gore ayarlanmasini saglar.
Fit to Comp Height: Gorselin ylksekligini kompozisyonun yiksekligine sigdirir.

Fit to Comp Width: Gorselin genisligini kompozisyon genisligine gore ayarlar.

Flip Horizontal: Secili gorselin saga veya sola donme islemini gerceklestirir.

Flip Vertical: Gorselin ters donmesini saglar.

Center Anchor Point In Layer Content: Cipa noktasinin merkeze alinmasini saglar.
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Anchor Point: Acilan pencerede girilen x ve y degerlerine bagl olarak gorselin hareket mer-
kezi degistirilir (Gorsel 2.40). Ozellikle ddnme hareketlerinde resim veya video déndiiriilecegi
zaman Anchor Point esas alinarak dondiirme islemi yapilir.

Gorsel 2.40: Anchor Point

Rotation: Belirlenen merkez noktasina gore gorselin dondirtlmesi isleminin gerceklestiril-
mesini saglar (Gorsel 2.41).

Gorsel 2.41: Rotation islemi
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Scale: Materyalin boyutunun olgekli bir sekilde buydtulip kiclltilmesi islemlerinin
gerceklesmesini saglar (Gorsel 2.42).

Gorsel 2.42: Scale (Olgekli biiyiitme ve kiigiiltme)

Reset: Kompozisyon Uzerindeki gorselleri baslangicta sahne Uzerine aktarildiklari sekle
dondstardr.

Position: Gorsellerin sahne lzerindeki konumunun belirlenmesini saglar.

Opacity: Gorsellerin seffafligini degistirmeyi saglar.

2.5. CIKTI (RENDER)

Gorsel efekt programinda calisilan proje, File>Save (Dosya>Kaydet) secenekleriyle birlikte
aep uzantil olarak kaydedilebilir. Proje daha sonra diizenlenmek istenirse aep uzantili olarak
kaydedilmelidir.

2.5.1. Gorsel Efekt Programiyla Render islemi

Calisilan projeyi avi uzantii kaydetmek, herhangi bir programa ihtiya¢c duymadan projenin
baska bilgisayarlarda da oynatilabilmesine olanak verir. Bunun igin File>Export>Add to Render
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Queue secenekleriyle ilgili panel agilir (Gorsel 2.43).

Gorsel 2.43: Render kuyruguna ekleme ve render paneli

Render Settings>Custom: Best Settings 6zelligi secildiginde acilan pencereden render almak
icin gerekli olan asagidaki bazi ayarlara ulasilir.

e Quality: Gorintl kalitesini ayarlama secenegidir. Best, Draft ve Wireframe secenekleri
vardir. Best segenegi tercih edilmelidir.

e Resolution: Cozunurltgln ayarlandigl kisimdir. Goriinti kalitesi yiksek tutulmak istendigin-
de Full secilir. Calisma sirasinda islemleri hizlandirmak icin daha disilik ¢ozinurlikler tercih
edilebilir fakat ¢ikti alinmadan 6nce Full segenegi tercih edilmelidir.

e Frame Rate: Animasyon ve videolarda saniye basina diisen kare sayisi bilgisini girmeye
yarayan secenektir. Kompozisyonda verilen kare sayisi degeri tercih edilebilir veya render
isleminden once bu secenekle yeni kare sayisi degeri girilebilir. Dikkat edilmesi gereken énemli
nokta, kompozisyondakinden ¢ok daha fazla kare sayisi giriimemesidir ¢linkl program, aradaki
kareleri ¢cok fazla tekrarla doldurur.

e Start ve End: Render siiresi igin diizenlemelerin yapildigi segeneklerdir.
e Custom Time Span: Bu secenekle yeni degerler girilebilir.
e Output Module>Lossless: Bu secenekle agilan pencerede “disariya aktarim ayarlari” yapilir.

e Format: Render alinabilecek dosya formatlari bulunur. Video, gorsel ve ses formatlarindan
calismaya uygun olan ve kullanilmak istenen format segcilir. JPEG Sequence formati, animasyon-
larda 25 karenin ayri ayri fotograf olarak kaydedilmesini saglar. PNG Sequence ise islem yapilan
video karelerinde Alpha bilgisi bulunuyorsa bu bilgiyi koruyarak kaydetme islemini gerceklestirir.

e Video Output>Channels: Renk kanallariyla ilgili se¢cim yapmayi saglar. RGB, Alpha,
RGB+Alpha secenekleri bulunur. Alpha segcilirse karelerde yalnizca Alpha bolgeleri kaydedilir.
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Animasyonlarda RGB+Alpha’yi aktif duruma getirebilmek icin Format Options>Video Codec
kismindan Animation secenegi secilmelidir. Bu secenekte hem RGB hem de Alpha kisimlar

kaydedilebilir.

e Resize: Bu segenekle projenin ¢6zunurligu degistirilebilir.

Audio Output Auto: Bu secenekle projenin ses kaydini a¢ip kapatma ve sesle ilgili 6zelliklerini

diizenleme islemleri yapilabilir.

Output To: Bu secenekle projenin kaydedilecegi yer secilir ve kayit ismi girilir.

Render Queue: Bu pencerede diizenleme islemleri yapildiktan sonra Render digmesine tiklanir.

Loading Bar: Proje kaydedilirken, ilgili panelde mavi bir serit olarak gorulir. Bu cizgi

tamamlandiginda render islemi de biter (Gorsel 2.44).

Gorsel 2.44: Calismanin render edilmesi

2.5.2. Media Encoder Programiyla Render islemi

Gorsel efekt programinda ¢alisilan dokiiman, media encoder ile mp3, mp4, avi, mpeg gibi
farkh formatlarda kaydedilebilir. Bu islemi gergeklestirmek igin File>Export>Add to Adobe Media
Encoder Queue secenekleriyle birlikte Media Encoder uygulamasi acilir (Gorsel 2.45).

File | Edit Composition Layer Effect Animation View Window Help

New AT /1 & i ¢
Open Project... Ctrl+0

Open Recent >

Browse in Bridge... Ctrl+Alt+Shift+0

Close Ctrl+W

Close Project

Save Ctrl+S

Save As >

Increment and Save Ctrl+Alt+Shift+5

Revert

Import >

Import Recent Footage >

Export > Add to Adobe Media Encoder Queue...

B & Compositi

Add to Render Queue
Export Adobe Premiere Pro Project...

Adobe Dynamic Link

Find Curl+F Maxon Cinema 4D Exporter...

AAA Crmtmmm 4m Cmmnem Chel o 1

Gorsel 2.45 Media Encoder Kuyruguna ekleme
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Acilan pencerede calisma hangi dosya tiriinde kaydedilmek isteniyorsa format alanindaki
seceneklerden uygun olani segcilir. Cikti dosyasi béliiminden ilgili projenin hangi konuma
kaydedilecegi secilir ve Kaydet simgesine (sag Ustteki kirmizi cerceveyle gosterilmis kicik yesil
simge) basilarak render islemi baslatilir (Gorsel 2.46).

Gorsel 2.46: Media Encoder ile mp4 formatinda dosya kaydetme

9. UYGULAMA

islem adimlarina gore gorsel efekt programinda calisilan projenin Media Encoder ile
mp4 formatinda render alinmasina dair 6rnek uygulamayi gerceklestiriniz.

1. Adim: File>Export>Add to Adobe Media Encoder Queue segenekleriyle birlikte Media
Encoder uygulamasini aginiz (Gorsel 2.46).

2. Adim: Media Encoder uygulamasinda format alanindaki segeneklerden H.264 seginiz.

3. Adim: Cikt1 dosyasi bolimiinden projeyi bilgisayarda nereye kaydedeceginizi seginiz.

4. Adim: Projeyi kaydedeceginiz konumu belirledikten sonra klavyeden Enter tusuna basiniz
veya kuyrugu baslat simgesine tiklayarak render islemini baglatiniz.
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SIRA SiZDE

Cahsma alaninda calisilan bir projeyi Media Encoder kullanarak .avi formatinda
kaydediniz.
DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi

yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. File>Export>Add to Adobe Media Encoder Queue secenekleriyle birlikte

Media Encoder uygulamasini act.

2. Media Encoder uygulamasinda format alanindaki segeneklerden avi secti.

3. Cikt dosyasi bolimiinden projeyi bilgisayarda nereye kaydedecegini secti.

4. Projeyi kaydedecegi konumu belirledikten sonra klavyeden Enter tusuna
basti.
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OLCME VE DEGERLENDIRME

A) Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Gorsel efekt programinda galisilan projeyi tam ekran olarak goriintiileyebilmek igin

3. Asagidakilerden hangisi kompozisyonda yer alan ¢alismayi ilgili panelde farkli yonlere

asagidakilerden hangisi segilmelidir?

A) info paneli>Screen
C) Preview>Full Screen

Window Help
Workspace

B) info paneli>Preview

D) Preview>Play

E) Preview>Cache Before Playback

Assign Shortcut to "Default” Workspace >

Extensions

~  Align

~  Audio
Brushes

~  Character

~  Content-Aware Fill
Effects & Presets
Essential Graphics

~ Info
Learn

~  Libraries
Lumetri Scopes
Mask Interpolation

Media Browser
Matadata

Verilen bu menii konumundan segilecek Reset “Default” to Saved Layout secenegi ile
asagidaki islemlerden hangisi gerceklestirilir?

Ctrl+4
Ctrl+9
Ctrl+6
Ctrl+5

Ctrl+2

A) Panellerin yeni konumu kaydedilir.

B) Paneller varsayilan hale geri ylklenir.

C) Yeni calisma alani olarak kaydedilir.

D) Kaydedilmis calismaya kisayol tusu atanir.

E) Paneller en son kaydedilmis hale geri yiklenir.

kaydirabilmek amaciyla kullanilir?

A) Selection Tool

C) Zoom Tool

E) Clone Stamp Tool

All Panels
Animation

Color

Default

Effects

Essential Graphics
Learn

Libraries
Minimal

Motion Tracking
Paint

Small Screen
Standard

Text

Undocked Panels

Reset “Default” to Saved Layout
Save Changes to this Workspace

B) Hand Tool

Shift+F10

Shift+F11

Shift+F12

D) Rotation Tool
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Import As:

Import Options:
Footage ~ > >

Footage [] Create Composition

Composition - Retain Layer Sizes
Dosya adr: | talfgensreiden All Acceptable Files e
Import Folder Iptal

Dosya import edilirken Composition secenegi segilirse asagidakilerden hangisi gergeklesir?

A) Katmanh dosyalarda sadece bir katmandaki icerik programa aktarilir.

B) Katmanlh dosyalarda, katmanlardaki tim icerikler programa aktarilr.

C) Katmanli dosyalardaki icerikler, katman blyklikleriyle birlikte programa aktarihr.
D) Calisma alanina baska bir Composition aktarilir.

E) Calisma alanina Footage ile birlikte baska bir Composition aktarilir.

5. Asagidakilerden hangisi Pan Behind (Anchor Point) aracinin yaptigi isi agiklar?

A) Ekranda yer alan bir resmi, videoyu veya yaziyi istenen yone dondirmeyi saglar.
B) Dikdortgen, elips, poligon ve yildiz araglarinin eklenebilecegi komuttur.

C) Herhangi bir seklin, resmin veya videonun merkez noktasini gérmek icin kullanilir.
D) Projeyi ilgili panelde farkh yonlere kaydirabilmek amaciyla kullanilir.

E) Kompozisyonda yer alan ¢alismanin arkasina golge ekler.

Asagidakilerden hangisi verilen bu gorseldeki islemi agiklar?

A) Dolgu rengi yesil ve kontur rengi olmayacak sekilde yildiz araciyla sekil gizilmistir.
B) Dolgu rengi yesil ve kontur rengi siyah olacak sekilde yildiz araciyla sekil gizilmistir.
C) Kalem araciyla yildiz gizilmeye ¢ahsiimistir.

D) Katmanlar bolimune aktarilan bir resim, firca araciyla siyah renge boyanmistir.

E) Katmanlar bélimune aktarilan bir resim, yildiz araciyla maskelenmeye calisiimistir.

7. Asagidakilerden hangisi resim veya videonun herhangi bir yerindeki bolgenin kopyala-
narak bagka bir bélgeye aktarilmasini saglar?

A) Pan Behind Tool B) Clone Stamp Tool
C) Puppet Pin Tool E) Roto Brush Tool D) Rectangular Tool
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Asagidakilerden hangisinde verilen ilgili komutun gorevi yanhis yazilmistir?
A) Kalem araciyla istenen sekil cizilir.

B) ilgili cizime déniisiim noktasi eklenir.

C) ilgili cizimden déniisiim noktasi silinir.

D) ilgili cizimin kenar hatlarindaki keskinlik azaltilr.

E) ilgili cizim vektérel hale cevirilir.

9. Asagidakilerden hangisi Roto Brush Tool aracinin ne ise yaradigini agiklar?

A) Firgayla segili katmani boyamayi saglar.

B) Donlisim noktasindan disariya dogru bir yumusatma efekti vermek igin kullanilir.
C) Resmin herhangi bir yerindeki bolgenin baska bir bolgeye aktarilmasini saglar.

D) Resim veya video Uzerindeki herhangi bir bolgeyi maskelemek igin kullanilir.

E) Katman Uzerine daha sonra diizenlenebilecek vektorel bir cizgi ekler.

10. Kukla araglanyla ilgili asagidaki bilgilerden hangisi yanlistir?
A) Puppet Position Pin Tool araci, hareketin baslanmasi istenen noktayi isaretlemek icin kul-
lanilir.
B) Puppet Starch Pin araciyla cakisma olmasi muhtemel durumlar ortadan kaldirilir.

C) Puppet Advanced Pin Tool araci, Starch Pin araciyla eklenen pinlerin arasina gelismis bir
pin ekler.

D) Puppet Bend Pin Tool araciyla birlikte boyun, kuyruk gibi kisimlara biikme veya egme ha-
reketi verilir.

E) Puppet Overlap Pin araciyla cakisma olmasi muhtemel durumlar ortadan kaldirilr.
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3. OGRENME BiRiMi

HAREKETLI GORUNTULER




HAZIRLIK CALISMALARI

1. Gorsel efekt yazilimi size ne ifade ediyor?

2. Gorsel efekt yaziliminin kullanim yerleri ile ilgili neler biliyorsunuz?

3.1. KOMPOZiSYON OLUSTURMAK

Resim, video ve ses dosyalarini kullanarak hareketli kompozisyonlar olusturmak, gorsel efekt
yazihminin en gli¢li oldugu noktalardan biridir. Kompozisyonlarin iginde farkli kompozisyonlar
olabilir. Hareketli goriintller icin kompozisyon olusturma, transform islemleri ve katmanlari iyi
anlamak gerekir.

Gorsel efekt yazilimina video, resim ve ses dosyalari eklendikten sonra bunlara katmanlarda
canlandirma ve efekt uygulamak icin kompozisyon olusturulur. Her kompozisyonun iginde
birden fazla katman ve bu katmanlarin kendine has bir zaman c¢izelgesi bulunur. Kompozisyon
olusturulurken iki yontem siklikla kullanilir. Bu yontemlerden biri, Project paneline eklenen
dosyalarin surikle birak yontemiyle Create a new Composition simgesinin tzerine birakilmasidir
(Gorsel 3.1).

'

Gorsel 3.1: Siiriikle birak yéntemiyle yeni kompozisyon olusturma
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Kompozisyon olusturma yontemlerden bir digeri ise meni ¢ubugundan Composition>New
Composition (Ctrl + N) secilmesidir (Gorsel 3.2).

Gorsel 3.2: Menii gubugundan yeni kompozisyon olusturma

3.2. KOMPOZISYON AYARLARI

Kompozisyon olusturma islemi Project panelindeki dosyayi stirtikle birak yontemiyle yapilirsa
herhangi bir ayar sorulmadan dosyanin ozellikleriyle ayni ayarlarda kompozisyon olusturulur.
Bu kompozisyonun ayarlarini degistirmek icin meni ¢ubugundan Composition>Composition
Settings (Ctrl + K) secilir (Gorsel 3.3).

Gorsel 3.3: Menii cubugundan kompozisyon ayarlarini agma

Menl ¢ubugundan yeni kompozisyon olusturulursa otomatik olarak kompozisyon ayarlari
penceresiyle karsilasilir (Gorsel 3.4).

Gorsel 3.4: Kompozisyon ayarlari
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Composition Name: Kompozisyonun isminin yazildigi bolimddr.

Preset: Kompozisyonun formatini belirler. Hazir formatlardan projeye uygun olani seger ve
videoyu disa aktarirken bu formati kullanir.

Frame Rate: Saniyede kag gerceve (fps) gosterilecegini belirler.

Width and Height: Kompozisyonun genislik ve yiksekligini belirler ve projenin boyutlarini
ayarlar.

Duration: Kompozisyonun siiresini belirler.

Background: Kompozisyonun arka plan rengi belirler.

Kompozisyon ayarlari yapildiktan sonra OK diigmesine tiklanarak yeni kompozisyon olustu-

rulur.

3.2.1. Kompozisyona Nesne Eklemek

Kompozisyona gorsel efekt yazihminin araclari kullanilarak cesitli sekiller (dikdértgen, elips,
cokgen ve yildiz gibi) eklenebildigi gibi projeye dahil edilmis resim, video ve ses dosyalari da
yerlestirilebilir.

3.2.2. Kompozisyona Sekil Eklemek

Gorsel efekt yazihminda kompozisyon olusturulduktan sonra farkli formatta bircok nesne
eklenebilir. Bu nesneler sekil, video, ses ve resimlerden olusabilir. Gorsel efekt yazilimi yaygin
olarak kullanilan tiim dosya formatlarini tanir. Kompozisyona bir nesne eklendiginde ona ait olan
katman otomatik olarak olusur.

1. UYGULAMA

islem adimlarina gore gorsel efekt yaziiminda kompozisyona dikdértgen sekli
ekleyiniz.

1. Adim: Araglar (Tools) cubugundan dikdortgen (Rectangle Tool) aracini seginiz (Gorsel 3.5).

Gorsel 3.5: Dikdortgen araci segimi
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2. Adim: Calisma alaninda mouse sol tusu basiliyken sol istten sag alt tarafa dogru ok isaretini
hareket ettiriniz (Gorsel 3.6).

Gorsel 3.6: Dikdortgen gizimi

2. UYGULAMA

islem adimlarina gére gorsel efekt yaziliminda kompozisyona elips sekli ekleyiniz.

1. Adim: Araclar cubugunda yer alan dikdortgen aracinin Ustiine mouse ok isaretini getirip sol
tusa basili tutunuz (Gorsel 3.7).

Gorsel 3.7: Elips araci segimi

2. Adim: Aclilan seceneklerden Ellipse Tool aracini seginiz.

3. Adim: Calisma alaninda mouse sol tusu basiliyken sol Uistten sag alt tarafa dogru ok isaretini
hareket ettiriniz (Gorsel 3.8).

Gorsel 3.8: Elips ¢izimi
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SIRA SiZDE

Gorsel efekt yazilminda kompozisyona yildiz sekli ekleyiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Araclar cubugundan yildiz seklini secti.

2. Calisma alanina yildiz seklini ¢izdi.

3. Zamani verimli kullandi.

3.2.3. Kompozisyona Disaridan Dosya Eklemek

Kompozisyona gorsel efekt yazilimindaki sekiller eklenebildigi gibi disaridan resim, video ve
ses dosyalari da eklenebilir.

3. UYGULAMA

islem adimlarina gére kompozisyona disaridan resim ekleyiniz.

1. Adim: 1024 piksel genisliginde, 768 piksel ylksekliginde yeni bir kompozisyon olusturunuz.

2. Adim: File>Import>File menisiinden bilgisayardaki “resim1.png” dosyasini segerek Project
paneline ekleyiniz (Gorsel 3.9).

Gorsel 3.9: Project panele resim dosyasi ekleme
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3. Adim: Project panelindeki “resim1.png” dosyasini sirikle birak yontemiyle kompozisyona
birakiniz (Gorsel 3.10).

Gorsel 3.10: Kompozisyona “resim1.png” dosyasini ekleme

4. Adim: Calisma alanina “resim1.png” dosyasinin yerlestigini goriiniiz (Gorsel 3.11).

Gorsel 3.11: Calisma alaninda “resim1.png”

SIRA SiZDE

Gorsel efekt yaziliminda kompozisyona disaridan dosya ekleyiniz.
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DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Dosyayi File>Import>File menisiinden Project panele ekledi.

2. Surikle birak yontemiyle dosyayl kompozisyona birakt.

3. Zamani verimli kullandi.

3.2.4. Kompozisyonda Nesneyi Uygun Konumlandirmak

Kompozisyona bir nesne eklendiginde galisma alaninin ortasinda goriintilenir. Bu nesne,
etrafindaki kutucuklardan tutularak boyutlandirilabilir ve sirikle birak yontemiyle ¢alisma
alaninda istenen yere konumlandirilabilir.

4. UYGULAMA

islem adimlarina gére kompozisyona eklenen nesnenin boyutunu kiigiiltiip calisma
alaninda sol st kdseye yerlestiriniz.

1. Adim: 1024 piksel genisliginde, 768 piksel yiksekliginde yeni bir kompozisyon olusturunuz.

2. Adim: File>Import>File menisiinden bilgisayardaki “resim1.png” dosyasini segerek Project
paneline ekleyiniz.

3. Adim: Project panelindeki “resiml.png” dosyasini siiriikle birak yontemiyle kompozisyona
birakiniz.

4. Adim: Calisma alaninda yer alan nesneyi etrafindaki kutucuklardan tutarak kiciltiniz
(Gorsel 3.12).

5. Adim: Calisma alanindaki nesneyi siiriikle birak yontemiyle sol Ust koseye yerlestiriniz
(Gorsel 3.13).

Gorsel 3.12: “resiml1.png” calisma ekraninda Gorsel 3.13: Nesnenin kiigiiltiilmesi ve taginmasi
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SIRA SiZDE

Kompozisyona eklenen nesnenin boyutunu kiclltip nesneyi sag (st koseye
yerlestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. Yeni kompozisyon olusturdu.

2. Disaridan bir dosyayi Project paneline ekledi.

3. Project panelindeki dosyayi siiriikle birak yontemiyle kompozisyona yerles-
tirdi.

4. Calisma alanindaki nesneyi kiiglltta.

5. Galisma alanindaki nesneyi siiriikle birak yontemiyle sag lst kdseye yerles-
tirdi.

3.2.5. Kompozisyonda Nesnelerin Goriinim Sirasi

Kompozisyona birden fazla nesne eklendiginde zaman gizelgesinde en (stte yer alan nesne
(Gorsel 3.14) calisma alaninda da diger nesnelerin Ustlinde gorinir (Gorsel 3.15).

Gorsel 3.14: Zaman gizelgesinde nesneler Gorsel 3.15: Nesnelerin goriiniim sirasi
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Zaman cizelgesindeki katman siralari degistirilerek ¢alisma ekraninda nesnelerin goriiniim
sirasi da ayarlanabilir. “resim2.png” katmani en (ste alindiginda (Gorsel 3.16) ¢alisma ekraninda
da en Ustte gorinir (Gorsel 3.17).

P

Gorsel 3.16: “resim2.png” katmani en iistte Gorsel 3.17: “resim2.png” en listte

Calisma alaninda nesnelerin goriinim sirasini degistirmek icin katmanlarin sirasi strikle
birak yontemiyle degistirilebilir. Bu sayede zaman gizelgesinde en st katmandaki nesne, ¢alisma
alaninda da en Ustte gorindr.

3.2.6. Kompozisyondaki Nesnenin Transform islemleri

Gorsel efekt yaziiminda kompozisyondaki nesnelerin capa noktasi, konumu, 6lceklendirmesi,
dontstu ve seffafligl ayarlanabilir. Kompozisyonda yer alan nesnelerden ayari degistirilecek
nesnenin sol tarafindaki “>” isareti tiklanir ve nesnenin asagisinda Transform segenegi gorilir
(Gorsel 3.18).

Gorsel 3.18: “resim2.png” nesnesine ait doniisiim segenegi

”

Donlstim seceneginin sol tarafindaki “>” isareti tiklandiginda acilan seceneklerden Gorsel

3.19'daki ayarlar yapilir.

Gorsel 3.19: Transform segenekleri

Anchor Point (Capa Noktasi): Capa noktasi tim Olcekleme, dondirme ve konumsal
hareketlerin temel alindigi noktadir. Nesne, capa noktasina gore doner. Nesnenin tam orta noktasi,
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varsayilan olarak ¢apa noktasi seklinde ayarlanir. Capa noktasl nesnenin kdsesine tasinmissa
Olgekleme veya dondirme islemi bu kdseden yapilir. Nesne segiliyken klavyeden “A” harfine
basilirsa bu déniisiim segenegi agllir.

Position (Konum): En ¢ok kullanilan doniisim secenegidir. Calisma alaninda nesnenin X ve Y
konumunu belirler. U¢ boyutta calisilirken Z derinlik ayari da yapilir. Nesne segiliyken klavyeden
“P” harfine basilirsa bu donisiim segenegi acilir.

Scale (Olgeklendirme): Genislik ve yiikseklik olmak tizere iki degerle ayarlanir. Burada yer
alan zincir simgesi (Gorsel 3.20) tiklanarak, genislik ve yiikseklik ayarlarina bagimsiz olarak deger
verilir (Gorsel 3.21). Nesnenin boyutu bayutalup kiglltulebilir. Nesne seciliyken klavyeden “S”
harfine basilirsa bu dénisiim secenegi acllir.

O O

Gorsel 3.20: Zincir simgesi aktif Gorsel 3.21: Zincir simgesi pasif

Rotation (Dondiirme): Nesnelere déniis hareketi eklemek icin bu déniisim kullanilir. iki
degerle ayarlanir. ilk deger, donis adedini; ikinci deger ise doniis acisini belirler. Ornegin burada
3x+180 degeri varsa nesne 3 tam tur doner ve 180 derece acl yapar. Bir baska deyisle 3,5 tur
doner. Nesne seciliyken klavyeden “R” harfine basilirsa bu donlisim secenegi acilir.

Opacity (Seffaflik): Nesnenin sahip oldugu seffaflik miktaridir. Buradaki deger %100 ise nesne
tam goriunir (opak) ve %0 ise nesne tamamen goriinmez olur. Nesne segiliyken klavyeden “O”
harfine basilirsa bu dénisiim secenegi acllir.

5. UYGULAMA

islem adimlarina gére kompozisyona yerlestirilen nesneyi ters déndiiriiniiz.

1. Adim: Kompozisyona yerlestirilmis nesnelerden birini seciniz.
2. Adim: Klavyeden “R” tusuna basiniz. Rotation dontsimini aginiz.

3. Adim: Mouse siirtikle birak yontemiyle veya klavyeden sayi girerek derece degerini 180
yapiniz (Gorsel 3.22).

/

Gorsel 3.22: Rotation degerini degistirme Gorsel 3.23: “resim2.png” nesnesi

4. Adim: Calisma alaninda “resim2.png” nesnesini inceleyiniz (Goérsel 3.23).
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SIRA SiZDE

Gorsel efekt yaziliminda kompozisyona eklenen nesneyi 270 derece dondiriiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme ol¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Kompozisyona yerlestirilen nesneyi secti.

2. Klavyeden “R” tusuna basip Rotation dontsimini acti.

3. Derece bolimiine 270 girdi.

4. Zamani verimli kullandi.

3.2.7. Kompozisyonun On izlemesi

Yapilan animasyonun gercek zamanli olarak 6n izlemesi (preview) yapilabilir. On izlemenin
hizi ve kalitesi bilgisayarin sahip oldugu RAM miktarina bagh olarak degisebilir. Gorsel efekt
yaziliminda bir kompozisyonun 6n izlemesini baslatmak icin kullanilacak kisayollar sunlardir:

e Bosluk tusu (Spacebar)

e Shift + bosluk tusu

e Numerik klavyeden (Numpad) 0 tusu
e Shift + Numerik klavyeden 0 tusu

¢ Alt + Numerik klavyeden 0 tusu

Her kisayol farkli bir 6n izleme davranisi gerceklestirir. Bu 6n izleme davranisi tuslara 6nizleme
ayarlarindan atanir. On izleme kisayollari kullanilmadan meniilerden yararlanilarak da 6n izleme
baslatilabilir.

e Window > Preview menisi veya Ctrl + 3 kisayol tusu ile agilan Preview panelinden Play
simgesine basilarak 6n izleme baslatilabilir (Gorsel 3.24).

O

Gorsel 3.24: Preview paneli ve Play simgesi
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e Composition>Preview>Play menisini kullanilarak da 6n izleme baslatilabilir.

3.2.8. Kompozisyona Anahtar Kare Eklemek

Keyframe (anahtar kare) kullanmak, gérsel efekt yaziiminda resim ve video gibi nesnelere
calisma alaninda hareket vermek icin en kolay ve en temel yontemlerden biridir. Zaman
cizelgesinde bir 6zelligin degeriyle degisiklik olusturmak icin en az iki anahtar kare kullanilir.
ilk anahtar kare degisimin basina, diger anahtar kare ise belirli bir siirede degisecek degisimin
sonuna yerlestirilir (Gorsel 3.25).

Gorsel 3.25: Anahtar karelerin yerlesimi

6. UYGULAMA

islem adimlarina gére nesneye soldan saga dogru ikinci saniyeden baslayip dor-
dlincil saniyede biten bir hareket ekleyiniz.

1. Adim: Soldan saga hareket eklenecek nesneyi seginiz.
2. Adim: Transform segeneklerini aginiz.

3. Adim: Current Time Indicator (bulunulan zaman gostergesi) mouse siriikle birak yontemiyle
zaman ¢izelgesinde ikinci saniye izerine getiriniz (Gorsel 3.26).

Gorsel 3.26: Current Time Indicator (CTl) ikinci saniye lizerinde
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4. Adim: Position yazisinin sol tarafindaki kronometre simgesine tiklayiniz ve ilk anahtar kareyi
ikinci saniyeye yerlestiriniz (Gorsel 3.27).

Gorsel 3.27: Position doniisiimiiniin ikinci saniyesinde anahtar kare

5. Adim: CTl simgesini zaman gizelgesinde dordlincli saniyeye yerlestiriniz (Gorsel 3.28).

Gorsel 3.28: CTI simgesi dérdiincii saniyede

6. Adim: Add or remove keyframe simgesine tiklayiniz (Gorsel 3.29).

Gorsel 3.29: Anahtar kare ekle / kaldir simgesi

7. Adim: Dordiincli saniyeye anahtar kare eklendikten sonra Position donisimiinin X
degerine 805 giriniz (Gorsel 3.30).

Gorsel 3.30: Nesneyi soldan saga dogru hareket ettirme
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SIRA SiZDE

Gorsel efekt yaziliminda kompozisyona eklenen nesneyi 5. saniyeden 10. saniyeye
soldan saga hareket ettiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Kompozisyona yerlestirilen nesneyi secti.

2. Transform segeneklerini agti.

3. CTl simgesini 5. saniyeye getirdi.

4. Position donlistminin sol tarafindaki kronometre simgesini tikladi.

5. CTl simgesini 10. saniyeye getirdi.

6. Position donlstimntn sol tarafindaki anahtar kare ekle / kaldir simgesine
tiklad.

7. Position donlsiminin X koordinatina ilk degerden daha bliyuk bir deger

girdi.

3.2.9. Kompozisyondan Anahtar Kareleri Silmek

Kompozisyonda bulunan katmanlardaki anahtar kareleri silmek igin su yontemlerden biri
kullanilabilir:

e Tek bir anahtar kare silinecekse o anahtar kare mouse ile segilir ve klavyeden Delete tusuna
basilir. Birden fazla anahtar kare silinecekse tiim anahtar kareler Shift tusuna basili tutulurken
mouse ile secilir ve Delete tusuna basilir.
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e CTI Uzerindeki anahtar kare silinecekse anahtar kare ekle / kaldir simgesi tiklanir. Gorsel
3.31’de CTI, dérdiinci saniyede yer alan anahtar karenin tzerinde bulunur. Anahtar kare ekle /
kaldir simgesine tiklandiginda dordiincii saniyedeki anahtar kare silinir.

\

Gorsel 3.31: Anahtar kare ekle / kaldir simgesi

e Bir dontisime ait anahtar karelerin tamami silinmek isteniyorsa donlstimun sol tarafindaki
kronometre simgesine tiklanir. Gorsel 3.32’deki kronometre simgesi tiklanirsa Position
dondstimiindeki tim anahtar kareler silinir.

/"

3.2.10. Kompozisyonda Anahtar Kareleri Tagimak

Gorsel 3.32: Kronometre simgesi

Anahtar kareler birbirine yaklagtirmak veya uzaklastirmak igin tasinabilir. Tasinarak birbirine
yaklastirilan anahtar karelerde dénlisim daha hizli, tasinarak birbirinden uzaklastirilan anahtar
karelerde donisiim daha yavas gerceklesir. Anahtar kareleri tasimak icin kullanilan yontemler
sunlardir:

e Yeri degistiriimek istenen anahtar kare mouse siriikle birak yontemiyle istenen zamana
birakilir.

e Yeri degistirilmek istenen anahtar kare segcilir. Ctrl + X tuslarina basilir. CTl, istenen zaman
Uzerine getirilir ve klavyeden Ctrl + V tuslarina basilr.

e Yeri degistirilmek istenen anahtar kareler Shift tusuna basili tutularak secilir. Ctrl + X tuslarina
basilir. CTl, istenen zaman Uzerine getirilir ve klavyeden Ctrl + V tuslarina basilr.
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3.2.11. Kompozisyonda Grafik Editér Kullanmak

Gorsel efekt yaziliminda nesnelere donlisiim verilirken anahtar karelerin yani sira grafik editor
de kullanilabilir. Grafik editor kullanabilmek icin en az iki anahtar karenin zaman cizelgesinde
olmasi isleri kolaylastirir. Gorsel 3.33’te soldan saga dérdiincl saniye baslayan hareket, on altinci
saniyede biter. CTl, onuncu saniyede animasyonun tam ortasindadir.

O

Gorsel 3.33: Soldan saga hareket ve grafik editor simgesi

Grafik editor simgesi tiklandiginda zaman cizelgesi yerini temel bir grafik dizenleme
tablosuna birakir (Gérsel 3.34). Bu tabloda Position déntsiminiin X koordinatini kirmizi gizgi, Y
koordinatini ise yesil renkli ¢izgi ifade eder. Kirmizi renkli ¢izgi mouse ile tiklanarak asagi dogru
hareket ettirildiginde X konumu azalir, kirmizi renkli cizgi mouse ile tiklanarak yukari dogru hareket
ettirildiginde X konumu artar. Kirmizi renkli cizgi mouse ile saga hareket ettirildiginde hareketin
slresi artar, kirmizi renkli cizgi sola hareket ettirildiginde hareketin siiresi azalir. Grafikteki yesil
renkli cizgi de benzer sekilde mouse ile asagi ve yukari hareket ettirilebilir.

Gorsel 3.34: Grafik editér paneli

3.3. KATMANLAR

Project paneline disaridan aktarilan video, resim, yazi, ses vb. dosyalar, hazirlanan
kompozisyona dahil edilerek zaman cetveline eklendiginde katmanlar olusturulur. Her katman,
zaman cetveli panelinde belirli bir hiyerarsik diizende siralanir. Standart olarak en Ustte bulunan
katman, Composition panelinde en énde goérintulenir.
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Her katman kendi icinde diizenlenebilir. Katmanlara efekt, yazi, maskeleme, hareketlendirme
gibi eklemeler yapilabilir. Ayrica katmanlar birbiriyle iliskilendirilerek farkh gorsel etkiler
olusturulabilir.

3.3.1. Kompozisyona Layer Meniisiinden Katman Eklemek

Kompozisyon olusturulduktan sonra katman eklemek icin Menil cubugundan Layer>New
secilir. Agilan listede istenen katman tiriine tiklanir (Gorsel 3.35). Katman panelinde bos bir
noktaya farenin sag tusuyla tiklanarak da ayni mentye ulasilir.

File Edit Composition Effect Animation View Window Help

Mew > Text Ctrl+Alt+Shift+T
Layer Settings... Ctrl+Shift+Y Solid... Ctrl+¥
= o Light... Ctri+Alt+Shift+L
Open Layer
Open Layer Source Alt+Numpad Enter e S AiLshiLs

. . Null Object Ctrl+Alt+Shift+Y
Reveal in Explorer

Shape Layer

Mask Adjustment Layer Chrl+Alt+Y

Lz ] Sl Content-Aware Fill Layer...

LAy Adobe Photoshop File...
Switches Mazxon Cinema 4D File...
Transform

Time

Frame Blending
3D Layer

Guide Layer
Environment Layer

Markers >

Preserve Transparency

Blending Mode

Mext Blending Mode Shift+=
Previous Blending Mode Shift+-
Track Matte

Layer Styles
Arrange

Reveal >

Create >
Camera bl
Auto-trace...

Pre-compose... Ctrl+Shift+C

Gorsel 3.35: Kompozisyona yeni katman ekleme meniisii

Secilen katmanin tiiriine gore bir ayarlama penceresi agilir. Agilan pencerede istenen 6zellikler
belirlendikten sonra OK diigmesine tiklanir. Secilen katman, kompozisyona ve zaman gizelgesinin

katman bolimine eklenir.

Solid Layer (Kati katman) ile istenen renkte, isimde, ¢ozinurlikte ve slresi kompozisyon
ile ayni uzunlukta bir katman olusturulur. Solid Layer genellikle arka plan katmani olarak veya
Uzerine efekt panelinden eklenen efektlerle birlikte kullantlir.
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7. UYGULAMA

islem adimlarina gére kompozisyona Solid katmani ekleyiniz.

1. Adim: Katman panelinde bir Solid katmani olusturmak icin Layer>New>Solid digme-
lerini sirayla tiklayiniz. Olusturulacak Solid katmaninin ayarlarinin yapildigi Solid Settings (Solid
Ayarlari) menisu agilacaktir (Gorsel 3.36).

Solid Settings X

Make Comp Size

Gorsel 3.36: Solid katmani ayarlama mendisii

2. Adim: Agilan Solid Settings menusiinde asagidaki islemleri gergeklestiriniz (Gorsel 3.36).

¢ Name alaninda kompozisyona eklenecek katmanin ismini belirleyiniz (A).

e Width ve Height alaninda genislik ve yikseklik piksel degerlerini girerek katmanin ¢ézinirlik
degerini belirleyiniz (B).
e Units (liniteler) alaninda birim degerini piksel olarak belirleyiniz (C). Projenin tiirline gore

birimler piksel degerinin yani sira in¢ veya milimetre cinsinden de hesaplanabilir.

o Pixel Aspect Ratio (piksel en ve boy orani) alaninda pikselin en ve boy oranini belirleyiniz (D).
Bu alani Square Pixels (kare pikseller) degerine ayarlamak, katmani déndirme gibi animasyonlar
uygulandiginda katmanin seklinin bozulmasini 6nleyecektir.

® Make Comp Size butonuna tiklayiniz (E). Bu butona tikladiginizda eklenecek Solid katmaninin
¢OzUnurlik degeri, olusturulan kompozisyonun ¢oziinirlik degerini alacaktir.

® Renk alaninda katmanin sahip olacagi rengi belirleyiniz (F). Damlalik araci kullanilarak da
istenen renk secilebilir.
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3. Adim: Ayarlamalari tamamladiktan sonra OK digmesine tiklayiniz. Olusturdugunuz katmani
zaman ¢izelgesi panelinde gorintileyiniz (Gorsel 3.37).

Gorsel 3.37: Solid katmani eklendiginde sahnenin goriiniimii

Solid katmanda herhangi bir degisiklik istenirse zaman cizelgesi panelinde Solid katmani
secildikten sonra Meni cubugundan Layer>Solid Settings secilerek Solid Settings menisu acilir
ve istenen degisiklikler yapilir.

4. Adim: Kompozisyona Text (yazi) katmani eklemek icin Layer>New>Text digmelerini sirayla
tiklayiniz (Gorsel 3.38).

File Edit Cemposition Effect Animation View Window Help

New > Text Cirl+Alt=Shift=T |
Solid Settings... Ctrl+Shift+Y Solid... Ctrl+Y
ey Light... Ctrl+Alt+Shift+L
Open Layer Source Alt+Numpad Enter e SrsL et
. o Mull Object Ctrl+Alt+Shift+Y
Reveal in Explorer
Shape Layer
>
2 Adjustment Layer Ctrl+Alt+Y
>
M el Content-Aware Fill Layer...
el > Adobe Photoshop File...
Saieh s ’ Mazxon Cinema 4D File...
Transform ¥
Time ¥
Frame Blending >
3D Layer
Guide Layer

Environment Layer

Markers ¥

Gorsel 3.38: Kompozisyona Text katmani ekleme

Zaman cizelgesi panelinde Solid katmaninin Ustline Text katmani Empty Text Layer (Bos yazi
katmani) ismiyle eklenir (Gorsel 3.39).
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Gorsel 3.39: Zaman gizelgesi panelinde Text katmani

5. Adim: Text katmanini kullanarak sahneye yazi eklemek i¢cin kompozisyon panelinde Solid
katmani Uzerindeki herhangi bir bos noktaya farenizin sol digmesi ile tiklayiniz. Klavyeden
istediginiz yaziyi yaziniz (Gorsel 3.40).

Gorsel 3.40: Text katmaniile yazi olusturma

Katman bolimindeki Transform mendisiinde bulunan Scale degerleri, katmanin X ve Y
eksenlerindeki buyukliklerini degistirmek icin kullanilir (Gorsel 3.41).

6. Adim: Yazi katmaninin yanindaki ok simgesine basip, agilan Transform mendsiiniinde Scale
degerini artirarak eklenen yazinin boyutunu biy{tliniz.

Transform mentsinde bulunan Position degerleri katmanin X ve Y eksenlerindeki konumlarini
degistirmek icin kullanihr (Gorsel 3.41).

7. Adim: Position degerlerini degistirerek yaziyi ekranin ortasina tasiyiniz.

Gorsel 3.41: Transform mentisi
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Bir katmani digerinden ayirmak i¢in her katmanin renk etiketi bulunur. Bu renkler istege gore
degistirilebilir.

8. Adim: Katman rengini degistirmek icin Solid katmanin solundaki renkli kutucuga tiklayiniz
ve acllan meniden dilediginiz bir rengi seginiz (Gorsel 3.42).

dirma Dersi Normal

d Katmani Normal

Select Label Group
MNone

® Red
Vellow
Agqua
Pink
Lavender
Peach
Sea Foam
Blue
Green
Purple
Orange
Brown
Fuchsia
Cyan
Sandstone
Dark Green

Gorsel 3.42: Katman rengini belirleme

Katmanin solunda soldan saga dogru sirasiyla gbz, hoparlor, nokta ve kilit simgeleri bulunur
(Gorsel 3.43).

Gorsel 3.43: Katman ozellikleri

Katmana ait satirda bulunan bu simgelerden Go6z (Hides Video-Videoyu gizle) tiklanarak
kapatildiginda o katman kompozisyon panelinde gizlenir. G6z simgesine tekrar tiklandiginda
ise katman kompozisyon panelinde gorinir hale gelir. Hoparlor (Mutes Audio-Sesi kapat)
digmesine tiklandiginda o katmanin sesi kapanir. Hoparlér simgesine tekrar tiklandiginda
katmanin sesi acilir. Nokta (Solo-hides all non solo video-isaretli olmayan tiim katmanlari gizle)
simgesine tiklandiginda o katman disindaki tiim katmanlar kompozisyon panelinde gizlenir. Nokta
simgesine tekrar tiklandiginda gizlenen katmanlar gosterilir. Kilit (Lock) simgesine tiklandiginda
katman, zaman cizelgesi panelinde secilemez hale gelir. Kilit simgesine tekrar tiklandiginda
katman segcilebilir.

9. Adim: Katmanlari gosterme, gizleme, kilitleme 06zelliklerini kullanarak sonuglari
gozlemleyiniz.
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Kompozisyona eklenebilecek diger katmanlar sunlardir:
Light Layer (Isik Katmani): Ug boyutlu ¢alismalarda sanal 1sik kaynagi olusturmak igin kullanilir.

Camera Layer (Kamera Katmani): U¢ boyutlu calismalarda sanal kamera olusturmak igin
kullanihr.

Null Object (Bos Obje Katmani): Null Object katmani, diger katmanlari kendine baglamaya
yarayan gizli bir katmandir.

Shape Layer (Sekil Katmani): Kompozisyona sekil eklemek icin kullanilir.

Adjustment Layer (Ayarlama Katmani): Katmanlailgili efektler, Adjustment Layer olusturularak
katmana eklenir. Adjustment Layer sadece altindaki katmanlari etkiler.

Yeni eklenen katman, zaman cizelgesinde varsayilan olarak Ustte konumlanir. Boylece bu
katman kompozisyon penceresinde de Ustte goriinir.

Her katmanin standart olarak Transform 6zelligi vardir. Katmanlar tiirlerine gére Transform
menisi disinda farkl islemler icin kullanilan mentilere sahiptir (Gorsel 3.44).

Gorsel 3.44: Katman ozellikleri

3.3.2. Layer Meniisiinden Katman Ozelliklerini Degistirmek

Layer menisiinde bulunan segenekler, katmanlarla c¢ahsilirken ihtiya¢ duyulan komutlari
icerir. Layer menisiinde bulunan segeneklerin bircogu Katman panelindeki katman secilerek
farenin sag tusuna tiklandiginda da acilir. Bu segenekler panellere, araglara, simgelere,
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actlir mendlere de eklenerek kullanim kolayligi saglanir (Goérsel 3.45).

Layer Effect Animation View Window Help

New >
Solid Settings... Ctrl+Shift+¥
Open Layer

Open Layer Source Alt+Numpad Enter
Reveal in Explorer

Mask >
Mask and Shape Path >
Quality >
Switches >
Transform >
Time >
Frame Blending >
3D Layer

Guide Layer

Environment Layer

Markers >
Preserve Transparency

Blending Mode >
Mext Blending Mode Shift+=
Previous Blending Mode Shift+-
Track Matte >
Layer Styles >
Arrange >
Reveal >
Create >
Camera >
Auto-trace...

Pre-compose... Ctrl+Shift+C

Gorsel 3.45: Layer mendisi

Layer menilst katmanlara maske, katman stili, karistirma modlari, isaret, efekt, tracker
eklemek; katmanlari dizenlemek, donistiirmek ve gruplamak; videonun hizini artirmak,
azaltmak veya ters ¢cevirmek gibi bircok komut igerir.

3.3.2.1. Karisim Modlari (Blending Modes)

Karisim Modlari, eklendigi katman ile altindaki katmani farkh olcitler kullanarak birlestirir.
Bunun sonucunda farkh dinamik renk etkilerine sahip gorseller ve videolar ortaya cikar.
Karistirma etkisi sadece modun eklendigi katmanla altindaki katman arasinda olur.

8. UYGULAMA

islem adimlarina gére gorsellere karisim modu uygulayiniz.

1. Adim: Kompozisyona iki adet gorsel ekleyiniz (Gorsel 3.46.a, Gorsel 3.46.b).
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Gorsel 3.46.a: Kompozisyona eklenen 1. gérsel  Gorsel 3.46.b: Kompozisyona eklenen 2. gorsel

2. Adim: Zaman ¢izelgesinde Ustte bulunan katmana farenin sag tusuyla tiklayiniz. Agilan
listeden Blending Mode digmesini segerek Karisim Modlari menisiini aginiz. Listeden Screen
karisim modunu seciniz (Gorsel 3.47).

Gorsel 3.47: Karisim modlari
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Karisim Modu alani, Katman panelinin altindaki Toggle Switches / Modes digmesine
tiklanarak panelde goriinir hale getirilir (Gorsel 3.48).

Gorsel 3.48: Toggle Switches / Modes diigmesi

3. Adim: Screen karisim modu kullanilarak birlestirilmis iki gérseli inceleyiniz (Gorsel 3.49).

Gorsel 3.49: Screen karisim modu etkisi

9. UYGULAMA

islem adimlarina gére gorsellere karisim modu uygulayiniz.

1. Adim: Yeni bir proje dosyasi olusturmak icin sirasiyla sol st kosede bulunan
File>New>New Project diigmelerini seciniz (Gorsel 3.50).

Gorsel 3.50: Yeni proje olusturma
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2. Adim: Yeni projede yeni kompozisyon olusturmak icin ekranin Ust tarafindaki meniide
sirastyla Composition>New Composition segeneklerini seginiz (Gorsel 3.51).

File Editfl Composition M Layer Effect Animation View Window Help
Mew Composition... Ctrl+N I

Composition Settings... Ctrl+ K

Set Poster Time
Trim Cemp to Work Area Ctrl+Shift+X
Crop Comp to Region of Interest

Add to Adobe Media Encoder Queue... Ctrl+Alt+M
Add to Render Queue Ctrl+M
Add Output Module

Preview

Save Frame As

Pre-render...

Save Current Preview... Ctrl+MNumpad 0

Open in Essential Graphics

Responsive Design — Time

Composition Flowchart Ctrl+Shift+F11
Composition Mini-Flowchart Tab
VR >

Gorsel 3.51: Yeni kompozisyon olusturma

3. Adim: Acilan Composition segenekleri penceresinde kompozisyon ayarlarini Gorsel
3.52’deki gibi yaparak OK diigmesine basiniz.

Composition Settings X

Gorsel 3.52: Kompozisyon ayarlari
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4. Adim: Karisim modlari uygulanacak gorselleri (Gorsel 3.53) once proje penceresine daha
sonra zaman gizelgesine ekleyiniz (Gorsel 3.54).

Gorsel 3.53: Karisim modlari uygulanacak gorseller

Gorsel 3.54: Gorselleri projeye dahil etme

5. Adim: Zaman cizelgesinde “Bulutlar” gorselini seciniz. Composition panelinde “Bulutlar”
gorselinin kenarlarindaki noktalari farenizin sol tusuyla tutarak “Sahil” gorselindeki gokyuziiniin
kapladigi alani hizalayacak sekilde kicultlinliz (Gorsel 3.55).

Gorsel 3.55: Gorselleri kompozisyon penceresine yerlestirme
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6. Adim: Karisim modu eklemek icin zaman cizelgesi penceresinde Bulutlar katmaninin

saginda bulunan Mode degerini Screen olarak degistiriniz. Olusan etkiyi gozlemleyiniz (Gorsel

3.56).

Gorsel 3.56: Karisim modu ekleme

3.3.3. Katman Stilleri (Layer Styles)

Katmanlara 1sik, gélge, kenarlik ve kabartma efektleri eklemek icin Layer Styles kullanilir.

Katman panelinde katmana farenin sag tusuyla tiklanir. Agilan meniden Layer Styles secilerek

Katman Stilleri mensi agilir. Hepsini Goster (Show All) secenegi, bitlin stilleri katmana ekler.

Hepsini Kaldir (Remove All) secenegi ise katmandaki bltin stilleri kaldirir (Gorsel 3.57).

Mask

Mask and Shape Path
Quality

Switches
Transform

Time

Frame Blending
3D Layer

Guide Layer
Environment Layer
Markers

Blending Mode

Layer Styles

Effect
Keyframe Assistant
Track & Stabilize

Open
Reveal

Create

Camera
Pre-compose...
Invert Selection
Select Children
Rename

Add to Essential Graphics

Convert to Editable Styles

Show All

Remove All

Drop Shadow
Inner Shadow
Outer Glow

Inner Glow

Bevel and Emboss
Satin

Color Overlay
Gradient Overlay
Stroke

Gorsel 3.57: Katman stilleri
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SIRA SiZDE

internetten bulacaginiz veya 6gretmeninizin dagitacagi 2 adet gorseli katman
bolimine ekleyerek Ust katmanda bulunan goérsele sirasiyla Hue (ton), Saturation
(doygunluk), Color (renk) karisim modlarini ekleyiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Yeni proje olusturdu.

2. Yeni kompozisyon olusturdu.

3. Gorselleri Project paneline ekledi.

4. Gorselleri Katman bolimiine ekledi.

5. Ust katmanda bulunan gérsele Hue karisim modunu ekledi.

6. Ust katmanda bulunan gorsele Saturation karisim modunu ekledi.

7. Ust katmanda bulunan gérsele Color karisim modunu ekledi.

10. UYGULAMA

islem adimlarina gére katmanlara katman stilleri ekleyiniz.

1. Adim: Zaman gizelgesine bir Text katmani ekleyiniz. Text katmanini Transform mentsiinde
bulunan Scale degerini degistirerek blyltlinlz. Text katmanini Transform menisinde bulunan
Position degerini degistirerek ekranin ortasina taslyiniz (Gorsel 3.58).
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Gorsel 3.58: Yeni Text katmani ekleme

2. Adim: Yazinin etrafina bir cergeve eklemek icin Text katmanina farenin sag tusuyla tiklayiniz

ve Layer Styles>Stroke secerek ekleyiniz (Gorsel 3.59).

Mask

Mask and Shape Path
Quality

Switches
Transform

Time

Frame Blending

3D Layer

Guide Layer
Environment Layer
Markers

Blending Mode

I Layer Styles

Effect
Keyframe Assistant
Track & Stabilize

Open
Reveal

Create
Camera
Pre-compose...

Invert Selection
Select Children

Rename

Add to Essential Graphics

Convert to Editable Styles
Show All

Remove All

Drop Shadow
Inner Shadow
Outer Glow

Inner Glow

Bevel and Emboss
Satin

Color Overlay
Gradient Overlay

Stroke I

Gorsel 3.59: Stroke katman stili
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Composition panelinde gorintiilenen Text katmaninin etrafinda cerceve olusur. Ayrica zaman
cizelgesi panelinde katmana ait Layer Styles basligi altinda Stroke komutuna 6zel ayarlarin geldigi
gorulir (Gorsel 3.60).

Gorsel 3.60: Text lizerinde Stroke katman stili etkisi

Text katmani igine eklenen Stroke menisi altindaki ayarlar sunlardir:

Blend Mode: Text katmaninin altindaki katman ile yazi ¢ergevesi arasindaki karisim modunu
belirler.

Color: Cerceve rengini belirler.
Size: Cergeve kalinhgini ayarlar.
Opacity: Cerceve gorinirligiuni ayarlar.

Position: Yazi etrafindaki gcergevenin yazinin neresinde hizalanacagini ayarlar.

3. Adim: Text katmaninin etrafina eklediginiz gercevenin renk, boyut, opaklik, konum gibi
ozelliklerini degistirerek olusturdugunuz etkileri Composition panelinde gézlemleyiniz.

4. Adim: Katman stillerini kullanarak, Text katmanina eklenen ¢ercevenin belli araliklarla yanip
sonmesi animasyonunu olusturmak icin 6ncelikle zaman cizelgesinde imleci 0. kare konumuna
aliniz.

5. Adim: Stroke katman stilinin altinda bulunan Opacity ayar digmesinin solundaki kronometre
digmesine tiklayarak 0. kareye anahtar kare eklenmesini saglayiniz.

6. Adim: Zaman cizelgesinde imleci 1. kare konumuna aliniz. Opacity degerini 0 olarak
ayarlayiniz. 1. kare konumuna otomatik olarak anahtar kare eklenecektir.
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7. Adim: Zaman cizelgesinde imleci 10. kare konumuna aliniz. Opacity degerinin en solunda
bulunan anahtar kare simgesine tiklayarak 10. kare konumuna anahtar kare ekleyiniz (Gorsel
3.61).

Gorsel 3.61: Anahtar kare ekleme

8. Adim: Zaman ¢izelgesinde imleci 11. kare konumuna aliniz. Opacity degerini 100 olarak
ayarlayiniz. 11. kare konumuna otomatik olarak anahtar kare eklenecektir.

9. Adim: Zaman gizelgesine eklenen anahtar kareleri farenizin sol diigmesiyle sirikleyerek
seciniz (Gorsel 3.62).

Gorsel 3.62: Anahtar kareleri segme

10. Adim: Klavyenizden Ctrl+C tuslarina basarak segilen anahtar kareleri kopyalayiniz. Zaman
cizelgesinde imleci 20. kare konumuna aliniz. Kopyalanan anahtar kareleri yapistirmak igin
klavyenizden Ctrl+V tuslarina basiniz.

11. Adim: Klavyenizden bosluk tusuna basarak olusturdugunuz animasyonu oynatiniz.
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12. Adim: Projeyi kaydetmek icin sol st kosedeki File>Save As diigmelerine sirasiyla basiniz
(Gorsel 3.63).

Gorsel 3.63: Projeyi kaydetme

13. Adim: Acilan pencerede Dosya adi kismina bir dosya ismi girdikten ve dosyanin
bilgisayarinizda nereye kaydedilecegini belirledikten sonra Kaydet diigmesine basiniz (Gorsel
3.64).

Gorsel 3.64: Proje dosyasina isim verme
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3.3.4. Pre-composition Olusturmak

Biyiik projelerde, calisilan Katman panelinde cok fazla sayida katman bulunabilir. iki veya
daha fazla katmanin bir araya getirilerek tek bir katmanmis gibi islem yapilabildigi durumlarda
Pre-composition (On kompozisyon) olusturulur. Olusturulan Pre-composition, yeni bir isim
verilip ana kompozisyona katman olarak eklenebilir. Boylece Katman panelindeki yigilma ve
karmasa onlenir.

11. UYGULAMA

islem adimlarina gére katmanlari kullanarak Pre-composition olusturunuz.

1. Adim: Yazilimi galistirdiktan sonra daha once kaydedilen proje dosyasini agmak icin sol
Ust kosede bulunan File>Open dugmelerine sirasiyla basiniz (Gorsel 3.65). Agilan pencerede
dosyanin kayith oldugu yerde proje dosyasini sectikten sonra Tamam butonuna basiniz.

Edit Cemposition Layer Effect Animation View

New >
I Open Project... Ctrl+0 I

Open Team Project...

Open Recent >

Browse in Bridge... Ctrl+Alt+Shift+0

Close Ctrl+W

Close Project

Save Ctrl+S

Save As ¥

Increment and Save Ctrl+Alt+Shift+5

Revert

Import 3

Impert Recent Footage >

Export >

Add Fonts frem Adobe...

Adobe Dynamic Link >

Gorsel 3.65: Kaydedilen proje dosyasini agma

2. Adim: Acilan projede zaman gizelgesi panelinde bulunan iki katmani farenizin sol tusuna
basili tutup sirikleyerek seciniz (Gorsel 3.66).

Gorsel 3.66: Katmanlari segme
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3. Adim: Farenizin sag tusuna tiklayarak, acilan pencerede Pre-compose... segcenegini secerek
on kompozisyon ayarlarinin yapildigi pencereyi aginiz (Gorsel 3.67).

Mask ¥
Mask and Shape Path >
Quality >
Switches ¥
Transform ¥
Time >
Frame Blending >
3D Layer
Guide Layer
Environment Layer
Markers ¥
Blending Mode >
Layer Styles ¥
Effect ¥
Keyframe Assistant >
Track 8 Stabilize >
Open >
Reveal ¥
Create ¥
Camera ¥
Pre-compose...
Invert Selection
Select Children
Rename

E Add to Essential Graphics

Gorsel 3.67: Pre-compose... segenegi ile on kompozisyon olusturma

4. Adim: Acilan pencerede New composition name alaninda yeni olusturulacak o6n
kompozisyona bir isim veriniz. Onceki kompozisyonda yapilan tiim animasyon ve efektlerin
on kompozisyona tasinmasini saglamak icin Move all attributes in to the new composition
secenegini isaretleyiniz. Ardindan OK diigmesine basarak islemi tamamlayiniz (Gorsel 3.68).

Gorsel 3.68: Pre-compose ayarlari
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Olusturulan 6n kompozisyon, ana kompozisyon icine katman olarak eklenir (Gorsel 3.69).
On kompozisyon icindeki katmanlara miidahale etmek gerekirse olusturulan 6n kompozisyona
farenin sol digmesiyle ¢ift tiklanarak katmanlara erisilebilir.

of)ed W - . sou
o

8 O = Text on Kompozisyory (NIRRT

Gorsel 3.69: On kompozisyonun ana kompozisyonda katman olarak bulunmasi

3.4. ZAMAN CETVELI (TIMELINE)

Timeline, kompozisyonun ve katmanlarin sirelerini gosteren bir paneldir. Katmanlarin sahip
oldugu konum, boyut, gérandrlik gibi bircok 6zelligi ile animasyonlar olusturmak icin zaman
cetveli panelinde siire gubuklarina anahtar kareler eklenir.

3.4.1. Zaman Cetvelinin islevleri

Zaman cetveli, icinde katman bolimind de bulunduran bir paneldir. Katman boélimiinde
bulunan materyaller belli bir hiyerarsik dlizene gore alt alta siralanir. Materyallerin karsisinda ise
katmanlarin siiresinin gosterildigi zaman ¢ubugu bulunur (Gorsel 3.70).

Gorsel 3.70: Zaman cetveli
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A. Zaman Gezgini Cubugu

B. Zaman Cetveli

C. Calisma Alani (Kompozisyon) Siire Cubugu
D. Kompozisyon On-render Gostergesi

E. Katman Sire Cubugu

F. Zaman imleci

G. Zaman Cetveli Zoom Kaydirici

H. Kompozisyon isaretleyici (Marker) Bélmesi
I. Kompozisyona Donme Simgesi

Zaman Gezgini Cubugu (A): Calisma alanini yakinlastirarak zaman imlecinin, zaman cetvelinde
her bir kareye daha kolay erismesini saglar. Zaman gezgini cubugu, basindan veya sonundan
tutulup siriklenerek istenen zaman araliginda yakinlastirma yapilir (Gorsel 3.71).

5 ve 20. kareler arasinda 5 ve 10. kareler ara-
yakinlagtirma yapilmasi sinda yakinlagtirma
yapilmasi

Gorsel 3.71: Zaman gezgini cubugu

Zaman Cetveli (B): Kompozisyonun siresini gosterir. Her kompozisyon igin ayri zaman
cetveli olusur. Bu siire kompozisyon ayarlarindan degistirilebilir. Katman siireleri kompozisyon

stiresinden uzun olamaz.

Calisma Alani Siire Cubugu (C): Kompozisyonun ¢iktida kullanilacak bolimiini gosterir. Bu
¢ubugun gosterdigi alanin disinda kalan siireler render edilmez. Kompozisyon tizerinde galisilirken
kompozisyonun sadece bir kismi ¢ikti olarak kullanilmak istenirse zaman cetvelinin bir bolimi
Calisma Alani olarak belirlenir. Calisma alani iki farkl yolla ayarlanabilir.

1. Yol: Siire Cubugu, basindan veya sonundan tutularak siriklenir (Gorsel 3.72).

Calisma alani 1 ve 2.
saniye olarak belirlendi.

Gorsel 3.72: Calisma alani siire gubugu
2. Yol: Calisma alaninin baslangi¢ zamanini belirlemek igcin zaman imleci istenen siireye

getirilerek klavyeden B digmesine basilir. Calisma alaninin bitis zamanini belirlemek i¢in zaman
imleci istenen slireye getirilerek klavyeden N diigmesine basilr.
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Zaman cetvelini yeni olusan c¢alisma alani sire cubuguna gore ayarlamak igin ¢alisma alani
siire gubugu Uzerinde farenin sag tusuna tiklanir. Acilan listede Trim Comp to Work Area segcilir
(Gorsel 3.73).

Lift Work Area
Extract Work Area

Trim Comp to Work Area

Create Protected Region from Work Area

Gorsel 3.73: Calisma alani ayar mentisi

Kompozisyon On Render Géstergesi (D): Olusturulan kompozisyonun ¢ikti alinmadan énce
on izleme yapilmasi istendiginde &n render edilip edilmediginin gérildiigi alandir. On render
edilmemis alanlar 6n izleme sirasinda gercek zamanl olarak izlenemez. Bu durum, videolarda
donmalara veya yavaslamalara yol acar. On render edilmis alanlar, én render gostergesinde yesil
renkte gosterilir. Bu islem, klavyeden bosluk tusuna basilip, video oynatildiginda otomatik olarak
baslar (Gorsel 3.74).

Gorsel 3.74: On render gostergesi

Katman Siire Cubugu (E): Katman siresini gosterir. Her katmanin kendine ait bir slire gubugu
vardir. Projeye aktarilan (import) fotograflarin ve calisma alaninda olusturulan katmanlarin (Text,
Shape, Null, Camera vb.) siiresi, kompozisyon siresi kadardir.

Projeye aktarilan video ve ses dosyalarinin siiresi kompozisyon siiresinden kisa ise katman
siire gubugu video ve ses dosyalarinin siiresine denk uzunlukta olusur (Gorsel 3.75).

Gorsel 3.75: Katman siire ¢ubugu
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Kompozisyona eklenen materyalin siresi kompozisyonun siiresinden uzun ise zaman
cetvelinde olusan siire gubugu, kompozisyon siresi kadardir. Video katmanina ait siire gubugu
farenin sol diigmesine basili tutularak sagdan sola dogru c¢ekildiginde goriinti, sire gubugunun
cekildigi sire kadar basindan kirpilir ve devamindaki gorinti siresi siire cubugunun sonuna
eklenir (Gorsel 3.76).

Gorsel 3.76: Video siiresinin kompozisyon siiresinden uzun olmasi durumu

3.4.1.1. Katman Siiresini Uzatmak veya Kisaltmak

Projeye aktarilan fotograflarin ve calisma alaninda olusturulan katmanlarin siiresini uzatmak
veya kisaltmak icin fare imleci, katman silire cubugunun ug¢ noktalarina goéturildigiinde imleg
sagl ve solu gosteren oklara donisir. Farenin sol digmesine basili tutulup, fare siriiklenerek
katman suresi uzatilabilir veya kisaltilabilir (Gorsel 3.76). Video ve ses dosyalarinin siireleri kendi
surelerinden daha fazla uzatilamaz fakat bu siireler basindan veya sonundan kirpilabilir (Gorsel
3.77).

Kirpilan siire Kirpilan siire

Gorsel 3.77: Suire gubugunun basindan ve sonundan kirpilmasi

Farenin imleci katman slre cubugunun orta bolgelerindeyken farenin sol tusuna basih tutulup,
fare saga veya sola siirliklenerek katman siire cubugunun yeri degistirilebilir (Gorsel 3.78).

Katman siire cubugu 1 ve 10. saniyeler arasinda

Katman siire gubugu 10 ve 20. saniyeler arasinda

Gorsel 3.78: Katman siire gubugunun yerinin degistirilmesi

3.4.1.2. Katman Siiresini Kesmek

Katmanin belirli bir béliminin gorinmesi istendiginde katman siiresi kesilerek sadece
goriinmesi istenen alan birakilir. Gegerli Zaman Gostergesi, katman siire cubugunun Gzerinde
istenen zamana getirilir. Klavyeden Ctrl+Shift+D tuslarina birlikte basildiginda katman o siireden
itibaren iki katmana ayrilir (Gorsel 3.79).
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Video katmani

Video katmani 2 katmana boliind. Ctrl + Shift + D

Video katmani 3 katmana bolindii. Ctrl + Shift + D

Gorsel 3.79: Katman siire gubugunun istenen zamandan kesilmesi

Silinmek istenen katman segilerek klavyeden Delete tusuna basilir.

3.5. YAZI OLUSTURMAK

Gorsel efekt programinda kompozisyona istenen 6zelliklerde yazilar eklenerek bu yazilarla
animasyonlar olusturulabilir. Yazi 6zelliklerinin belirlenebilmesi icin Character (Karakter) ve
Paragraph (Paragraf) panellerinin ¢alisma alanina eklenmesi gerekir.

Character ve Paragraph panellerini ¢alisma alanina eklemek igin Menl ¢ubugundan
Windows>Character ve Paragraph panelleri secilir (Gorsel 3.80).

Window IHa\p
Workspace >
Assign Shorteut to “Default” Workspace >

Find Extensions on Exchange...

Extensions >
v Align
v Audio Cirls4
Brushes Cirl+9
/ Character Cirl+6
+ Content-Aware Fill
Effects 8 Presets Cirl+5

Essential Graphics
+ Info Ctrl+2

Learn
¥ Libraries

Lumetri Scopes

Mask Interpolation

Media Browser

Metadata

Motion Sketch

Paint Ctrl+3
~ Paragraph Ctrl+ 7

v Preview Ctrl+3
Progress
Smoother
V| Tools Ctrie1
v Thacker

Wiggler

~  Composition: Yaz Olugturma
Effect Controls: (none)
Flowchart: (none)
Footage: (none)
Layer: (none)
V| Project CtrieD
Render Queue CtrlAlt+D

+ Timeline: Yaz Olusturma

Create Nulls From Paths,jsxc
VR Comp Editor.jsx

Gorsel 3.80: Character ve Paragraph panellerinin ¢alisma alanina eklenmesi
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Olusturulmak istenen yazinin karakter ozelliklerini belirlemek i¢in ekranin saginda bulunan

Character paneli kullanilir (Gorsel 3.81).

Gorsel 3.81: Character paneli

Olusturulmak istenen yazinin paragraf ozelliklerini belirlemek igin ekranin saginda bulunan

Paragraph paneli kullanilir (Gorsel 3.82).

Gorsel 3.82: Paragraph paneli

Fare imleci Character panelinin Gzerindeyken farenin sol digmesine basilarak panel genisletilir

ve yazl karakteri 6zellikleri agilir (Gorsel 3.83).

[ Yazi rengi belirlenir. |

!

[ Yaz tipi (font) ayarlanir. | <«—j | I:l —> Karakter gerceve rengi belirlenir. |

[ Font &zelligi (kalin, italik) ayarlanir. | <—] |

[ Yaziboyutu ayarlanir. | <— > [Satirlar arasindaki bosluk miktari ayarlanir]

Karakter araligi (Kerning) <« : —>[Harfler arasindaki bosluk miktari ayarlanir]
{ {—>[ Kenarlik yénii belirlenir. |

[ Kenarlik kalinligi ayarlanir. | <
—>[ Harflerin genigligi ayarlanir. |

[Harflerin uzunlugu ayarlanr. | <€—
Harflerin capa noktasina (anchor | —>| Karakterler arasindaki bosluklarin
point) gére yiiksekligi ayarlanir. | | sikistirilmasi orani (tsume) ayarlanir,

!

Kalin, italik, biiyik harf, alt simge, list
simge gibi yazi 6zellikleri belirlenir.

Gorsel 3.83: Character paneli simgelerinin agiklamalari

Fare imleci Pharagraph panelinin Gzerindeyken farenin sol diigmesine basilarak panel genis-

letilir ve paragraf ozellikleri agilir (Gorsel 3.84).

Yazi [saga yasli|ortaya yasli[ sola yash]| olarak ayarlanir.

X"-EI! Paragrafin satir bagi miktarini ve yaziyi
<

Paragrafi ¢apa noktasindan . . . .
{anchor point) saga ya da olugtururken imlecin saga dogru mu
sola ételemek icin kullanili. yoksa yazinin sola dogru mu ilerlemesi

: l gerektigi belirlenir.

Paragraftan once ya da sonra bosluk
birakmak igin kullanihr.

Gorsel 3.84: Paragraph paneli simgelerinin agiklamalan
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3.5.1. Kompozisyona Yazi Katmani Eklemek

Olusturulan kompozisyona yazi katmani eklemek icin farkli yollar kullanilabilir. Birinci yol, arag
cubugunda bulunan ve T seklinde gosterilen Horizontal Type Tool (Yatay harf araci) diigmesinin
secilerek aktiflestirilmesidir (Gorsel 3.85).

Gorsel 3.85: Horizontal Type Tool diigmesi

Composition panelindeki sahnede yazi olusturulmak istenen alana farenin sol digmesiyle
tiklanarak klavyeden istenen yazi girilir. Bu sirada zaman gizelgesinin katman boéliminde adini,
yazilan yazinin ilk kelimelerinden alan bir yazi katmani olusur. Yazi katmani kendi iginde birgok
ozelligi barindinir. Horizontal Type Tool digmesini aktif hale getirmek icin kullanilan kisayolu
Ctrl+T’dir.

Olusturulan kompozisyona yazi katmani eklemenin baska bir yolu ise zaman ¢izelgesi
panelinde katmanlarin bulundugu bolgedeki bos bir yere farenin sag digmesine basilarak
New>Text diigmelerinin sirasiyla secilmesidir (Gorsel 3.86). Zaman ¢izelgesinin katmanlar
boliminde <empty text Layer> isminde bir yazi katmani olusur. Yazi katmani zaman g¢izelgesi
panelinde olustuktan sonra klavyeden istenen yazi girilebilir. Yazi katmaninin ismi, girilen yazinin
ilk birkag kelimesi olarak degisir. Bu isim, katman Uzerinde farenin sag diigmesine basilip, daha
sonra Rename diigmesi secilerek degistirilebilir.

B Yaz Olusturma =

Mew Viewer

Composition Settings... Text

Reveal Composition in Project Solid...
Light...
Camera...
Mull Object
Shape Layer

Preview
Switch View Layout
Switch 3D View

Rename
Adjustment Layer

Open in Essential Graphics mtent e il

Composition Flowchart Adobe Photoshop File...

Composition Mini-Flowchart Maxen Cinema 4D File...

G 4 & Frame Render Time: Oms

Gorsel 3.86: Zaman gizelgesi panelinden yazi katmani ekleme
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Meni ¢cubugundan Layer>New ve Text digmeleri sirasiyla secilerek de kompozisyona yazi
katmani eklenebilir (Gorsel 3.87).

Layer | Effect Animation View Window Help
New Al Text Cirl+Alt+Shift+T |
Layer Settings... Ctrl+Shift+Y Solid... Ctrl+Y
Light... Ctrl+ Alt+Shift+ L
Camera... Ctrl+Alt+5hift+C
Null Object Ctrl+Alt+Shift+Y

Open Layer
Open Layer Source Alt+Numpad Enter

Reveal in Explorer
Shape Layer

L Adjustment Layer CtrleAlt+Y

Mask and Shape Path
Quality

Switches

Content-Aware Fill Layer...
Adobe Photeshop File...

Maxon Cinema 4D File...
Transform

Time

Frame Blending
3D Layer

Guide Layer
Enviranment Layer

Markers >

Preserve Transparency

Blending Made >
Next Blending Maode Shift+=
Previous Blending Mode Shift+-
Track Matte

Layer Styles >

Arrange >
Reveal >
Create >
Camera >

Auto-trace...

Pre-compose... Ctrl+Shift+C

Gorsel 3.87: Kompozisyona Layer meniisiinden yazi katmani ekleme

3.5.2. Yazi Katmani ve Ozellikleri

Katman panelinde yazi katmaninin yanindaki ok simgesine tiklanarak katman parametreleri
actlir. Yazi katmanlari, Transform mentsiine ek olarak Text mentsiine de sahiptir (Gorsel 3.88).

Gorsel 3.88: Yazi katmani 6zellikleri

3.5.3. Text Agilir Meniisii

Text acilir menistiniin solundaki ok simgesine tiklanarak Text parametreleri acilr.

Source Text: Source Text parametresi, kaynak yazinin karakterlerini kapsar. Kaynak yazidaki
harfler, animasyonun belli zaman arali§inda Source Text parametresinden degistirilebilir.
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Path Options: Yaziya lzerinde hareket edebilecegi bir yol atama secenegidir. Kompozisyon
alaninda Pen Tool (kalem araci) veya Rectangle Tool (kare sekli araci) gibi sekil olusturma
araclariyla gizilen sekiller kullanilarak yazinin bu sekil lizerinde hareket etmesi saglanir. Path
digmesinin altinda “yazinin yolu nasil takip edecegiyle ilgili secenekler” bulunur.

More Options: Path Options alaninda yapilan secimlerden daha farkl secenekler bulunur.
Ornegin Anchor Point Grouping seceneginin yanindaki secim listesi acildiginda yazi harflerinin
teker teker veya tamaminin secilmesi yontemiyle “ayni yol Uzerindeki oturma sekilleri”
degistirilebilir.

3.5.4. Transform Agilir Meniisii

Transform o6zelligi, tim katmanlarda standart olarak bulunur. Bu mentide bulunan paramet-
reler sunlardir:

e Anchor Point: Yazinin ¢apa (merkez) noktasinin yerini ayarlar.

e Position: Yazinin X ve Y eksenlerindeki konumunu ayarlar.

e Scale: Yazinin oransal olarak buyuklGgiini ayarlar.

e Rotation: Yazinin ¢apa noktasi etrafinda déndirilmesini saglar.

e Opacity: Yazinin goérunirlik (saydamlik-opaklik) miktarini ayarlar.

3.5.5. Yazi Katmaninin Composition Ekraninda Hizalanmasi

Olusturulan yazi katmanlarini sahnede hizalamak icin ekranin saginda bulunan Allign paneli
kullantlir (Gorsel 3.89).

Gorsel 3.89: Allign paneli
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Allign panelini agcmak icin ekranin Gstiinde bulunan meni c¢ubugunda sirasiyla
Windows>Allign diigmeleri segilir (Gorsel 3.90).

Windowl Help
Workspace »
Assign Shortcut to "Default” Workspace ¥

Find Extensions on Exchange...

Extensions »
. Align I
~  Audio Ctrl+4

Brushes Ctrl+9
~  Character Ctrl+6
~  Content-Aware Fill

Effects & Presets Ctrl+5

Essential Graphics
~  Info Ctrl+2
Learn
~  Libraries
Lumetri Scopes
Mask Interpolation
Media Browser
Metadata
Motion Sketch
Paint Ctrl+8
~  Paragraph Ctrl+7
~  Preview Ctrl+3
Progress
Smoother
~  Tools Ctrl+1
~  Tracker

Wiggler

Gorsel 3.90: Allign panelinin agilmasi

Allign paneli, yazi katmani segiliyken aktif olan hizalama diigmelerine sahiptir (Gorsel 3.91).

[ VYazyisolayaslandi. | <—— > | Yazyialtayaslandir. |
| Yaziyi dikey eksende ortala. | D S —>| Yaziyi yatay eksende ortala. |
| Yaziyi saga yaslandir. | < > | Yaziyi liste yaslandir. |

Gorsel 3.91: Allign paneli diigmeleri

12. UYGULAMA

islem adimlarina gére 5’ten geriye sayan saya¢ animasyonu yapiniz.

1. Adim: Yeni bir proje olusturmak i¢cin menii gubugundan sirasiyla File>New>New Project
seceneklerini seciniz.
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2. Adim: Acilan projede yeni bir kompozisyon olusturmak icin mend ¢ubugundan sirasiyla
Composition>New Composition segeneklerini seginiz.

3. Adim: Ekrana gelen kompozisyon secenekleri menistiinde kompozisyon ayarlarini Gorsel
3.92'deki gibi yapiniz.

Composition Settings X

Gorsel 3.92: Yeni kompozisyon ayarlari

4. Adim: Olusturulan kompozisyona yeni bir Text katmani eklemek icin menl ¢ubugundan
sirasiyla Layer>New>Text diigmelerini seginiz (Gorsel 3.93).

File Edit Composition | Layer | Effect Animation View Window Help

New o[ et Ctrl+-Alt+Shift=T |
Layer Settings... Ctrl+Shift+Y Solid... Ctrl+Y
Open Layer Light... Chrl+Alt+Shift+L
Open Layer Source Alt+Mumpad Enter e CEARTNEE
. i Null Object Ctrl+ Ale+Shift+Y

Reveal in Explorer

Shape Layer
Mask .

Adjustment Layer Ctrl+ Alt+Y
L abellh Content-Aware Fill Layer...
e Adobe Photoshop File...
Switehes Maxon Cinema 4D File...
Transform
Time

Frame Blending

3D Layer

Guide Layer

Environment Layer

Markers »
Preserve Transparency

Blending Made

Next Blending Mode Shift+=
Previous Blending Mode Shift+-
Track Matte

Layer Styles

Amange

Reveal >

Create >

Camera >
Auto-trace...

Pre-compose.. Ctrl+Shift+C

Gorsel 3.93: Kompozisyona Text katmani ekleme
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Bu islemden sonra zaman gizelgesinin katmanlar béliminde <empty text layer> isminde bir
Text katmani olusur (Gorsel 3.94).

Gorsel 3.94: <empty text layer> isimli yazi katmani

5. Adim: Olusturulan yazi katmanina ait 6zellikleri belirlemek icin ekranin saginda bulunan
Character panelinde gerekli ayarlari Gorsel 3.95teki gibi yapiniz.

Gorsel 3.95: Character panelinden yazi katmani ayarlarini yapma

6. Adim: Composition panelini sectikten sonra kompozisyon ekranina 5 sayisini klavyeden
giriniz. Yazdiginiz yaziyr Allign panelini kullanarak ekranin ortasina tasiyiniz (Gorsel 3.96).

Gorsel 3.96: Klavyeden yazi girilmesi

7. Adim: Zaman imlecini 0. saniye konumuna aliniz. Text acilir menisine ait Source Text
diigmesinin solundaki kronometre simgesine farenizin sol tusuyla basarak 0. saniye konumuna
anahtar kare eklenmesini saglayiniz (Gorsel 3.97).

Gorsel 3.97: Source Text ayar diigmesine anahtar kare eklenmesi
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8. Adim: Zaman imlecini 1. saniye konumuna aliniz ve Composition ekraninda bulunan 5
rakaminin Uzerine ¢ift tiklayarak klavyeden 4 rakamini giriniz (Gorsel 3.98).

1. saniye konumunda yazi degistirildiginde 1. saniyeye otomatik olarak bir anahtar kare
eklenecektir. Bunun anlami; zaman 0 ve 1. saniyeler araligindayken ekranda 5 rakami goriinecek,
zaman imleci 1. saniyeye ulastiginda ekranda 4 rakami gorinecektir (Gorsel 3.98).

Gorsel 3.98: 1. saniye konumunda yaziyi degistirme

9. Adim: Zaman imlecini 2. saniyeye alip Composition ekranindaki rakami 3 olarak degistiriniz.
Daha sonra zaman imlecini 3. saniyeye alip Composition ekranindaki rakami 2 olarak degistiriniz.
Bu islem adimlarini zaman imleci 5. saniye konumundayken Composition ekranindaki rakami 0
olacak sekilde degistirinceye kadar strdtrtintiz (Gorsel 3.99).

Gorsel 3.99: Source Text ile yaziyi degistirme
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10. Adim: Zaman imlecini 0. saniye konumuna aldiktan sonra klavyeden bosluk digmesine

basarak olusturdugunuz animasyonu inceleyiniz.

11. Adim: Projeyi bilgisayariniza kaydediniz.

SIRA SiZDE

1’den baslayarak 5’e kadar birer saniye araliklarla sayan bir uygulama yapiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi

yaparken degerlendirme olgutlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Yeni proje olusturdu.

2. Yeni kompozisyon olusturdu.

3. Yeni text katmani ekledi.

4. Source Text 6zelliginin degerlerini degistirerek anahtar kareler ekledi.

5. Projeyi bilgisayara kaydetti.

13. UYGULAMA

islem adimlarina gére Animate 6zelligini kullanarak Text animasyonu olusturunuz.

1. Adim: Yeni bir proje olusturunuz ve agilan projeye Gorsel 3.100’deki ayarlara sahip bir

kompozisyon ekleyiniz.
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Composition Settings X

Gorsel 3.100: Kompozisyon ayarlari

2. Adim: Yeni bir yazi katmani olusturmak igin zaman gizelgesi panelinin katmanlar kisminda
bos bir alana farenizle sag tiklayarak acgilan meniden sirasiyla New>Text digmelerini seginiz
(Gorsel 3.101).

B Text Animat

Viewer

Composition Settings.. Text

Reveal Compuosition in Project Solid...
Light...

Camera...

Preview

Switch View Layout
Switch 3D View Null Object
Rename Shape Layer
Adjustment Layer
Open in Essential Graphics .
Composition Flowchart Pl e

Composition Mini-Flowchart Maxon Cinema 4D File...

Gorsel 3.101: Yeni bir Text katmani olusturma

3. Adim: Character panelinde yazi ayarlarini Gorsel 3.102°de gorildigi gibi yapiniz.

Character

Calibri

Gorsel 3.102: Character paneli ayarlari
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6. Adim: Composition panelini sectikten sonra yazmak istediginiz yaziyi klavyeden giriniz.
Yazdiginiz yaziyi arag¢ ¢ubugundaki Allign panelini kullanarak ekranin ortasina tasiyiniz (Gorsel
3.103).

Gorsel 3.103: Klavyeden yazi yazma

7. Adim: Zaman gizelgesindeki katman alaninda bulunan yazi katmanina ait meniyi agabilmek
icin katmanin isminin solunda bulunan ok simgesine basiniz. Agilan mentde Animate diigmesine
tiklayiniz. Bu mentide dogrudan katmana uygulanabilecek bazi animasyonlar bulunur (Goérsel
3.104).

Enable Per-character 3D

Anchor Point
Position

Scale

Skew

Rotation

Opacity

All Transform Properties

Fill Coler >
Stroke Color >
Stroke Width

Tracking
Line Ancher
Line Spacing
Character Offset

Character Value

Blur

Gorsel 3.104: Animate mendisii

8. Adim: Yazi katmaninda karakterlerin konumlarini degistirerek animasyon olusturmak igin
Animate menisitnde bulunan Position diigmesini se¢iniz. Animator 1 mensi yazi katmanina
eklenecektir (Gorsel 3.105).

Gorsel 3.105: Animator 1 meniisu
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Animator 1 menilsi altinda Range Selector 1 alt menisi ve katmana eklenen Position
animasyonu bulunur.

Range Selector 1 alt mendisiinde animasyonun hangi uzunlukta olacagi ayarlanir. Start, O ile
100 arasinda bir deger alir. 0 degeri yazilan yazinin ilk karakterine, 100 degeri ise yazilan yazinin
son karakterine denk gelir (Gorsel 3.106).

Gorsel 3.106: Range Selector 1 alt meniisii

9. Adim: Range Selector 1 alt men(su altinda bulunan Start degerine anahtar kare eklemek igin
zaman imleci 0. saniye konumundayken diigmenin solunda bulunan Stop watch (Kronometre)
digmesine basiniz. Zaman imlecini 5. saniye konumuna alip, Start degerini 100 olarak ayarlayiniz
(Gorsel 3.107).

0. Saniye 5. Saniye
Start degeri =0 Start degeri =100

Gorsel 3.107: Start degerine anahtar kare eklemek

Boylece Start degerinin 5 saniyelik sirede 0’dan 100’e dogru hareket etmesi saglanir. Yazilan
yazi lizerinde Start degerinin gosterdigi karakter, o anda Position degerinin gosterdigi konumdan
baslayarak ilk bulundugu konuma dogru hareket eder. Yazilan yazi lGzerinde Stop degerinin
gosterdigi karakter ise o anda yazinin bulundugu ilk konumdan baslayarak Position degerinin
gosterdigi konuma dogru hareket eder.

10. Adim: Position ayarinin Y ekseninde hareketi saglayan ikinci degeri, yazilan yazinin ekranin
disina ¢ikmasini saglayacak sekilde degistiriniz (Gorsel 3.108).

Gorsel 3.108: Position degerinin degistirilmesi

11. Adim: Klavyenizden bosluk tusuna basarak olusturdugunuz animasyonu inceleyiniz.
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Yazilan yazi karakterlerinin 5 saniyede sirasiyla ekranin disindan baslayarak ilk konumlarina
dogru hareket ettigi gorilir (Gorsel 3.109).

Gorsel 3.109: Yazi animasyonu

Add o6zelligi kullanilarak Animator 1 mendsiine yeni animasyonlar eklenebilir.

12. Adim: Harflerin asagidan yukari dogru gelirken kicllmesi islemi icin Animator 1
mendsiiniin solunda bulunan Add menusiine farenizin sol digmesiyle basiniz. Ardindan sirasiyla
Property>Scale diigmelerini seginiz (Gorsel 3.110).

Gorsel 3.110: Katmana yeni animasyon ekleme

Scale degerinin Animator 1 menistline eklendigi goruliir (Gorsel 3.111).

Gorsel 3.111: Animator 1 menisiinde Scale degerinin goriilmesi

13. Adim: Scale degerini 200 olarak degistiriniz (Gorsel 3.112).

Gorsel 3.112: Scale degeriyle animasyon olusturma
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14. Adim: Klavyenizden bosluk tusuna basarak olusturdugunuz animasyonu inceleyiniz.

15. Adim: Projeyi bilgisayariniza kaydediniz.

14. UYGULAMA

islem adimlarina gére Text katmanina hazir animasyonlar ekleyiniz.
1. Adim: Yeni bir proje olusturmak i¢in menii gubugundan sirasiyla File>New>New Project
seceneklerini seciniz.

2. Adim: Agilan projede yeni bir kompozisyon olusturmak icin menid ¢ubugundan sirasiyla
Composition>New Composition seceneklerini seginiz.

3. Adim: Ekrana gelen kompozisyon segenekleri menisiinde kompozisyon ayarlarini Gorsel
3.113’te goruldugl gibi yapiniz.

Composition Settings X

Gorsel 3.113: Yeni kompozisyon ayarlari

4. Adim: Olusturulan kompozisyona yeni bir Text katmani eklemek icin menl ¢ubugundan
siraslyla Layer>New>Text diigmelerini seginiz.

Bu islemden sonra zaman gizelgesinin katmanlar bolimiinde <empty text layer> isminde bir
Text katmani olusur (Gorsel 3.114).

Gorsel 3.114:<empty text layer> isimli Text katmani
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5. Adim: Olusturulan yazi katmanina ait 6zellikleri belirlemek icin ekranin saginda bulunan
Character panelinde gerekli ayarlari Gorsel 3.115te goruldigu gibi yapiniz.

Gorsel 3.115: Character panelinde Text katmani ayarlarini yapma

6. Adim: Composition panelini sectikten sonra kompozisyon ekraninda klavyeden istediginiz
yaziyi giriniz. Yazdiginiz yaziyi Allign panelini kullanarak ekranin ortasina taslyiniz (Gorsel 3.116).

Gorsel 3.116: Klavyeden yazi girilmesi

Olusturulan yazi katmanina hazir animasyonlar eklemek igin ekranin saginda Effect &
Presets panelinde bulunan Animation Presets efektleri kullanilir. Animation Presets, icinde
siniflandirilarak klasorlere ayrilmis bircok efekt barindirir. Effect & Presets paneli ekranin saginda
gorinmiyorsa Window menistinden Effect & Presets segilerek panel aktiflestirilir (Gorsel 3.117).
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Gorsel 3.117: Effect & Presets paneli

7. Adim: Yazi katmanina hazir animasyon eklemek i¢in yazi katmani seciliyken Effect & Presets
panelinde sirasiyla Animation Presets>Text>Blurs diigmelerini seciniz. Daha sonra Foggy efektine
¢ift tiklayarak animasyonun yazi katmanina uygulanmasini saglayiniz (Gorsel 3.118).

Gorsel 3.118: Effect & Presets panelinde Foggy efekti
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Foggy efekti, yazi karakterlerinin soldan saga dogru bulanikliginin giderilerek netlesmesi
animasyonudur (Gorsel 3.119).

Gorsel 3.119: Foggy efekti

Animasyonun yazi katmanina uygulanmasiyla beraber yazi katmanina Foggy efekti menisi
eklenir. Hazir animasyonlar kendi icinde daha 6nceden olusturulmus bazi 6n ayarlar ve anahtar
karelerle gelir. Burada animasyonun siresinin uzatilmasi icin Offset ayarina ait 2. anahtar kare
ileri bir slireye cekilir. Ayrica Scale, Opacity ve Blur ayarlari degistirilerek animasyondaki boyut,
goriandrliuk ve bulanikhk degerleri degistirilebilir (Gorsel 3.120).

Gorsel 3.120: Yazi katmani iginde Foggy efekti meniisi

8. Adim: Offset degerine atanan ikinci anahtar kareyi farenizin sol tusuyla tutup sirikleyerek
ileriki bir zamana tasiyiniz.

9. Adim: Scale, Opacity ve Blur degerlerini degistirdikten sonra animasyonu oynatarak olusan
etkileri gbzlemleyiniz.

10. Adim: Yazi katmaninda bulunan Foggy Animator efektini secip, klavyenizden Delete
digmesine basarak siliniz.

11. Adim: Yazi katmani seciliyken Effect & Presets panelinde sirasiyla Animation
Presets>Backgrounds digmelerini seciniz. Daha sonra Deep Tissue efektine cift tiklayarak
animasyonun yazi katmanina uygulanmasini saglayiniz (Gorsel 3.121).
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Gorsel 3.121: Effect & Presets panelinde Deep Tissue efekti

Deep Tissue, yazi katmanina hareketli bir arka plan efekti uygulanmasini saglar (Gorsel 3.122).

Gorsel 3.122: Deep Tissue efekti

12. Adim: Yazi katmanina Effect & Presets panelinden Animation Presets>Text klasorleri
altindaki diger hazir animasyonlari ekleyerek sonuglari gézlemleyiniz.

3.6. SEKiL OLUSTURMAK

Geometrik sekillerin olusturulmasi igin sekil araglari kullanilir. Ekranin st kisminda
bulunan ara¢ c¢ubugu panelinde Rectangle Tool varsayllan bulunur. Bunun
disinda gorsel efekt programinda dort temel sekil araci daha vardir. Bunlar;
Rounded Rectangle Tool, Ellipse Tool, Polygon Tool ve Star Tool araglaridir. Diger
dort sekil aracini aktif etmek icin Rectangle Tool aracina farenin sol digmesiyle bir middet
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basili tutulur. Boylece diger sekil araglarinin bulundugu men agilir ve ¢izilmek istenen sekil araci
secilir (Gorsel 3.123).

Gorsel 3.123: Sekil olusturma araglar

Temel sekil araglarinin disinda arag cubugundaki Pen Tool ile 6zel sekiller gizilir (Gorsel 3.124).

N O T, S L& i *

Gorsel 3.124: Pen Tool

3.6.1. Temel Sekil Araglariyla Sekil Olusturmak

Arac cubugundan Sekil araci secilir. Farenin imleci kompozisyon ekranina gotirildigiinde
imlecin seklinin degistigi gorilir. Bundan sonra kompozisyon ekraninda farenin sol digmesine
basili tutulup, fare siiriiklenerek sekil gizilir. istenen sekil cizildiginde zaman ¢izelgesinin katmanlar
bolimiine Shape Layer 1 isminde sekil katmani eklenir. Shape Layer 1 katmaninin Contents
kisminda ise ¢izilen seklin ismi gorilir (Gorsel 3.125).

Gorsel 3.125: Sahneye sekil ¢izme

Katman panelinde herhangi bir sekil katmani segiliyken sahneye sekil gizildiginde olusan yeni
sekil, kompozisyona yeni katman olarak eklenmez. Cizilen yeni sekil, secili katmanin icine eklenir.
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Boyle bir durumda katmanda yapilan buttin degisiklikler, olusan yeni sekle de uygulanir.
Shape Layer 1 seciliyken sahneye cizilen yeni sekil, Shape Layer 1’in Contents 6zelligine eklenir
(Gorsel 3.126).

Gorsel 3.126: Ayni katmana sekil gizme

Seklin ayri bir katmanda ¢izilmesi i¢in katman bolimiinde herhangi bir sekil katmaninin segili
olmamasi gerekir. Katmana ait Transform 6zellikleri ayni katmanin Contents bélimiinde bulunan
batin sekiller icin ortaktir (Gorsel 3.127).

Gorsel 3.127: Sekil katmaninin 6zellikleri
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Composition panelinde bulunan iki farkli seklin ayri Transform o6zelliklerine sahip olmasi
istenirse bu iki sekil, farkli sekil katmanlarinda bulunmaldir. Bu nedenle yeni bir katman
olusturulacagi zaman katman bolimiinde segili bir katman olmamalidir (Gorsel 3.128).

Gorsel 3.128: Sekillerin farkh katmanlarda bulunmasi

Katman panelinde sekil katmani disinda bir katman (gorsel veya video katmani) segiliyken
sahneye sekil cizildiginde secili katman Gzerinde Maske olusturulur (Gorsel 3.129, Gorsel 3.130).

Gorsel 3.129: Katman maskesi eklenecek gorsel

Gorsel 3.130: Seklin katman maskesi olarak kullanilmasi
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3.6.2. Kalem Araciyla Ozel Sekiller Olusturmak

Serbest gizimler olusturmak icin ara¢ gubugundan Pen Tool segcilir (Gorsel 3.131).

Gorsel 3.131: Pen Tool

Kalem araci kullanilarak serbest gizimler olusturmak igin ara¢ ¢ubugundan kalem araci
secildikten sonra Composition panelinde sahnede bir noktaya farenin sol diigmesiyle basilir.
Farenin imleci farkh bir noktaya gotiurilip tiklanarak ikinci bir nokta belirlenir. Birinci nokta ile

ikinci nokta arasinda diiz bir gizgi olustugu gorilir. Bundan sonra fare ile belirlenen baska bir
noktada ¢izim devam ettirilebilir (Gorsel 3.132).

Gorsel 3.132: Sahneye Pen Tool ile serbest ¢gizim olusturma

Cizilen seklin ¢izgi kalinhg ve iginin herhangi bir renkle dolu olup olmayacagi belirlenebilir.
Cizgi kalinliginin kag piksel olacagi (sekil katmani seciliyken) ekranin st kismindaki px degeri ile
belirlenir. Cizgi rengi ise ekranin Ust kisminda bulunan Stroke alanindan segcilir (Gorsel 3.133).

Gorsel 3.133: Cizilen seklin kalinhgi ve dolgu rengi ayarlan

Hareketli Goruntiler

207



Seklin icinin herhangi bir renk ile dolu olup olmayacagi veya seklin ici doluysa hangi renk
olacagl ekranin Ust kismindaki Fill digmesi ile belirlenir. Fill digmesine basildiginda agilan
meniide birinci siradaki Gzeri kirmizi gizgili beyaz digme None (Higbiri) secildiginde cizilen seklin
dolgu rengi kaldirilarak seklin ici bos hale gelecektir (Gorsel 3.134).

Gorsel 3.134: Cizilen seklin dolgu renginin silinmesi

Dolgu rengini degistirmek icin Fill digmesinin yanindaki renk diigmesine basilir. Agilan renk
paletinden istenen renk segcilir (Gorsel 3.135).

Gorsel 3.135: Cizilen seklin dolgu renginin belirlenmesi

3.6.3. Cizilen Seklin Koselerini Egimli Yiizeyler Haline Doniistiirmek

Pen Tool araci ile serbest gizim yapildiktan sonra gizimin bazi késeleri egimli hale getirilmek
istenebilir. Bunu yapmak icin ekranin tst kisminda Pen Tool aracina farenin sol diigmesiyle basili
tutulur. Agilan menide Convert Vertex Tool (Kdse doniistiirme araci) secilir (Gorsel 3.136).
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Gorsel 3.136: Convert Vertex Tool

Composition ekraninda cizilen seklin koselerindeki baglanti noktalarindan siriklenerek, bu
koseler siirikleme miktarina bagli olarak istenen seviyede egimli hale getirilir (Gorsel 3.137).

Egimli hale getirilmek
istenen nokta

i

Farenin sol digmesiyle
tutulup surtklenir.

o

Gorsel 3.137: Cizilen seklin kdselerinin egimli hale getirilmesi

3.6.4. Cizilen Sekle Yeni Koseler Eklemek ve Koseleri Silmek

Pen Tool araci ile serbest gizim yapildiktan sonra gizime bazi yeni kdselerin eklenmesi veya var
olan koselerin silinmesi istenebilir. Cizime yeni kdselerin eklenmesi icin ekranin st kisminda Pen
Tool aracina farenin sol digmesiyle basili tutulur. Acilan meniide Add Vertex Tool araci segilir. Var
olan koselerin silinmesi icin Delete Vertex Tool (Kose silme araci) segilir (Gorsel 3.138).

Gorsel 3.138: Add Vertex Tool ve Delete Vertex Tool
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Eklenen koseler arag cubugundaki Selection Tool ile istenen yere tasinabilir (Gorsel 3.139).

Yeni kdse eklemek istenen yerler

Késeler Selection Tool
araci ile istenen yere
tasinabilir.

Gorsel 3.139: Cizilen sekle yeni koseler eklenmesi

3.6.5. Sekil Katmanina Eklenebilen Diizenleyiciler

Contents alt menUsilinin karsisindaki Add digmesi ile acilir meniden cizilen sekle, sekil
Uzerinde degisiklikler yapilabilmesini saglayan diizenleyiciler eklenebilir (Gorsel 3.140).

B Compl =

of)ed W - 4

o 1 | Shape Layer 1 *

Normal Group (empty)
Rectangle
Ellipse

Palystar

Path

Fill

Stroke
Gradient Fill
Gradient Stroke

Merge Paths
Offset Paths.
Pucker & Bloat
Repeater

Round Corners
Trim Paths

Twist

Wiggle Paths
Wiggle Transform
Zig Zag

Gorsel 3.140: Add mendisii
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15. UYGULAMA

islem adimlarina gére Repeater, Twist, Wiggle Paths degistiricilerini katmanlara
ekleyerek animasyonlar olusturunuz.

1. Adim: Yeni bir proje olusturmak i¢cin menii cubugundan sirasiyla File>New>New Project
seceneklerini seginiz.

2. Adim: Agilan projede yeni bir kompozisyon olusturmak icin meni ¢ubugundan sirasiyla
Composition>New Composition seceneklerini seginiz.

3. Adim: Ekrana gelen kompozisyon secenekleri meniisiinde kompozisyon ayarlarini Gorsel
3.141’de gorildigi gibi yapiniz.

Gorsel 3.141: Yeni kompozisyon ayarlari

4. Adim: Kompozisyon ekranina Fill, Stroke ve px 0Ozellikleri Gorsel 3.142’de goruldUgu gibi
bir cember sekli ¢iziniz. Cizdiginiz cember seklini Move Tool araci ile ekranin sol (st késesine
tasiyiniz.

Gorsel 3.142: Cember sekli gizilmesi
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5. Adim: Repeater degistiricisini cember sekil katmanina ekleyiniz (Gorsel 3.143).

Gorsel 3.143: Sekil katmanina Repeater degistiricisi ekleme

Repeater degistiricisi, cizilen seklin kopyalanarak yan yana siralanmasini saglar.

6. Adim: Contents mentsiline eklenen Repeater menisiindeki Copies degeri, kopya sayisinin
belirlenmesini saglar. Bu degeri 6 olarak ayarlayiniz (Goérsel 3.144).

6 adet cember olusturulur.

Gorsel 3.144: Repeater degistiricisi menlisi

212 | Hareketli Goruntller



7. Adim: Cemberlerin birbirlerine olan uzakhgini belirlemek icin Transform: Repeater 1
mensi icindeki Position degerini degistiriniz (Gorsel 3.145).

Gorsel 3.145: Position degerinin degistirilmesi

8. Adim: Transform: Repeater 1 mendisi icindeki Scale diigmesi ile animasyon olusturmak igin
zaman ¢izelgesinde Scale degerini %0 olarak ayarladiktan sonra zaman gizelgesinin 0. saniyesine
anahtar kare ekleyiniz. Zaman imlecini 5. saniyeye alarak, Scale degerini %100 olarak ayarlayiniz.
Zaman ¢izelgesinin 5. saniye konumuna otomatik olarak anahtar kare eklenir (Gorsel 3.146).

Gorsel 3.146: Scale degerine anahtar kare eklenmesi

9. Adim: Zaman imlecini 0. saniye konumuna alarak bosluk diigmesiyle animasyonu oynatiniz.
Ekrandaki cember sekillerinin zamanla blylyerek belirdigi gorulir (Gorsel 3.147).

Gorsel 3.147: Olusturulan animasyonun 6n izlemesi
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10. Adim: Cember seklinin bulundugu sekil katmanini secerek Delete digmesi ile siliniz.
Kalem aracini segerek ekranin ortasina Fill, Stroke ve px 6zellikleri Gorsel 3.148'de gorildugi gibi
diz bir gizgi giziniz.

Gorsel 3.148: Kalem araci ile sahnede ¢izim yapilmasi

11. Adim: Twist degistiricisini cember sekil katmanina ekleyiniz (Gorsel 3.149).

Gorsel 3.149: Twist degistiricisinin sekil katmanina eklenmesi

Twist degistiricisi, istenen tur sayisinca, belirlenen bir referans noktasindan itibaren cizilen
seklin kivrilmasini saglar.

7. Adim: Contents mendsiline eklenen Twist menisiinde bulunan Angles (Agi) degeri seklin
kag derece kivrilacaginin belirlenmesini saglar. Bu degeri 1000 olarak ayarlayiniz. Center (Merkez)
degeri ise seklin kivrilirken hangi noktanin referans alinacagini belirler (Gorsel 3.150).
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Gorsel 3.150: Twist degistiricisi

8. Adim: Contents menusiine eklenen Twist menisini secip, klavyeden Delete digmesine
basarak siliniz (Gorsel 3.151).

Gorsel 3.151: Degistiricinin katmandan silinmesi

9. Adim: Wiggle Paths degistiricisini gember sekil katmanina ekleyiniz (Gorsel 3.152).

Gorsel 3.152: Wiggle Paths degistiricisinin sekil katmanina eklenmesi
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Wiggle Paths degistiricisi, cizilen seklin rastgele noktalardan rastgele miktarlarda sallanmasini
saglar. Wiggle Paths degistiricisi katmana uygulandiginda anahtar kare eklenmesine gerek
kalmadan animasyon olusur.

Contents menusiline eklenen Wiggle Paths menuslndeki degerler sunlardir:

Size degeri, hareketin dikey eksende blylkliguni belirler.

Detail degeri, hareketin yatay eksende sikhgini belirler.

Points degeri, kdselerin sivri uglardan mi yoksa yumusak hatlardan mi olusacagini belirler.
Wiggles/Seconds degeri, saniyede olusacak hareket sayisinin belirlenmesini saglar. Bu deger

0 girildiginde sallanma hareketi olusmaz.

10. Adim: Wiggle Paths menistindeki degiskenlere farkli degerler vererek olusan animasyonu
oynatiniz. Degiskenlere atanan degerlerin etkilerini gozlemleyiniz.

16. UYGULAMA

islem adimlarina gére Trim Path komutunu kullanarak sekil katmaniyla animasyon
olusturunuz.

1. Adim: Daha 6nce kaydedilen 5’ten Geriye Sayma uygulamasinda kaydettiginiz animasyonu
acmak icin mend cubugundan sirasiyla File>Open Project digmelerini seciniz. Kaydettiginiz
dosyayi secerek aginiz (Gorsel 3.153).

Gorsel 3.153: Kaydedilen bir dosyanin agilmasi

2. Adim: Ara¢ c¢ubugunda bulunan Ellipse Tool aracini seciniz. Composition ekraninda
bulunan sahneye cizilen seklin tam bir daire olmasini saglamak igin ¢izim yaparken klavyeden
Shift digmesine basili tutunuz.
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3. Adim: Sahnedeki dairenin ¢izgi kalinligini 40 px olacak sekilde ayarlayiniz. Allign panelindeki
digmeleri kullanarak daire seklini sahnede ortalayiniz (Gorsel 3.154).

Gorsel 3.154: Sekil katmani 6zelliklerinin belirlenmesi

4. Adim: Daire seklini kesikli gizgiler haline getirmek igin sekil katmaninda, Contents>Ellipse
alt mendilerinin icinde, ¢izgi ayarlarinin yapildigi Stroke bolimiinde bulunan Dashes digmesinin
yanindaki + digmesini seginiz. Kesikli ¢cizgi kalinligi degerini Dash diigmesini kullanarak ayarlayiniz
(Gorsel 3.155).

Gorsel 3.152: Sekil katmani 6zelliklerinin belirlenmesi

Gorsel 3.155: Dash diigmesiyle kesikli ¢izgi olugturma
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Animasyon oynatildiginda daire sekline ait ¢izgilerin saat yoniinden baslayarak kaybolmasini
saglamak icin sekil katmanina Trim Path animasyonu eklenir.

5. Adim: Sekil katmanina Trim Path animasyonu eklemek igin dnce Contents menisiinin
yanindaki Add digmesini sonra acgilan meniden Trim Path digmesini seciniz (Gorsel 3.156).

Group (empty)

Normal
Rectangle
2 Ellipse
Polystar

Path

Fill

Stroke
Gradient Fill
Gradient Stroke

Merge Paths
Offset Paths
Pucker & Bloat
Repeater
Round Corners
Twist
Wiggle Paths
Wiggle Transform

ZigZag

Gorsel 3.156: Sekil katmanina Trim Path animasyonu ekleme

Boylece Trim Paths 1 menisii Contents mendsiinlin icine eklenir. Start ve End degerleri,
gizilen seklin bastan veya sondan belli bir yizdelik kisminin kirpilmasi islemini gerceklestirir
(Gorsel 3.157).

Gorsel 3.157: Thrim Paths meniisii

6. Adim: Cizilen sekil sondan basa dogru kaybolacagi igin Start degerini %100’e, End degerini
%0’a ayarlayiniz (Gorsel 3.158).

Simultaneo

Gorsel 3.158: Start ve End parametrelerinin belirlenmesi
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7. Adim: Zaman ¢izelgesinde zaman imlecini 0. saniye konumuna aliniz ve End degerine bir
anahtar kare koyunuz.

8. Adim: Zaman gizelgesinde zaman imlecini 5. saniye konumuna aliniz ve End degerini %100
olarak ayarlayiniz. 5. saniye konumuna otomatik olarak anahtar kare kondugu gorulir (Gorsel
3.159).

Gorsel 3.159: End parametresine anahtar kare eklenmesi

9. Adim: Zaman ¢izelgesinde zaman imlecini 0. saniye konumuna aliniz. Animasyonu oynatarak
inceleyiniz (Gorsel 3.160).

Gorsel 3.160: Olusturulan animasyonun oynatilmasi

SIRA SiZDE

bikilmesini saglayiniz. Ardindan Trim Path komutu ile gizginin bir ucundan baslayarak

zamanla kaybolmasini saglayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LIiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. Yeni proje olusturdu.

2. Yeni kompozisyon olusturdu.

3. Yeni sekil katmani ekledi.

4. Sekil katmanina Twist degistiricisi ekledi.

5. Sekil katmanina Trim Path komutu uyguladi.

6. Sekil katmanina anahtar kareler ekledi.

7. Projeyi bilgisayara kaydetti.
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17. UYGULAMA

islem adimlarina gore cizilen sekil katmanini Text katmanina ait bir yol seklinde
atayarak animasyon olusturunuz.

1. Adim: Yeni bir proje olusturmak i¢in menl gubugundan sirasiyla File>New>New Project
segeneklerini seginiz .

2. Adim: Acilan projede yeni bir kompozisyon olusturmak icin mend ¢ubugundan sirasiyla
Composition>New Composition seceneklerini seginiz.

3. Adim: Ekrana gelen kompozisyon segenekleri menisiinde kompozisyon ayarlarini yapiniz.

4. Adim: Olusturulan kompozisyona yeni bir Text katmani eklemek icin menl ¢cubugundan
siraslyla Layer>New>Text diigmelerini seginiz.

5. Adim: Olusturulan yazi katmanina ait 6zellikleri belirlemek igin ekranin saginda bulunan
Character panelinde gerekli ayarlari Gorsel 3.161'de gorildigi gibi yapiniz.

Gorsel 3.161: Character panelinden yazi (text) katmani ayarlarini yapma
6. Adim: Composition panelini sectikten sonra yazmak istediginiz yaziyi klavyeden giriniz.

Daha sonra yazdiginiz yaziyi arag¢ cubugundaki Allign panelini kullanarak ekranin ortasina taslyiniz
(Gorsel 3.162).

Gorsel 3.162: Klavyeden yazi girilmesi
7. Adim: Zaman gizelgesinin katmanlar bélimindeki Text katmani segiliyken ara¢ ¢ubugunda

bulunan Ellipse Tool aracini aktif hale getiriniz. Klavyeden Shift tusuna basili tutarak, Composition
ekraninda farenizi strikleyerek bir cember sekli ¢iziniz.
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Cember sekli gizilirken yazi katmani secili oldugu icin cizilen sekil, yazi katmaninin bir maskesi
olur (Gorsel 3.163).

Gorsel 3.163: Yazi katmaninda gember seklinde maske olusturulmasi

8. Adim: Yazi katmaninin Path Options acilir penceresine ait bir parametre olan Path deger
kutucugunda Mask 1 degerini seciniz (Gorsel 3.164).

Gorsel 3.164: Path degerine Mask 1 degerinin atanmasi
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Boylece Mask 1 (cember sekli) maskesi, Gzerinde yazinin hareket edebilecegi bir yol haline
gelir (Gorsel 3.165).

Gorsel 3.165: Cember seklinin yazi katmani igin Path olarak kullaniimasi

9. Adim: Yazi katmaninin Path Options acilir penceresine ait bir parametre olan Reverse Path
ayarini On konumuna getiriniz. Boylece olusturulan yazi, cember seklinin dis ceperinde hizalanir
(Gorsel 3.166).

Gorsel 3.166: Reverse Path ayarinin On konumuna getirilmesi

10. Adim: Yazi katmaninin Path Options acilir penceresine ait bir parametre olan Force
Allignment ayarini On konumuna getiriniz. Boylece olusturulan yazi, cember seklinin ¢evresinin
tamamini kaplayacak sekilde hizalanir (Gorsel 3.167).
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Gorsel 3.167: Force Allignment ayarinin On konumuna getirilmesi

Yazi katmaninin Path Options acilir penceresine ait bir parametre olan First Margin ayari 0 iken
cember seklinin etrafinda hizalanan yazinin son harfi ile ilk harfi arasinda hi¢ bosluk olmayacaktir
(Gorsel 3.168).

Gorsel 3.168: First Margin ayarinin 0 olmasi durumu

11. Adim: First Margin ayarini artirarak cember seklinin etrafinda hizalanan yazinin son harfi
ile ilk harfi arasinda bir miktar bosluk olmasini saglayiniz (Gorsel 3.169).

Gorsel 3.169: First Margin ayarinin 100 olmasi durumu
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12. Adim: Yazinin cember etrafinda dénmesi animasyonunu olusturmak icin zaman imlecini
0 konumuna alarak First Margin ve Last Margin ayarlarinin solunda bulunan Stop-watch
digmelerine basiniz. Boylece zaman ¢izelgesinde bu ayarlara ait anahtar kareler olusur (Gorsel
3.170).

Gorsel 3.170: First Margin ve Last Margin ayarlarina anahtar karelerin eklenmesi

13. Adim: Zaman imlecini 5. saniye konumuna alarak First Margin degerini 2100’e, Last Margin
degerini 2000’e ayarlayiniz. Bu ayarlardan sonra zaman ¢izelgesinde 5. saniye konumuna anahtar
kareler otomatik olarak eklenecektir (Gorsel 3.171).

Gorsel 3.171: First Margin ve Last Margin ayarlarina ikinci anahtar karelerin eklenmesi

14. Adim: Zaman imlecini 0. saniye konumuna aldiktan sonra klavyeden bosluk diigmesine
basarak olusturulan animasyonu inceleyiniz.

15. Adim: Proje dosyasini kaydetmek icin arac cubugundan sirasiyla File>Save As>Save As...
digmelerini seciniz (Gorsel 3.172).

Gorsel 3.172: Projeyi kaydetme
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16. Adim: Acilan pencereden projeye bir isim veriniz ve dosyanin bilgisayarda kaydedilecegi

konumu belirleyip Kaydet digmesine basiniz (Gorsel 3.173).

Gorsel 3.173: Projeye isim verme ve projenin kayit yerini belirleme

3.6.6. Kukla Araci (Puppet Pin Tool)

Puppet Pin Tool, hareketsiz nesnelere baglanti noktalari ekleyerek bu noktalarla nesneye
hareket verilmesini saglar. Hareket verilecek nesne bir karakter gorseli ise bu gorselin arka plani
seffaf, png uzantili bir gérsel olmasi tercih edilir.

Puppet Pin Tool, ara¢ cubugunda bulunur. Varsayilan olarak ayarlanmis Puppet Position Pin
Tool simgesinin altinda farkli hareket ayarlari yapilmasini saglayan Puppet araglari vardir (Gorsel
3.174).

N O T 1L & i

Gorsel 3.174: Puppet Pin Tool meniisii

18. UYGULAMA

islem adimlarina gére karakter ile el sallama animasyonu olusturunuz.

1. Adim: Olusturdugunuz proje ve kompozisyonda hareket verilecek gorseli katman bolimiine
taslyiniz. Gorsel 3.175’te goriilen karakter ile el sallama animasyonu olusturulacaktir.

Gorsel 3.175: Animasyon olusturulacak karakter
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2. Adim: Zaman ¢izelgesinde zaman imlecini 0. saniye konumuna aliniz ve ara¢ cubugundan
Puppet Position Pin Tool seginiz (Gorsel 3.176).

Gorsel 3.176: Puppet Position Pin Tool

Sahnede fare imlecinin seklinin degistigi gorilecektir. Bu asamadan sonra karakterin hareket
ettirilecek ve hareketten etkilenecek bolgelerine farenin sol digmesi ile pinler eklenir.

3. Adim: Gorselde gosterilen noktalara pinler ekleyiniz (Gorsel 3.177).

Gorsel 3.177: Pin eklenecek noktalar

Hareket ettirilecek gorsel lizerinde pinler olusturuldugu anda zaman cizelgesinin katman
bolimindeki Effects menisi altinda Puppet 6zelligi eklenir. Puppet 6zelliginin altindaki Deform
mensi icinde eklenen pinler gorilebilir (Gorsel 3.178).

Gorsel 3.178: Eklenen pinlerin katman béliimiinde gosterilmesi

4. Adim: Eklenen ilk Gi¢ pin olan Pin 1, Pin 2 ve Pin 3 diigmelerinin solundaki ok simgelerine
basarak pinlere ait mendlerin agilmasini saglayiniz (Gorsel 3.179).
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Gorsel 3.179: Pinlere anahtar kare eklenmesi

Her U¢ pinin de Position degerlerine (6nceden belirlenen 0. saniyeye) anahtar karelerin

otomatik olarak eklendigi gorilir.
5. Adim: ikinci anahtar kareleri koyabilmek icin zaman imlecini 1. saniye konumuna aliniz.

6. Adim: Composition ekraninda Pin 1, Pin 2 ve Pin 3 pinlerini karakterin el sallama hareketini

gerceklestirebilecegi sekilde yukariya dogru kaldiriniz (Gorsel 3.180).

Gorsel 3.180: Pinleri kullanarak animasyon olusturma

7. Adim: 1. saniye konumuna eklenen (¢ anahtar kareyi seginiz. Ctrl+C dugmeleri ile
kopyaladiktan sonra zaman imlecini 2. saniye konumuna aliniz ve kopyalanan anahtar kareleri
Ctrl+V digmeleri ile yapistiriniz. Boylece karakter ilk hareketi yaptiktan sonra bulundugu

konumda karakterin bir saniye beklemesi saglanir.

8. Adim: 0. saniye konumuna eklenen (¢ anahtar kareyi seciniz. Ctrl+C digmeleri ile
kopyaladiktan sonra zaman imlecini 3. saniye konumuna aliniz ve kopyalanan anahtar kareleri
Ctrl+V dagmeleri ile yapistiriniz. Karakter bir siire bekledikten sonra kol ilk harekete basladigi
konuma geri doner.
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9. Adim: Olusturulan animasyonu bosluk tusu ile oynatiniz.

Bir katman igin Transform o6zellikleriyle olusturulmus hareket animasyonlari, o katmana
baglanan baska katmanlara da uygulanabilir. Boylece birden fazla katmanin es zamanl olarak
ayni hareketleri yapmasi saglanir.

3.7. HAREKET TAKIBI

Videonun iginde secilen bir noktanin X ve Y eksenlerindeki hareketleri tespit edilerek o noktaya
aslinda orada olmayan nesneler eklenebilir. Sonradan eklenen nesneler, daha dnce tespit edilen
hareketleri tekrar ederek nesnenin oraya sonradan eklendigi gizlenir.

3.7.1. Parent (Ebeveyn) Ozelligiyle Hareket Takibi

Parent ozelligi ile bir katman diger bir katmana baglanir. Boylece bir katmanda olusturulan
hareketler baska bir katmana aktarilir (Gorsel 3.181).

Gorsel 3.181: Parent simgesi

19. UYGULAMA

islem adimlarina gére parent 6zelligini kullanarak katmanlari birbirine baglayiniz.

1. Adim: Yeni bir proje ve projede bir kompozisyon olusturunuz.

2. Adim: Kompozisyona gorseldeki gibi icinde 10 yazan Text katmani ve bir besgen bulunan
sekil katmani ekleyiniz. Katmanlari ekranda ortalamak igin Allign panelini kullaniniz (Gorsel
3.182).

Gorsel 3.182: Kompozisyona sekil ve yazi katmani ekleme
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3. Adim: 10 sayisinin yazdigi Text katmani ile ekranin solundan donerek gelecek sekilde, 5.
saniyede sonlanacak bir animasyon olusturunuz (Gorsel 3.183).

Gorsel 3.183: Yazi katmaniyla animasyon olusturma

4. Adim: Zaman imlecini 5. saniyeye aliniz. Besgen sekil katmanini yazi katmanina baglayarak
ayni animasyona sahip olmasini saglamak icin sekil katmaninin Parent digmesine farenizin sol
digmesiyle basili tutup, fareyi siiriikleyerek yazi katmaninin tGzerine getiriniz ve birakiniz (Gorsel
3.184).

Gorsel 3.184: Sekil katmanini yazi katmanina baglama
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5. Adim: Zaman imlecini 0. saniye konumuna aliniz ve animasyonu oynatiniz. Sekil katmaninin
Text katmanina baglanarak ayni animasyona sahip oldugu gorulir (Gorsel 3.185).

Gorsel 3.185: Sekil katmaninin yazi katmaniyla es zamanli animasyonu

6. Adim: iki katman arasindaki Parent &zelligini kaldirmak igin zaman imlecini 5. saniye
konumuna aliniz ve Parent digmesinin yanindaki kutucugu secerek acilan meniide None
digmesini seginiz (Gorsel 3.186).

Gorsel 3.186: Parent 6zelligini kaldirmak

Bir katmanin herhangi bir Transform 06zelligi, baska bir katmanin Transform ozelligine
baglanabilir.

7. Adim: Sekil katmaninin Scale 6zelligini yazi katmaninin Rotation 6zelligine baglayiniz (Goérsel
3.187).

Gorsel 3.187: Transform o6zelliklerinin birbirine baglanmasi
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8. Adim: Zaman imlecini 0. saniye konumuna alarak olusan animasyonu gozlemleyiniz.

SIRA SiZDE

Parent 6zelligi kullanarak olusturacaginiz bir sekil katmani ile bir Text katmanini
birbirine baglayiniz. Birbirine baglanan katmanlarla hareket animasyonu olusturunuz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme o6l¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

. Yeni proje olusturdu.

[

N

. Yeni kompozisyon olusturdu.

w

. Yeni sekil katmani ekledi.

4. Yeni Text katmani ekledi.

(5]

. Katmanlari birbirine bagladi.

6. Birbirine baglanan katmanlarla hareket animasyonu olusturdu.

N

. Projeyi bilgisayara kaydetti.

3.7.2. Null Object Ozelligiyle Katmanlari Birbirine Baglamak

Kendi icinde farkl animasyonlara tabi tutulmus birden fazla katmanin, ayni zamanda tek bir
katmanmis gibi davranip, toplu olarak hareket etmesi istendiginde Null Object katmani kullanilr.
Null Object ekranda yalnizca kilavuz gérevindedir. Proje giktisinda goriintlist gizlenir.

Kendi icinde farkli animasyonlara tabi tutulmus katmanlar sahneye eklenen Null Object
katmanina baglanir. Toplu olarak verilmek istenen animasyon Null Object katmanina uygulanir.
Boylece hem katmanlar kendileri igin Uretilmis 6zel animasyonlari oynatirken hem de toplu
olarak Null Object katmanina uygulanmis olan animasyonlari oynatr.
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20. UYGULAMA

islem adimlarina gére Null Object katmani kullanarak animasyon olusturunuz..

1. Adim: Yeni bir proje olusturunuz. Bu projede 20 saniye uzunlugunda, 1920x1080 piksel
¢Ozunurliginde bir kompozisyon olusturunuz.

2. Adim: Sahneye yukaridan asagiya yazan bir yazi katmani eklemek i¢in ara¢ cubugundaki Text
digmesine basiniz. Agilan meniide dikey yazma digmesini seciniz ve yazdiginiz yaziy1 gorseldeki
gibi sahnenin soluna yerlestiriniz (Gorsel 3.188).

Gorsel 3.188: Kompozisyona yazi katmani eklenmesi

3. Adim: Yazi katmanina maske eklemek igcin katmani seginiz. Ardindan cember aracini segerek
katmanin Gzerine yazinin tek bir harfini kaplayacak sekilde cember sekli ¢iziniz (Gorsel 3.189).

Gorsel 3.189: Yazi katmaninin maskelenmesi

232 | Hareketli Goruntller



4. Adim: Katman maskesine animasyon uygulamak icin Mask 1 menisind aginiz. Katman
maskesinin altinda bulunan Expansion degeri azaltildiginda maskelenen alan kiigllir. Bu deger
artirildiginda maskelenen alan artar.

5. Adim: Expansion degerine anahtar kareler ekleyerek (¢ saniye uzunlugunda (0-3 saniyeleri
arasinda), katman maskesinin hi¢ gérinmedigi gorintiden bitlin metni kapsadigl gorintiye
dogru ilerleyen bir animasyon olusturunuz (Gérsel 3.190).

Gorsel 3.190: Maske ile animasyon olusturma

6. Adim: Sahneye soldan saga dogru uzanan yeni bir yazi katmani daha ekleyerek Gorsel
3.191'deki gibi yerlestiriniz.

Gorsel 3.191: ikinci yazi katmaninin eklenmesi
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5. Adim: ikinci Text katmanina da katman maskesi uygulayip, Expansion degerine anahtar
kareler ekleyerek ¢ saniye uzunlugunda (3-6 saniyeleri arasinda), katman maskesinin hig
gorinmedigi gorintliden bitin metni kapsadigl goriintliye dogru ilerleyen bir animasyon
olusturunuz (Gorsel 3.192).

Gorsel 3.192: Maske ile animasyon olusturma

6. Adim: Null Object katmani eklemek icin zaman cizelgesinin katman boéliminde bos bir
alana farenizin sag digmesine tiklayarak agilan pencereden New>Null Object seceneklerini
seciniz (Gorsel 3.193).

Composition Settings... Text
Reveal Compaesitien in Project Solid...
Preview A3l
Camera...

Mull Object

Switch View Layout
Switch 30 View

Rename Shape Layer

Adjustment Layer

T D Em Content-Aware Fill Layer...

Composition Flowchart Adobe Photoshop File...

Composition Mini-Flowchart Maxon Cinema 4D File...

Gorsel 3.193: Kompozisyona Null Object eklenmesi
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Sahneye Null Object katmani eklemenin baska bir yolu ise ara¢ cubugundan sirasiyla

Layer>New>Null Object digmelerini se¢mektir (Gorsel 3.194).

File Edit Composition | Layer | Effect Animation View Window Help

MNew

|

Layer Settings...
Open Layer
Open Layer Source

Reveal in Explorer

Mask

Mask and Shape Path
Quality

Switches
Transform

Time

Frame Blending
3D Layer

Guide Layer
Environment Layer
Markers

Preserve Transparency
Blending Mode

Mext Blending Mode
Previous Blending Mode
Track Matte

Layer Styles

Arrange

Reveal
Create
Camera
Auto-trace...

Pre-compose...

Ctrl+Shift+Y

Alt+Numpad Enter

vov v v v v v

Shift+=
Shift+-

Ctrl+Shift+C

Text Ctrl+Alt+Shift+T
Solid... Ctrl+Y
Light... Ctrl+ Alt+Shift+ L
Camera... Ctrl+ Alt+Shift+C
Null Object Ctrl+Alt+Shift+Y
Shape Layer

Adjustment Layer Crl+ Alt+Y
Content-Aware Fill Layer...

Adobe Photoshop File...

Maxon Cinema 4D File...

Gorsel 3.194: Kompozisyona farklh bir yolla Null Object eklenmesi

Null 1 isimli Null Object katmani, katman boélimine gelir ve sahnede kare seklinde kilavuz

cizgileri gorlinlir (Gorsel 3.195).

Gorsel 3.195: Null Object katmaninin katman boliimiinde ve kompozisyon ekraninda goriiniimii

Hareketli Goruntiler

235



236

7. Adim: Null Object nesnesini sahnede harflerin birlestigi noktaya tasiyiniz (Goérsel 3.196).

Gorsel 3.196: Null Object katmaninin sahnede taginmasi

8. Adim: Text katmanlarini Null 1 isimli katmana baglayiniz (Gérsel 3.197).

1 Mull 1
1 Mull 1

Gorsel 3.197: Katmanlarin birbirine baglanmasi

9. Adim: Null Object katmanina katmanin Transform 6zelliklerini kullanip, sagdan 40 derece
donerek gelecek sekilde animasyonu uygulayiniz (Gorsel 3.198).

Gorsel 3.198: Animasyonun oynatilmasi
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OLCME VE DEGERLENDIRME

A) Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Asagidakilerden hangisi her katmanda ortak olarak bulunan standart bir meniidiir?

A) Add
B) Ofset
C) Path
D) Start

E) Transform

2. Katmani sahnede hizalamak i¢in kullanilan panel asagidakilerden hangisidir?
A) Allign
B) Character
C) Libraries
D) Paragraph

E) Preview

3. Asagidakilerden hangisi sekil ¢izim araglariyla gizilebilecek sekillerden degildir?
A) Sphere Tool
B) Polygon Tool
C) Ellipse Tool
D) Star Tool
E) Rounded Rectangle Tool

4. Asagidakilerden hangisi sekil katmanina eklenebilen diizenleyicilerden biridir?
A) Darken
B) Multiply
C) Saturation
D) Screen

E) Twist

Hareketli Goruntiler
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5. Hareketsiz nesnelere baglanti noktalari ekleyerek bu noktalarla nesneye hareket veril-
mesini saglayan arag¢ asagidakilerden hangisidir?

A) Clone Stamp Tool
B) Brush Tool

C) Puppet Pin Tool
D) Pan Behind Tool
E) Hand Tool

. Gorselde kompozisyon ayarlarindan bir tanesi gosterilmektedir.

Buna gore calisma alani ile ilgili asagidakilerden hangisi dogrudur?

A) Cozunirligt 800x800 pikseldir.
B) Genisligi 800 pikseldir.

C) Yuksekligi 800 pikseldir.

D) CozunurlGgli 800x600 pikseldir.
E) Derinligi 800 pikseldir.

Gorseldeki transform (doniisiim) ile nesnenin asagidaki hangi 6zelligi degistirilir?
A) Nesnenin konumu

B) Nesnenin buylklGgi

C) Nesnenin agisi

D) Nesnenin ¢apa noktasi

E) Nesnenin seffalig

8. Asagidakilerden hangisi kompozisyonun 6n izlemesini baslatmak igin kullanilacak kisa-
yollar arasinda yer alir?

A) Enter tusu
B) Shift tusu
C) Alt tusu

D) Bosluk tusu
E) Tab tusu
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9. Anahtar kare segiliyken asagidaki tuslardan hangisine basilirsa anahtar kare silinir?

A) Tab tusuna

B) Shift tusuna

C) Delete tusuna

D) Ctrl tusuna

E) Caps Lock tusuna

10. Asagidakilerden hangisi nesnenin seffaligini ayarlamayi saglar?
A) Opacity
B) Rotation
C) Scale
D) Position
E) Anchor Point
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HAZIRLIK CALISMALARI

1. Videolarda arka plan degistirmenin faydasi neler olabilir?

2. Bir videoda aslinda olmayan bir nesne (bina, kale, dag, gol vb.) videoya nasil
yerlestirilebilir?

4.1. MASKELEME (MASK)

Maskeleme (Mask) islemi gorsel efekt programlarinda siklikla kullanilan yéntemlerden biridir.
Maskelemenin temel mantigl, belirlenen igerikte yalnizca istenen yerlerin gosterilmesi, diger
alanlarin gizlenmesi ilkesine dayanir. Boylece kurgusal mekanlar, kisi ve nesne yerlestirmeler, sira
disi efektler videolarda kolayca yapilabilir.

4.1.1. Shape Nesnesi Kullanarak Maskelemek

Gorsel efekt programinin Tools paletindeki Shape aracinin (Gorsel 4.1) alt nesneleri (Gorsel
4.2) kullanilarak basit sekillerde maskeleme yapilabilir.

Gorsel 4.1: Tools paleti ve Shape araci

Gorsel 4.2: Shape aracinin alt nesneleri

Maskeleme isleminde Shape aracina ait alt nesnelerin ¢izimi, 6zellikleri ve Layer panelindeki
ozellikleri iyi bilinmelidir. Bir katmani maskeleme amaciyla Shape nesnelerini kullanmak igin
katman panelinde resim veya video isaretliyken Shape araglarindan istenen arag segcilir ve sekil
olusturulur. Boylece gizilen sekilde ilgili katmandaki icerik goriintilenir.

Maskeleme Teknikleri



Gorsel 4.3'te Shape araclari ile bir gérsel maskelendiginde olusabilecek gorintiler bulunur.

Gorsel 4.3: Shape araclariyla maskelenmis bir fotograf sahnedeki goriiniimleri

Shape araglariyla gizilen sekiller, maskeleme icin referans sekillerdir. Sekiller tizerindeki
vertexler (iki cizginin birlestigi noktalar) degistirilerek farkh sekiller de elde edilebilir.
Gorsel 4.4'te Star Shape nesnesi ile ¢izilmis bir mask gorilir.

Gorsel 4.4: Star Shape araciyla cizilmis maske goriiniimii

Gorsel 4.5’te ise Star nesnesinin vertexleri ile oynanarak elde edilmis yeni maske gorinimu
verilmistir. Vertexleri konumlandirmak icin Selection Tool (V) araci segilmis, mouse isaretgisi ile
Uzerine tiklanarak vertexler hareket ettirilmistir.

Gorsel 4.5: Star Shape araciyla ¢izilmis seklin vertexleriyle oynanmig hali
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Bir katmandaki gorsel veya videoya maske eklendiginde katman paneline Mask 1 ile baslayan
yeni bir 6zellik alt katmani ilave edilir (Gorsel 4.6).

Gorsel 4.6: Maske cizildiginde katman paneline eklenen Mask 6zellikleri alt katmani

Ayni katman Uzerine birden fazla maske eklenmeye devam edilirse Mask 1, Mask 2... seklinde
artan alt katmanlar olusur.
Mask alt katmanindaki 6zellikler sunlardir:

Mask Path: Eklenen maske seklinin sinirlarini degistirip yeniden belirlemeyi saglar.

Mask Feather: Eklenen maske seklinin gergevesinde gegisi yumusatarak alt katmanlarla
kaynasmayi kolaylastirir.

Mask Opacity: Eklenen maske seklinin gériinirlik oranini ayarlar.

Mask Expansion: Eklenen maske seklinin sinirlarini artirip azaltmaya yarar.

Gorsel 4.7'de Ustteki gorsele maske uygulanmis ancak Mask Opacity degeri “0” olarak
ayarlanmistir. Bu durum, maskenin islevini ortadan kaldirmistir. Gorsel 4.8'de Mask Opacity
degeri “100”e ayarlanmistir. GOriildUgi Gzere maskenin sinir cizgilerinde keskin bir gecis s6z
konusudur. Gorsel 4.9’da ise Mask Feather degeri “40”a ayarlanarak sinirlarin alttaki gorselle
biraz daha kaynasmasi saglanmistir.

Gorsel 4.7: Maskesiz gorsel
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Gorsel 4.8: Maske eklenip, Feather degeri “100” olarak ayarlanan gorsel

Gorsel 4.9: Maske eklenip, Mask Feather degeri “40” olarak ayarlanan gorsel

1. UYGULAMA

islem adimlarina gére Shape nesnelerinden biri ile maskeleme yapip, Position
animasyonunu kullanarak bir ¢alisma gergeklestiriniz.

1. Adim: CozUnarligu Full HD (1920x1080), Frame Rate degeri 30 fps olan bir Composition
olusturunuz.

2. Adim: Uygulama iginde kullanilabilecek gorsel veya videolari uygun web sitelerinden
indiriniz.
3. Adim: Gorseli fare ile sirlikleyerek Project béliminden Timeline panelinin katmanlar

bolimiine birakiniz.

4. Adim: Gorselin boyutunu Scale degeriyle veya sahnede gorsele sag tiklayip, Transform>Fit
to Comp Width secerek gorselin sahneyi doldurmasini saglayiniz.
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Fit to Comp secildiginde resim ve videolarda bazen en ve boy sorunlari olusabilir.
Bu nedenle uygun doldurma secenegi denenmeli, en ve boy oraninin bozulmasina izin
verilmemelidir.

5. Adim: Resminize ait katman segiliyken Shape nesnesinden Rectangel Tool secerek Gorsel
4.10’daki gibi sahnenin alt alanindan bir bolim{ maskeleyiniz.

Maske s>

Gorsel 4.10: Rectangle Tool ile maske uygulanmis sahne ve Timeline katman béliimii

6. Adim: Katman panelinde gorselin adinin Uzerine tiklayarak mask o6zelliklerinin segimini
kaldiriniz.

7. Adim: Klavyeden Ctrl+D veya Edit>Duplicate yaparak katmanin ikizini olusturunuz.

8. Adim: Yeni olusan katman bir dnceki katmanin lzerine konumlanmis durumdadir. Yeni
katman seciliyken klavyeden M tusuna basarak Mask 6zelliklerinin gériinmesini saglayiniz (Gorsel
4.11).

Katman seciliyken M tusuna basildiginda
Mask ozellikleri géruntilenir.

Gorsel 4.11: Segili katmanda M tusu ile Mask ozelliklerine erisim
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9. Adim: Mask 1'i gorintiledikten sonra katman 06zelliklerindeki Inverted kutusunu
isaretleyerek maskelenmis alani tersine ceviriniz. Boylece katmanlardaki ayni gorselin zit
bolgelerini maskeleyerek iki katmandan tek bir goriintli elde ediniz (Gorsel 4.12). Bu islemden
sonra artik iki katmandan olusan tek bir gorsel vardir. Bir sonraki adimda animasyonla alttaki
gorsel sagdan sola, Ustteki gorsel ise soldan saga kayarak gorsel bitiin hale gelecektir.

-

Gorsel 4.12: Maskelerinden biri Inverted edilmis iki katmanin tek gorseli olusturmasi

10. Adim: Katman panelini diizenlemek ve gerekli Position 6zelligini agmak icin katman
panelindeki ilgili katmanlari seginiz ve P (Position) tusuna basiniz (Goérsel 4.13).

Katman panelinde ilgili katmanlar segilir
ve P tusuna basilr.

Gorsel 4.13: Katmanlarin mouse ile segilmesi

11. Adim: Animasyonun iki (2) saniyede gerceklesmesini isterseniz Timeline gizgisini 2.
saniyeye ¢ekiniz ve Position Keyframe ikonuna basarak 2. saniyeye bir anahtar kare olusmasini
saglayiniz (Gorsel 4.14).

Gorsel 4.14: Segili katmanlarda P tusuna basildiginda Position parametresinin goriintiilenmesi
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12. Adim: Timeline ¢izgisini 0. saniyeye ¢ekip katmanlarin tek tek Position x (yatay) degerlerini
degistiriniz. Animasyonda alt katmandaki gorsel sagdan sola gelecegi icin 0. saniyede Position
x degerini artirarak gorseli sahnede saga dogru oteleyiniz. Ust katmandaki gorsel icin de tersi
yonde ayarlama yapiniz (Gorsel 4.15).

Bu calismada kullanilan gorsel, hareketi belli etmesi acgisindan sahne 6l¢iilerinde
secildive kenarlardabosluk ortaya cikti. Gorsel, sahneden dahabuiylk 6lcilendirildiginde
bu kenar bosluklari goriinmeyecektir.

Gorsel 4.15: Saga ve sola 6telenerek animasyona hazirlanan gorseller

13. Adim: Animasyon hareketinin fizik kurallarina daha uygun oynamasi icin Easy Ease
ozelligini aktiflestiriniz. Bunun igin Timeline cizgisinde anahtar kareleri mouse ile segerek
klavyeden F9 tusuna basiniz (Gorsel 4.16).

NOT: Easy Ease Ozelligi kaldiriimak
isteniyorsa Ctrl tusuna basil iken anahtar
karelere tiklanmalidir.

Gorsel 4.16: Easy Ease aktif edildiginde anahtar karelerin aldigi form
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14. Adim: Keyframeler segiliyken (zerine sag tiklaylp Keyframe Velocity penceresindeki
degerleri Gorsel 4.17'de oldugu gibi ayarlayiniz.

> >

Gorsel 4.17: Keyframe Velocity penceresindeki degerler

Bu degerlerin animasyon hizina etkisi Gorsel 4.18’deki grafikte verilmistir. Keyframe Velocity
penceresindeki degerler, durmak lizere olan bir cismin hiz egrisiyle neredeyse es degerdir ve bu
degerler animasyonlarda siklikla kullanilir.

Gorsel 4.18: Graph Editorde Easy Ease ve Velocity in: 100-out: 0.1 degerleri sonucunda olusan hiz egrisi

On dordiinclii adimdaki islem, Graph Editor kullanilarak da yapilabilir.

15. Adim: Bu galisma gergeklesirken Text araci ile yazacaginiz birkag kelimelik bir metne
Opacity ve Position animasyonu ekleyiniz.
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SIRA SiZDE

Belirleyeceginiz bir gorsel Gzerinde birinci uygulamada oldugu gibi Rectangle Tool
araci ile maske olusturup animasyonla goérseli hareketlendiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme o6lcutlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. 1920x1080 ¢ozunirliik ve 30 fps degerlerinde Composition olusturdu.

2. Belirtilen materyali ilgili klasérden programa aktardi.

3. Gorseli Timeline katman paneline tasidi.

4. Katman paneline tasinan gorselin ¢ozinirligini sahneye gore ayarladi.

5. Gorseli secerek gorselin izerine Rectangel Tool ile maske alani olusturdu.

6. Katman panelinde dosya ismini segerek Ctrl+D (Edit>Duplicate) katmanin
ikizini ¢ikardi.

7. Cogaltilan yeni katmanda Mask>Inverted se¢cenegini isaretleyerek maske
alanini ters gevirdi.

8. Katman panelindeki gorsel katmanlarinda Position 6zelligini aktif hale
getirdi.

9. Timeline ¢izgisini 2. saniyeye getirerek her iki gérsel icin de anahtar kare
olusturdu.

10. Timeline gizgisini 0. saniyeye getirerek gorsellerin Position x degerlerini
dogru ayarladi.

11. Olusturulan dért anahtar kareyi secerek F9 ile Easy Ease Ozelligini aktif-
lestirdi.

12. Anahtar karelerin Keyframe Velocity degerlerini dogru sekilde ayarladi.

13. Gorsel animasyonuna ek olarak metin animasyonu gergeklestirdi.
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4.1.2. Pen Aracini Kullanarak Maskelemek

Pen araci, maskeleme isleminde ¢ok sik kullanilir. Ozellikle VFX denilen gérsel efekt islemlerinde
farkli nesneler kullanilarak bir sahne olusturulurken Shape aracglarindaki net cizgilerle degil, daha
girintili maskeleme yapilarak gorsel etki artirilmaya calisilir. Bu nedenle Pen aracini maskeleme
isleminde tercih etmeden 6nce yardimci araglariyla birlikte etkin bir sekilde kullanmak énemlidir.
Pen ve yardimci araglari Gorsel 4.19°da verilmistir.

Gorsel 4.19: Pen ve yardimci araglari

Pen Tool: Serbest sekil cizim aracidir. Noktalar (vertex) ekleyerek sekiller olusturur. Bir vertex
icin tiklandiginda sol tus birakilmadan mouse hareket ettirilirse keskin bir ¢izgi yerine yay seklinde
bir cizgi elde edilebilir (Gorsel 4.20).

Pen araciyla ¢alismada eklenen bir vertexin yeri, lzerine tiklanip, birakilmadan
suriklenerek degistirilebilir.

Gorsel 4.20: Pen araciyla gizilmis iki farkh ¢izgi 6rnegi

Add Vertex Tool: Cizilen sekilde daha fazla vertexe ihtiyag varsa bu aracg ile vertex eklenebilir.
Pen Tool seciliyken vertex disinda gizginin Gzerine mouse isaretgisi gotirildiginde de Add Vertex
Tool araci otomatik olarak gagrilir.

Delete Vertex Tool: Eklenen vertexleri silmek icin kullanilir. Pen araci aktifken Ctrl tusuna
basilarak vertexin lizerine mouse isaretgisi ile gidildiginde de c¢agrilir.
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Convert Vertex Tool: Vertexleri keskin cizgilerden acili yaylara (bezier) veya acili yaylardan
keskin ¢izgi formuna donusturdr.

Mask Feather Tool: Maskeleme isleminde kullanilmig Pen aracinin gizgilerini bozmadan Mask
Feather Tool ile eklenen vertexler, maskenin Feather alanini 6zellestirmeye yarar (Gorsel 4.21).

Mask Feather Tool ile
Pen araciyla gizilmis bir eklenmis bir noktanin
maske alanina ait vertex maske alanina etkisi

Gorsel 4.21: Mask Feather Tool aracinin kullanimi

2. UYGULAMA

islem adimlarina gére Pen Tool aracini kullanip, bir vadi ve kaleden olusan iki gérseli
maskeleyerek tek bir kompozisyon elde ediniz.

1. Adim: CozinGrlGghu Full HD (1920x1080), Frame Rate degeri 30 fps bir Composition

olusturunuz.

2. Adim: Uygulama icinde kullanilabilecek gorsel veya videolari uygun web sitelerinden
indiriniz. Renk uyumu diizenlemesi yapilmayacaktir (Gorsel 4.22).

Gorsel 4.22: Renk diizenlemesi yapilmamis sadece kompozisyon olusturulmus sahne goriintisii
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3. Adim: ilgili gdrselleri Timeline katman alanina siiriikleyerek Comp1’e ekleyiniz.

4. Adim: Arka plan vadi gorselini uygun oldugunu dislindiigiintiz alandan Pen Tool kullanip
isaretleyerek maskeleyiniz (Gorsel 4.23).

Gorsel 4.23: Arka plan goérseline Pen Tool ile maske uygulanmasi

5. Adim: Arka plan gorselini Ctrl+D veya Edit>Duplicate yoluyla ¢cogaltip, Mask 6zelligini Invert
ederek iki gorselden tek gorsel meydana getiriniz. Maske kenarlarinda belirginlik olustuysa
vertexlerin yerini degistirerek bu sorunu ¢ozebilirsiniz.

NOT

Bu calisma 6zelinde st katmanda kalan gorselin maskeye ihtiyaci yoktur. Mask
ozelligi silinerek de ¢alismaya devam edilebilir.

6. Adim: Kale gorselini Timeline katmanlar alanina dahil ediniz ve katmanlari siralayiniz. Bu
kompozisyonda maskeli vadi resmi en Ustte, kale resmi ortada ve maskesiz tamamlayici resim ise
en alt sirada olacak sekilde katmanlarda sirali vaziyettedir (Gorsel 4.24).

Gorsel 4.24: Katmanlarin dogru sekilde siralandigi sahne diizeni
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7. Adim: Kale gorselini Pen Tool yardimiyla maskeleyiniz (Gorsel 4.25).

Gorsel 4.25: Pen Tool araciyla maskelenmis kale gorseli

8. Adim: Sahnenin geneline gore biylik oldugunu dislinliyorsaniz Scale oOzelligi ile kale
gorselini kigultiniz.

9. Adim: Pen Tool ve Mask Feather Tool araglarini kullanarak kale ile vadi gorsellerini
birbirine karisacak sekilde diizenleyiniz. Bunu yaparken gerekirse Pen Tool ile eklenen vertexleri
degistirmekten ¢ekinmeyiniz. Gerekli yerlere Mask Feather vertexi ekleyiniz (Gorsel 4.26).

Gorsel 4.26: Pen ve Mask Feather Tool ile diizenleme

10. Adim: Kale gorseline uygulanan maske islemi, gorselin kenarlarinda keskinlik meydana
getirebilir. Bu keskinligi Mask 6zelligindeki Feather degerinden diizenleyiniz. Feather islemi ile
kale etrafinda resmin diger alanlari belirir ve bir cerceve meydana getirirse Mask Expansion
ozelligini negatif yonde ayarlayiniz (Gorsel 4.27).

Gorsel 4.27: Kale gérselinde Mask Feather ve Mask Expansion degerlerinin ayarlanmasi
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11. Adim: Arka plan gorselinin derinlik algisi lizerine eklenen kale gorseli bu derinlige uymazsa
kale gorselinin 3D Ozelligini aktiflestirerek ve Y ekseninde kale gorselini birka¢ derece dondirerek
derinlik algisini daha uygun hale getiriniz (Gorsel 4.28).

3D ozelligi aktiflestirildik-
ten sonra katman segiliy-
ken R tusuna basilarak
Oriantation ozelligi g6-
riintilenebilir.

Gorsel 4.28: Kale katmaninin 3D o6zelligi aktiflestirilerek elde edilen sahne goriintiisi

SIRA SiZDE

Belirleyeceginiz en az iki gorseli Pen Tool aracini kullanarak maskeleyiniz ve
gorsellerden yeni gorsel meydana getiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. istenen ¢oziiniirliik ve fps degerlerinde Composition olusturdu.

2. ilgili klasdrden belirtilen materyali programa aktardi.

3. Arka plan gorselini Timeline katman paneline tasidi.

4. Katman paneline tasinan gorselin ¢ozinarligina sahneye gore ayarladi.

5. Arka plan gorselini secerek Pen Tool ile maske alani olusturdu.

6. Katman panelinde dosya ismini secerek Ctrl+D (Edit>Duplicate) ikizini ¢ikar-
di.
7. Cogaltilan yeni katmanin Mask>Inverted secenegini isaretleyerek maske

alanini ters gevirdi veya Mask katmanini sildi.

8. Katman panelinde bulunan (g katmani dogru sekilde siraladi.

9. Gorseli Pen Tool araciyla maskeledi.

10. Arka plan gorselinin Feather degerlerini uygun sekilde ayarladi.

11. Kale gorselinin Feather degerlerini uygun sekilde ayarladi.

12. Gorseli Scale degeriyle uygun oOlclye getirdi.
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4.1.3. Track Matte Yontemiyle Maskelemek

Maskeleme isleminin bir diger yontemi “Track Matte” 06zelligidir. Track Matte, gorsel
animasyonlarda cok sik kullanilan bir yontemdir. Timeline katman panelindeki Track Matte
secenegi Gorsel 4.29 ve Gorsel 4.30°daki gibi gosterilip gizlenebilir. Track Matte 6zelliginde
maskeleyici olarak katmanlar kullanilir ancak katmanlardaki nesnelerin renk bilgileri de 6nemlidir.
Track Matte yonteminde Ust Uste konumlanan iki katmandan Ust katmanin Alpha veya Luma renk
bilgileri kullanilarak altta kalan katman, st katman dolgusunda maskelenebilir (Gorsel 4.31).

Gorsel 4.29: Track Matte kapali Gorsel 4.30: Track Matte acik

rd

Alpha kanali olarak referans
alinan katmandaki nesnele-
rin dolgusu saydam bir alan
meydana getirir. Diger alanlar opak
bir halde davranir.

Gorsel 4.31: Track Matte 6zelliginde Alpha Matte segiliyken gergeklesen maskeleme
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Alpha Inverted 6zelligi secilirse Ust katmanin dolgu alanlarinin disi saydam kabul edilir ve
buna gore maskeleme yapilir (Gorsel 4.32).

Gorsel 4.32: Alpha Inverted 6zelligi seciliyken gerceklesen maske

3. UYGULAMA

islem adimlarina goére Track Matte Alpha 6zelligini kullanarak bir calisma
gerceklestiriniz. Calismanizin sonunda Gorsel 4.33’e benzer bir gérinti elde ediniz.

Gorsel 4.33: Uygulama sonunda elde edilecek ¢alismanin bir kesiti
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1. Adim: CozinGrlGghu Full HD (1920x1080), Frame Rate degeri 30 fps bir Composition
olusturunuz.

2. Adim: Uygulama iginde kullanilabilecek gorsel veya videolari uygun web sitelerinden
indiriniz.
3. Adim: Arka plan olarak belirlediginiz gorsel veya videoyu Timeline katman paneline

surikleyip birakiniz.

4. Adim: Arka plan nesnesinde boyutla ilgili bir diizenleme gerekirse en ve boy oranini
koruyarak bu dizenlemeyi gerceklestiriniz.

5. Adim: Metin olarak SU UMUTTUR mesaji tercih edildi. Text katmani olarak énce SU
kelimesini yaziniz. Ardindan ikinci bir Text katmanina UMUTTUR kelimesini Gorsel 4.34’e benzer
sekilde yerlestiriniz.

Gorsel 4.34: Calismanin ilk yerlestirme ve metinlerin eklendigi hali

6. Adim: SU kelimesinin oldugu katmani Ctrl+D kisayolu ile harf sayisinca ¢ogaltiniz (Gorsel
4.35).

Gorsel 4.35: Harf sayisi kadar gogaltilmis kelime katmani ve katman panelinin son hali
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Yeni ¢cogaltilan metin katmanlari kullanilirken kolaylik olmasi agisindan metnin rengi
degistirilebilir.

7. Adim: Cogalttiginiz metin katmanlarindaki birer harfi silerek S ve U’nun kalmasini saglayiniz,
alttaki SU kelimesine gore hizalayiniz (Gorsel 4.36).

Gorsel 4.36: S ve U harflerinin rengi degistirilmis ve alttaki kelimeye gore hizalanmig hali
8. Adim: SU kelimesinin yazili oldugu katmani gizleyiniz veya siliniz.
9. Adim: Track Matte o6zelliginde kullanacaginiz gorselleri Timeline katman panelinde S ve U

harflerinin altlarinda olacak sekilde konumlandiriniz ve Scale degerlerini harf boyutuna uygun
halde ayarlayiniz (Gorsel 4.37).

Gorsel 4.37: Gorsellerin harflere gére ayarlanmasi
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10. Adim: S ve U harflerinin altina yerlestirdiginiz gorsellerin katman panelindeki Track Matte
ozelligi aktif degilse bu 6zelligi aktiflestiriniz ve Alpha Track Matte seginiz (Gorsel 4.38).

|

/

Gorsel 4.38: ilgili gorsellere Alpha Matte uygulanmis ve bu goérsellerin iist katmaninda yer alan harfler
tarafindan maskelenmis halleri

11. Adim: On plana ¢ikmasi istenen nesnelerle arka plan arasinda bir fark olusturabilmek igin
arka plan gorseli tizerine siyah renkle doldurulmus Rectangle Tool nesnesini Gorsel 4.39’daki gibi
ekleyip, Opacity degerini diistrerek bir fark katmani elde ediniz.

Gorsel 4.39: Siyah doldurulmug Rectangle Tool nesnesi

NOT

Mavi renkle doldurulmus ikinci katman da istenirse kompozisyona eklenebilir
(Gérsel 4.40). ilerleyen siirecte bu islem efektlerle de yapilabilir.

Gorsel 4.40: Calismanin mavi Rectangle Tool eklenmis son hali
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12. Adim: UMUTTUR kelimesine Animate>Tracking ozelligini ekleyerek bir animasyon
gerceklestiriniz.

13. Adim: Bu 6zelligi eklemek igin UMUTTUR katmanindaki asagi acilir oka tiklayip yandaki
Animate bolimiinden Tracking seciniz (Gorsel 4.41).

1

\

Gorsel 4.41: Text katmanina Tracking 6zelligi ekleme

14. Adim: Tracking eklendikten sonra Timeline c¢izgisini 2. saniyeye getiriniz ve Tracking
Amount degerinin yanindaki anahtar kare butonunu aktiflestirerek Timeline paneline bir anahtar
kare ekleyiniz. Bu islem, animasyon sona erdiginde Amount degerini belirtmenin yontemlerinden
biridir (Gorsel 4.42).

t A

Gorsel 4.42: Timeline paneline anahtar karelerin eklenmesi
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15. Adim: Anahtar kareyi 2. saniyeye ekledikten sonra Timeline ¢izgisini 0. saniyeye cekiniz ve
Tracking Amount degerini bir miktar degistiriniz (Gorsel 4.43).

Gorsel 4.43: Animasyon baslamadan 6nce anahtar karelerin olusturulmasi

16. Adim: Tracking Amount anahtar karelerini secip F9 ile Easy Ease hareketini aktiflestiriniz.
Easy Ease aktiflestirildikten sonra Graph Editor yardimiyla veya Keyframe Velocity (anahtar
kareye sag tik) penceresinden Incoming Velocity degerini 100, Outgoing Velocity degerini 0,01
yaparak animasyon hizini belirleyiniz (Gorsel 4.44).

Gorsel 4.44: Easy Ease degerlerinin ayarlanmasi
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SIRA SiZDE

Belirleyeceginiz bir konuda gorsel veya videolar Gzerinde en az iki kelimelik bir

sloganin tek kelimesini Track Matte kullanarak sloganla uyumlu gorsellerle maskeleyiniz.
Sloganin diger kelime veya kelimelerine Animate kullanarak animasyon ekleyiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme o6l¢itlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. istenen ¢oziiniirliik ve fps degerlerinde Composition olusturdu.

2. ilgili gorseli veya videoyu programa aktardh.

3. Arka plan gorselini veya videosunu katmanlar paneline ekledi.

4. Arka plan nesnesinin boyutunu en ve boy oranini koruyarak olgilendirdi.

5. Text aracini kullanarak ilgili metni olusturdu.

6. ilgili metnin boyutunu ayarladh.

7. Metni sahneye gore hizaladi.

8. ikinci kelimeyi Text aracini kullanarak ayri bir katmanda ekledi.

(Y-}

. Ik kelime katmanini harf sayisinca ¢ogaltt.

10. Cogaltilan katmanlardaki harfleri dogru sekilde konumlandirdi.

11. Harflerin alt katmanina ilgili gérselleri veya videolari ekledi.

12. Eklenen nesnelerin boyutlarini ayarladi.

13. Track Matte panelini aktif hale getirdi.

14. ilgili katmanlarda Alpha Matte 6zelligi ile dogru maskeleme yapt.

15. Arka planla kontrast i¢in Rectangle Tool nesneleri ile katmanlar olustur-
du.

16. Katmanlarin Opacity degerlerini ayarladi.

17. ikinci kelimenin Tracking Amount 6zelligiyle animasyon yapt.
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4. UYGULAMA

islem adimlarina gére sahnenin belirlediginiz bir yerinde maskelenerek ortaya ¢ikan
Text animasyonunu gergeklestiriniz.

1. Adim: CozinUrlGgu Full HD (1920x1080), Frame Rate degeri 30 fps olan bir Composition
olusturunuz.

2. Adim: Uygulama icinde kullanilabilecek gorsel veya videolari uygun web sitelerinden
indiriniz.
3. Adim: Gorselinizi katman paneline siiriikleyerek sahneye ekleyiniz.

4. Adim: Gorselin boyutunu dizenleyiniz (Gorsel 4.45).

Gorsel 4.45: Sahneyi tam dolduran arka plan gorseli

5. Adim: Text aracini kullanarak sahneye TRACK MATTE metnini yaziniz (Gorsel 4.46).
6. Adim: Arka plan gorselinin Ctrl+D ile kopyasini olusturunuz.

7. Adim: Kopyasini olusturdugunuz gorselin Track Matte 6zelligini aktiflestirerek Alpha Matte
secenegini metin katmani olacak sekilde ayarlayiniz.

8. Adim: Kopyasini olusturdugunuz gorseli metne gore hizalayiniz.
9. Adim: Kopya gorselin boyutunu eklediginiz metnin boyutuna gore Scale ile ayarlayiniz.

10. Adim: Track Matte uyguladiginiz gorselin Gzerine sag tiklayip, Transform>Flip Horizontal
secerek gorseli yatayda yansitiniz (Goérsel 4.46).

Gorsel 4.46: Yatay yansitma uygulanarak elde edilen Track Matte maskelemesi
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11. Adim: Arka plan ile metin arasinda kontrast olusmasi igin iki katman arasina Pen Tool
yardimiyla ici dolu bir Shape nesnesi ¢iziniz (Gorsel 4.47). Renk paletini agip, damlalik aracina
tiklayarak gorsel Gizerinden koyu bir ton seginiz ve katmanin Opacity degerini seffaf olabilecek
uygun bir degere ayarlayiniz (Gorsel 4.48).

Gorsel 4.47: Pen Tool araciyla Shape nesnesinin gizilmesi

/

Gorsel 4.48: Pen Tool yardimiyla Shape nesnesinin gizilmesi, renginin ve Opacity degerinin ayarlanmasi

12. Adim: Metne animasyon uygulayiniz.
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13. Adim: Text katmaninin tzerine sag tiklayip, Pre-compose... secerek Text katmanini Pre-
compose haline getiriniz. Bu uygulamada Pre-compose’u Text olarak adlandiriniz (Gérsel 4.49 ve
Gorsel 4.50).

Gorsel 4.49: Text katmaninin Pre-compose’a Gorsel 4.50: Pre-compose yapildiktan sonra
doniistiiriilmesi katmanin goriintiilenmesi

14. Adim: Pre-compose haline gelen Text katmanina cift tiklayarak Pre-compose’u aginiz.

15. Adim: Pre-compose’daki TRACK MATTE Text katmanini Ctrl+D ile iki kez ¢cogaltiniz (Gorsel
4.51).

Gorsel 4.51: Track Matte kelime animasyonu igin Text katmanlarinin gogaltilmasi

Ug¢ katmandan ilki hizalama ve maske ¢iziminde referans olacagi igin iic kopya
olusturuldu.

16. Adim: Kopyalanan diger iki katmandaki kelimeleri dizenleyiniz (Gorsel 4.52).
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Gorsel 4.52: Kelimelerin kilavuz kelimeye gore hizalanmasi

En alttaki TRACK MATTE katmani referans oldugu icin farkli bir renkle gosterildi.
Diger Text katmanlari Gorsel 4.52'de goriindtgi gibi diizenlenmelidir.

17. Adim: Alpha Inverted Matte olarak her bir katman icin Rectangle Tool nesnesi ¢iziniz
(Gorsel 4.53).

Cizilen Shape nesneleri
metinleri saklayacak ve
animasyonla metinler gorinir
yapilacaktir. Bu nedenle Shape
nesneleri kelimelerin saklanacagi
yerde olmalidir. Matte kelimesini
maskeleyecek Shape nesnesi, listte
gorinen kirmizi Shape nesnesidir.

Gorsel 4.53: Cizilecek Shape nesnelerinin konumlari
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18. Adim: Shape Layerlerini olusturduktan sonra Track Matte o6zelliginden Alpha Inverted
Matte secerek maskeleme yapiniz (Gorsel 4.54).

Gorsel 4.54: Alpha Inverted Matte segimi

19. Adim: Metinleri anime ediniz. Kelimeler ayni anda ortaya cikacak, bir siire bekleyip tekrar
kaybolacaktr.

20. Adim: Track ve Matte Layerlerinin Position 6zelligini gorlintilemek icin katman seciniz ve
klavyeden P tusuna basiniz (Goérsel 4.55).

Gorsel 4.55: Segili katmanlarda P tusuna basildiginda Position parametresinin goriintiilenmesi

21. Adim: Timeline gizgisini 1. saniyeye getiriniz ve Position yanindaki kronometre ikonuna
tiklayarak anahtar kareler olusturunuz (Gorsel 4.56).

Gorsel 4.56: Animasyona bitis anahtar karelerinin eklenmesi
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22. Adim: Timeline cizgisini 0. saniyeye cekiniz. Track kelimesini sahneden kayboluncaya
kadar asagi, Matte kelimesini ise yukari dogru hareket ettiriniz (Gorsel 4.57).

Gorsel 4.57: Animasyona baglangi¢ anahtar karelerinin eklenmesi

23. Adim: Sadece bitis anahtar karelerine F9 ile Easy Ease veriniz.

24. Adim: Kelimelerin sahnede 1 saniye durup tekrar gizlenmesi icin Timeline gizgisini 2.
saniyeye getiriniz ve Position 6zelliginin en solundaki anahtar kareye tiklayiniz (Gorsel 4.58).

Gorsel 4.58: Easy Ease uygulanmis anahtar karelerin Timeline goriintisii

25. Adim: Timeline gizgisini 3. saniyeye aliniz ve kelimeleri tekrar ortaya ciktiklari maske
alanina geri dondiriiniz (Gorsel 4.59).

Gorsel 4.59: Animasyona bitis anahtar karelerinin eklenmesiyle olugsan Timeline gérintiisii

26. Adim: Text Pre-compose’dan Comp1’e tiklayarak geri doniiniiz.
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27. Adim: Animasyonu Numpad 0 veya space tusuna basarak on izleyiniz. Gorsel 4.60’ta bu
animasyonun kesitleri verilmistir.

Gorsel 4.60: Animasyonun kesitleri

SIRA SiZDE

Sececeginiz bir konu hakkinda (spor, sanat vb.) gorsel belirleyip, konuya uygun bir
metni dordiincli uygulamada oldugu gibi Track Matte (Alpha Matte ve Alpha Inverted
Matte) ile maskeleyerek animasyonla hareketlendiriniz.

DEGERLENDIRME

Calismalarinizdiger sayfada yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.
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DEGERLENDIRME OLCUTLERI EVET HAYIR

. Istenen ¢éziiniirliik ve fps degerlerinde Composition olusturdu.

KONTROL LiSTESI

. Ilgili materyali programa aktardi.

. Arka plan gorselini veya videosunu katmanlar paneline ekledi.

. Arka plan nesnesinin boyutunu en ve boy oranini koruyarak olgilendirdi.

. Text aracini kullanarak ilgili metni olusturdu.

. Ilgili metnin boyutunu ayarladi.

. Metni sahneye gore hizaladi.

. Arka plan nesnesini Ctrl+D ile kopyaladi.

O |0 N OV IWIN (=

. Kopyaladigi arka plan nesnesinin Track Matte 6zelligine metin secerek mas-
keledi.

10.

Maskeledigi gorseli Transform>Flip Horizontal yaparak yansitti.

11.

Maskeledigi gorselin Scale degerini metne uygun hale getirdi.

12.

Arka plan ile metin arasina Pen Tool araciyla Shape nesnesini ¢izdi.

13.

Metin katmanina sag tiklayarak Pre-compose yapt.

14. Pre-compose icinde metinleri diizenledi.

15. Maskeleme igin Shape Rectangle Tool nesnelerini gizdi.

16. Track Matte 6zelliginden Alpha Inverted Matte secerek metinleri maskele-
di.

17. Position animasyonlarini anahtar kareler ile ilgili saniyelerde gergeklestirdi.
18. Anahtar karelere F9 ile Easy Ease 6zelligi verdi.

19. Comp1’e geri donerek animasyonu 6n izledi.

5. UYGULAMA

islem adimlarina gore Track Matte &zelliginin Luma Inverted Matte maskeleme

yontemini kullanarak bir calisma gercgeklestiriniz.

1. Adim: CozinUrlGgu Full HD (1920x1080), Frame Rate degeri 30 fps bir Composition

olusturunuz.

2. Adim: Uygulama iginde kullanilabilecek goérsel veya videolari uygun web sitelerinden

indiriniz.

3. Adim: Gorselleri katman paneline sirikleyerek sahneye ekleyiniz.

4. Adim: Gorsellerin boyutunu sahneye gore diizenleyiniz.

5. Adim: Gorseller arasi gegiste kullanilan videolari ink splash (mirekkep damlasi) ismiyle

bulunuz.
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6. Adim: Gegis videosunu da c¢alismaniza dahil ediniz.

7. Adim: Gegiste tek bir video kullanilacag icin projede g gorsel ve bir ink splash videosu
yer alacaktir. Katman panelindeki siralama Gorsel 4.61’deki gibi olacaktir. Timeline panelinde
gorselin kaginci saniyede baslamasini isterseniz Timeline panelinde yer alan katman izini mouse
ile sirlikleyerek ilgili saniyeye yerlestiriniz.

AN
AN

Gorsel 4.61: Gorseller ve gegis videosu ile birlikte katman paneli ve Timeline gériinimii

8. Adim: Gegis videosunu Ctrl+D ile gorsel sayisinca ¢ogaltiniz.
9. Adim: Videolar ile gorsellerin baslangicinin ayni hizada olmasina dikkat ediniz (Gorsel 4.61).

10. Adim: Katman panelinde en alttaki gorselin Scale ve Rotation 6zelliklerini aktiflestiriniz.
Bu islem icin Shift tusu basiliyken S (Scale) ve R (Rotation) tuslarina basildiginda sadece iki 6zellik
alt alta goriinecektir.

11. Adim: Gorselin baslangicina Scale ve Rotation degerleri igin birer anahtar kare ekleyiniz.

12. Adim: Timeline gizgisini videonun bitisine aliniz. Scale degerini artirirken Rotation degerini
birkac derece degistiriniz (Gorsel 4.62).
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Gorsel 4.62: Rotation ve Scale degerlerindeki degisim

13. Adim: Katman panelinde en alttaki gorselin Timeline panelinde bulunan anahtar karelerini
mouse isaretgisiyle segili hale getirip Ctrl+C ile kopyalayiniz.

14. Adim: ikinci gérselin baslangic Frame’ine Timeline cizgisini cekip Ctrl+V ile yapistiriniz.
Boylece bir yerdeki animasyon anahtar karelerini bagka katmanlara da aktarabilirsiniz. Ayniislemi
Uclincl gorsel icin de yapiniz (Gorsel 4.63).

Gorsel 4.63: Ctrl+C ve Ctrl+V ile kopyalanip yapistirilan anahtar karelerin Timeline panelindeki son hali

15. Adim: Gorsellerin katman panelindeki Track Matte 6zelliklerini Luma Inverted Matte
olarak belirleyiniz (Gorsel 4.64).

Gorsel 4.64: Gorsele Luma Inverted Matte uygulanmasi
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16. Adim: Yaptiginiz calismayi On izleyiniz (Gorsel 4.65).

Gorsel 4.65: Luma Inverted Matte uygulanmig gorsellerin sahnedeki goriiniimii

SIRA SiZDE

Belirleyeceginiz bir konu icin birden fazla gorsel bulunuz. Goérsel gegisleri icin ink
splash tarzi video veya videolar bularak bir akis gerceklestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. istenen ¢oziiniirliik ve fps degerlerinde Composition olusturdu.

2. Gorselleri katman paneline yerlestirdi.

3. Ink splash videoyu katman paneline yerlestirdi.

4. Videoyu gorsel sayisi kadar ¢ogaltt.

5. Her bir gorselin st katmanina bir video gelecek sekilde dlizenledi.

6. Gorseller ve videolari Timeline panelinde istenen saniyelere surikleyerek
zaman ayarlamasi yapt.
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DEGERLENDIRME OLCUTLERI EVET HAYIR

7. Videolar ile gorsellerin baslangi¢ Frame’lerini eslestirdi.

8. ilk gorsele Scale ve Rotation animasyonlari igin anahtar kareler olusturdu.

9. ilk gorselden Ctrl+C ile kopyaladigi anahtar kareleri diger gorsellere de
Ctrl+V ile yapistirdi.

10. Track Matte 6zelliginden Luma Inverted Matte segerek ink splash video
ile gorselleri maskeledi.

4.2. YESIL PERDE (GREENBOX) TEKNOLOJISI

Chroma Key (Anahtarlama) islemindeki Greenbox teknigi, tek renk bir zemin tzerindeki
gorintinin renk maskelemesiyle zemin renginden ayristirilarak baska bir gorsel veya video
Uzerine eklenmesi islemidir. Bu islem, tek renk zemin olarak yesil (Greenbox) tercih edildigi icin
Greenbox diye de adlandirilir. Ortam, kostiim vb. durumlara gére zemin renginde mavi (Bluebox)
de tercih edilebilir.

Chroma Key tekniginde arka planda ¢ogunlukla yesil renk kullanilmasi, yesilin insan ten
renginde en az bulunmasindan dolayidir. Eger ilgili sahnede yesil renkli nesnelerin bulunmasi
gerekiyorsa bu durumda mavi renkli arka plan kullanilir. Bu arka plan; kumas, isik yansitmayan
kagit ve Chroma Key igin 6zel boyalarla elde edilebilir.

Bu teknik ilk olarak Larry Butler tarafindan 1940 yilinda c¢ekilen Bagdat Hirsizi (The Thief
of Bagdad) filminde kullanilmistir. Reklam, bilim kurgu, tarihi filmler ve tehlikeli olabilecek
sahnelerde sikhkla kullanilan bir teknik olmaya devam etmektedir (Gorsel 4.66).

Gorsel 4.66: Greenbox tekniginin kullanildigi sahnelerden gériintiiler

Chrome Key isleminde tek renk arka plan rengi bilgisayar yazilimlariyla temizlense de kaliteli
sonuclar icin dikkat edilmesi gereken bazi hususlar sunlardir:

1. Arka plan rengi ile 6n planda kalan nesne veya kisi arasinda mesafe olmalidir. Aksi halde
Keying isleminde arka plan renginin sinir cizgilerine yansimasi sonucu kisinin etrafinda renk
atlamasi denilen bir yansima meydana gelebilir. Ayrica kisinin golgesi arka plana diserse veya
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arka plan zemini (perde, kagit vb.) kirisiksa Keying isleminde zorluklarla karsilasilabilir (Gorsel
4.67).

Anahtar Isik (Key)
100%

Kamera

Yesil Perde
Greenbox

Kisi ya da Nesne

Arka Isik (Back) Dolgu Isik (Fill)
40% 60%

Gorsel 4.67: Greenbox stiidyosu plani

2. Video cekimleri acik alanlarda yapilabildigi gibi Chroma Key icin 6zel olarak hazirlanmis
studyolar da kullanilir. Bu durumda Greenbox yeterli buyiklikte olmalidir (Gorsel 4.68).

Gorsel 4.68: Chroma Key icin 6zel olarak hazirlanan stiidyo

3. Chroma Key tekniginde 1siklandirma ¢ok énemlidir. Arka plan yiizeyi dogru ve esit bir sekilde
aydinlatilmalidir (Gorsel 4.69).

Gorsel 4.69: Arka plani esit aydinlatiimamis gorsel
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4. On plandaki nesne veya kisilerin de esit ve dengeli bir sekilde aydinlatiimasi, istenen
kalitede sonuglar igin gereklidir (Gorsel 4.70).

Gorsel 4.70: Dogru igsiklandirilmis Greenbox ortami ve gorseli

5. Arka plan rengi ile ayni renkte kiyafet ve aksesuar kullanilmamalidir. Siyah kiyafet daha iyi
sonuglara yardimci olacaktir.

6. Greenbox ortaminda bir video c¢ekimi yapilirsa kamera ayarlari hareket bulanikhigini
giderecek sekilde olmalidir.

6. UYGULAMA

islem adimlarina gére Greenbox ile gekilmis bir gériintiiyli gérsel efekt programinda
Chroma Key teknigiyle kullaniniz.

1. Adim: CozUnUrlGga Full HD (1920x1080) piksel olan bir Composition olusturunuz.

ONEMLI: Uygulamada video kullanilacaksa Composition Frame Rate hizi, videonun fps
degerine gore belirlenmelidir.

2. Adim: Uygulama icinde kullanilabilecek gorsel veya videolari uygun web sitelerinden

indiriniz.

3. Adim: Gorseli veya videoyu sahnenin katman paneline ekleyiniz (Gorsel 4.71)

Gorsel 4.71: Sahnenin katman paneline gérsel eklenmesi
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4. Adim: Keying islemi icin Effect>Keying>Keylight1.2 efektini Greenbox ile ¢ekilmis gorin-

tlinln Gzerine ekleyiniz.

Cahsma dizleminde Effect Control paneli kapaliysa Window>Effect Control yolu ile
actlip bu panel goriintilenebilir.

5. Adim: Keylight 1.2 efektindeki Screen Colour parametresinin yanindaki damlalik aracina
tiklayarak sahnedeki nesnenin arka plan renginden secim yapiniz. Yesil alanlar saydam hale
gelmelidir (Gorsel 4.72).

Gorsel 4.72: Keylight 1.2 efektinde Screen Colour parametresi ekrandaki yesil renkle ayarlandiginda
olugan goriintii

NOT

Arka plan rengini saydamlastirmada istenen sonug elde edilmemisse bunun isik
ve ¢ekimle ilgili bir eksiklikten kaynaklandigi unutulmamahdir. Keylight 1.2 yardimci
parametre ayarlari bu eksiklikleri bir yere kadar tolere edebilir. Gorsel 4.73'teki
parametrelerden bazilarinin degerleri degistirilerek gorsele uygulanmistir (Gorsel 4.72).
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Gorsel 4.73: Keylight efektine ait parametreler

6. Adim: Tek renk arka plan rengini saydamlastirdiginiz gérselin alt katmanina konuya uygun
baska bir gorsel veya renk ekleyerek uygulamayi tamamlayiniz (Gorsel 4.74).

Gorsel 4.74: Chrome key teknigi ile degistirilen arka plan goriiniimi

NOT

On plandaki gérsele Tranform>Flip Horizontal yénlendirmesi uygulanmstir.

SIRA SizDE

Sececeginiz Greenbox ile ¢cekilmis bir gorseli veya videoyu uygun baska bir gorsel

veya video Uzerine ekleyerek 6zgiin bir calisma gerceklestiriniz.
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DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. istenen ¢oziiniirliikte Composition olusturdu.

2. ilgili gorseli veya videoyu programa aktardh.

3. Chroma Key uygulanacak gorseli veya videoyu katman paneline ekledi.

4. Effect>Keying>Keylight1.2 efektini Chroma Key teknigi ile ¢cekilen gorsele
veya videoya ekledi.

5. Screen Colour parametresi ile ekrandan arka plan rengini secti.

6. Tek renk arka plani saydamlastirmada sorunlar olustuysa diger Keylight
ayarlarini degistirerek goriinti sorunlarini giderdi.

7. Arka plani saydamlastirarak maskelenmis gorseli veya videoyu kompozis-
yona uygun baska bir gorselin veya videonun (st katmanina ekledi.

4.3. ROTO BRUSH ARACI MASKELEME VE ROTOSKOP

Gorsel efekt programinda Roto Brush, hareketli gorintilerdeki kisilerin veya nesnelerin
secime bagl sezgisel olarak sinirlarini belirleyen ve bunlari arka plandan ayirarak maskeleyen
aractr.

Shape veya Pen Tool araclariyla videolardaki hareketli bir nesneyi anahtar kareler ekleyerek
maskelemek is ylikina oldukga artirir. Roto Brush araciyla bu is kolayca yapilabilir. Refine Edge
Tool ise detaylarin ok oldugu sac, ¢cimen vb. alanlari Roto Brush isleminden sonra maske alanina
dahil etmek igin kullanilir (Gorsel 4.75).

Gorsel 4.75: Gorsel efekt programinda Roto Brush Tool ve Refine Edge Tool aracinin yeri

Rotoskop, video kaydi alinan gercek goruntilerin 6zel bir yizeye yansitilarak videodaki
hareketlerin kopyalanmasi teknigidir. Boylece cizilen karakterlerin animasyonlari daha gergekgi
hale gelir. ilk olarak 1917 yilinda Max Fleischer isimli yapimcinin kullandigi bu teknik geliserek
glinimiize kadar gelmistir. GUinimizde video kayitlarinin {izerine gizimler eklenerek videoyu
yeniden olusturma seklinde de kullanilir. A Scanner Darkly, Undone benzeri filmler bu teknikle
olusturulmustur.
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Motion Capture isimli teknik de Rotoskop tekniginden ilham alinarak gelistirilen animasyon
yakalama teknigidir.

7. UYGULAMA

islem adimlarina gore gorsel efekt programinda Roto Brush aracini kullanarak bir
calisma gerceklestiriniz.

1. Adim: Roto Brush aracini kullanarak islem yapilacak videonun fps degerlerine sahip bir

Compotision olusturunuz.

Hazir bir calismaya video eklenerek Roto Brush islemi yapilacaksa videonun fps
degeri Compotision Frame Rate degerine esitlenmelidir (bk. Interpret Footage) ve
sahne izleme ¢ozlndrlGga Full olmalidir.

2. Adim: Uygulama ic¢inde kullanilabilecek gorsel veya videolari uygun web sitelerinden
indiriniz.

3. Adim: Videoyu katman paneline siiriikleyerek ekleyiniz. Ardindan katmanin Uzerine gift
tiklayarak sahnede katman detayina erisiniz (Gorsel 4.76).

/

)

Gorsel 4.76: Katman panelinde katmana cift tiklandiginda sahnede agilan katman detayi
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4. Adim: Roto Brush aracini seginiz (Gorsel 4.75). Videoda maskelenecek alani sinirlarindan
tasmadan boyayiniz (Goérsel 4.77 ve Gorsel 4.78).

Gorsel 4.77: Roto Brush araci ile maskelenecek Gorsel 4.78: Roto Brush sonrasi olusan
alanin boyanmasi maskeleme sinirlari

Kullanilan videonun bir kesitine Roto Brush uygulanacaksa set IN poin to current
time ve set OUT point to current time butonlariyla videonun tamamindan yalnizca bir
bolim secilecek sekilde bir ayarlama yapilir. Videonun ister bir kesitine ister tamamina
Roto Brush uygulanmasinda Timeline ¢izgisi ilk Frame’de iken isleme baslanmahdir
(Gorsel 4.79).

] [l

Gorsel 4.79: Set IN poin to current time ve Set OUT point to current time noktalari ile ilk Frame vurgusu

5. Adim: Maskeleme alaninda tasmalar varsa klavyeden Alt tusuna basarak tasan alanlari
tekrar boyayiniz. Roto Brush firgasinin boyutu Ctrl tusu ile ayarlanarak daha hassas galisilabilir
(Gorsel 4.80).
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Gorsel 4.80: Alt tusuyla tagmalarin giderildigi maskelenen Roto Brush iglemi

6. Adim: Space tusuna basarak 6n izleme yapiniz. Videonun ister bir kesitine ister tamamina
Roto Brush uygulandiginda kisi veya nesne her Frame’de maskelenir.

7. Adim: On izlemeyi dikkatlice yapiniz. Herhangi bir Frame’de maske alaninda tasma varsa o
Frame’de gerekli Roto Brush diizeltme islemini Alt tusu ile olabildigince hatasiz yapmaya galisiniz.

NOT

Roto Brush aracinin kusursuz g¢alisabilmesi icin dikkat edilecek hususlar sunlardir:

1. Videonun ¢ekim kalitesi ¢ok iyi olmalidir.

2. Videodaki nesne arka planla benzer renklerden uzak olmahdir.

8. Adim: Kullanilacak tiim Frame’ler i¢in se¢im ve maskeleme islemi tamamlandiktan sonra
pencerenin alt tarafindaki Freeze butonuna tiklayiniz (Gorsel 4.81).

—

Gorsel 4.81: Roto Brush isleminin tamamlanmasi igin Freeze butonuna tiklanmasi
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9. Adim: Freeze islemini tamamlayip sahneye déndigiliniizde belirlenen nesne veya kisinin
maskelenmis goriintlisiint goriintiz (Gorsel 4.82).

Gorsel 4.82: Roto Brush ile maskelenen kisinin sahnedeki goriintiisu

10. Adim: Maskelenmis videonun kopyasini Ctrl+D ile alip alt katmana sirikleyiniz. Effect
kontrol panelinden Roto Brush efektini kaldiriniz. Boylece sahnede Roto Brush uygulanmis ve
uygulanmamis ayni videodan iki tane olacaktir.

11. Adim: Bu iki katman arasindan temaya uygun bir metin animasyonu gerceklestirerek
uygulamayi tamamlayiniz (Gorsel 4.83).

Gorsel 4.83: Roto Brush kullanilarak maskelenmis goriintii ve metin animasyonu
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SIRA SiZDE

Segeceginiz videodan bir kisiyi Roto Brush kullanarak maskeleyiniz. Temaya uygun
bir arka plan ve metin ile destekleyerek bir animasyon gergeklestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

. istenen ¢éziinirliikte Composition olusturdu.

. ilgili videoyu programa aktardh.

. Video katman panelini acti.

. Roto Brush araci ile segim yapt.

. Space tusuna basarak belirlenen aralikta 6n izleme yapti.

. Her Frame'yi kontrol ederek tasma veya eksik alan varsa dizeltti.

. Ana sahneye geri donerek temaya uygun arka plan ve metin belirledi.

W I N o | v A WIN|F

. Metin animasyonu gercgeklestirerek calismayi tamamladi.
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OLCME VE DEGERLENDIRME

A) Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Asagidaki kisayol tuslarindan hangisi gorsel efekt programinda katman panelindeki
maske alt katmanlarini gosterir?

A)M B) P CR D)T E)U

2. Gorsel efekt programinda Shape nesnesinin maske olarak ¢alismasi i¢in asagidakilerden
hangisi yapilmalidir?
A) Composition Frame Rate degeri gorsel veya video ile ayni olmalidir.
B) Sahnedeki nesne, katman panelinde segcili vaziyette olmalidir.
C) Sahnede en az iki nesne bulunmalidir.
D) Sahnedeki nesnenin 3D ozelligi aktiflestirilmelidir.

E) Sahnedeki nesneye herhangi bir efekt eklenmemis olmalidir.

3. Asagidaki 6zelliklerden hangisi Mask alt katmanina ait degildir?
A) Expansion
B) Feather
C) Opacity
D) Orientation
E) Path

4. Pen Tool araci ile eklenen bir vertexi kaldirmak icin asagidaki hangi kisayol tusu basil
tutulmahidir?

A) Alt B) Alt Gr C) Cmd D) Ctrl E) Shift

5. Track Matte i¢in asagidakilerden hangisi dogrudur?
A) D tusu ile kisayoldan erisilir.
B) Efekt menisiinden erisilir.
C) Katman panelinde hep gorinir.
D) Keyframeler ile animasyon yapilir.

E) Transfer Controls pane ile aclilip gizlenir.
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6. Greenbox tekniginden yararlanarak video ¢ekimi yapilirken asagidaki renklerden hangisi
video 6znesi lizerinde bulunmamahdir?

A) Gri

B) Kirmizi
C) Mavi
D) Siyah
E) Yesil

7. Hareketli goriintiilerdeki bir nesneyi arka plandan ayirmak i¢in asagidaki araglardan
hangisi kullanilmalidir?
A) Clone Stamp Tool B) Hand Tool C) Puppet Pin Tool
D) Shape Tool E) Roto Brush

8. Asagidaki araglardan hangisini kullanirken Composition Frame Rate ile video fps degerleri
ayni olmalidir?

A) Clone Stamp Tool B) Puppet Pin Tool C) Roto Brush
D) Shape Tool E) Text Tool

Gorselde kirmiziyla isaretlenen alan asagidaki hangi arag kullanilarak elde edilir?

A) Mask Expansion
B) Mask Feather

C) Mask Feather Tool
D) Mask Opacity
E) Mask Path
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5. OGRENME BiRiMi

GORUNTU EFEKTI
OLUSTURMA




HAZIRLIK CALISMALARI

1. Gorsel efekt programlarinda efektlerin 6nemi nedir?

2. CGI teknolojisi sinema diinyasina nasil bir katki sunmustur?

5.1. EFEKTLER

Efektler, gorsel efekt programlarinin gercek gliclinl ortaya cikaran araclardir. Bazi efektler
Plugin adi verilen eklentilere donlsturulerek daha kolay uygulanabilir.

5.1.1. Efektlerin Nesnelere Eklenmesi

Efektler secili katmana uygulanir. Secili bir katmana efekt uygulayabilmenin birden fazla yolu
bulunur. Ornegin katman seciliyken Ustteki Effect menisiinden ilgili efekt segilerek katmana
eklenebilir (Gorsel 5.1).

Gorsel 5.1: Effect meniisiinden efektin secilmesi
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Bir diger yontem ise Effects & Presets componentinin arama kismina yazilarak efekte
erisilmesidir. Efektin Gzerine tiklanarak veya efekt siriklenerek segili katmana eklenebilir (Gorsel
5.2). Effects & Presets componenti Window meniisiinden goriintilenip gizlenebilir.

Gorsel 5.2: Effects & Presets componentinden efektin bulunmasi ve segili katmana eklenmesi

5.1.2. Effect Control Paneli

Bir katmana efekt eklendiginde efektin cesitli 6zelliklerinin degistirildigi Effect Controls paneli
gorintilenir. Panel gizliyse klavyeden F3 tusuna basilarak veya Window>Effect Controls yolu
secilerek panel gorintiilenebilir (Gorsel 5.3).

Gorsel 5.3: Efekt eklendikten sonra Effect Controls panelinin goriinimii
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Ayni katmana birden fazla efekt eklendiginde efektler Effect Controls panelinde alt alta
siralanir. Her efektin kendine ait parametreleri vardir (Gorsel 5.4).

Gorsel 5.4: Birden fazla efektin bir katmana eklenmesi ve efektlerin Effects Controls panelinde siralanmasi

5.1.3. Adjusment Layer ve Efekt Kontroli

Efektler sahnede secili nesneye eklenebilir ancak bazi durumlarda bir efektin tim sahneyi
etkilemesi gerekebilir. Ornegin renk diizenleme, lens blur vb. efektler icin Adjustment Layer
katmani eklenerek efekt bu katman Uzerine uygulanir. Boylece sahnedeki tim nesneler efektten
etkilenir. Adjustment Layer katmani, Timeline katman paneline sag tiklayip New boéliimiinden
eklenebilir (Goérsel 5.5). Bu katman, Layer menisiinden New yolu takip edilerek de eklenebilir.

292 | Goruntu Efekti Olusturma



Gorsel 5.5: Katman panelinden Adjustment Layer eklenmesi

Adjustment Layer seffaf bir katmandir ve (zerine eklenen efektleri kendinden asagidaki
katmanlara yansitmak icin kullanilir (Gorsel 5.6).

Gorsel 5.6: Adjustment Layer katmanina Tint efekti eklenmis ve maskelenmis bir calisma
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5.1.4. Plugin Eklemek

Bazi efektler Plugin adi verilen ve 6zel yiklenen araglarla kolay ve hizli bir sekilde
gerceklestirilebilir. Pluginler cogunlukla Ucretli araglardir ancak bazi Ureticiler, bazi Pluginleri
Ucretsiz olarak da sunabilir. Video Copilot’a ait Saber Plugini lcretsiz eklentilere 6rnek iken ayni
Ureticinin Element 3D eklentisi Ucretli bir Plugindir. Saber Plugini ilgili Greticinin sayfasindan
indirilip kuruldugunda Effects menistne eklenecektir (Gorsel 5.7).

Gorsel 5.7: Saber Plugini yiiklendikten sonra Effects & Presets panelinde goriintiilenmesi

Saber Plugini ile Gorsel 5.8’de gortilen efektler kolayca yapilabilir.

Gorsel 5.8: Ucretsiz Saber Plugini ile videodaki bir nesneye efektlerin uygulanmasi
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1. UYGULAMA

islem adimlarina gére Glitch adi verilen etkiyi gerceklestiriniz.

1. Adim: CozunUrlGga Full HD (1920x1080) piksel olan bir Composition olusturunuz.

2. Adim: Sahneye bir portre fotograf ekleyiniz.

3. Adim: Fotografin boyutunu uygun oldugunu disiindigiiniiz bir 6lgliye ayarlayiniz.
4. Adim: Timeline katman alaninda New>Solid yoluyla siyah renk bir Solid olusturunuz.

5. Adim: Katmanin adini Fractal Noise olarak degistiriniz (Gorsel 5.9).

Gorsel 5.9: Siyah renk Solid katmanin eklenmesi ve adinin Fractal Noise olarak degistirilmesi

6. Adim: Fractal Noise ismini verdiginiz siyah renkli Solid katmanin lzerine Effects & Presets
panelinden Fractal Noise efektini slrlkleyerek birakiniz (Gorsel 5.10).

Gorsel 5.10: Fractal Noise efekti eklenmis siyah renkli Solid katmanin gériiniimii
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7. Adim: Effect Controls panelindeki Fractal Noise degerlerini Gorsel 5.11’deki degerlere
benzer sekilde uygulayiniz.

Gorsel 5.11: Fractal Noise efektine ait degerler

8. Adim: Timeline katman paneline sag tiklayip Adjustment Layer ekleyiniz.

9. Adim: Adjustment Layer katmanina Effects & Presets panelinden Displacement Map
efektini ekleyiniz.

10. Adim: Adjustmen Layer Gzerindeki Displacement Map efektinin degerlerini Gorsel 5.12'de
gorildugl gibi degistiriniz.

Gorsel 5.12: Displacement Map Layer degerinin Fractal Noise katmani olarak degistirilmesi
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11. Adim: Fractal Noise katmanini secip Timeline ¢izgisini 1. saniyeye cekiniz.

12. Adim: Effect Controls panelinde Fractal Noise efektinin Random Seed degerini 1. saniyede
0 olarak degistirip anahtar kare ekleyiniz.

13. Adim: Timeline gizgisini 2. saniyeye ¢ekip Random Seed degerini artiriniz (Gorsel 5.13).

Gorsel 5.13: Random Seed degerinin anahtar kareyle anime edilmesi

14. Adim: Fractal Noise isimli katman Gzerindeki efektin etkili olabilmesi icin bu katmani Pre-
compose haline getiriniz (Gorsel 5.14).

Gorsel 5.14: Fractal Noise katmaninin Pre-compose haline getirilmesi
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15. Adim: Gorsel 5.15'te oldugu gibi Comp 1'de var olan G¢ katmani secip, Pre-compose
haline getirerek adina Goérsel Orijinal ismini veriniz.

Gorsel 5.15: Comp 1’de yer alan li¢ katmanin segilerek Gorsel Orijinal ismiyle Pre-compose haline

getirilmesi

16. Adim: Timeline katman panelinde yer alan Gorsel Orijinal isimli katman segiliyken
klavyeden Ctrl+D kisayolu ile katmani ¢cogaltiniz ve adini Gorsel Kirmizi olarak degistiriniz.

17. Adim: Gorsel Kirmizi isimli katmana Effects & Presets panelinden Shift Channels isimli
efekti ekleyiniz ve ayarlarini Gorsel 5.16’da gorildigi gibi yapiniz.

Gorsel 5.16: Gorsel Kirmizi katmanina ekli Shift Channels efektinin ayarlarn

18. Adim: Gorsel Kirmizi katmanini Gorsel Yesil ve Gorsel Mavi adiyla iki kez daha ¢ogaltiniz ve
Shift Channels efektindeki Blue ve Green ayarlarini yapiniz.

Yesil katmanda Take Green From= Green, diger renkler Full Off seklinde; Mavi
katmanda da Take Blue From= Blue, diger renkler Full Off seklinde ayarlanmalidir.

Goruntl Efekti Olusturma



19. Adim: Shift Channels efektine ait ayarlamalar ve katman c¢ogaltma islemini bitirdikten
sonra ¢ogalttiginiz ti¢ renk katmaninin karisim modlarini Screen olarak degistiriniz (Gorsel 5.17).

Gorsel 5.17: Kopyalanan katmanlar ve karisim modlarinin ayarlanmasi

20. Adim: Renk katmanlarinin Gglinii de segip, klavyeden P tusuna basarak Position 6zelligini
gorintileyiniz.

21. Adim: Gorsel Yesil katmanindan baslayip, Position 6zelligi yanindaki anahtar kare ikonuna
Alt tusuna basiliyken bir kez tiklayarak Expression: Position 6zelligini goriintileyiniz (Gorsel 5.18).

Gorsel 5.18: Alt tusu ile birlikte Position 6zelligi yanindaki anahtar kare ikonuna tiklandiginda agilan
Expression ozelligi

22. Adim: transform.position scriptinin yer aldigl script alanina wiggle(10,30) scripti
ekleyiniz ve fare ile bos bir alana tiklayiniz.

wiggle titresim scriptinde 10 degeri frekansa, 30 degeri ise genlige karsilik gelir.
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23. Adim: Diger iki renk katmani icin de wiggle(10,30) scripti ekleyiniz (Gorsel 5.19).

Gorsel 5.19: Renk katmanlarinin Position 6zelliklerine wiggle(10,30) scriptinin eklenmesi

24. Adim: Yesil, Mavi ve Kirmizi renkli katmanlarin sahnede goériinmesini 1. saniyeye kadar
engellemek i¢in Timeline gizgisini 1. saniyeye ¢ekip renk katmanlarinin Opacity 6zelligini O’a
getiriniz. Timeline cizgisini 10 frame ilerletip renk katmanlarinin Opacity degerini 100 yapiniz.
Timeline ¢izgisini 10 frame ilerletip, renkli katmanlarin Opacity degerini 100 olarak tekrar
anahtar kareleyiniz. Timeline gizgisini 10 frame daha ilerletip bu kez renk katmanlarinin Opacity
degerlerini 0 yapiniz (Gorsel 5.20).

Gorsel 5.20: Opacity ozelligiyle anahtar karelenmis katmanlarin Timeline goriintiisu

25. Adim: Katman paneline sag tiklayip New>Adjustment Layer ekleyiniz.

26. Adim: Adjustment Layer katmanina Effects & Presets panelinden Optic Compensation
efektini ekleyiniz.

27. Adim: Effects & Presets panelinden Adjustment Layer katmanina Radial Blur efektini de
ekleyiniz (Gorsel 5.21).
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Gorsel 5.21: Effect Controls panelinde iki efektin alt alta gériinimii

28. Adim: Timeline gizgisini 1. saniye 20. frameye getiriniz.
29. Adim: Optic Compensation efektinde Reverse Lens Distortion kutusunu isaretleyiniz.
30. Adim: Radial Blur efektinde Type segenegini Zoom olarak degistiriniz.

31. Adim: Timeline gizgisi 1. saniye 20. framedeyken Field Of View ve Amaount degerlerinin
anahtar kare ikonlarina tiklayip birer keyframe olusturunuz.

32. Adim: Timeline cizgisini 2. saniyeye c¢ekiniz. Field of View ve Amount degerlerini Gorsel
5.22'de goruldigu gibi ayarlayiniz.

Gorsel 5.22: Optics Compensation efektinde Field of View degeri, Radial Blur efektinde Amount
degerinin gosterimi
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Glitch etkisi bir gorsel veya videodan baska bir gorsel ya da videoya gecis icin
kullanilabilir. Dolayislyla istenirse Optics Compensation ve Radial Blur efekti ile birlikte
Rotation animasyonu da eklenebilir.

33. Adim: Efektler uygulandiktan sonra elde edilen etkiyi 6n izleyiniz (Gorsel 5.23).

Gorsel 5.23: Efektlerin uygulanmasi sonucu elde edilen etki

SIRA SiZDE

Belirlediginiz gorsel veya videolar arasinda Glitch etkisini gecis olarak kullanacaginiz
bir animasyon gergeklestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. istenen ¢oziiniirliikte Composition olusturdu.

2. ilgili video veya gérseli programa aktardi.

3. Gorsel veya video lizerine siyah Solid katman olusturdu.
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DEGERLENDIRME OLCUTLERI EVET HAYIR

4. Siyah Solid katmanda Fractal Noise efekti ile gerekli ayarlamalari yapti.

5. Siyah Solid katmani Pre-compose haline getirdi.

6. Katman paneline Adjustment Layer ekledi.

7. Adjustment Layer katmanina Displacement Maps efekti ekleyerek gerekli
ayarlamayi yapti.

8. Tum katmanlari secerek Pre-compose haline getirdi.

9. Pre-compose haline gelen katmanlari Ctrl+D ile kopyaladi.

10. Shift Channels efektini kopyalanan katmana ekledi.

11. Shift Channels ekli katmani iki kez daha kopyalayarak renk diizenlemelerini
yapt.
12. Renk katmanlarinin Position ozelliklerine wiggle (10,30) Expressionu
ekledi.

13. Renk katmanlarinin Opacity Ozelligi ile gereken animasyonu anahtar kare-

lerle gerceklestirdi.

14. Adjustment Layer ekledi.

15. Adjustmen Layer katmanina Optic Compensation efektini ekledi.

16. Adjustmen Layer katmanina Radial Blur efektini ekledi.

17. ikinci gorsel veya videoyu bu etkiden hemen sonra yerlestirerek gecis
animasyonunu gergeklestirdi.

2. UYGULAMA

islem adimlarina gére 3D Camera Tracker efektinden yararlanarak videolara sabit
yazi veya logo ekleyiniz.

1. Adim: Cozanarltga Full HD (1920x1080) piksel olan bir Composition olusturunuz.

2. Adim: Sahneye bir video ekleyiniz.

Ucretsiz ve telifsiz video destegi saglayan sitelerden video indirilebilir.

3. Adim: Video Frame Rate o6zellikleri ile olusturdugunuz Comp 1 6zellikleri benzer degilse
Project menisiinde videoya sag tiklayip New Comp from Selection yoluyla videodan bir
Composition olusturunuz.

4. Adim: Effects & Presets panelinden 3D Camera Tracker efektini bulup, video Uzerine
suriikleyerek birakiniz.
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NOT

Window menusiinden Tracker secenegi tiklanip, Track Camera segenegi secilerek de
ayni efekte erisilebilir (Gorsel 5.24).

Gorsel 5.24: 3D Camera Tracker ve Tracker béliimiinden Track Camera’ya erigsim

5. Adim: 3D Camera Tracker efekti ekleyerek gorsel efekt programinin videoyu analiz etmesini
saglayiniz (Gorsel 5.25).

Gorsel 5.25: 3D Camera Tracker ile videonun islenmesi

Videonun sadece bir bélimiinde bu etkinin ¢alismasi istenirse video, Comp 1 icinde
sinirlanabilir.
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Analiz sona erdiginde video tizerinde renkli noktalar géruliir (Gorsel 5.26). Bunlar,
sabitlenecek yazi, Solid vb. unsurlar icin referans noktalaridir. Noktalardan biri veya
birkaci birlikte secilip, sag tiklanarak agilan mentiden istenen nesne eklenebilir.

Gorsel 5.26: Track pointlerin video ilizerinde gériintiilenmesi

6. Adim: Belirlediginiz bir noktaya veya sectiginiz noktalar grubuna sag tiklayip Create Text
and Camera segenegini isaretleyiniz (Gorsel 5.27).

Gorsel 5.27: Create Text and Camera segeneginin isaretlenmesi
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7. Adim: Sahneye bir Text yazisi eklenecektir. Bu yazlyl videonuza uygun bir kelimeyle

degistiriniz. Yazinin agisini ve blyiikliglini Transform 6zelliklerinden istediginiz gibi ayarlayiniz
(Gorsel 5.28).

Gorsel 5.28: Eklenen Text yazisinin degistirilerek ayarlanmasi

Eklenen yazinin video 6n izlendiginde sabit bir nesne gibi davranmasi beklenir.
Eklenen yazinin sahneye daha fazla dahil olmasi istenirse Gorsel 5.29°da gorildigu gibi
video kopyalanip, maskeyle sinirlandirilarak daha etkin videolar tasarlanabilir.

Gorsel 5.29: Videonun kopyalanmasi ve maskeyle sinirlandirilmasi

NOT

Element 3D Plugini sayesinde 3D objeler eklenerek CGI destekli videolar da
yapilabilir.
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SIRA SiZDE

Belirleyeceginiz bir videoda 3D Camera Tracker efektini uygulayarak bir metin efekti
gerceklestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olgttlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. istenen ¢oziiniirliikte Composition olusturdu.

2. ilgili video veya gorseli programa aktardi.

3. Videodan Comp olusturdu.

4. Video lzerine Track Camera veya 3D Camera Tracker efekti ekledi.

5. Analiz sonrasi Track Point noktasi belirledi.

6. Belirlenen Track Point noktasina Text and Camera ekledi.

7. Eklenen Text yazisini diizenledi.

8. Videoyu kopyalayarak maskeyle diizenledi.

5.2. SAHNEDE KAMERA

Gorsel efekt programlari g boyutlu bir uzay dizlemine sahiptir. Bu ¢alisma dizleminde
yapilan animasyonlara derinlik, bir baska deyisle Z eksenine ait boyut ise katildiginda etkisi daha
glcli animasyonlar ortaya cikarilir. Ayrica CGl (Computer Generated Imagery), VFX vb. sinematik
kavramlara ait etkileri videolarda gosterebilmek icin bu U¢ boyutlu uzay dizlemi kullanilir. Bu
uzay diizlemindeki nesneleri gosterebilmek igin varsayilan gériinim alanindan fazlasina ihtiyag
vardir ve bu ihtiyac, sahneye baska kameralar eklenerek giderilebilir.
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Gorsel efekt programinda sahneye kamera eklemek icin iki yol vardir. ilki Layer>New>Camera,
digeri ise Timeline katman paneline sag tik New>Camera seklindedir. Her iki yontem de Camera
Settings penceresi agilir, sahnede kullanilacak kameranin ayarlari yapilarak kamera sahneye
eklenir (Gorsel 5.30).

Gorsel 5.30: Camera Settings penceresi ve kamera se¢enekleri

Type: Bu bolimde One Node ve Two Node olmak lizere iki tip kamera segilebilir. One Node
kamerada sabitlenmis bir goriintiileme noktasi yoktur. Two-Node Camerada ise sabitlenmis ikinci
bir goriintileme noktasi vardir. Kamera hareketleri bu ikinci nokta referansinda sabitlenebilir.
Genellikle Two-Node Cameranin daha g¢ok kullanildigi gorulir.

Name: Kameraya verilecek isimdir. Bir sahnede birden fazla kamera olabilir. Kameralar,
kullanimina goére isimlendirilebilir.

Preset: Kameranin lens Ozelliklerinin belirlendigi yerdir. Genis agidan dar aglya hazir lens
ayarlari kullanilabilecegi gibi Custom boélimiinden daha 6zel lens ayarlari da yapilabilir.

Enable Depth of Field: Kameranin derinlik alanin acilip kapatilabildigi secenektir. Kameralarin
odaklandigi alan disindaki nesnelerde olusan bulanikligi (Bokeh) ortaya ¢cikarmak icin bu segenek
aktiflestirilebilir.
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Sahneye kamera eklendikten sonra kamera hareketleri icin Tools panelindeki
Gorsel 5.31'de gorilen araglar kullanilabilir ancak kamera hareketinde tam kontrol igin
genellikle Null Object olusturulup, kameranin Parenti yapilarak ¢ahsilir (Gorsel 5.32).

Gorsel 5.31: Kamera kontrol araglari

Gorsel 5.32: Sahnede kamera kontrolii icin Null Object eklenerek kameranin Parent objesi yapilmis hali

Kameraya ait Ozellikler istenirse Timeline katman panelinde Camera katmaninin hemen
yanindaki oka tiklanarak agilan Camera Options bolimiinden de degistirilebilir (Gorsel 5.33).

Gorsel 5.33: Kameraya ait 6zelliklerin katman panelinden goriintiilenmesi

3. UYGULAMA

islem adimlarina gére kamera kullanarak resim galerisi animasyonu gergeklestiriniz.

1. Adim: Cozinarltga Full HD (1920x1080) piksel olan bir Composition olusturunuz.
2. Adim: Sahneye stok sitelerinden indirebileceginiz en az on adet gorsel ekleyiniz.

3. Adim: Create a new composition tiklayarak 800x800 o&l¢ulerinde, Gorsel 1 adinda bir
Composition olusturunuz.
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4. Adim: Olusturulan Compositiona Stroke degeri 50 px olan ici bos bir Rectangular nesnesi
olusturarak bir ¢ergeve ekleyiniz (Gorsel 5.34).

Gorsel 5.34: 50 px Stroke degeriyle olusturulmus cergeve

5. Adim: Gorsel 1 Comp’una belirlediginiz gorsellerden ilkini yerlestirip Scale degerini
ayarlayiniz (Gorsel 5.35).

Gorsel 5.35: Cerceve altina yerlestirilen ve Scale degeri ayarlanan gorsel

6. Adim: Gorsel 1 Comp’unu baslangigta olusturdugunuz ana Comp’a tasiyiniz.

7. Adim: Project bolimiinde yer alan Gorsel 1 Comp’unu Ctrl+D kisayolu ile gorsel sayisinca
cogaltiniz. Ctrl+D’ye her bastiginizda Gorsel 2, Gorsel 3... seklinde artan bir kopyalama goreceksi-

niz.
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8. Adim: Project béliimiinde gorsel sayisi kadar kopyaladiginiz Gérsel Comp’larini Timeline
katman paneline surikleyip birakiniz (Gorsel 5.36).

Gorsel 5.36: Timeline paneline kopyalanarak ¢ogaltilmis Comp’larin taginmasi

9. Adim: Her bir Goérsel Comp’unun igine eriserek gorselini sirayla degistiriniz.

NOT

Gorsel Comp’u icinde resim katmani seciliyken Alt tusuna basilip, Project
bolimiinden baska bir gorsel siriklenerek Timeline katman panelinde secili gorsel
katmaninin Gzerine birakilirsa gorsel hizlica degistirilebilir.

10. Adim: Gorsel Comp’larinin icerigi tamamen degistirildikten sonra Timeline katman pane-
linde tiim katmanlarin 3D 6zelligini aktif hale getiriniz (Gorsel 5.37).

Gorsel 5.37: 3D ozelligi aktif hale getirilen katmanlar

11. Adim: Sahneye 50 mm 6zelliklerinde Two Node Camera ekleyiniz.
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12. Adim: Sahneye Null Object ekleyerek 3D 6zelligini aktif ediniz ve kamerayi Null Objecte
Child olarak baglayiniz (Gorsel 5.38).

Gorsel 5.38: Camera ve Null Objectin eklenerek Parent-Child baginin kurulmasi

13. Adim: Sahne goriiniminid 1 View modundan 2 View moduna alarak gorselleri sahnede
dagitiniz (Gorsel 5.39).

Gorsel 5.39: Sahne goriiniimiiniin 1 View modundan 2 View moduna alinmasi

14. Adim: Sahnedeki gorselleri Gorsel 5.40'ta gorildigu gibi dagitiniz.

Gorsel 5.40: Gorsellerin sahneye dagitilmasi
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15. Adim: Timeline katman alanina bir Null Object daha ekleyip, adini wiggle olarak degistiriniz.

16. Adim: Katman panelindeki tiim gorsel katmanlarini wiggle isimli Null Objecte Child olarak
baglayiniz.

17. Adim: Wiggle isimli Null Objectin 3D katman 6zelligini aktif ediniz.

18. Adim: Wiggle isimli Null Object katmaninin Position 6zelligini Alt tusuna basarak Expression
paneliyle goriintileyiniz. Script olarak wiggle(.3,50) degerini yaziniz (Gorsel 5.41).

Gorsel 5.41: Wiggle isimli Null Objecti ve Wiggle scriptinin eklenmis Expression hali

19. Adim: Gorsellerin hafif hafif sallandigl animasyonu 6n izleyiniz.

20. Adim: Kameranin Child olarak baglandigi Null Objecti sahnede bir resmi gérecek sekilde
konumlandiriniz.

21. Adim: Timeline c¢izgisini 1. saniyeye ayarlayip Null Objectin Position 6zelligine anahtar
kare ekleyiniz.

22. Adim: Timeline gizgisini 20 frame 6teleyerek bir anahtar kare daha ekleyiniz.

23. Adim: Timeline gizgisini 1 saniye 6teleyip Camera Null Objectini baska bir gorseli gorecek
sekilde konumlandiriniz (Gorsel 5.42).

Gorsel 5.42: Null Objecte bagli kameraya anahtar kareler eklenerek hareket ettirildiginde olugan sahne

goruniimii

24. Adim: Bu islemi tim gorseller icin yapiniz.

25. Adim: Arka plan icin New>Solid yolunu izleyerek bir Solid katmani ekleyiniz ve katmani en
alta sirikleyiniz.

Goruntl Efekti Olusturma

313



26. Adim: Solid katmanina Gradient Ramp efekti ekleyerek griden beyaza boyayiniz (Gorsel
5.43).

Gorsel 5.43: Solid katmani ve Gradient Ramp efekti eklenmis katman paneli

NOT

Bu noktadan sonra Particular tarzi videolar eklenerek, katman karisimi degistirilip
farkh etkiler elde edilebilir (Gorsel 5.44).

Gorsel 5.44: Particular eklenerek katman karisimi Screen yapilmis bir videonun etkisi

27. Adim: Yaptiginiz calismayi Numpad 0 tusuna basarak on izleyiniz.
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SIRA SiZDE

Belirleyeceginiz gorsellerle bir galeri animasyonu hazirlayiniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olgutlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. istenen ¢oziiniirliikte Composition olusturdu.

2. ilgili gérselleri calismaya aktardi.

3. Gorsel tutucu olarak 800x800 boyutlarinda, Goérsel 1 adinda bir Comp
olusturdu.

4. Gorsel 1 Comp’unu Project béliminde gorsel sayisi kadar ¢cogaltt.

5. Cogaltilan Comp’lari Katman paneline ekledi.

6. Katman panelinde yer alan Goérsel katmanlarindaki gorselleri degistirdi.

7. Gorsellerin 3D katman ozelligini acth.

8. Wiggle isminde bir Null Object olusturdu.

9. Tum Gorsel katmanlarini Wiggle Null Objectine Child olarak bagladi.

10. Wiggle Null Objectinin Position degerinin Expression kismina wiggle(.3,50)
degerini yazd..

11. 50 mm Two Node Camera ekledi.

12. Kamera icin Null Object ekledi.

13. Kamerayi Null Objecte Child olarak bagladi.

14. Sahnedeki gorselleri sahne uzayinda dagitt.

15. Gorsellerden birine gére kamerayi ayarladi.

16. Timeline cizgisinde gorselden gorsele anahtar karelerle gecis animasyonu
yapt.
17. Calismayi 6n izledi.

4. UYGULAMA

islem adimlarina gére 3D harita animasyonunu gerceklestiriniz.

1. Adim: Cozinarltga Full HD (1920x1080) piksel olan bir Composition olusturunuz.
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2. Adim: Fiziki bir Turkiye haritasi gorselini stok gorsel sitelerinden temin ederek programa
aktariniz.

3. Adim: Scale degerini sahneyi dolduracak sekilde ayarlayiniz.

4. Adim: Tirkiye haritasi gorselinin 3D katman 6zelligini aktif ediniz.

5. Adim: 50 mm Two Node Camera ve kameranin Child olarak bagli oldugu bir Null Object
ekleyerek Null Objectin 3D katman 6zelligini aktif ediniz.

6. Adim: Effects & Presets panelinden Color Emboss efektini harita gorselinin tizerine birakiniz.
7. Adim: Relief Contrast degerini Gorsel 5.45’te goruldigu gibi veya sizin gorselinizde sahte

bir kabarma etkisi yapacak diizeyde degistiriniz.

Gorsel 5.45: Color Emboss efekti eklenmis harita gorseli

8. Adim: Harita gorselinizin Gzerine Mesh Warp efektini ekleyiniz.
9. Adim: Mesh Warp efektinin parametre ayarlarindan Rows ve Columns degerlerini haritada
olusturmak istediginiz kabarma etkisine gore ayarlayiniz (Gorsel 5.46).

Gorsel 5.46: Mesh Warp efektine ait parametrelerin ayarlanmig hali
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10. Adim: Mesh Warp efekti aktifken cizgilerin kesisim noktalarini tiklayip, beliren hareket
tutmacini oynatarak gorseli deforme ediniz.

11. Adim: Orbit Around araciyla gorsel goriis agisini degistiriniz. Harita Gzerinde belirtilen
ylkseltileri Mesh Warp efektiyle deforme ediniz (Gorsel 5.47).

Gorsel 5.47: Mesh Warp efektinin uygulanmasi

12. Adim: Gorsel etkinin daha gliglii olmasi icin golge etkisinden faydalanabilirsiniz. Bunun
icin siyah Solid bir katmani gorselin Gst katmanina ekleyerek 3D 6zelligini aktif ediniz.

13. Adim: Siyah Solid katmaninin gortintrlik goz isaretini kapatiniz.

14. Adim: Golge olmasi gerektigini disindtgliniz yerleri i1sik yoniine dikkat edip, Pen aracini
kullanarak maskeleyiniz.

15. Adim: Golge alanlarini belirledikten sonra katmanin goz isaretini agarak Opacity degerini
ayarlayiniz.

16. Adim: Solid katmani segiliyken F tusuna basarak Maske Feather 6zelligini aginiz.

17. Adim: Gerekli Feather degerlerini ayarlayarak golgeleri yumusatiniz (Gorsel 5.48).

Gorsel 5.48: Golge alanlari olusturularak Mask Feather ile yumusatiimig gorsel
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Gorsel kontrastina katki sunmak istenirse Effects & Presets panelinden Curves
efekti gorselin lzerine siriklenerek egri ayarlari doygunluk ve kontrast yoniinde
degistirilebilir. Ayrica gorselin etkisini gliclendirmek icin istenirse PNG formatinda bulut
gorselleri ile harita desteklenebilir (Gorsel 5.49).

Gorsel 5.49: Curves efekti ve PNG bulut gorselleri ile desteklenmis harita

18. Adim: Pen araciyla haritanin bir bolgesinden diger bolgesine uzanan bir cizgi olusturunuz
(Gorsel 5.50).

Gorsel 5.50: Pen araciyla gizilmis bir ¢izgi
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19. Adim: Gorsel 5.51'de gorildigiu gibi Shape katmanin Contents bolimiinde yer alan Add
sekmesinden Stroke o6zelligi ekleyiniz.

Gorsel 5.51: Stroke 6zelliginin eklenmesi

20. Adim: Katmanlara eklenen Stroke 6zelliginin Dashes alt 6zelliginin + ikonuna tiklayarak
Dash ve Offset 6zelliginin belirmesini saglayiniz (Gorsel 5.52).

Gorsel 5.52: Dashes 6zelligi altina Dash ve Offset alt 6zelliginin eklenmesi

21. Adim: Cizgi katmaninin 3D 6zelligini aktif ederek sahnede yeniden konumlandiriniz.
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Katmanlar arasi Z ekseninde fark coksa kamera acisi degistiginde goriintiler
bulundugu yerden kayabilir. Bu nedenle Z ekseni degeri tekrar ayarlanabilir.

22. Adim: Dashes ozelligi acildiginda sahnedeki diiz cizgi, kesikli cizgiye donisir. Content>Add
yolunu izleyerek Trim Paths 6zelligi ekleyiniz (Gorsel 5.53).

Gorsel 5.53: Trim Paths 6zelliginin End degerinin degistiriimesiyle animasyon elde edilmesi

23. Adim: Trim Paths 6zelliginin End degerini 0. saniyede 0, 2. saniyede 100 olarak anahtar
karelerle anime ediniz.

24. Adim: Cizginizin gectigi bolgelerdeki bazi illerin isimlerini lokasyon olarak yaziniz.

illerin isimlerinin yanina Gérsel 5.54’te gériildiigi gibi lokasyon ikonu da eklenebilir.
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Gorsel 5.54: Bazi illerin lokasyon ikonlu hali

25. Adim: illerin isimlerini ve varsa lokasyon ikonlarini ¢izgi Trim Path animasyonu tam o
bolgeye denk geldiginde ortaya cikacak sekilde Timeline gizgisinde konumlandiriniz (Gorsel 5.55).

Gorsel 5.55: Cizgi animasyonuna gore beliren sehir adlari ve lokasyon ikonlari

26. Adim: Timeline gizgisini 0. saniye alip kameranin Parent nesnesi olan Null Objectin
Shift tusuna basiliyken Positon (P) ve Orientation (R) parametrelerini ilgili klavye tuslariyla
gorlntileyiniz.

27. Adim: Position ve Orientation parametreleri icin 0. saniyede birer anahtar kare ekleyiniz.

28. Adim: Timeline ¢izgisini 2. saniyeye aliniz.
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29. Adim: Gorsel sahnede yatay gorinebilecek sekilde Null Objectin degerlerini degistiriniz
(Gorsel 5.56).

Gorsel 5.56: Kamera Null Objectinin degerlerindeki degisime goére sahne goériinlimiiniin degismesi

NOT

istenirse ¢izgi animasyon siiresi uzatilarak farkl kamera animasyonlari da yapilabilir.

SIRA SiZDE

Belirleyeceginiz bir haritada benzer kabartma, gizgi ve lokasyon isimli bir animasyon
gerceklestiriniz.

DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

1. istenen ¢oziiniirliikte Composition olusturdu.

2. ilgili gorseli calismaya aktarip 3D katmanini aktiflestirdi.

3. Gorsele Color Emboss efekti uyguladi.

4. Gorsele Mesh Warp efekti uygulayarak gorsel ylkseltilerini deforme etti.

5. Curves efekti ile gorsel renk dengesini sagladi.

6. Pen araci yardimiyla gorsel boyunca ¢izgi ¢izdi.
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DEGERLENDIRME OLCUTLERI EVET HAYIR

7. Cizgi katmanina Stroke 0Ozelligi ekleyerek Dashes alt 6zelligini aktif etti.

8. Cizgi katmanina Trim Paths efekti uyguladi.

9. Trim Paths animasyonu gerceklestirdi.

10. Harita Uzerinde ¢izginin gectigi cesitli lokasyonlarin isimlerini yazdi.

11. ismi yazilan lokasyonlarin ¢izgi animasyonuna gére sahnede belirmesini
sagladi.

12. Sahneye 50 mm Two Node Camera ekledi.

13. Kameranin Parenti olacak Null Object ekledi.

14. Null Objectin Position ve Orientation degerleriyle animasyonu gerceklestir-
di.

5. UYGULAMA

islem basamaklarina gére goriintii isleme programinda Dekupe edilen gorselleri
kullanarak bir animasyon gergeklestiriniz.

1. Adim: CozinGrlGga Full HD (1920x1080) piksel olan bir Composition olusturunuz.

2. Adim: Kompozisyon olusturabilecek en az dort adet gorsel belirleyerek gorsellerdeki gerekli
nesneleri maskeleyiniz veya goriintl isleme programinda Dekupe islemi yaparak gorsel efekt
programina aktariniz (Gorsel 5.57).

Goruntuler gorsel efekt programinda maske yontemi kullanilarak da animasyona
hazir hale getirilebilir ancak bazi gorsellerde daha ¢ok detay secilmesi gerektigi icin
goriintli isleme programindan yardim alinmasi gerekir.

Uygulamadaki kompozisyon daglari seyreden bir dagci fikrine dayanir. Birbirinden
farkh gorsellerden daglar Dekupe edilmistir. Dagci gorseli ile magara gorseli birlesti-
rilerek tek gorsel haline getirilmistir. Boylece zemin gorseli, sahnenin sol tarafina bir
dag gorseli, sag tarafina bir dag ve en geride magaradan daglari seyreden dagci gorseli
hazirlanarak bir kompozisyon olusturulmustur.

Gorsel 5.57: Birbirinden farkli gérsellerden uygun alanlar Dekupe edilerek farkli katmanlara yerlestirilen
gorseller
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3. Adim: En alt zemine yerlestireceginiz gorsel disinda kalan katmanlarin 3D katman 6zelligini
aktif hale getiriniz (Gorsel 5.58).

Gorsel 5.58: Katmanlarin 3D 6zelliklerinin aktiflestirilmesi

En alt zemine yerlestirilen gorselin 3D 6zelligi aktif olmadiginda calisma uzayinin
zemini daima bu gorsel olur.

4. Adim: Sahneye 50 mm Two Node Camera ve kameranin Child olarak baglanacagi 3D katman
ozelligi aktiflestirilmis Null Object ekleyiniz (Gorsel 5.59).

Gorsel 5.59: Camera ve Null Objectin eklenmesi

5. Adim: Kamera, zemin gorselinden baslayarak geriye dogru hareket edecektir. Hangi gorselin
hangi sirayla gelmesini istiyorsaniz sahne uzayinda buna gore bir yerlestirme yapiniz (Gorsel
5.60).

—> Dag Sol

—> Dag Sol
—> Kamera

—> Dagcl

Gorsel 5.60: Gorsellerin sahne uzayina yerlestirilmesi
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6. Adim: Kameray! Ucer saniyede bir gorsele erisecek sekilde Position animasyonu Z ekseninde
geriye dogru hareket ettiriniz (Gorsel 5.61).

Kameranin diz ilerlemesi istenmezse saga, sola, yukari, asagl hareketler eklenerek
Position anahtar kareleriyle animasyona degisik etkiler katilabilir.

—> Kamera animasyonun baslangic noktasi

—> Kamera animasyonun bitis noktasi

Gorsel 5.61: Kameranin Position animasyonunun gergeklestirilmesi

Kamera geriye dogru hareket ederken uzakta kalan nesneler giderek kiigilecektir.
Bu etkiyi verebilmek igin istenirse gorsellerin Scale degerleri de anime edilerek daha
gercekei etkiler saglanabilir.

7. Adim: Calismayi 6n izleyiniz. Gorsellerin Scale ve Position degerlerini gerekirse yeniden
ayarlayiniz.

SIRA SiZDE

Bir kompozisyon icin belirleyeceginiz gorsellerden gerekli maskeleme veya Dekupe
islemi yaparak bir animasyon gergeklestiriniz.
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DEGERLENDIRME

Calismalariniz asagida yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme olcitlerini dikkate aliniz.

KONTROL LIiSTESI

DEGERLENDIRME OLCUTLERI EVET HAYIR

1. istenen ¢oziiniirlikte Composition olusturdu.

2. Kompozisyonu belirledi.

3. Kompozisyon i¢in uygun gorselleri belirledi.

4. Gorsellere maskeleme veya Dekupe islemi yapt.

5. Zemin gorseli harig diger gorsellerin 3D katman o6zelligini aktiflestirdi.

6. Gorselleri sahne uzayina uygun bicimde yerlestirdi.

7. 50 mm Two Node Camera ekledi.

8. Null Object ekledi.

9. Null Objecti kameranin Parenti olarak ayarladi.

10. Gorselleri sirayla gorecek sekilde kamerayi anime etti.

11. Calismayi 6n izledi.

5.3. SAHNEDE ISIK

Gorsel bir tasarimin 6nemli unsurlarindan biri de isiktir. Isik, gorsel efekt programlarinda
sadece sahne dolgu unsuru olarak degil, animasyonun kendisi olarak da kurgulanabilir. Gorsel
efekt programinda yardimci Pluginler sayesinde sahneye eklenebilen 3D nesnelerin sahneyle
uyumu icin de 1sik nesnelerinden yardim alindigi unutulmamalidir.

Sahneye 1sik ekleyebilmek icin iki ydntem vardir. ilki, Layer>New>Light... yolunu kullanmaktr.
ikinci yol ise Timeline katman paneline sag tik>New>Light... yoludur. Her iki ydntem de Gérsel
5.62’'deki Light Setting penceresini gorltintlleyecektir.
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Gorsel 5.62: Light Settings penceresinin goriintiilenmesi

Light Settings penceresindeki parametreler sunlardir:

Name: Isigin isminin belirlendigi alandir.

Light Type: Isik tipinin belirlendigi alandir. Paralel, Spot, Point ve Ambient olmak lzere dort
farkh 1sik tiird segilebilir.

Color: Sahnenin dokusuna ve isigin kullanilacagi nesnenin rengine gore 1sik rengi belirlenebilir.
Intensity: Isik yogunlugunun belirlendigi parametredir.

Cone Angle: Spot isik tirl disinda pasif olan degerdir. Isik tiirt Spot secildiginde diizenlenebilir.
Cone Feather: Spot isik tiirlintin yayllmasinin keskinliginin ayarlandigi parametredir.

Falloff: Isik kaynaginin aydinlatma siddetinin Intensity degerine bagh olarak aydinlatma
¢apinin, aydinlatma c¢api icinde aydinlatilan bdlgenin genisliginin ayarlandigi, Radius ve Falloff
Distance degerlerinin yer aldigi parametredir.

Casts Shadows: Secilen isik tliriiniin nesnelere carptiginda golge Uretip Uretmeyeceginin
belirlendigi secenektir.

Shadow Darkness: Uretilen gélgenin koyulugunun ayarlandigi parametredir.

Shadow Diffusion: Golgenin ne kadar dagilacagini veya bulaniklasacagini belirleyen
parametredir.
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Bir 1sik tlirt eklendikten sonra katman panelinden Light Settingse erisilerek isik tird
ve diger ozellikleri degistirilebilir. Sahneye isik eklendikten sonra sahnedeki nesnelerin
Istk karsisindaki davranislari katman panelindeki Material Options bdliminden
belirlenebilir. Gorsel 5.63’te bu 6zelliklerin detaylari verilmistir.

Gorsel 5.63: Material Options boliimiinden nesnelerin 1siga karsi davraniglarinin ayarlanmasi

Material Options bolimiinde Casts Shadows, Light Transmission, Accept Shadows,
Accept Lights baslangicta en ¢ok kullanilan parametrelerdir. Diger parametreler ise 151k
detayi ve hassasiyeti gerektiginde kullanilir.

Casts Shadows: Nesnenin gblge olusturmasi, sadece golgenin kalip nesnenin kaybolmasi ve
goblgenin olmamasi durumudur. On, Only ve Off seklinde lg deger alabilir (Gorsel 5.64).

Casts Shadows: On Casts Shadows: Only Casts Shadows: Off

sue

Gorsel 5.64: Casts Shadows degerleri degistiginde olusan etki
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Light Transmission: Nesnenin 1sik gecirgenligini ayarlar. Light Transmission degeri arttikca
nesne kendi rengini golgeye yansitir (Gorsel 5.65).

Gorsel 5.65: Light Transmission degeri arttikga nesne renginin golgeye yansimasi

Accept Shadows: Casts Shadows ile benzer gorevdedir. Cast Shadows parametresine

bagimlidir.

Accept Light: Nesnenin renk ve gorindrlik durumlarinin sahne isiklarindan etkilenip
etkilenmemesini ayarlayan degerdir.

Diger parametreler nesneye diisen isiga daha hassas davranislar sergilemek igin kullanilir.

6. UYGULAMA

islem adimlarina goére eklenen 1sigin Position animasyonunu gerceklestiriniz.

1. Adim: CozUnUrlGga Full HD (1920x1080) piksel olan bir Composition olusturunuz.
2. Adim: Sahneyi tiimuyle kaplayacak agik gri renkli bir Shape olusturunuz.

3. Adim: Shape layerin 3D katman 6zelligini aktiflestiriniz.

4. Adim: Sahneye “Gorsel Efekt” veya uygun olabilecek baska bir kelime yaziniz.

5. Adim: Shape katmanini X ekseninde 90 derece dondirerek yatay bir zemin olmasi icin

sahnenin en altina hizalayiniz.

6. Adim: Yazdiginiz kelimeyi de zemine gére konumlandiriniz (Gérsel 5. 66).

Gorsel 5.66: Zemin ve kelimelerin konumlandirilmasi
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7. Adim: Sahneye Point tlrlinde bir 1sik ekleyiniz.
8. Adim: Is1g81 Gorsel 5.67°de gorildugi gibi metnin arkasina konumlandiriniz.

9. Adim: Material Options 6zelliklerinden Casts Shadows 6zelligini acarak metnin golgesinin

olusmasini saglayiniz.

Gorsel 5.67: Isigin konumlandirilmasi ve golgenin aktiflestirilmesi

10. Adim: Isig1 sahnenin en solunda olacak sekilde konumlandiriniz.
11. Adim: Position 6zelligi icin 0. saniyeye bir anahtar kare ekleyiniz.

12. Adim: Timeline gizgisini 2. saniyeye aliniz. Isik nesnesini sahnenin en sagina dogru X
ekseninde hareket ettiriniz. Gorsel 5.68’de oldugu gibi bir etki géreceksiniz.

Gorsel 5.68: Isik nesnesinin Position animasyonuyla olugan etki

7. UYGULAMA

islem adimlarina gore pencere, isiyan nesneler vb. sahnelerde kullanilabilecek
calismayi gergeklestiriniz.

1. Adim: CozunUrlGga Full HD (1920x1080) piksel olan bir Composition olusturunuz.
2. Adim: Sahneyi tiimuyle kaplayacak agik gri renkli bir Shape olusturunuz.
3. Adim: Shape nesnesinin 3D katman 6zelligini aktiflestiriniz.

4. Adim: Shape nesnesini X ekseninde 90 derece déndirerek zemin haline getiriniz.
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5. Adim: Zemin Uzerine Text aracini kullanarak EFEKT yaziniz. 3D katman 6zelligini aktiflestiriniz
ve Gorsel 5.69’da oldugu gibi sahnede konumlandiriniz.

Gorsel 5.69: Zemin ve yazinin konumlandiriimasi

6. Adim: 28 mm Two Node Camera 6zelliklerinde bir kamera ekleyiniz.
7. Adim: Cast Shadows 0zelligi aktif olan Point tlrlinde bir 1sik ekleyiniz.
8. Adim: Eklenen 15181 sahnede yazinin gerisine konumlandiriniz.

9. Adim: Text katmaninin Casts Shadows 6zelligini aginiz (Gorsel 5.70).

Gorsel 5.70: Isigin konumlandirilmasi ve Text katmaninin golge 6zelliginin agilmasi

10. Adim: Beyaz renkte bir Solid nesnesi ekleyerek 3D katman 6zelligini aktiflestiriniz.
11. Adim: Elips Tool kullanarak Solid nesnesinin merkezinde daire seklinde maskeleme yapiniz.
12. Adim: Material Options se¢eneklerinden Accept Light secenegini Off yapiniz.

13. Adim: Maskelenen beyaz renkli Solid katmani yazi nesnesinin arkasina, 1s1ga yakin bir
konuma strtkleyiniz (Gorsel 5.71 ).

Gorsel 5.71: Beyaz Solid katmaninin konumlandirilmasi
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14. Adim: Katman paneline Adjustment Layer ekleyiniz.

15. Adim: Adjustment Layer katmanina CC Radial Fast Blur efekti ekleyerek parametreleri
Gorsel 5.72'de gorildugi gibi ayarlayiniz.

Gorsel 5.72: CC Radial Fast Blur efektinin Adjustment Layer katmanina eklenmesi ve ayarlanmasi

16. Adim: Adjustment Layer katmaninin karisim modunu Screen olarak degistiriniz.
17. Adim: Katman paneline bir Null Object ekleyiniz ve 3D katman 6zelligini aktiflestiriniz.

18. Adim: Null Objectin konumunu i1sik nesnesinin arkasina gelecek sekilde ayarlayiniz.

NOT

Adjustment Layer katmaninda yer alan Center parametresi Child olarak Null Objecte
baglanmalidir. Aksi halde kamera yonii degistiginde Adjustment Layerda etki gosteren
CC Radial Fast Blur efekti dogru yonde durmaz.

19. Adim: Gorsel 5.73'te gosterilen CC Radial Fast Blur efektine ait Center degerinin anahtar
karesine Alt tusu ile birlikte basarak Expression aktif hale getiriniz.

20. Adim: Pick Whip Tool araci ile Null Object katmanini Parent olarak baglayiniz.

21. Adim: Expression kismindaki scripti “thisComp.layer("Null 2").toComp([0,0,0]);” sek-
linde diizenleyiniz.

Null 2, Null 1 veya baska isimle olabilir. Katman panelinde yazan isim énemlidir.

P Pick Whip Tool araci

Script bu sekilde tamamlanmahdir.

Gorsel 5.73: Expression aktiflestirilmesi ve yazilan script
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23. Adim: Adjustment Layer katmanina Curves efekti ekleyerek kontrastini artiriniz (Gorsel
5.74).

Gorsel 5.74: Curves efektinin eklenmesi ve ayarlanmasi

24. Adim: Adjustment Layer katmanina ikinci Curves efektini CC Radial Fast Blur efektinin
altina ekleyiniz. Red, Green ve Blue parametrelerini Gorsel 5.75’te goruldugi gibi ayarlayiniz.

Gorsel 5.75: Eklenen ikinci Curves efektinin egri ayarlari
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25. Adim: Adjustment Layer katmanina son olarak Tint efekti ekleyerek Map White To rengini
mavi yapiniz (Gorsel 5.76).

Gorsel 5.76: Tint efektinin eklenmesi

26. Adim: Tint efektinin rengini degistirerek farkh renklerde i1simalar elde ediniz (Gorsel 5.77).

Gorsel 5.77: Tint efektinin renginin degismesiyle farkli isimalarin elde edilmesi

SIRA SiZDE

Belirleyeceginiz bir kelime Gzerinde 1sima efekti gerceklestiriniz.

DEGERLENDIRME

Calismalariniz diger sayfada yer alan kontrol listesi kullanilarak degerlendirilecektir. Calismanizi
yaparken degerlendirme ol¢itlerini dikkate aliniz.
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KONTROL LiSTESI

DEGERLENDIRME OLGUTLERI EVET HAYIR

. Istenen ¢éziiniirlitkte Composition olusturdu.

. Zemin katmani olusturdu.

. Zemini 3D hale getirdi.

. Zemini sahneye konumladi.

. Metni yazdi.

. Metni 3D hale getirdi.

. Metni sahneye konumladi.

. Kamera ekledi.

O (0 N[O U & W N | R

. Point tlirlinde Light nesnesi ekledi.

=
o

. Beyaz Solid nesnesi ekleyerek Elips Tool ile maskeledi.

11. Adjustment Layer ekledi.

12. Adjustment Layer katmanina CC Radial Fast Blur efekti ekledi.

13. Adjustment Layer katmanina Curves efekti ile kontrast ayari yapt.

14. Adjustment Layer katmaninin karisim modunu Screen olarak belirledi.

15. Katman paneline Null Object ekledi.

16. Null Objectin 3D katman o6zelligini aktiflestirdi.

17. CC Radial Fast Blur efektinin Center degerini Null Objecte Pick Whip Tool
araciyla baglad.

18. Null Objecte Pick Whip Tool araciyla baglanan Center degerinin Expression
scriptini tamamladi.

19. Adjustment Layer katmanina ikinci Curves ekleyerek Red, Blue ve Green
degerlerini ayarladi.

20. Adjustment Layer katmanina Tint efekti ekleyerek isima rengini degistirdi.

8. UYGULAMA

islem adimlarina gére belirlediginiz alanda 1sima efektini gerceklestiriniz.

1. Adim: Cozinarltga Full HD (1920x1080) piksel olan bir Composition olusturunuz.
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2. Adim: Gorsel 5.78'de gorildigu gibi bir video bularak veya cekerek sahneye ekleyiniz.

Gorsel 5.78: Isimada kullanilabilecek videonun bir kesiti

3. Adim: Sahneye eklediginiz videoya 3D Camera Tracker efektini uygulayiniz.

4. Adim: Gorsel 5.79'da gorildagi gibi sahne tzerinde Tracker yapilabilecek noktalardan
Isima alanina en yakin olanlari seginiz.

Gorsel 5.79: Tracker alanlarindan isima bélgesine en yakin olanlarin segilmesi

5. Adim: Secim yapilan Tracker bolgesinde sag tiklayip Create Null and Camera segenegini
isaretleyiniz.
6. Adim: Sahneye Adjustment Layer ekleyiniz.

7. Adim: Adjustment Layer katmanina Curves efekti ekleyip degerleri Gorsel 5.80’de oldugu
gibi ayarlayiniz.

NOT

Bu calismada mavi isima renkleri kullanilacagi icin tonlama Gorsel 5.80’de gorildigi
gibi ayarlandi. Farkli renkler istenirse Curves egrileri ona gore ayarlanabilir.
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Gorsel 5.80: Curves egrilerinin son durumu

8. Adim: Adjustment Layer katmanina CC Radial Fast Blur efekti ekleyiniz. Zoom parametresini
Brightest olarak degistiriniz. Amount degerini uygun gordiginiz bir degere dogru yikseltiniz.

9. Adim: Adjustment Layer katmanin karisim modunu Screen yapiniz (Gorsel 5.81).

Gorsel 5.81: Sahnenin son durumu

10. Adim: Adjustment Layer katmaninda yer alan CC Radial Fast Blur efektine ait Center
parametresini eklediginiz Null Objecte Child olarak baglayiniz ve Expression kismina “thisComp.
layer("Track Null 1").toComp([0,0,0]); ” scriptini yaziniz.

11. Adim: Null Objectini isima alaninin merkezinde konumlandiriniz (Gorsel 5.82).

Gorsel 5.82: Null Objectin 1isima alaninin merkezinde konumlandiriimasi
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12. Adim: Adjustment Layer katmanina Tint efektini ekleyiniz. Map White To rengini mavi
veya ¢alismaniza uygun bir renk olarak belirleyiniz.

13. Adim: Adjustment Layer katmaninin Effect Controls panelinde Curves efektinden hemen
sonra araya Fractal Noise efektini ekleyiniz. CC Radial Fast Blur ve Tint efektleri, Fractal Noise
efektinden sonra gelmelidir.

14. Adim: Fractal Noise efektinde Fractal Type: Dynamic, Blending Mode: Darken olarak
belirleyiniz.

15. Adim: Evolution parametresinin anahtar kare ikonuna Alt tusu ile basarak Expression
kismina time*25 scriptini yaziniz (Gorsel 5.83).

Gorsel 5.83: Efektler ve gerekli Expression scriptler yazildiktan sonra sahnenin son hali

16. Adim: Calismanizi Numpad 0’a basarak 6n izleyiniz.
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OLCME VE DEGERLENDIRME

A) Asagidaki sorulari dikkatlice okuyarak dogru secenegi isaretleyiniz.

1. Asagidaki kisayol tuslarindan hangisi gorsel efekt programinda Expression béliiminii
aktiflestirir?

A) Alt B) Ctrl C) Shift D) Shift+Ctrl E)Z

2. Asagidakilerden hangisi gorsel efekt programinda i1sik nesnesinin golge olusturmasi igin

secilmelidir?
A) Depth of Field B) Accept Light C) Metalic
D) Casts Shadows E) Falloff Distance

3. Asagidaki tuslardan hangisi Effect Control panelini acip kapatir?
A) F4 B) Alt C)F3 D) F12 E) Alt Gr

4. Pluginler igin asagidakilerden hangisi yanhstir?

A) Pluginler Efektlerin kolayca uygulanmasini saglar.

B) Pluginler Ucretli ve (icretsiz olabilir.

C) Gorsel efekt programina U¢ boyutlu nesne ekleyebilmek i¢in Plugine ihtiyag vardir.
D) Gorsel efekt programinin standart sunmadigi bazi 6zellikleri igerir.

E) Pluginler sahne Olcilerinin ayarlanmasina yardimci olur.

5. Gorsel efekt programinda kamera tipi sayisi asagidakilerden hangisinde dogru verilmistir?

A)1 B) 2 Q)3 D)4 E)5

6. Asagidakilerden hangisi bir katmana efekt ekleme yoludur?

A) Effects & Presets B) Layer>New>Effects C) Window>View>Effect

D) Compotision>Preview E) Views>Effects

7. Sallanma Expression scripti asagidakilerden hangisidir?

A) anchorPoint B) Bounce C) random D) time E) wiggle

8. Asagidaki efektlerden hangisi eklendigi gorselde deformasyon meydana getirir?

A) Tint B) Curves C) Mesh Warp D) Fractal Noise E) Color Emboss

9. Asagidakilerden hangisi bir katmana efekt ekleme yoludur?

A) Tint B) Optics Compensations C) Fractal Noise
D) Displacement Map E) Gradient Ramp
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CEVAP ANAHTARLARI

. OGRENME BiRiMiNiN CEVAP ANAHTARI

.G 2.C,3.B,4.E,5.B,6.E,7.D,8.C,9.C,10. B

. OGRENME BiRiMiNiN CEVAP ANAHTARI

.C,2.B,3.B,4.B,5.C,6.E,7.B8,8.E,9.D, 10. B, 11. D

. OGRENME BiRiMiNiN CEVAP ANAHTARI

.E,2.A,3.A,4.E,5.C,6.B,7.A,8.D,9.C,10. A

. OGRENME BiRiMiNiN CEVAP ANAHTARI

.A2.B,3.D0,4.D,5.E,6.C,7.E,8.C,9.C

. OGRENME BiRiMiNiN CEVAP ANAHTARI

.A,2.D0,3.C,4.E,5.B,6.A,7.E,8.C,9.E
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